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The ScadaPro RTE User Guide contains detailed information about using ScadaPro Real Time Engine Data Acquisition Software package.

The guide assumes a working knowledge of Windows. For information on Windows please refer to the documentation supplied with that product.

The guide details the use of the core Real Time Engine. For information concerning external Input / Output devices please refer to the documentation supplied with that product.

The guide details the use of the core Real Time Engine. For information concerning external Input / Output devices connected to the system please refer to Appendix A at the rear of this manual.
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You can use a single-button mouse or a multiple-button mouse with ScadaPro.

If you have a multiple-button mouse, the left hand button is the primary mouse button, unless you have configured it differently.
“Point” means to position the mouse pointer until the tip of the pointer rests on whatever you want to point to on the screen
“Click” means to press and immediately release the mouse button without moving the mouse.
“Double Click” means to press the mouse button twice in quick succession without moving the mouse.
“Drag” means to point and then hold down the mouse button as you move the mouse.
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Preface

Throughout this manual the Control key is referred to as CTRL. The Escape key is shown as ESC. Key combinations are shown as CTRL+E, which requires the user to press both the Control key and the E key simultaneously.
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[bookmark: _Toc408990966]Part One – Overview / Installation
Part one introduces the ScadaPro Product and outlines how to install the ScadaPro Software

[bookmark: _Toc394464700][bookmark: _Toc394745873][bookmark: _Toc394916757][bookmark: _Toc395410223][bookmark: _Toc457898902][bookmark: _Toc408990967]
Introduction
ScadaPro is Real Time Data Acquisition software for Microsoft Windows. It is designed as mission critical software running on a mission critical operating system.

Optimised to use the powerful real time, multi-tasking features of Windows, ScadaPro provides integrated data acquisition, monitoring, data logging, mimic development and report generation.

The product comprises of a user configurable real time engine that collects and processes the measured data and configurable object orientated graphics engine that can be used to design graphical user interfaces and real time display. The real time engine interfaces to external data collection devices from which it imports the data to a real time memory resident database. Here it processes and redirects this data to other tasks such as alarm monitors, data loggers, real time calculators, trend displays and mimics. 
[bookmark: _Toc394464701][bookmark: _Toc394745874][bookmark: _Toc394916758][bookmark: _Toc395410224][bookmark: _Toc457898903]Main Features
Fully User Configurable
True Real time Operation
Up to 64 Independent Data Loggers
In Built Prioritised Alarm Processing and Logging
Real Time Calculator
Multi-Document Interface (MDI) Channel Monitor Displays.
Scaleable Object Orientated Graphic Display System
MDI Based Real Time Trends of Measured Data
User Configurable Menus and Displays
Expandable from 8 to 10,000 Channels
[bookmark: _Toc394464702][bookmark: _Toc394745875][bookmark: _Toc394916759][bookmark: _Toc395410225][bookmark: _Toc457898904]Software Architecture 
The software architecture of ScadaPro exploits the modular multi-tasking structure of Windows. The architecture can be broken down into input, output and processing tasks. Input tasks enable the system to acquire data. Output tasks redirect this data to devices such as printers, displays, disk drives etc. 

Processing tasks such as calculators or alarm monitors process the data. Central to this architecture is a real time database called a data module.

The data module provides the real time interchange between the various tasks. Data can be shared between tasks such that different tasks have access to a common data pool. This allows the same acquired data to be processed, logged and displayed simultaneously. A diagram of the software architecture is shown on the following page.
[bookmark: _Toc394745876][bookmark: _Toc394916760][bookmark: _Toc395410226][bookmark: _Toc457898905]Client Software Features
The ScadaPro software supports Client/Server functionality from version 1.3 onwards. The ScadaPro Client software allows Client machines to access ScadaPro via a PC connected to the server using an existing site network.

From the ScadaPro Client, the user can:
Configure - Devices, Processors and Loggers
Control - Enable, Disable, Restart and Initialise
Monitor Data and Alarms
Trend - Real Time & Historic data
Export – Data
Change Channel Values and Acknowledge Alarms
Part One		Installation Procedure
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ScadaPro ConfigurationOther applications


Spreadsheets



Printer


Replays
Loggers
Data 
Export
Trend 
Windows
Alarm 
Listing
Logger
1
Logger
64
Alarm Logger

All aspects of the product are user configurable and simple to use. Point and click techniques encompassed with pull down menus make it easy to navigate around the software. Separate windows for configuration menus enable configurations to be checked on line. System design, integration, commissioning, and training costs are significantly reduced with this product.
[bookmark: _Toc394464704][bookmark: _Toc394745878][bookmark: _Toc394916762][bookmark: _Toc395410228][bookmark: _Toc457898907]Data Acquisition
The true real time multi-tasking operation of the product enables data to be acquired in real time from a wide selection of devices including programmable logic controllers (PLCs), 3 term controllers and other intelligent devices.

The system architecture permits a large number of devices to be connected to the host computer (depending on available serial ports).
[bookmark: _Toc394464705][bookmark: _Toc394745879][bookmark: _Toc394916763][bookmark: _Toc395410229][bookmark: _Toc457898908]Real Time Calculator
The real time calculator allows the creation and calculation of data directly from signal inputs. Calculations can be devised in a free form fashion and can be processed in the same way as other data i.e. logged, displayed, animated or alarm processed.
[bookmark: _Toc394464706][bookmark: _Toc394745880][bookmark: _Toc394916764][bookmark: _Toc395410230][bookmark: _Toc457898909]Alarm Processing
An important aspect of monitoring systems is the ability to handle alarms and events. With ScadaPro, each channel can be given an event and an alarm condition. Each alarm condition can be given priority and an associated block of text to give meaning to the alarm.

Alarm channels can be linked to a common alarm output channel for annunciation purposes, or to automatically switch off important parts of the process or plant.

The alarm monitor allows operators to monitor and acknowledge their occurrence. The integral alarm logger records all alarms and the time they were acknowledged.
[bookmark: _Toc394464707][bookmark: _Toc394745881][bookmark: _Toc394916765][bookmark: _Toc395410231][bookmark: _Toc457898910]Data Logging
SCADAPRO can operate up to 64 independent logging tasks, each of which can be configured to take 64 independent groups of channels to files or databases.

The loggers can be configured to operate on a period basis, an event basis or period until event basis. In addition there is a separate alarm logger that stores all alarms identified by the system. Loggers can be cycled to store data on an hourly, daily, weekly or shift basis.
[bookmark: _Toc394745882][bookmark: _Toc394916766][bookmark: _Toc395410232][bookmark: _Toc457898911]Trends
MDI is used to present the real time trends. This means a number of separate trends can be displayed on the screen simultaneously. Each trend can support infinite channels of data. Features such as pan and zoom make it simple to isolate specific areas of interest. Trend displays can be any length from a few seconds to 50 years (dependent on disk space)
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ScadaPro Server Installation
[bookmark: _Toc408990969]Hardware requirements
The following are the minimum and recommended hardware requirements needed to run the ScadaPro Data Acquisition Software
Minimum Requirements
Windows XP Professional
Pentium 300-megahertz (MHz) processor or faster
At least 256 megabytes (MB) of RAM 
At least 2.0 gigabytes (GB) of available space on the hard disk 
CD-ROM or DVD-ROM drive
Free USB Port
Keyboard and a Microsoft Mouse or some other compatible pointing device
Video adapter and monitor with Super VGA (1024 x 768 x 256 colour) or higher resolution

Recommended Requirements
[bookmark: _Toc394464713][bookmark: _Toc394745886][bookmark: _Toc394916770][bookmark: _Toc395410236][bookmark: _Toc457898915]Windows 7 Professional
1 gigahertz (GHz) or faster processor
4 GB RAM
20 Gb free disk space
DVD-ROM Drive
Free USB port
Keyboard and a Microsoft Mouse or some other compatible pointing device
Video adapter and monitor with Super VGA (1024 x 768 x 256 colour) or higher resolution
Sound Card
 Hardware Key Installation
The ScadaPro Server software can be supplied with a hardware key or a software key 

If you are using a hardware key then you will need to select the key type during installation. There are 2 key types newer HASP HL keys or older Sentinel SuperPro keys. The hardware key should be plugged into the parallel or USB port of the ScadaPro Clent machine before installing the software.

Server and Client Keys are different. The software will not operate if the wrong key is used.

If you are using a Sentinel SuperPro USB hardware key, you will need to install a driver for the Sentinel USB dongle before running the Server setup. 
Installing ScadaPro Server 
It is essential you log on with Administrator privileges before installing the ScadaPro Server.

The ScadaPro Server software can be installed on a partition formatted to NTFS, or a standard FAT partition.  

The ScadaPro Server software can be installed with either a Sentinel hardware key or a software key.

Before installing the ScadaPro software you need to know the number of data loggers you will require.

Press the Windows button and R ([image: Picture of the Windows logo key]+R.) 
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Click NEXT to continue the installation.
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When installation starts you will be prompted to install select which type of installation you require.  If you are using a Sentinel SuperPro hardware key you must install the sentinel protection system. If you are using a HASP HL Key you must install the HASP runtime software.

Click the “Hardware Key – HASP HL Key” button in the following dialog to install the HASP runtime software.

Click the “Hardware Key – Sentinel SuperPro Key” button in the following dialog to install the sentinel protection system.  

If you will be using a software key then click the “Software Key” button in the following dialog and installation of the software will continue.  If you are using a software key you can skip the Sentinel protection system installation section below and proceed to the ScadaPro Server Installation section.

If you wish to install the evaluation version of the software, which does not require an unlock code, or the Sentinel Protection software installed click the “Demo Version” button.

[image: ]

HASP Runtime Driver Installation (Hardware Key only)

If you are using a USB key do not plug the key into the machine until the HASP runtime driver phase has been completed (see below).

After you click the HASP HL Key button, a command line installation will run as shown in the image below, wait for it to complete.

[image: ]

Once the installtion is complete it will show you a message as below, simply click OK to continue to the installtion of the SCADAPRO client.

[image: ]

You can now connect your USB Hardware Key, it will be automaticlly recognised and installed.
Sentinel Protection System Installation (Hardware key only)
If you are using a parallel hardware key the key should be plugged into the parallel port of the ScadaPro Server machine before continuing.  If you are using a USB key do not plug the key into the machine until the Sentinel Protection System installation phase has been completed (see below).

Server and Client Keys are different. The software will not operate if the wrong key is used.

Click Next to continue the Sentinel Protection System installation

[image: Sent1]














Click “I accept the terms in the license agreement” and click Next

[image: Sent2]

Click the Complete radio button and click Next

[image: Sent3]



Click Yes to changing the Windows Firewall.

[image: Sent5]


NOTE: The Installation Wizard indicates it has completed as shown below. If you are using a USB Dongle you can now connect it to a free USB port on your computer. The USB driver will be automatically located once the Sentinel Protection System has completed successfully.  





















Click Finish to proceed to the ScadaPro installation phase.

[image: Sent6]

ScadaPro Server Installation
Follow the Install Wizard screens. In most instances it is recommended to use the default answers to questions as follows:


[image: ]

You must read and accept the end user licence agreement before the installation can continue.  Using your mouse you must scroll to the bottom of the licence dialog.  When you reach the bottom of the licence dialog, the “I Agree” button will become active.  If you have fully read and agree with the end user licence agreement (EULA), click the “I Agree” button to continue with the installation.  If you do not agree with the EULA click the “I Disagree” button to terminate the installation.

If you are not using a standard ScadaPro hardware key and are installing ScadaPro for the first time, the following dialog is displayed.
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If the computer has an internet connection click “Get from Web” to receive the unlock code via the web. The following dialog will appear

[image: ]

Enter an email address to receive the unlock code to, the unlock code will appear in the key required dialog within a few seconds. The email sent to the email address entered is for reference purposes. 

If a proxy server is used in your organisation, enter your email address and then check the User Proxy Server check box.  Enter the proxy server address together with your username and password.  You may need to contact your IT department to obtain the proxy server details.

If you do not have an internet connection or if you receive any problems contact the distributor named making sure you specify the product variant and the lock code. Enter the unlock code. If you enter an invalid unlock code, you cannot proceed with the installation.

Accept the default directory location or use the Browse button to select your preferred directory location and name. 















Input the number of data loggers required, the maximum is 64, or accept the default.

[image: ]

Select the destination folder where you want the product installed.
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Click Install to bein installation - set-up copies the appropriate files to your hard disk and creates a program group and icons.

(Note:  At this point stand-alone users will receive the following error message: “Warning failed to add ScadaPro Share C:\ScadaPro.  Networking is not installed or the Server is not started.  Setup will continue.”  Click Ok and the Setup should continue.)

[image: ]

When the setup has finished copying ScadaPro click Ok

[image: ]

Installation is now complete you are ready to start the software.
[bookmark: _Toc394464715][bookmark: _Toc394745887][bookmark: _Toc394916771][bookmark: _Toc395410237][bookmark: _Toc457898916]
ScadaPro File Structure 
Once ScadaPro has been installed and the system configured the file structure will be similar to that shown.
The main directory containing all the ScadaPro files is called ScadaPro. Each of the sub-directories is described below:

	BIN
	Contains all the program files necessary to run ScadaPro

	AMONITORS
	Contains saved Alarm Monitor Configuration Files.

	CMONITORS
	Contains saved Configurable Monitor Configuration Files.

	CURRENT_CONFIG
	Contains all the configuration files for the current configuration. Within this directory are more sub directories holding the configuration for each device data processor and logger configured.

	LOGGED_ALARMS
	If the Alarm System has been enabled and configured to log alarms to disk then this sub directory will exist containing the alarm data files.

	LOGGED_DATA
	When a Logger has been enabled this sub directory will be created. Within this sub directory will be further sub directories one for each logger that has been enabled. See Parts 6 for logger configuration information.

	MONITORS
	Contains saved Channel Monitor Configuration Files.

	REPLAY_OPTIONS
	This sub directory will contain files used during Data Export operations. 

	SAVED_CONFIG
	The SAVED_CONFIG sub directory stores all configuration files that have been saved. Some or all of these may be in compressed form.

	SAVED_VALUES
	This sub-directory is created when the Save Outputs option on one or more devices or the Auto Save function on one or more processors is enabled. Files representing the values of each channel when the system is shutdown are stored here.

	TRENDS
	The Trends sub directory stores configuration files used for the Trends option. See part 7 for Replay options.



The above directory structure is typical of a used system. Some directories may not exist until certain facilities are used. 
Part One		Installation Procedure
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[bookmark: _Toc394464716][bookmark: _Toc394745888][bookmark: _Toc394916772][bookmark: _Toc395410238][bookmark: _Toc457898917]Uninstall Utility
The uninstall wizard issued with ScadaPro creates a log of all changes made as part of the Installation and creates an Uninstall icon in the ScadaPro program group.

The Install Wizard records:

All programs and data files added to the system
All shared files (some DLL files are shared with other applications)
All directories created as part of the installation
Changes made to the registry
Program groups and program icons created

Before attempting to run ScadaPro Uninstall utility on a server or client system ensure that all programs are shutdown. 

Before using the Uninstall utility on an ScadaPro Server the ScadaPro service must be shutdown. Select the Services icon in Control Panel, highlight the ScadaPro service from the list and click the Stop button. The ScadaPro service will then be shutdown.

To uninstall ScadaPro Server or Client select the ScadaPro program in Add/Remove Programs in Control Panel.

Click Uninstall to remove the product from the system

Accepting this prompt will permanently delete the application and related components from your system; no other warnings will be given.

[image: ]
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The utility removes all components, based on an installation log created when the program was installed. The user will be prompted before the utility removes any files that may be shared with other applications. It will attempt to remove the following items:

Shared Program files
Standard Program files
Folder items
Program Folders
Program Directories
Program Registry entries

Click Remove to begin the uninstallation of the Scadapro Server. 
[image: ]

Depending on the security settings of the server/pc, the following dialog may appear, click yes to continute. 

[image: ]

Click Finish to complete the uninstallation. 
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[bookmark: _Toc394464719]Manual Removal of User Files

THE UNINSTALL UTILITY WILL NOT REMOVE FILES OR DIRECTORIES THAT THE INSTALL UTILITY DID NOT CREATE.

As part of normal ScadaPro operation users create configuration and data files. The configuration files include custom configurations of Trends, Configurable Monitors and saved ScadaPro configurations (.orc files). Data files include log files in the LOGGED_DATA sub-directory, and export files created by the Data Export program. The uninstall utility will not remove these files or the directories they are in.

Files created by running and using ScadaPro will be left on the system after the Uninstall utility has run. The user can backup these data and configuration files, before removing them and the rest of the ScadaPro directory structure.

ALL CONFIGURATION AND DATA DIRECTORIES MUST BE BACKED UP MANUALLY BEFORE THE ScadaPro DIRECTORY AND ALL SUBDIRECTORIES ARE DELETED.

These directories and files should be removed manually using Explorer if required.

[bookmark: _Toc394464720][bookmark: _Toc394745889][bookmark: _Toc394916773][bookmark: _Toc395410239][bookmark: _Toc457898918]The exact directory structure and files remaining after uninstall will depend on whether the machine had ScadaPro Server or ScadaPro Client software installed.



[bookmark: _Toc408990970]ScadaPro Client Installation
[bookmark: _Toc394464723][bookmark: _Toc394745890][bookmark: _Toc394916774][bookmark: _Toc395410240][bookmark: _Toc457898919]Hardware Requirements
ScadaPro Client can be run on the following:
Windows 2000
Windows XP
Windows Vista (32 + 64 BIT)
Windows 7 (32 + 64 BIT)


Client machines must be of a suitable specification to run the required operating system.

Hardware specification for ScadaPro Client machines under Windows are as follows:
[bookmark: _Toc394464724]
[bookmark: _Toc394464726][bookmark: _Toc394745891][bookmark: _Toc394916775][bookmark: _Toc395410241][bookmark: _Toc457898920]Minimum Requirements
x86 based microprocessor (486/66 or higher)
128 Mb of RAM
Windows 2000
Minimum 160 Mb free disk space for system files 
Further free space required for logged data (250 Mb Recommended)
CD ROM Drive
Parallel or USB port
SVGA 1024 * 768 * 256 colour graphics

Recommended Requirements
1 gigahertz (GHz) or faster 32-bit (x86) or 64-bit (x64) processor
1 GB of RAM (32-bit) or 2 GB RAM (64-bit) 
Windows 7
500 Mb free disk space
CD ROM Drive
Free USB port
SVGA 1024 * 768 * 256 colour graphics
Network and ScadaPro Server Preparation
All standard network hardware and software for both Server and Client machines must be installed and tested before attempting to install ScadaPro Client.

The following Client installation procedures assume that all standard network hardware and software is fully installed and operational. Refer to your Windows documentation for information on installing and configuring networks.

ScadaPro Real Time Engine (RTE) Server must be installed, configured and tested on the appropriate ScadaPro data server machine(s) BEFORE attempting to install software on the Client machine(s).

The ScadaPro (RTE) Server installation creates a “network share” of its install directory, by default the directory share name created is “ScadaPro”. This allows ScadaPro clients on the network permission to access ScadaPro configuration and data files on the server. The ScadaPro Server directory share must be available to allow client operation.

To confirm that the ScadaPro (RTE) Server software has created the correct directory share:

Using Windows Explorer on a client machine, select “Network Neighbourhood”.
Select the ScadaPro Server from the list of machines on the network.
Check “ScadaPro” is available as a shared directory, see the example below

[image: ]

If for any reason the Server installation has not created the share directory automatically the directory must be shared manually using File Manager or Explorer on the ScadaPro Server. Default share permissions of “Full Control” to group “Everybody” are correct, although permissions can be tailored at a later date.

The ScadaPro Directory on ScadaPro Server machine(s) must be available as network share before installing ScadaPro Client Software
Hardware Key Installation
The ScadaPro Client software can be supplied with a hardware key or a software key 

If you are using a hardware key then you will need to select the key type during installation. There are 2 key types newer HASP HL keys or older Sentinel SuperPro keys. The hardware key should be plugged into the parallel or USB port of the ScadaPro Clent machine before installing the software.

Server and Client Keys are different. The software will not operate if the wrong key is used.

If you are using a Sentinel SuperPro USB hardware key, you will need to install a driver for the Sentinel USB dongle before running the Client setup. 

[bookmark: _Toc394745893][bookmark: _Toc394916777][bookmark: _Toc395410243][bookmark: _Toc457898922][bookmark: _Toc394464730]
Installing ScadaPro Client
The ScadaPro Client software can be installed on a partition formatted to NTFS or a standard FAT partition.   

Before installing ScadaPro Client for the first time you will need to know the “network name” of the machine you wish to use as your ScadaPro (RTE) data server. Consult your Network Administrator or the engineer who installed the ScadaPro Server software for this information.

It is essential you log on with Administrator privileges before installing ScadaPro client.

Press the Windows button and R ([image: Picture of the Windows logo key]+R.)


Enter C:\Client\Scadapro\SETUP.msi in the text box and click the OK button. (Where D: is is your CD ROM Drive)

[image: ]

[image: ]


When installation click next to continue you will then be asked what Key you want to install with. 

Click the “Hardware key  - HASP HL Key” button to install the HASP runtime. 

If you are using the Sentinel Superpro key click the “Hardware Key - Sentinel SuperPro Key” button. 

If you will be using a software key then click the “Software key” button and installation of the software will continue. If you are using a software key you can skip the sentinel and HASP Driver installation section below and proceed to the ScadaPro client installation section.

[image: ]

HASP Runtime Driver Installation (Hardware Key only)

If you are using a USB key do not plug the key into the machine until the HASP runtime driver phase has been completed (see below).

After you click the HASP HL Key button, a command line installation will run as shown in the image below, wait for it to complete.

[image: ]

Once the installtion is complete it will show you a message as below, simply click OK to continue to the installtion of the SCADAPRO client.

[image: ]

You can now connect your USB Hardware Key, it will be automaticlly recognised and installed.



Sentinel Protection System installation (Hardware key only)
If you are using a parallel hardware key the key should be plugged into the parallel port of the ScadaPro Client machine before continuing.  If you are using a USB key do not plug the key into the machine until the Sentinel Protection System installation phase has been completed (see below).

Server and Client Keys are different. The software will not operate if the wrong key is used.
Click Next to continue the Seninel Driver installation

[image: Sent1]
























Click “I accept the terms in the license agreement” and click Next

[image: Sent2]

Click the Complete radio button and click Next

[image: Sent3]








Click Yes

[image: Sent5]



NOTE: The Installation Wizard indicates it has completed as shown below. If you are using a USB Dongle you can now connect it to a free USB port on your computer. The USB driver will be automatically located once the Sentinel Protection System has completed successfully.  

[image: Sent6]




















ScadaPro Client Installation
Follow the Install Wizard screens. In most instances it is recommended to use the default answers to questions as follows:

You must read and accept the end user licence agreement before the installation can continue.  Using your mouse scroll to the bottom of the licence dialog.  When you reach the bottom of the licence dialog, the “I Agree” button will become active.  If you have fully read and agree with the end user licence agreement (EULA), click the “I Agree” button to continue with the installation.  If you do not agree with the EULA click the “I Disagree” button to terminate the installation.


[image: ]

Accept the default directory location or use the Browse button to select your preferred directory location and name. 

If you are not using a standard ScadaPro hardware key and are installing ScadaPro for the first time, the following dialog is displayed.

[image: ]

If the computer has an internet connection click “Get from Web” to receive the unlock code via the web. The following dialog will appear

[image: ]

Enter an email address to receive the unlock code to, the unlock code will appear in the key required dialog within a few seconds. The email sent to the email address entered is for reference purposes. 

If a proxy server is used in your organisation, enter your email address and then check the User Proxy Server check box.  Enter the proxy server address together with your username and password.  You may need to contact your IT department to obtain the proxy server details.

If you do not have an internet connection or if you receive any problems contact the distributor named making sure you specify the product variant and the lock code. Enter the unlock code. If you enter an invalid unlock code, you cannot proceed with the installation.

Accept the default directory location or use the Browse button to select your preferred directory location and name. 


[image: ]


Accept the default program folder name

[image: ]


Set-up copies the appropriate files to your hard disk and creates a program group and icons
[image: ]



[image: ]

Installation is now complete you are ready to start the software.
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[bookmark: _Toc394464737][bookmark: _Toc394745894][bookmark: _Toc394916778][bookmark: _Toc395410244][bookmark: _Toc457898923][bookmark: _Toc408990971]Part Two – Product usage

Part Two explains how the ScadaPro package is used. How to launch and control it. How to save and open configuration files 
[bookmark: _Toc394464738][bookmark: _Toc394745895][bookmark: _Toc394916779][bookmark: _Toc395410245][bookmark: _Toc457898924][bookmark: _Toc408990972]
Using ScadaPro
The following is a brief guide to the steps necessary to use the system.

Before any information can be obtained from ScadaPro, various modules have to be configured.

From the ScadaPro program group in the start menu, access can be gained to all modules for configuration. 

[image: ]

To launch ScadaPro, click on the ScadaPro icon in the program menu.
From the main window, all the features of the package can be configured using the pull down menus.

[bookmark: _Toc394464740][bookmark: _Toc394745896][bookmark: _Toc394916780][bookmark: _Toc395410246][image: ]
[bookmark: _Toc457898925]Configuring ScadaPro Channels
The channels in ScadaPro are divided into two groups. The first group refers to device channels whose values are acquired from physical input output devices. The second group refers to processor channels whose value is computed or processed.
[bookmark: _Toc394464741][bookmark: _Toc394745897][bookmark: _Toc394916781][bookmark: _Toc395410247][bookmark: _Toc457898926]Configure Device Channels 
To configure a block of device channels choose Devices from the menu and the required device from the drop down menu.  A configuration dialog box will appear for the particular device. 
[bookmark: _Toc394464742][bookmark: _Toc394745898][bookmark: _Toc394916782][bookmark: _Toc395410248][bookmark: _Toc457898927]Configure Processors
To configure a block of processor channels choose Processors from the menu bar and the required processor from the drop down menu. e. g. Calculator. A configuration dialogue box will appear for the particular processor. 
[bookmark: _Toc394464743][bookmark: _Toc394745899][bookmark: _Toc394916783][bookmark: _Toc395410249][bookmark: _Toc457898928]Configure & Control Loggers
To configure and control loggers from the main ScadaPro Window choose the appropriate logger or Control Logger option from the Loggers menu.
[bookmark: _Toc394464744][bookmark: _Toc394745900][bookmark: _Toc394916784][bookmark: _Toc395410250][bookmark: _Toc457898929]Configure and Use Replays
Data Export and Trend replays can be accessed from the main ScadaPro Window. Choose the appropriate option from the Replay menu.
[bookmark: _Toc394464745][bookmark: _Toc394745901][bookmark: _Toc394916785][bookmark: _Toc395410251][bookmark: _Toc457898930]Configure and Use Monitors
The Monitor Windows are all available via the main ScadaPro Window. Choose the appropriate function from the Monitors menu.
[bookmark: _Toc394464746][bookmark: _Toc394745902][bookmark: _Toc394916786][bookmark: _Toc395410252][bookmark: _Toc457898931]Controlling ScadaPro
When the components of the ScadaPro system have been configured the system needs to be controlled from the main ScadaPro Menu Window.
[bookmark: _Toc394464747]Enable ScadaPro
To enable ScadaPro and to start the interchange of information between the physical devices, the processors, the monitors and the logging tasks choose the [image: Help0017] tool button or select Enable from the Control menu.
Shortcut:
Keys: CTRL+E
[bookmark: _Toc394464748]Disable ScadaPro
To disable the ScadaPro system choose the [image: Help0018] tool button. .
Shortcut:
Keys: CTRL+D
[bookmark: _Toc394464749]Reconfigure ScadaPro 
On enabling the system the software reads the configuration of all the ScadaPro modules from the hard disk. It then configures processors and devices to operate in that defined way. 
Whilst the system is enabled the configuration of devices and processors can be modified. Any modification will not be acted upon until either the system is disabled and enabled again. The new configuration will be read from the disk and acted upon.
Alternately, the Reconfigure option can be used to change the configuration without having to disable and enable the system.
The configuration of Devices can be modified and the devices can be reconfigured without the need for the system to be disabled and re-enabled.
To Reconfigure the devices either choose the [image: Help0019] tool button or select Reconfigure from the Control menu. Alternatively press the keys CTRL+R whilst the window is active.
All processors (except the Alarm System) can be reconfigured in the same way as the devices.

Shortcut:
Keys: CTRL+R
[bookmark: _Toc394464750]Initialise Channels
Device channels can be configured to include the reference feature. The reference facility allows channels to be referenced to a value of a particular state. Choosing Initialise from the Control menu will define the reference value. Subsequent readings on channels with the reference feature set will be offset by the values recorded when the Initialise option is selected.
Shortcut:
Keys: CTRL+I
[bookmark: _Toc394464751]Reset
Choosing Reset from the Control menu will reset any digital counters on all Devices.
Shortcut:
Keys: CTRL+T
[bookmark: _Toc394464752]Autostart
Choosing this option will toggle the feature off and on. When selected i. e. a  appears alongside Autostart in menu list. Once the configuration has been saved, Autostart will be set on. If the power fails, or the system is shutdown the ScadaPro system will start and enable itself automatically when the power returns or it is switched back on again. The system will restart in the background even if the user is not available to log back on again. 
Shortcut:
Keys: CTRL+A
Options
Choosing this option presents the options for system enable and disable. Options include confirmation of system enable/disable and which loggers are automatically enabled or disabled on a system enable/disable.
[bookmark: _Toc394464754][bookmark: _Toc394745903][bookmark: _Toc394916787][bookmark: _Toc395410253][bookmark: _Toc457898932]Status Bar
The status bar at the bottom of the ScadaPro Window advises the user of the status of the system. The centre box tells whether a system is enabled or disabled. The right hand box will detail any error encountered by ScadaPro when enabling.

The status bar can be toggled on or off by choosing the Status Bar option from the View menu.
[bookmark: _Toc394464755]Status Error Indicator
The Status error indicator describes any errors that may occur whilst the ScadaPro System is enabled.
[bookmark: _Toc394464756]Status Indicator
Shows whether ScadaPro System is enabled or disabled. 
[bookmark: _Toc394464753][bookmark: _Toc394464757]Alarm Annunciation
When an alarm occurs on the system the channel number and alarm message will be displayed in the Alarm bar at the bottom of the ScadaPro Main Window just above the status bar. Alarms with the higher priority will over write those of a lesser status. 
Alarm messages will remain, even if the channel has returned to a normal status, until they are acknowledged. Alarms should be acknowledged within the monitor windows.
The Alarm bar can be toggled on or off by choosing the Alarm Bar option from the View menu. Also, the alarm bar is dockable. It can be placed on any position on the windows desktop.
[bookmark: _Toc394745904][bookmark: _Toc394916788][bookmark: _Toc395410254][bookmark: _Toc457898933]Opening and Saving Configurations
When a request is made to save a modified configuration for a module, e.g. the Calculator processor then this is placed in the CURRENT_CONFIG directory.

The Current configuration files (i.e. everything in CURRENT_CONFIG) can be saved as one file in the directory SAVED_CONFIG. Complete configurations can therefore be saved and recalled at a later date.
[bookmark: _Toc394464758]Save Complete Configurations.
Using the File menu, choose Save or Save As. Using normal Windows techniques the configuration can be saved.   The configuration can be saved in any of three formats:
· Zipped Configuration (.zip)  - 
· Compressed Configuration (.orc)
· Uncompressed Configuration (.tar)
A typical configuration can be 5MB in size.  If saved in Zipped format the file will be compressed to around 10% of the original size.  When saved in Zipped format the configuration can be opened with a compatible Zip viewer such as WinZip or with Windows Explorer on Windows XP and Windows Vista systems.  If compressed configuration is selected the file will normally be compressed to 20% of the original size, .orc files can only be opened using ScadaPro.  If the configuration is saved in uncompressed format the file can be opened using compatible tar viewers.
[bookmark: _Toc394464759]Open Stored Configurations.
Configurations saved onto disk can only be recovered when the ScadaPro system is disabled. 
If the existing configuration has been changed since it was last saved a dialog box will ask if you wish to save the old configuration before opening the new files.

[bookmark: _Toc394464760]Blanking the Current Configuration
Selecting File|New will prompt the user if (s)he wishes to blank the current configuration. Answering Yes will return all channels in the system to Disabled, clears all loggers and returns the system to the state it was in when first installed.
Answering No will leave the last configuration intact, and allow the user to save under a new name.

Trace Save Histrory
If trace save history is switched on, a dialog box will appear requesting a comment each time a configuration change is saved.  This provides tracability in reviewing changes made to the Scadapro configuration.
View History
Selecting View History will display a text file showing comments made on each system configuration change.  The username, date and time of the change are also recorded.
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[bookmark: _Toc394464761][bookmark: _Toc394745905][bookmark: _Toc394916789][bookmark: _Toc395410255][bookmark: _Toc457898934][bookmark: _Toc408990973]Using ScadaPro Client
[bookmark: _Toc394464762][bookmark: _Toc394745906][bookmark: _Toc394916790][bookmark: _Toc395410256][bookmark: _Toc457898935]Running ScadaPro Client & Selecting a Data Server
To run ScadaPro Client double click on the ScadaPro icon. The first time ScadaPro software is invoked you will see the following screen stating that the ScadaPro Service is not installed on “Server: machine_name”, where machine_name is the network name of your PC.
Click Ok to make a selection.

If required a Client may be run without the input of a data server so that trends maybe viewed using the local machine.

If a server is required then the following selection is presented.

[image: screen1]

There are a number of different server types.

1) Server on a Windows network. This is normally the case where the client and server are on the same LAN or connected via a VPN.

2) Web Server on Internet/Intrenet. This is normally the case where the client and server are on the Internet and the Server only provides http/https inbound connections.

3) TCP/IP Server. This is normally the case where the client and server are on the Internet and the Server without any security requirements. Connection is made via port 11234 and the SocketServer registry setting is set to ON.

4) Logged data in a directory. This is normally used on site by office clients to view replicated data. No configuration or alarm monitoring is available on a logged data server.

5) Logged data in a database. This is normally used on site by office clients to view replicated data. No configuration or alarm monitoring is available on a logged data server.




If a Windows server is required then selection of the browse button will display all available computers on the network. Checking the auto browse box will ensure that the list of available servers is displayed upon opening the selected server from the menu.

[image: ]

If a Web service server is required the following dialog is displayed:

[image: webservicenew]

Enter the web address of the server and the user name and password credentials that have access to the server.  











If a TCP-IP server is required the following dialog is displayed:

[image: Description: IPNEW]
Enter the web address of the server and the user name and password credentials that have access to the server.
NOTE: In order to select a TCP-IP server using ScadaPro you will need the SocketServer registry setting to be set as ON. To do this we will create a registry within the Windows Registry using regedit.
On the machine that you installed ScadaPro on click the start button then search “regedit” it should display “regedit .exe” click it . You should be presented with this dialog:

[image: ]


Now navagate to the correct folder.
32-bit:		HKEY_LOCAL_MACHINE\SOFTWARE\Measuresoft\ SCADAPRO
64-bit 		HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Measuresoft\SCADAPRO
Now right click within this directory and select  New > String Value, name the String Value “SocketServer” and set Value Data as “ON”.
If a Logged Data Directory server is required the following dialog is displayed:

[image: screen5]


If a Data Logged Database server is required the following dialog is displayed:

[image: screen6]

Once an ScadaPro (RTE) data server has been selected the ScadaPro main program window will be displayed.








The title bar displays the Server name\user name and the ScadaPro configuration.

E.G.	Notepad\Administrator – demo.zip or demo.orc

[bookmark: _Toc394745907][image: ]
[bookmark: _Toc394916791][bookmark: _Toc395410257][bookmark: _Toc457898936][bookmark: _Toc408990974]
ScadaPro Menu Options
[bookmark: _Toc394464766][bookmark: _Toc394745908][bookmark: _Toc394916792][bookmark: _Toc395410258][bookmark: _Toc457898937]File Menu
The file menu has the following options:
Select server
This allows the user to select an ScadaPro (RTE) data server from the available list. The Server machine selected must have ScadaPro Server installed.
[image: ]
Once a data server has been selected the ScadaPro main program appears. The title bar displays the Server name\user name and the ScadaPro configuration. The configuration name displayed will be the same as the current configuration on the selected server. Current configuration and information on Devices, Processors and Loggers are all picked up from this configuration.
New
This option asks the user if they want to blank the current configuration. If the user answers Yes, the system configuration is returned to the state it was in when the system was installed. If the user answers No, the name of the current configuration is changed to Untitled.orc until a save is performed. See Blanking the Current Configuration earlier in this chapter for more details.
Open
See Opening and Saving Configurations earlier in this section for details.
Save
See Opening and Saving Configurations earlier in this section for details.
Save As
See Opening and Saving Configurations earlier in this section for details.
Print
This option has the effect of printing all ScadaPro configurations (devices/processors/loggers and overall system information).
Print Setup
Shows the standard windows Print Setup dialog which allows you to configure the current printer and paper orientation.
Import Configuration
Use this command to import channel configuration from an ASCII file. This command presents an Import dialog box, where you may specify the range of channels to be imported, the file to import from etc.
Export Configuration
Use this command to export channel configuration to an ASCII file.   This command presents an Export dialog box, where you may specify the range of channels to be exported, the file to export to etc.
Exit
Quits ScadaPro Client and closes the ScadaPro window. 
Other options are greyed out, as they are not currently available on an ScadaPro client system.
[bookmark: _Toc394464767][bookmark: _Toc394745909][bookmark: _Toc394916793][bookmark: _Toc395410259][bookmark: _Toc457898938]View menu
Allows the user to change the display of the ScadaPro main window. The Tool Bar, Status Bar and Alarm Bar can be displayed or removed from the window:
[bookmark: _Toc394464768][bookmark: _Toc394745910][bookmark: _Toc394916794][bookmark: _Toc395410260][bookmark: _Toc457898939]Control Menu
Refer to “Controlling ScadaPro” earlier in this chapter for details on the menu options..
[bookmark: _Toc394464769][bookmark: _Toc394745911][bookmark: _Toc394916795][bookmark: _Toc395410261][bookmark: _Toc457898940]Monitors Menu
Channel Monitor
Alarm Monitor
Configurable Monitor
Refer to the Part 5 of the manual for details on monitors.
[bookmark: _Toc394464770][bookmark: _Toc394745912][bookmark: _Toc394916796][bookmark: _Toc395410262][bookmark: _Toc457898941]Replay Menu
Data export
Trends
[bookmark: _Toc394464771][bookmark: _Toc394745913][bookmark: _Toc394916797][bookmark: _Toc395410263]Log File Synchronisation
Refer to the Part 6 of the manual for details on replays.
[bookmark: _Toc457898942]Devices Menu
Allows the user to configure ScadaPro device drivers.  Refer to the appropriate Manual for your device driver.
[bookmark: _Toc394464772][bookmark: _Toc394745914][bookmark: _Toc394916798][bookmark: _Toc395410264][bookmark: _Toc457898943]Processors Menu
Allows the user to configure the ScadaPro Processors. Refer to part 4 of the user guide for details of processor configuration and operation.
[bookmark: _Toc394464773][bookmark: _Toc394745915][bookmark: _Toc394916799][bookmark: _Toc395410265][bookmark: _Toc457898944]Loggers Menu
Part Two		Using and Controlling ScadaPro
Allows the user to configure the ScadaPro Loggers. Refer to part 6 for details of logger configuration.

[bookmark: _Toc394745916][bookmark: _Toc394916800][bookmark: _Toc395410266][bookmark: _Toc457898945][bookmark: _Toc408990975]Part Three – Channel configuration

Part Three describes in detail how to configure Channels in ScadaPro
[bookmark: _Toc394745938][bookmark: _Toc395410287][bookmark: _Toc457898968][bookmark: _Toc408990976]
Channel Configuration
[image: ]

A Channel Configuration window will show which channels have been configured.  Channels not yet configured will bear the tag description of DISABLED. Channels that have been configured will be shown with a tag description and a channel description.

To configure a channel, point to and double click the mouse button on the channel to be configured. Alternatively select a channel, click on the Configure Channel button (ALT+C) or press Return.  A Configure Channel Dialog box will be displayed.

[bookmark: _Toc394916820][bookmark: _Toc395410288][bookmark: _Toc457898969][bookmark: _Toc408990977]
Advanced Channel Configuration
[bookmark: _Toc394916821][bookmark: _Toc395410289][bookmark: _Toc457898970]AutoEnable
Before any Channels can be incorporated into the overall ScadaPro System the Advanced Configuration bar must be selected and the AutoEnable User Analogs box checked. Now, when the ScadaPro system is enabled from the Main Menu, the User Analog channels will automatically be enabled also.

[image: ]
[bookmark: _Toc394745939][bookmark: _Toc394916822][bookmark: _Toc395410290][bookmark: _Toc457898971]Auto Save.
To Enable this utility check the AutoSave flag. All values in all channels are saved to disk when the system is disabled. The next time the system is restarted the values which were previously in each channel will be restored to the appropriate channel number.
By Tag
Channel values can be saved and restored to channels using the channel tag as the reference instead of the channel number. In this way, channels can be rearranged within the modules and as long as the channel tags remain the same, the correct channel values will be restored to the appropriate channel number.

[bookmark: _Toc394745940][bookmark: _Toc394916823][bookmark: _Toc395410291][bookmark: _Toc457898972][bookmark: _Toc408990978]Saving the Configuration
When a configuration has been completed it must be saved to retain any changes made.  To save either:
1.	Click on the Save icon; [image: filesave] The User Analog configuration will be saved to the current ScadaPro System configuration.  No File Name will be requested.
2.	Select Save from the File menu.
3.	Select Exit from the file menu.  If any changes have been made a dialog box will ask if you want to save the configuration before exiting the window.

NB.
Any changes to the Channel Configuration will not be incorporated into the ScadaPro System until it is next enabled or the device/processor is reconfigured.

[bookmark: _Toc457898973][bookmark: _Toc408990979][bookmark: _Toc394745941][bookmark: _Toc394916824][bookmark: _Toc395410292]Import / Export the Configuration
[bookmark: _Toc457898974]Import the Configuration
Select Import Configuration from the File Menu to import channel configuration from an ASCII file.   This command presents an Import dialog box, where you may specify the range of channels to be imported, the file to import from etc.
[bookmark: _Toc457898975]Export the  Configuration
Select Export Configuration from the File Menu to export channel configuration to an ASCII file.   This command presents an Export dialog box, where you may specify the range of channels to be exported, the file to export to etc.
[bookmark: _Toc457898976]Import/Export Dialog
[image: ]
The Import/Export dialog allows the user to configure how channel configurations will be imported/exported. User settings are saved and are used as default settings the next time the dialog is invoked.

Header
If Header is checked column headers will be exported with the configuration, these headers make it easier to identify the contents of each column

Value Width
Results are stored in the Systems Log Files with full floating point precision.  The actual width of the number passed can be modified.  In the Value Width text box enter or edit the total number of digits, including the decimal point required.  If the value when converted is greater than the width defined the value will be converted to Scientific notation.

Value Precision

In this box enter the number of digits after the decimal point.

Delimiter

Three options and a User Defined alternative are available in this drop down list.  The delimiter separates each field in a row.  The correct delimiter is required for the spreadsheet package to import the data correctly.  The choices are:
		User
		Space
	 	Comma  
		Tab.  
Most modern spreadsheets including Microsoft Excel and Lotus use the Comma separator.
As an alternative to the fixed choices a User option is available.  If this is chosen enter the delimiting character in the text box that appears alongside the list.

End Line
Similar to the Delimiter there are choices for the end of line separator.  The choices are: 
		User
		CR/LF.
		LF(LineFeed) 
		CR ( Carriage Return) 
A User option is again an option.  Microsoft Excel and Lotus require  CR/LF end of line characters.

Import/Export File
Enter the path of the file you wish to export to or import from. Alternatively click the button on the right hand side to browse for the desired file.

Channel Range
Select the All Channels button if you wish to import/export every channel configuration.
Alternatively select the Channels button and enter a range of channel configurations you wish to export.
[bookmark: _Toc457898977]Copy and Paste
Two of the icons on the toolbar are Copy and Paste. From the Configuration Window it is possible to copy one channels configuration to another. Point to the channel to be copied, it will be highlighted, click on the Copy icon the configuration will be copied to the clipboard.  Now point to the channel that the configuration is to be copied to, again it will be highlighted. Select the Paste icon and the configuration will be pasted from the clipboard.
[bookmark: _Toc394745942][bookmark: _Toc394916825][bookmark: _Toc395410293][bookmark: _Toc457898978]Shortcuts
Toolbar:	[image: editcopy][image: editpast]
Keys:	CTRL+C, CTRL+V
[bookmark: _Toc394745943][bookmark: _Toc394916826][bookmark: _Toc395410294][bookmark: _Toc457898979][bookmark: _Toc408990980]
Configure Analog Channel
The configure User Analog Channel is divided into 5 sections plus a row of buttons at the bottom. 

[image: ]
[bookmark: _Toc394745944]Enable Channel
For a channel to be operative and therefore configurable the Enable Channel check box must be checked.
[bookmark: _Toc394745945]Tag
A 15 character alphanumeric field that can contain channel information or wiring schedule references.
[bookmark: _Toc394745946]Description:
A 32 character alphanumeric field in which a description of the channel can be detailed. 
[bookmark: _Toc394745948]Engineering Units:
Minimum
The minimum default scale value used in displays.
Maximum
The maximum default scale value used in displays
Descriptor 
An 8 character field available to describe the units of the measurement.

Significant Change
To enable check the Significant Change check box.  

This facility allows filtering of data on channels on which significant change is of interest.  Such changes can cause an event, which can be logged.

The figure entered in the Value text box is the rate of change in engineering units, which, if the measured channel exceeds per scan, either increasing or decreasing will cause the significant change event trigger. 
[bookmark: _Toc394745949]Event Checking
Event checking is used, if required to trigger a logger to record information on an event. Check the Event Checking check box if this facility is needed.
High Limit
A value entered in this text box will define the level that if exceeded, by the channel result will cause an event trigger.
Low Limit
A value entered in this text box will define the level that if the channel result falls below will cause an event trigger.
Alarm Error Checking
Drive Common
A common alarm is a single digital output which will switch on when any channel with the Drive Common Alarm enabled goes into an alarm state.
Check this box if a link to the Common Alarm is required.
Priority
Enter or edit the number in the text box to allocate the priority of this channels alarm.
Delay	
Enter the time, in seconds, between the channel value entering the alarm state and the system flagging an alarm.
[bookmark: _Toc394745950]Low and High Alarm Checking
Alarm checking is available on all channels throughout the ScadaPro system.  Low Alarm and High Alarm levels can be configured independent of each other. All the values entered are in engineering units.  If a channel reading exceeds the High Alarm limit then an alarm will be triggered as it will if the channel goes below the Low Alarm limit.  
When monitoring channels, if the high or low alarm is triggered, then the fact will be annotated alongside the other channel information in the Monitor Window.   
Enable Alarm Checking:
Check either the Low Alarm Checking or High Alarm Checking or both check boxes to enable the facility.
Alarm Limit:
The value at which the channel will flag an alarm.
Warning and Limit:
If required, a warning can be displayed when a channel reaches a limit close to the alarm limit. For low alarm checking, the alarm limit must be less than the warning limit. For high alarm checking, the warning limit must be less than the alarm limit.
Delay:
Specify the number of seconds the channel must be in the alarm zone before an alarm will be flagged within the system.
Hysteresis 
Hysteresis can prevent 'noisy' channels from reporting multiple alarms when the average reading is close to the alarm or warning threshold. The Hysteresis value is relative to the alarm or warning limit.
For example, if a channel’s high alarm is set to 80 degrees C, Hysteresis is enabled and a Hysteresis value of 5 degrees C is specified the system will respond as follows:
When the channel reading goes above the high alarm limit of 80 it will trigger the alarm. The alarm will not be reset until the channel reading falls below 75, the high limit - Hysteresis value.
Check the box if this feature is needed.  Enter the value of the dead band in the text box.
Priority
Enter or edit the number in the text box to allocate the priority of this alarm.  
Drive Common Alarm:
A common alarm is a single digital output, which will switch on when any channel with the Drive Common Alarm enabled goes into an alarm state.
Check this box if a link to the Common Alarm is required.
Alarm Message:
An Alarm Message can be defined to be displayed on the Status line of the ScadaPro Main Window when a channel goes into an alarm state. 
Enter the message, up to 32 characters.
[bookmark: _Toc394745951][bookmark: _Toc394916827][bookmark: _Toc395410295][bookmark: _Toc457898980]
Windows Buttons
[bookmark: _Toc394745957]Eight buttons are at the bottom of the Configure Channel Window. Their use is explained below.

[image: ]
When a channel has been successfully configured, click the OK button to accept and move back to the previous window.

[image: ]
Clicking on the Cancel button will nullify any changes made. The configuration of that channel will remain the same, The previous window will be displayed.

[image: ]
If the configuration of the current channel is to be repeated, clicking on this button will copy the configuration to the Windows Clipboard.
[image: ]
When a configuration has been copied to the Clipboard, it can be pasted into any other channel in this group by this button.

[image: ]
Clicking on Previous or Next buttons will accept the current channels configuration and move on to either the next or previous channel’s Configuration Window.

[image: ]
Selecting the Goto… button will accept the current channel’s configuration and move on to the channel entered in the resulting Goto Channel No. dialog box.

[image: ]
If any help is required concerning any element of this window, clicking on this button will select the Help utility.
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[bookmark: _Toc394916834][bookmark: _Toc395410303][bookmark: _Toc457898991][bookmark: _Toc408990981]Configure Digital Channel
The configure digital channel window is divided into 2 sections plus a row of buttons at the bottom.

[image: ]
[bookmark: _Toc394745958][bookmark: _Toc394745959]Enable Channel
For a channel to be operative and therefore configurable the Enable Channel checkbox must be checked.
Tag
An 12 character alphanumeric field that can contain channel information or wiring schedule references.
[bookmark: _Toc394745960]Description:
A 32 character alphanumeric field in which a description of the channel can be detailed.
[bookmark: _Toc394745961]Low State Description:
A 32 character field in which to enter a description of the low state of the channel.
[bookmark: _Toc394745962]High State Description:
A 32 character field in which to enter a description of the high state of the channel.
[bookmark: _Toc394745963]Event checking
Event checking is used, if required, to trigger a logger to record information on an event. (see Part 5). If this facility is required click on the drop down box and select DISABLED, HIGH STATE, or LOW STATE as appropriate. 
[bookmark: _Toc394745964]Alarm Error Checking
Drive Common
A common alarm is a single digital output which will switch on when any channel with the Drive Common Alarm enabled goes into an alarm state.
Check this box if a link to the Common Alarm is required.
Priority
Enter or edit the number in the text box to allocate the priority of this channels alarm.
Delay	
Enter the time, in seconds, between the channel value entering the alarm state and the system flagging an alarm.
Alarms
Alarm State
Alarm checking is available on all channels throughout the ScadaPro system. To configure alarm checking on this channel click on the drop down box and select OFF, HIGH STATE, or LOW STATE as appropriate. If a channel's status changes to an Alarm State an alarm will be triggered on that channel. When monitoring channels, if the alarm is triggered, then the fact will be annotated alongside the other channel information in the Monitor Window.   
Alarm Priority
Enter the priority of the alarm triggered by this channel.
Common Alarm
Channels can be configured to trigger a Common Alarm.  A common alarm is a single digital output which will switch on when any channel with the Drive Common Alarm enabled goes into an alarm state.
Alarm Delay
Enter the time, in seconds, between the channel value entering the alarm state and the system flagging an alarm.
Alarm Message
An Alarm Message can be defined for displaying on the Status line of the ScadaPro Main Window when a channel goes into an alarm state.
[bookmark: _Toc394745965]


[bookmark: _Toc394745932][bookmark: _Toc394916815][bookmark: _Toc395410281][bookmark: _Toc457898961][bookmark: _Toc408990982]Part Four – Processors

Part Four covers the configuration of ScadaPro Processors

History Channels
Calculator Channels
Alarm System
System Error Processor

[bookmark: _Toc394745933][bookmark: _Toc395410282][bookmark: _Toc457898962][bookmark: _Toc408990983]User Analog Channels
The User Analog channels are "internal channels" that can be used in many ways.  User Analog channels can be used to hold manually input values, entered via the channel Monitor Window. These manually entered values could be the set point or coefficient value required by an algorithm configured in ScadaPro's Calculator package.

User Analog channels can also hold the results of calculations performed by the Calculator package.  The channels are used wholly at the users discretion.
Once configured User Analog Channels have the prefix 'P' and can be monitored, logged and replayed in the usual way.
[bookmark: _Toc394745934][bookmark: _Toc394916816][bookmark: _Toc395410283][bookmark: _Toc457898963][bookmark: _Toc408990984]User Digital Channel Description
The User Digital channels are also "internal channels". Using the channel monitor window the status of the User Digital channels can be changed by selecting the channel and pressing the spacebar on the computer’s keyboard to switch a User Digital channel ON or OFF. User Digital Channels can also be used as 'flags' in Calculator Algorithms

Once configured, User Digital Channels have the prefix ‘Q' and can be monitored, logged and replayed in the usual way.
[bookmark: _Toc394745935][bookmark: _Toc394916817][bookmark: _Toc395410284][bookmark: _Toc457898964][bookmark: _Toc408990985]History Channel Description
The History processor provides a short-term history over a user defined time period for up to 33 ScadaPro Channels. A block of 30 contiguous channels given the prefix ‘H’ records the history of any ScadaPro channel.  
The main use of these channels is to animate mini-trends in the Visual Environment animation package. History channels can also be used to provide a lag function in control algorithms.  
[bookmark: _Toc394745936][bookmark: _Toc394916818][bookmark: _Toc395410285][bookmark: _Toc457898965][bookmark: _Toc408990986]Calculator Channel Description
The Real Time Calculator Processor allows complex or simple real time calculations to be performed on data being collected by the ScadaPro System. Calculator channels are analogue channels whose value is calculated from a user-specified formula. Any ScadaPro channel can be used as part of a calculation, both digital or analogue, input or output. 

There are up to 10000 calculator channels available and have the prefix 'C'.  Calculator Channels can be configured to cause events and alarms and can be monitored and logged like any other ScadaPro Channel.
[bookmark: _Toc394745937][bookmark: _Toc394916819][bookmark: _Toc395410286][bookmark: _Toc457898966][bookmark: _Toc408990987]Alarm System Description
When each channel is configured within ScadaPro, fields are available within the configuration window of that channel type, to define alarm and warning limits for that particular channel.  Once the system is enabled the alarm status of each channel will be shown along side its entry on its respective monitor window.  If any channel, included in a logger configuration, goes into an alarm state then the log record will be annotated with the alarm status.

The Alarm System, if enabled, allows the alarms to be reported to an Alarm Monitor. An Alarm status line at the bottom of the ScadaPro Window will display the last four channels to go into alarm. The user can, via the Alarm Monitor Window, acknowledge these alarms and also see what time the alarm occurred and its duration.

When configuring channel alarm levels in the various configuration windows the user has the option of checking a "Drive Common Alarm" box.  If this is selected, and the Alarm System is enabled then an output from a Device digital output module can be configured to go high whenever any of those channels exceed their alarm levels.  The output can be used to drive an alarm bell or warning lamp to advise operators that an alarm has occurred.

The Alarm System can also be configured to record on a printer when a channel goes into alarm, when it returns to a normal level and also record when the Alarm occurrence is acknowledged by the user from the Alarm Monitor Window.  In addition, or instead an Alarm Logger can be configured to log this alarm information to disk.
[bookmark: _Toc457898967][bookmark: _Toc408990988]System Error Processor
For each Module in ScadaPro, an internal channel called a system error channel is configured when the ScadaPro Service Starts. These channels can be used to report any system errors that occur while the system is running.

Once configured, System Error Channels have the prefix ‘SE' and can be monitored, logged and replayed in the usual way.


[bookmark: _Toc394745966][bookmark: _Toc395410304][bookmark: _Toc457898992][bookmark: _Toc408990989]History Channel Configuration
Before they can be used the History channels must be configured. 

To configure either double click on the History icon in the ScadaPro program group or choose History Channels from the Processor menu on the ScadaPro Menu bar.



A History Channels Configuration Window will be displayed.

[image: ]

Channel blocks that have been configured will have entries displayed describing the source channel, time period and if averaging is being used. These fields are blank for channels not yet enabled.

To configure a block of H channels, point to them, and the line will be highlighted then double click the mouse button. A Configure History Channels dialog box will be shown.

[bookmark: _Toc394916835][bookmark: _Toc395410305][bookmark: _Toc457898993][bookmark: _Toc408990990]Advanced History Configuration
[bookmark: _Toc394916836][bookmark: _Toc395410306][bookmark: _Toc457898994]AutoEnable History Channels
Before any History Channel can be incorporated into the overall ScadaPro System the Advanced History Channel Configuration bar must be selected and the AutoEnable History Channels box checked. Now, when the ScadaPro system is enabled from the Main Menu, the History channels will automatically be enabled also.

AutoSave History Channels
The history of a channel can be preserved across system disable and re-enable sequences by selecting Auto Save. The Auto Save rate is the rate at which saved history values are written to disk. When the system is re-enabled, history values are restored from disk. At least one history channel may be in error after system enable depending on the time to establish channel values. 


[image: ]
[bookmark: _Toc394916837][bookmark: _Toc395410307][bookmark: _Toc457898995][bookmark: _Toc408990991]Saving the Configuration
When a configuration has been completed it must be saved to retain any changes made.  To save either:
1.	Click on the Save icon; [image: ] The History Channel configuration will be saved to the current ScadaPro System configuration.  No File Name will be requested.
2.	Select Save from the File menu.
3.	Select Exit from the file menu.  If any changes have been made a dialog box will ask if you want to save the configuration before exiting the window.

NB.
Any changes to the History Channel Configuration will not be incorporated into the ScadaPro System until it is next enabled.

[bookmark: _Toc394916838][bookmark: _Toc395410308][bookmark: _Toc457898996][bookmark: _Toc408990992]Copy and Paste
Two of the icons on the Configure History Channels toolbar are Copy and Paste. From the History Channel Configuration Window it is possible to copy one channels configuration to another. Point to the channel to be copied, it will be highlighted, click on the Copy icon the configuration will be copied to the clipboard.  Now point to the channel that the configuration is to be copied to, again it will be highlighted. Select the Paste icon and the configuration will be pasted from the clipboard.

[bookmark: _Toc394916839][bookmark: _Toc395410309][bookmark: _Toc457898997]Shortcuts
Toolbar:	[image: editcopy][image: editpast]
Keys:	CTRL+C, CTRL+V
[bookmark: _Toc394916840][bookmark: _Toc395410310][bookmark: _Toc457898998][bookmark: _Toc408990993]
Configure History Channels
When the Configure Channel button is pressed, the following dialog box appears:

[image: ]

[bookmark: _Toc394745967]Source Channels
Type in or edit the entry in the text box to nominate the ScadaPro source channel. This could be any ScadaPro channel, including any of the ScadaPro processor channels such as User Analogs, User Digitals and Calculator Channels.
[bookmark: _Toc394745968]Averaging
If this box remains unchecked, averaging is not selected. The values recorded in the history channels will be the instantaneous readings of the source channel at the update.

When the Averaging Check box is checked, averaging is selected. The values recorded in the History channels will be the average of the source channel values between updates of the history channel.

When the Averaging Check box is checked, averaging is selected. The values stored in the History channels will represent the average of the source channel between updates.
[bookmark: _Toc394745969]History Period
From the drop down list choose the time period for the application. Each of the History channels in the block will contain values 1/30th of the time period apart. Choices are:

	Time
	½ Hour
	8 Hours

	1 Min
	1 Hour
	12 Hours

	5 Mins
	2 Hours
	Day

	10 Mins
	4 Hours
	



If fixed time periods do not suit choose Time and enter actual time period in text box as HH:MM:SS.

Click on the OK Button to accept configuration, or select the Cancel button to return to the previous Window without changing the configuration.

[bookmark: _Toc394745972][bookmark: _Toc395410311][bookmark: _Toc457898999][bookmark: _Toc408990994]
Calculated Channels
[bookmark: _Toc394745973]To configure either double click on the Calculator icon in the ScadaPro programme group or select Processors and then Calculated Channels from the ScadaPro menu bar.




The Calculator Channels Configuration window will show which channels have been configured.  Channels not yet configured will bear the tag description of DISABLED. Channels that have been configured will be shown with a tag description and a channel description.

[image: ]

[bookmark: _Toc394745974]To configure a channel, point to and double click the mouse button on the channel to be configured. Alternatively select a channel, click on the Configure Channel button (ALT+C) or press Return.  A Configure User Channel Dialog box will be displayed.
[bookmark: _Toc394916841][bookmark: _Toc395410312][bookmark: _Toc457899000][bookmark: _Toc408990995]Advanced Calculator Configuration.
[bookmark: _Toc394916842][bookmark: _Toc395410313][bookmark: _Toc457899001]AutoEnable Calculator
Before any Calculator Channel can be incorporated into the overall ScadaPro System the Advanced Calculator Configuration bar must be selected and the Auto-Enable Calculator box checked.
[image: ]
Auto Save.
To Enable this utility check the Auto Save flag. All values in output channels are saved to disk when the system is disabled. The next time the system is restarted the values which were previously in output channels will be restored to the appropriate channel number.
[bookmark: _Toc395410314][bookmark: _Toc457899002][bookmark: _Toc408990996][bookmark: _Toc394745976]Saving the Calculator Configuration
When a configuration has been completed it must be saved to retain any changes made.  To save either:
1.	Click on the Save icon; [image: ]The User Analog configuration will be saved to the current ScadaPro System configuration.  No File Name will be requested.
2.	Select Save from the File menu.
3.	Select Exit from the file menu.  If any changes have been made a dialog box will ask if you want to save the configuration before exiting the window.

NB.
Any changes to the Calculated Channel Configuration will not be incorporated into the ScadaPro System until it is next enabled or the processor is reconfigured.
[bookmark: _Toc457899003][bookmark: _Toc408990997]Import / Export the Calculator Configuration
[bookmark: _Toc457899004]Import the Calculator Configuration
Select Import Configuration from the File Menu to import channel configuration from an ASCII file.   This command presents an Import dialog box, where you may specify the range of channels to be imported, the file to import from etc.
[bookmark: _Toc457899005]Export the Calculator Configuration
[bookmark: _Toc457899006]Select Export Configuration from the File Menu to export channel configuration to an ASCII file.   This command presents an Export dialog box, where you may specify the range of channels to be exported, the file to export to etc. [image: ]
Import/Export Dialog
The Import/Export dialog allows the user to configure how channel configurations will be imported/exported. User settings are saved and are used as default settings the next time the dialog is invoked.

Header
If Header is checked column headers will be exported with the configuration, these headers make it easier to identify the contents of each column

Value Width
Results are stored in the Systems Log Files with full floating point precision.  The actual width of the number passed can be modified.  In the Value Width text box enter or edit the total number of digits, including the decimal point required.  If the value when converted is greater than the width defined the value will be converted to Scientific notation.
Value Precision
In this box enter the number of digits after the decimal point.
Delimiter
Three options and a User Defined alternative are available in this drop down list.  The delimiter separates each field in a row.  The correct delimiter is required for the spreadsheet package to import the data correctly.  The choices are:
		User
		Space
	 	Comma  
		Tab.  
Most modern spreadsheets including Microsoft Excel and Lotus use the Comma separator.
As an alternative to the fixed choices a User option is available.  If this is chosen enter the delimiting character in the text box that appears alongside the list.
End Line
Similar to the Delimiter there are choices for the end of line separator.  The choices are: 
		User
		CR/LF.
		LF(LineFeed) 
		CR ( Carriage Return) 


A User option is again an option.  Microsoft Excel and Lotus require  CR/LF end of line characters.
Import/Export File
Enter the path of the file you wish to export to or import from. Alternatively click the button on the right hand side to browse for the desired file.
Channel Range
Select the All Channels button if you wish to import/export every channel configuration.
Alternatively select the Channels button and enter a range of channel configurations you wish to export.
[bookmark: _Toc394916843][bookmark: _Toc395410315][bookmark: _Toc457899007][bookmark: _Toc408990998][bookmark: _Toc394745977]Copy and Paste
Two of the icons on the Configure User Analog toolbar are Copy and Paste. From the Calculator Configuration Window it is possible to copy one channels configuration to another. Point to the channel to be copied, it will be highlighted, click on the Copy icon the configuration will be copied to the clipboard.  Now point to the channel that the configuration is to be copied to, again it will be highlighted. Select the Paste icon and the configuration will be pasted from the clipboard.

[bookmark: _Toc394916844][bookmark: _Toc395410316][bookmark: _Toc457899008]Shortcuts
Toolbar:	[image: editcopy][image: editpast]
Keys:	CTRL+C, CTRL+V
[bookmark: _Toc394916845][bookmark: _Toc395410317][bookmark: _Toc457899009][bookmark: _Toc408990999]
Configure Calculator Channel
The Configure Calculated Channel is divided into 6 sections plus a row of buttons at the bottom.

[image: \\ds\Store\GCanning\Unit Cat Pics\unit_cat4.png]
User Category Drop Down Menu
When editing a calculator channel the user can select a category fromm the drop down menu, this drop menu grabs all the units in Unit Category, after selecting an item from the drop down menu it will fill in the descriptor with the base name from Units Category.
[bookmark: _Toc394745985]Formula
A full description on the use of formulae in the Calculator Processor is described in the next section Calculator Formulae. This section deals with the mechanics of configuring the formula for a channel.

Channel Formula can be entered in two ways. It can be typed directly into the formula text box. When completed the syntax of the formula can be checked by choosing the Check Formula button.

Alternatively Formula elements can be inserted into the formula text box. Choose the Functions button.


A Construct a Formula dialog box will be shown

[image: \\ds\Store\GCanning\Unit Cat Pics\unit_cat3.png]

To construct a formula select a user function, an operator, or a constant from the scrolling lists boxes and then click the Insert button. Edit the formula manually to add function parameters, channel numbers, etc. When the formula is complete check that the syntax is correct by choosing the Check Formula configure button.

When the formula has been entered satisfactorily choose the OK button. The previous dialog box will be returned.

Unit Category
Calculator channel units can be dynamically converted by allocating the channel to a unit category with the unit selection facility provided.

From Category you can select from a list of unit categories which will dynamically change the units.

[bookmark: _Toc394745987][bookmark: _Toc394916846][bookmark: _Toc395410318][bookmark: _Toc457899010][bookmark: _Toc408991000]Calculator Formulae
[bookmark: _Toc394745988][bookmark: _Toc394916847][bookmark: _Toc395410319][bookmark: _Toc457899011]Introduction
Many different formulae can be inserted into Calculator channels to produce real time, on-line calculations.

In the examples in this section the text within the square brackets [] is the actual syntax of the formula.

Formulae can be of simple arithmetic construction

Example:	Channel C1 formula is [DS1 + DS2]

Or a more complex mathematical algorithm incorporating integration, trigonometric, logarithmic, timing and control and statistical functions.

Conditional statements are available allowing calculations only to be performed when the status of a condition is either true or false.

Each calculator channel yields a single result. Each formula can contain up to 39 characters. The result of one calculator channel can become an element of another channel.

Example:
Channel C1 formula is [DS1 * DS2/P1		]
Channel C2 formula is [DS5 - DS7		]
Channel C3 formula is [C1 + C2		]
[bookmark: _Toc394745989][bookmark: _Toc394916848][bookmark: _Toc395410320][bookmark: _Toc457899012]Formula Construction
A formula comprises one or more operands and one or more operators. The Calculator compiler is not case sensitive.


Operands
Operands are numeric quantities that are formed from:
User Constants.
Integer and floating point constants can be entered e.g. 1, 1.5, or 2.35e+6
Engineering Constants.
A set of predefined constants are provided:

pi 	= 3.14159		PI
me	= 9.10953e-31		Electron Rest. mass kg
u0	= 1.25664e-06		Permeability of free space H/m
na	= 6.02205e+23		Avagadros number mol-1
vm	= 0.0224138		Molar Volume mol-1
e0	= 8.85419e-12		Epsilon zero F/m
c	= 2.99792e+08		Speed of Light in free space ms-1
h	= 6.62618e-34		Planck’s constant JS
gc	= 6.672e-11		Gravitational constant Nm2kg-2 
g	= 9.80665		Acceleration due to gravity ms-2 
ec	= 1.60219e-19		Unitary charge, Coulombs
u	= 1.66057e-27		Unit of atomic mass kg
k	= 1.38066e-23		Boltzmans constant J/K
r	= 8.31441		Gas constant J/mol/K

Example:		[DS3 * pi	]
Channels
Any channel in the ScadaPro system can be specified as an operand in an expression. Calculator channels may also be specified.  Channels can reference tags eg. DS1 or as an array eg. D1[0].  Tags can also be user to access arrays eg. If DS1 – DS16 stores a temperature profile and P1 is the current index then DS[P1-1] will access the profile array.

NB
Calculations are evaluated in Channel number order. The result of any Calculator channel can be used in subsequent calculator channel formula but NOT in preceding channels.

Calculator Variables
There are up to 1000 local variables available for use within the Calculator. These variables have the prefix ‘V’ and within the Calculator package look like normal ScadaPro channels. They cannot be seen by the rest of the ScadaPro System and have no channel configuration. They can be assigned any value by the assignment operator (=), their current value used as an operand in any expression. 

Example:			[V1 = DS1*2	]
			[P2 = V1	]
Function Calls
Sets of predefined functions are provided. Each function yields a single result known as the return value. This value is available for use as an operand. Function calls are described later in this section.
Result of sub-expression
An expression can be made up of a number of sub-expressions. Each sub-expression yields a single value that becomes an operand for a further expression.
[bookmark: _Toc394745990]
Operators
Operators specify an action to be taken by the calculator.
Arithmetic Operators
^	Power			e.g. DS1^3
*	Multiplier		e.g. DS1 * 10
/	Divisor			e.g. DS1/100
+	Addition		e.g. DS1+DS4
-	Subtraction		e.g. DS1 - DS2
Logical Operators
Operands are always rounded to the nearest integer before the logical operation. In logical operations the number zero is considered as FALSE, and any number that is non zero is considered as TRUE. The result of a logical operation is 0 if FALSE and 1 if TRUE.

!	Logical NOT	e.g. !DS1 if logical test if TRUE return 1, if DS1 is non zero 			then return 0

&	Logical AND	e.g. DS2 & DS3 – TRUE returned if both operands are non 			zero
|	Logical OR	e.g. DS6 | DS23 – TRUE if either are non zero

Relational Operators.
These operators compare their first operand to their second operand. The result of the expression has a value of 1 if the test condition is TRUE and 0 if it is FALSE.

>	Greater than		e.g. DS8 > 3.45
<	Less than		e.g. DS3 < DS6
>= 	Greater than or equals	e.g. DS3 >= P3
<=	Less than or equals	e.g. DS4 <= P4
==	Equal to		e.g. DS5 == 27
!=	Not equal to		e.g. DS23 != 0
~=	Approximately equal to	e.g. DS6 ~= 23.5

Note	relational tests are normally performed on floating point numbers. Due to 	rounding errors that occur during floating point arithmetic it is often not practical 	to use the == (is exactly equal to)

If an action is required when a temperature, being monitored on a Device Channel reaches 35 degrees C DO NOT use ==. As the temperature rises the ScadaPro System may never read exactly 35.00. It may see 34.9994 or 35.010 but to the computer that is not 35.00. In these instances use the approximately equals (~=) operator.
	Example:	[DS5 ~= 35.00	]

In the example above the operator will round its two operands to the nearest integer before the test. The condition will be regarded as TRUE whilst DS5 is between 34.5 and 35.49999.
Assignment Operator
The assignment operator is =. It assigns the second operand to the first. E.g. P5 = 2 * DS2
The Calculator can only assign values to User Analog (P Channels); User Digital (Q Channels); Device Output channels (digital or analog); ScadaPro devices with output channels; and calculator temporary variables V.
 
Compound Expression Operators
The compound expression operators allow more than one expression to be evaluated. The operators are:

>> Return result of right hand expression
<< Return result of left hand expression

Example: In channel C5 the formula is written as:
	[DS2 * pi << P3 = DS23	]

The Channel C5 will take the value of DS2 * pi, the expression P3 = DS23 will be evaluated but the result will not be assigned to Calculator channel C5.
Conditional Operator
The conditional operator allows an IF THEN scenario to be computed.
	Conditional Test ? Do if TRUE : Do if FALSE
The ? and : are the conditional operator delimiters.

Example: Channel C3
	 [DS23>40 ? P2=40 : P2=0	]

If DS23 is greater than 40 the expression P2 = 40 will be computed. Channel C3 will also assume the value of 40. If DS23 is less than 40 then the expression P2=0 will be actioned. C3 and P2 will assume the value of 0.
The conditional operator relates to the term:
	If Condition True ? (THEN) do this : (ELSE) do this.


Operator Precedence and Order of Evaluation.
When more than one operator is used in an expression, operators are given a priority to ensure a specific order if evaluation. Operators with the highest priority are evaluated first. The following list shows the priority of all the operators:

Highest	()			Parenthesis
	!			Logical NOT
	^			Powers
	* /			Multiply, Divide
	+ -			Addition, Subtraction
	< <= > >= == != ~=	Relational
	& |			Logical AND, OR
	?:			Conditional
	=			Assignment
Lowest		<< >>			Compound

Example:	[4 + 5 * 2 ^ 2		]
	[(4 + 5) * 2 ^ 2		]

For the first expression in the example above the system will calculate the result as 24, whereas the second expression will yield a result of 36.

Where two or more operators have the same priority then the expressions are evaluated left to right.
	
Example:		[4 * 5 / 2	] yields 10
			[5 / 2 * 4	] yields 10
Function Calls
A Function Call consists of a function name followed by an expression list in parenthesis. An expression list is a list of parameters each separated by a comma. The function uses each parameter to produce the function call result.

Example:			[pulse(hour, min, sec)		]

Each function produces only one result, so a function call is an expression that can be used as an operand and used as part of more complex formula. Functions can be used within either function calls as an item or in the parameter list.

Example:			 [greatest(DS1, pulse(06, 0, 0))	]

The function call greatest(x, y) returns the result of the largest value that ScadaPro channel attains. X is the ScadaPro Channel, when  r  is TRUE ( > 0) the value is reset and the greatest value is the current value.

The call pulse(h, m, s) returns a value of TRUE (1) for the scan when the computer system clock has the same time hour, minute and second as that in the parameter list.

In the above examples Channel C33 will hold the greatest value that channel DS1 attains. As 06:00 every day the greatest value will be reset. Hence producing the greatest value of a channel on a daily basis.

It is only necessary to enter the first Four characters of a function name. However it is recommended that if space allows the full name is used for readability and clarity.

Function calls can be grouped into 8 categories:
Logical Functions
Mathematical Functions
Counting and timing functions
Control pulse functions
Statistical functions
Steam Table Functions
Channel Status Functions
Component Control Functions

In addition to these functions, String handling functionality has also been implemented, this will be explained latter.
Logical Functions:
These groups of functions perform bitwise operations on their arguments. Arguments are rounded to the nearest integer before being passed to the function. Arguments x and y can be ScadaPro channels, actual values or calculator variables.
and(x, y)		bitwise AND of x, y
or(x, y)		bitwise OR of x, y
xor(x, y)		bitwise exclusive or (XOR) of x, y
not(x)		bitwise compliment of x
nand(x, y)		bitwise not and (NAND) of x, y
nor(x, y)		bitwise not or (NOR) of x, y
xnor(x, y)		bitwise nor exclusive or (XNOR) of x, y
Mathematical Functions:
A range of mathematical functions are available. Argument x can be ScadaPro channel, an actual value Calculator variable or any expression.
hypot(x, y)		Euclidean distance function

		I.e. 
sin(x)		Sine of angle x in radians
cos(x)		Cosine of angle x in radians
tan(x)		Tangent of angle x in radians
dsin(x)		Sine of angle x in degrees
dcos(x)		Cosine of angle x in degrees
dtan(x)		Tangent of angle x in degrees
asin(x)		Arc sine of angle x in radians
acos(x)		Arc cosine of angle x in radians
atan(x)		Arc tangent of angle x in radians
dasin(x)		Arc sine of angle x in degrees
dacos(x)		Arc cosine of angle x in degrees
datan(x)		Arc tangent of angle x in degrees
ln(x)		Natural Log of x
log(x)		Log to the base 10 of x
exp(x)		Raise to the power of x
fabs(x)		Absolute value of x
floor(x)		Round down to the nearest integer
ceil(x)		Round up to the nearest integer
rnd(x)		Round to nearest integer
sqrt(x)		Square root of x
Counting and Timing Functions
ctime()		Seconds since midnight
ytime()		Days since January 1 in the current year
day()		Day of the week 1 = Monday; 7 = Sunday

The time functions return an integer value.
period(H1, M1, S1, H2, M2, S2)

The time period test function returns the value of 1 (TRUE) when the time as reported by the computer system clock is between H1:M1:S1 and H2:M2:S2. When time is not between the listed parameters the value of 0 (FALSE) is the result.
stimer(n)		Start timer n. If timer n is already running then this function has no effect
etimer(n)		Stops timer n and retains value. If the timer is already stopped then this function has no effect.
rtimer(n)		Resets timer n to zero, returns the value of the timer before the reset.
vtimer(n)		Gets the current value of timer n without interfering with the update of the counter

There are up to 1000 individual timers available. The value of each timer is reported in seconds and is accurate to 1/100th of a second. They can be stopped, started and reset independently of each other. n is the number of the timer from 1 to 1000

Timers can be used as cumulative timers or as single event timers. If a timer is halted with the etimer(n) function then the timer value is retained and starts from that value when restarted with the stimer(n) function.
scount(n)		Start counter n. Counter n increments by 1 whenever this function is evaluated.
ecount(n)		Stop counter n. Has no effect on the counter, but returns its current value.
rcount(n)		Resets the counter n to zero. Returns the value of the counter before reset.
vcount(n)		Gets the value of counter n without interfering with the update of the counter.

There are up to 1000 individual counters available. They can be stopped, started and reset independently of each other. n is the number of the counter from 1 to 1000.

Counters can be used as cumulative counters or as single event counters. If a counter is halted with the ecount(n) function then the counter value is retained and starts from that value when restarted with the scount(n) function.

NB 
When using the counters be aware that the counts increment every time the calculator channel evaluates the expression containing the scount(n) start counter function. See later examples.
delta(n)		Reports the time in seconds since the last call to this delta timer.

There are up to 1000 delta timers available. The value of each timer is reported in seconds and is accurate to 1/100th of a second. Delta timers are used to report the time since they were last called.
Control Pulse Functions
The following functions all provide a “pulse” output. Normally the return value of the function is zero (FALSE), but at the appropriate time the return value becomes 1 (TRUE). The duration of the pulse will last one scan, sufficient time for all calculations that are dependent on the pulse to be evaluated once. These pulses can therefore be used to specify when calculations occur. (see later examples).
pulse(h, m, s)		Provides a pulse at time h-hours; m-minutes; and s-seconds
dpulse(h, m, s, r)	Provides a pulse on a repeated basis every h-hours; m-minutes; and s-seconds after the last pulse. When r = 1(TRUE) the timer is reset and the next pulse is produced after a further h, m, s time.
cpulse(x)		Provides a pulse when x changes state from zero to non zero or non zero to zero (FALSE to TRUE or TRUE to FALSE). – Any change of state.
ppulse(x)		Provides a pulse when x changes state from zero to non zero (FALSE to TRUE). – e.g. A channel going of an alarm state.
npulse(x)		Provides a pulse when x changes state from non zero to zero (TRUE to FALSE). – e.g. A channel going out of an alarm state.
Statistical Functions
min(x, y)		The lesser of x and y.
max(x, y)		The greater of x and y
limit(x, y)		If x < y then logical 1 else 0
ulimit(x, y)		If x > y then logical 1 else 0
least(x, r)		The least value that x has attained. When r becomes non zero reset greatest to current value of x.
range(x, r)		The range between the greatest value of x and the least value of x. When r becomes non zero reset to current value of range.
rate(x)		dx/dt – change of z against time
integral(x, r, v)		Integral of x with respect to time. When r is non zero reset integral to v. i.e.

			
filter(x, y)		logarithmic average of x with a gain of y

			
mean(x, r)		Statistical mean of x. When r is non zero reset mean.
stdev(x, r)		Standard deviation of x. When r is non zero reset deviation.

[bookmark: _Toc394745991]			
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Steam Table Functions
The Steam Table Functions are a List of functions that calculate the thermodynamic and transport properties of steam and water. They are available only if the WinSteam 3.0 libraries have been purchased from Techware Engineering Applications Inc. Information about these functions can be found at http://www.techwareeng.com. All files purchased from Techware must be placed and registered in <Root>\BIN.



	Steam Function
	Descriptor

	StmPT(Pressure, Unitset)
	Temperature

	StmTP(Temperature, Unitset)
	Pressure

	StmPTC(Pressure, Temperature, Unitset) 
	Specific Heat

	StmPTG(Pressure, Temperature, Unitset)
	Isentropic Expansion Coefficient

	StmPTH(Pressure, Temperature, Unitset) 
	Specific Enthalpy

	StmPTK(Pressure, Temperature, Unitset) 
	Thermal Conductivity

	StmPTM(Pressure, Temperature, Unitset) 
	Viscosity

	StmPTS(Pressure, Temperature, Unitset) 
	Specific Entropy

	StmPTV(Pressure, Temperature, Unitset) 
	Specific Volume

	StmPTW(Pressure, Temperature, Unitset)
	Sonic Velocity

	StmPQC(Pressure, Quality, Unitset)
	Specific Heat

	StmPQG(Pressure, Quality, Unitset)
	Isentropic Expansion Coefficient

	StmPQH(Pressure, Quality, Unitset)
	Specific Enthalpy

	StmPQK(Pressure, Quality, Unitset)
	Thermal Conductivity

	StmPQM(Pressure, Quality, Unitset) 
	Viscosity

	StmPQS(Pressure, Quality, Unitset) 
	Specific Entropy

	StmPQV(Pressure, Quality, Unitset) 
	Specific Volume

	StmPQW(Pressure, Quality, Unitset) 
	Sonic Velocity

	StmPSC(Pressure, Entropy, Unitset) 
	Specific Heat

	StmPSG(Pressure, Entropy, Unitset)
	Isentropic Expansion Coefficient

	StmPSH(Pressure, Entropy, Unitset)
	Specific Enthalpy

	StmPSQ(Pressure, Entropy, Unitset)
	Quality

	StmPST(Pressure, Entropy, Unitset)
	Temperature

	StmPSV(Pressure, Entropy, Unitset)
	Specific Volume

	StmPSW(Pressure, Entropy, Unitset)
	Sonic Velocity

	StmPHC(Pressure, Enthalpy, Unitset) 
	Specific Heat

	StmPHG(Pressure, Enthalpy, Unitset)
	Isentropic Expansion Coefficient

	StmPHQ(Pressure, Enthalpy, Unitset) 
	Quality

	StmPHS(Pressure, Enthalpy, Unitset) 
	Specific Entropy

	StmPHT(Pressure, Enthalpy, Unitset)
	Temperature

	StmPHV(Pressure, Enthalpy, Unitset)
	Specific Volume

	StmPHW(Pressure, Enthalpy, Unitset)
	Sonic Velocity

	StmTQC(Temperature, Quality, Unitset)
	Specific Heat

	StmTQG(Temperature, Quality, Unitset)
	Isentropic Expansion Coefficient

	StmTQH(Temperature, Quality, Unitset)
	Specific Enthalpy

	StmTQK(Temperature, Quality, Unitset)
	Thermal Conductivity

	StmTQM(Temperature, Quality, Unitset)
	Viscosity

	StmTQS(Temperature, Quality, Unitset)
	Specific Entropy

	StmTQV(Temperature, Quality, Unitset)
	Specific Volume

	StmTQW(Temperature, Quality, Unitset)
	Sonic Velocity

	StmTempTI(ITS-95 Temperature. Unitset)
	IPTS-68 Temperature

	StmTempIT(IPTS-68 Temperature, Unitset)
	ITS-95 Temperature



Channel Status Functions
The Channel Status functions are a set of functions that get the current status of an ScadaPro channel. These functions are used by the . extension to a channel eg P1.ALM. The functions are : (note OC = Any Processor ScadaPro Channel)

OC.ALM			Return Alarm Status of channel (1 if in alarm, 0 if out)
OC.WRN			Return Warning Status of channel (1 if in warning, 0 if out)
OC.EVT			Return Event Status of channel (1 if in event, 0 if out)
OC.ERR			Return Error Status of channel (1 if in error, 0 if out)
OC.UAK	Return Acknowledge Status of channel (1 if unacknowledged , 0 if acknowledged)
[bookmark: _Toc457899013]Component Control Functions
These Functions can be used to Control various Components in the ScadaPro System. At present only Logger Control Functions have been implemented but further Control functions may be added in the future. The functions are as follows :

slog(num)			Start Logger where num refers to the logger number.
elog(num)			Stop Logger where num refers to the logger number.
vlog(name)			Current Value of Logger where name refers to the Logger name.
clog(num,status)		Set Loggers Status, where num is the number and status is the state, 1 for on 0 for off.

(Note : See the section on String Handling to see how to use this functions using logger Names instead of numbers.)

[bookmark: _Toc457899014]String Handling Functionality
The Calculator can handle Strings in formulas, and can be used as follows. The first way is to reference a channel in the system by tag. For example if we have an Analog channel P1 configure with a Tag of STR, we can reference this channel in the calculator by putting “_STR” in a Calculator channels formula. 

Note: To reference a channel as prefix the tag with an “_ “
The string functionality can also be used to reference Loggers. For example to use the above vlog(name)  function to reference a logger named LOGGER_1, simply use vlog(“LOGGER_1”). Be sure to enclose the Logger name in quotes, i.e “ “ , this applies to all string references.
[bookmark: _Toc457899015]Calculation Formula Timing
Calculator channel expressions are re-evaluated whenever any ScadaPro Channel is updated. E.g.

	C1 = [DS1 + P1		]

C1 will be updated whenever DS1 or P1 updates.

Channels in an expression that are being assigned values by the assignment operator do not case a re-evaluation if an update occurs to the assigned channel. The calculator will only re-evaluate the expression when the assigning channel updates. E.g.
				
					C1 = [DS17 = Q1	]

This expression will only re-evaluate when Q range of channels update, and do not if updates occur on the DS channels.

If an expression contains one of the following timing functions then these expressions are re-evaluated at least once per second.

	stimer()
	Pulse()

	etimer()
	Dpulse()

	day()
	Period()

	ctime()
	Ytime()
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These functions are functions that are created by the user, to insert a User Function into the calculator channel open up the functions configuration screen by selecting the Functions button on the calculated channel configuration screen and on the left side of the window under the User Functions section.

When inserting a User Function a window will display asking for the user to input in channels in the text fields, once that is done the user can select check formula to make sure that the valid they are inputting is valid, after the formula has been verified the user will select OK to close down the windows until they are back to the Calculated Channel Configuration screen.

NB.  When inserting User Functions into the calculator channels it will display as “UserCalc("TotalFlowRate",”Values”)”  
Example Formulae
The following examples are designed to use most of the function types and utilities in the Calculator package.  The examples will be introduced with a description of the process and the monitoring requirements.  The description will include a list of ScadaPro channels allocated.
Example 1 - Process Efficiency Monitoring.
This imaginary plant operates two 12-hour shifts seven days a week. Shifts start at 06:00 and 18:00 each day. The requirement is to monitor the plant on a shift basis to calculate machine efficiency.  To log to disk at the end of each shift the total running time of the machine, the downtime and the number of times it stops.  

One analogue Device channel DS1 is monitoring, via a transducer the speed of a drum.  When the transducer indicates greater than 2 rpm then the machine is operating.

The calculator formula could be configured as follows.
	C1 = [period(06,00,00,18,00,00)    ]
C1 will =1 during the defined period therefore the result of this channel will produce a value of 1 for day shift and 0 for night shift.
	C2 = [pulse(05,59,45)                   ]
	C3 = [pulse(06,00,00)                   ]
	C4 = [pulse(17,59,45)                   ]
	C5 = [pulse(18,00,00)                   ]
Calculator channelsGlossChannels.73 2 and 4 will be configured to trigger a logger ( Event Low set to -1 and Event High set to 0.5).  Two loggers configured; one called DAYSHIFT, set to event mode, event trigger channel defined as C4; the other called NIGHTSHIFT, set to event mode, event trigger channel defined as C2.

Channels C3 and C5 will be used to reset timers at the end of the respective shifts.
	C5 = [DS1>2?stimer(1):etimer(1)            ]
Test DS1 to see if it is greater than 2 (Machine running).  If it is running start timer number 1 - the machine runtime timer. If it is not running stop the timer.
	C6 = [DS1<2?stimer(2):etimer(2)            ]
When DS1 is less than 2 the machine has stopped. Start downtime timer when stopped, stop timer when machine restarts.
	C7 = [C5/(C5+C6)*100		   ]

	Calculate efficiency 
	C8 = [npulse(ds1<2)                      ]
C8 will have the value of 1 (TRUE) for the scan in which the machine stops.  (When DS1 goes less than 2).
	C9 = [c8?scount(1):c9                   ]
When C8 is True increment counter, i.e. every time machine stops. C9 is placed in the ELSE field to ensure the calculator maintains the count value even if not being incremented.
	C10= [C1?P1=C5<<P2=C6:P11=C5<<P12=C6]
If it is day time copy run time and down time to User Channels P1 and P2; If it is night time copy to P11 and p12.  The << allows more than one expression to be evaluated.
	C11= [C1?P3=C7<<P4=C9:P13=C7<<P14=C9 ]	
Copy efficiency and number of stops to different  User Analogue channels dependent on the current shift.  It is the User Analogue channels that in this example will be logged to disk at the end of each shifts. 
	C12= [c3|c5?rtimer(1)<<rtimer(2)<<rcount(1):0]
Reset the timers and counter to zero at the start of a shift.

Example 2 - Manually Entered Coefficients.
The scenario for this example is a laboratory.  Different fluids are used in a reactor vessel and the chemist needs to manually enter a coefficient equal to the viscosity of the fluid being used.  A Device Channel DS1 is monitoring the flow rate (volume) of the fluid being used.  The weight of the fluid used per minute is the result required.  The viscosity coefficient is needed to calculate the weight of the different fluids tested 

The ScadaPro Monitor Windows can be used to manually enter data in to the User Analogue ChannelsGlossChannels.73 

The calculator formulaeGlossCalculatorFormulae.72 may be as follows:
	C1 = [V1=P1                                    	]
Assign the viscosity coefficient from P1 to the calculator variable V1.
	C2 = [!P1?v1=1:0			]
In case operator does not enter value set a value of 1.  If P=0 make V=1.  NB. !P1 means NOT TRUEGlossTrue.91 i.e. is zero. 
	C3 = [rate(DS1)*60                           	]
If the scan rate of the Device is set to 1 second the rate(DS1) will be litres/second.  Multiply by 60 will give litres per minute.
	C4 = [c2*1.64*v1                 		]
C3 will assume the value of the weight of the fluid used per minute.  The volume per minute (C2) is multiplied by a constant 1.64 and also by the manually inputted coefficient to produce an exact weight.

Example 3 - Statistical Monitoring
This example is concerned with an Electricity Power Generation Unit.  The requirement is to monitor the purity of the water used to produce the steam to drive the generator.  The levels of calcium, pH and suspended solids are monitored via suitable transducers.  A daily record of the maximum, minimum and mean value of each parameter is to be recorded.  The calculations are to be performed only when the unit is generating electricity. The generator is regarded as running when an output of greater than 5 Mega Watts is reached.
 
Device Channel DS1 is monitoring the output of the unit in megawatts; DS2 the calcium level; DS3 the pH; and DS4 the suspended solids.

The calculator formula may be written as follows:
	C1 = [pulse(23,59,55)			]
A pulse 5 seconds before midnight each day. Channel C1 will be configured to trigger a logger. The logger will be set to event mode, event trigger specified as C1 and logger configured to record channels C4 to C12.  This will store the days results.
	C2 = [pulse(00,00,00)			]
A pulse at midnight to reset all greatest, least and mean calculations.
	C3 = [DS1>5:1:0			]
If the generator is operating channel C3 will assume the value of 1 (TRUE).  If not running will have the value of 0 (FALSE).
	C4 = [C2|C3?greatest(DS2,C2),C4	]
Calculate the greatest value that DS2 achieves, only whilst C3 is TRUE.  Reset the calculation when a pulse appears on channel C2  (i.e. at midnight). Maintain the value on the calculator channel even if generator not running.	 

NB.  If the formula was only written as [C3?greatest(DS2,C2),C4  ] then the greatest calculation would only be evaluated when generator is operating.  If the unit was stationary at midnight the calculation would not be evaluated and therefore the  greatest value would not be reset.  

Making the condition C2|C3   (C2 OR C3) ensures the greatest function is evaluated and reset at the correct time, even if generator still.  

The formula is repeated for each parameter and statistic required.
	C5 = [C2|C3?greatest(DS3,C2),C5	]
	C6 = [C2|C3?greatest(DS4,C2),C6	]
	C7 = [C2|C3?least(DS2,C2),C7		]
	C8 = [C2|C3?least(DS3,C2),C8		]
	C9 = [C2|C3?least(DS4,C2),C9		]
	C10= [C2|C3?mean(DS2,C2),C10	]
	C11= [C2|C3?mean(DS3,C2),C11	]
	C12= [C2|C3?mean(DS4,C2),C12	]

Example 4 - Control Algorithms
This example shows how the Calculator formula can be used for control.  In this imaginary process.  

The operator presses a start button to initiate a process.  The calculator checks certain parameters on the process to ensure it is safe to start the process cycle.  It is the calculator in this example that actually starts the process.  The operator effectively issues a request to start.

DS1 monitors a temperature of a cooling fluid; DS17 is a digital input from the operators START BUTTON;  DS18 and DS19 are digital inputs connected to detectors sensing machine status' ; DS33 is a digital output signal to a contactor to start the machine cycle; DS34 is a digital output signal powering a red indicator lamp ; DS35 a digital output driving a green  indicator lamp. The contactor needs to be operated by a digital pulse of 5 second duration.

The process can only be allowed to start if the cooling fluid is below 25oC and all the detectors are HIGH.

The calculation formula may be:
	C1 = [DS17&DS1<25?1:0				]
	C2 = [C1&DS18&DS19?DS33=1<<DS35=1:DS34=1	]
The conditions are tested and if all are true then the contactor will be switched in and the green indicator lit.  If they are not all true then the red indicator lamp only will be powered. 
	C3 = [C2?stimer(1):rtimer(1)				]
When all conditions are met and the contactor powered a timer is started.
	C4 = [C3>=5?DS33=0<<rtimer(1):0			]
After five seconds the digital output powering the contactor is turned off and the timer reset.

[bookmark: _Toc394745993][bookmark: _Toc394916851][bookmark: _Toc395410323][bookmark: _Toc457899017]Compiler Errors

Errors that are displayed in response to choosing the Check Formula button in the Configure Calculator Channel Window are explained below.
Bad Parenthesis:
The number of left '(' parenthesis and the number of right ')' do not match, or are in the wrong order.
Incorrect Number:
A constant number is not specified correctly.
Too Many Decimal Points:
More than 1 decimal place is included in a number.
Too Many Exponents:
More than one exponent is included in the number.
Invalid Channel Name:
The specified name is not a valid ScadaPro channel name.

Too Many ? Statements:
Too Many :  Statements:
The number of ? and : contained in conditional expressions do not match, or are in incorrect order.
Token Count Exceeded:
A maximum number of 26 tokens are allowed per formula expression.  Tokens include operands, operators and functions.
Variable Stack Exceeded:
A maximum number of 10 operands are allowed per formula expression.
Bad lhs - Not a Channel:
The left-hand side of an assignment expression is not a channel.
Invalid Argument Type:
The stimer, etimer, rtimer, delta, scount, ecount, and rcount functions expect a number in the range 1 to 1000.
Invalid Number of Arguments:
Too few or too many arguments are passed to a function call.
Missing Arguments in a Function Call:
There are no arguments between comma separators in a function call.
Invalid Function Name:
The function called is not a Calculator function.
Comma Outside Function Call:
Comma can only be used to separate arguments in a function call.
Unrecognised Operator:
The operator specified is not a valid calculator operator.

[bookmark: _Toc408991001]Unit Categories
Unit Categories can be used to dynamically convert units by allocating the channel to a unit category with the unit selection facility provided. To configure select Processors and then Unit Categories from the ScadaPro menu bar.

[image: ]

Unit Category Channel Configuration
With Units Category you can configure channels, when configuring a channel you can enable the channel to allow you to edit the fields in the configuration screen.  In the configuration screen of Units Categories you can give a channel a name that is in the Unit Category text box on top of naming the channel you are able to give the channel a base name and base unit.

To do conversion in Unit Category you will need to input a conversion name and then conversion units, once you have the conversion name and units entered you will then need to enter in the conversion formula via the operand text fields and drop down menu. In the drop down menu you will be given a list of operators (+, -, *, /) and in the text field you will then have to enter in the value of the conversion to allow Unit Categories to work out conversions.
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Advanced Unit Category Configuration.
AutoEnable Unit Category
Before any Unit Category Channel can be incorporated into the overall ScadaPro System the Advanced Unit Category Configuration bar must be selected and the Auto-Enable Unit Category box checked.
[image: ]
Auto Save.
To Enable this utility check the Auto Save flag. All values in output channels are saved to disk when the system is disabled. The next time the system is restarted the values which were previously in output channels will be restored to the appropriate channel number.
Saving the Unit Category Configuration
When a configuration has been completed it must be saved to retain any changes made.  To save either:
1.	Click on the Save icon; [image: ]The Unit Category configuration will be saved to the current ScadaPro System configuration.  No File Name will be requested.
2.	Select Save from the File menu.
3.	Select Exit from the file menu.  If any changes have been made a dialog box will ask if you want to save the configuration before exiting the window.

NB.
Any changes to the User Category Configuration will not be incorporated into the ScadaPro System until it is next enabled or the processor is reconfigured.
Import / Export the Unit Category Configuration
Import the Unit Category Configuration
Select Import Configuration from the File Menu to import channel configuration from an ASCII file.   This command presents an Import dialog box, where you may specify the range of channels to be imported, the file to import from etc. 
Export the Unit Category Configuration
Select Export Configuration from the File Menu to export channel configuration to an ASCII file.   This command presents an Export dialog box, where you may specify the range of channels to be exported, the file to export to etc. [image: ]
Import/Export Dialog
The Import/Export dialog allows the user to configure how channel configurations will be imported/exported. User settings are saved and are used as default settings the next time the dialog is invoked.

Header
If Header is checked column headers will be exported with the configuration, these headers make it easier to identify the contents of each column

Value Width  
Results are stored in the Systems Log Files with full floating point precision.  The actual width of the number passed can be modified.  In the Value Width text box enter or edit the total number of digits, including the decimal point required.  If the value when converted is greater than the width defined the value will be converted to Scientific notation.
Value Precision
In this box enter the number of digits after the decimal point.
Delimiter
Three options and a User Defined alternative are available in this drop down list.  The delimiter separates each field in a row.  The correct delimiter is required for the spreadsheet package to import the data correctly.  The choices are:
		User
		Space
	 	Comma  
		Tab.  
Most modern spreadsheets including Microsoft Excel and Lotus use the Comma separator.
As an alternative to the fixed choices a User option is available.  If this is chosen enter the delimiting character in the text box that appears alongside the list.  
End Line
Similar to the Delimiter there are choices for the end of line separator.  The choices are: 
		User
		CR/LF.
		LF(LineFeed) 
		CR ( Carriage Return) 


A User option is again an option.  Microsoft Excel and Lotus require  CR/LF end of line characters.
Import/Export File
Enter the path of the file you wish to export to or import from. Alternatively click the button on the right hand side to browse for the desired file.
Channel Range
Select the All Channels button if you wish to import/export every channel configuration.
Alternatively select the Channels button and enter a range of channel configurations you wish to export.
 
[bookmark: _Toc394745994][bookmark: _Toc395410324][bookmark: _Toc457899018][bookmark: _Toc408991002]Alarm System Configuration
To configure the Alarm System, either select  Alarm System from the Processor drop down menu on the main menu, or double click on the Alarm System icon in the Program Group.


The Alarm System Configuration Window will be displayed.

[image: ]

The Configure Alarm System Window is divided into Three sections, with a fourth section accessed by clicking on the Advanced Alarm Configuration button.

[bookmark: _Toc408991003]Alarm Configuration
[bookmark: _Toc394745995][bookmark: _Toc394916852][bookmark: _Toc395410325][bookmark: _Toc457899019]Common Alarm Output
If a Common Alarm is required checking the Enable Common Alarm Output check box enables this.  When checked access will be available to the Channel Text box.  Type in the Device Channel digital output channel number that is to be the common alarm output.
[bookmark: _Toc394745996][bookmark: _Toc394916853][bookmark: _Toc395410326][bookmark: _Toc457899020]Alarm Printer
If a printer is to be dedicated as an Alarm Printer , check the Enable Alarm Printing check box and select the printer port that is to be used from the drop down list.  Parallel ports are designated LPT1: LPT2 etc.  Serial ports are designated COM1:,  COM2 etc.

If the user selects the "other" option from the printer drop down list, the "Select Alarm Printer Name" dialog will be invoked. This dialog allows the user to enter another name for the printer port.
Parallel Printers
Click on the Settings ... button to specify the Transmission Retry Time.
The Transmission Retry Time is the time for which the Print Manager will wait for a printer to set itself up to print the next section of information. A Printer Not Ready message will appear if the printer is not ready within the time specified.
Serial Printers
Click on the Settings... button of the Alarm System Configuration Window to set-up the serial communication information required for the PC to communicate with the printer.  The first dialog box that is displayed asks for the port name, select the appropriate port designation.

Click on the Settings button in the Ports dialog box. By using the Drop Down Lists for each section select the correct settings for the printer configuration to be used.

Note: USB and TCP printer ports are not supported
[image: ]
For details of the entries required for each section consult the printers hardware manual or seek help from a competent hardware specialist.
Remote Printers
The alarm printing system can print alarms to a printer which is attached to a remote machine on the same network. To enable remote printing, set the printer location to remote and type in the name of the machine where the printer is located. Alternatively, click on the Select button. The Browse for a Computer dialog will appear with a list of all visible computers on the network. Select the computer where the printer is located and click the OK button. The computer name is automatically filled in to the Server Name of the Alarm System window.

For a machine to act as a host for remote alarm printing (the machine which has the printer physically attached to it), the Alarm Printer service must be installed and started.




To install the alarm printer service on the machine with the printer attached, perform the following in a DOS window: (replace <root> with the root directory of your software, e.g. \SCADAPRO) 
	
	cd <root>\bin
	alrmprnt –install
If you type: 
	
	alrmprnt -?

a full list of command line options will appear.

Note: USB and TCP printer ports are not supported
[bookmark: _Toc394745997][bookmark: _Toc394916854][bookmark: _Toc395410327][bookmark: _Toc457899021]Alarm Logging
If the Enable Alarm Logging box is checked the alarm logger will log alarms to disk. The logger will run continually whilst the Alarm System is enabled, and this field is set to Enabled.  The remainder of the entries in this box determine the way in which the logger operates.  

The Alarm Logger is independent of the Data Loggers described in Part 5. The two should not be confused.
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Start Mode
From the drop down list select one of the two options APPEND or CREATE.  This field determines where logged data is placed on the hard disk.

Selecting CREATE means that a new file will be started each time the Alarm system is enabled, or when the system is restarted after a power failure.

APPEND means if the system is disabled and then restarted the alarm logging will continue and data added to the end of the most recent alarm log file.   This facility is useful in the case of power failures.  Providing the system is set to Autostart when the power is restored the alarm logger will continue placing the alarm-logged data into the same data file. 

Logger Name
Enter a suitable name for the alarm-logged data.  The name can be up to 25 characters and must obey operating system path name conventions. 

The Logger Name should describe the equipment or test, as this will help you to identify the correct file when using the Alarm Listing replay utility.  The name can be changed as often as is necessary e.g. after each test.

Delete Logs
Alarm logs can be stored permanently on disk by leaving this box unchecked.  If the Delete Log check box is checked then a period of time can be specified for which you want to keep this information available.  Each time a new Alarm Log File is created or the system enabled then all Alarm files that exceed their specified period are automatically deleted.  If CYCLE mode is selected, the time specified applies to the end of the cycle.  It is recommended that this feature is used whenever possible as it will help prevent the hard disk from becoming full. To specify the length of time, select the appropriate time from the Older Than drop down list box.  Predefined times of:

	½ HR
	8 HOURS
	2 WEEKS

	HOUR
	12 HOURS
	MONTH

	2 HOURS
	DAY
	2 MONTHS

	4 HOURS
	WEEK
	3 MONTHS



are available.  If a suitable time period is not shown select the TIME option, additional boxes will appear asking for a specified time period in the form of:
	
			MM/DD    HH:MM

Enter the time period in the month, day, hours and minutes fields as required.

*Note: Logs cannot be deleted from Excel Worksheets.

Cycle Mode
If this option is not enabled ( the CYCLE MODE check box left unchecked ) and the Alarm Logging System is enabled and if START MODE is set to APPEND one continuous Alarm Log file will be created.  Each time the system is enabled then more alarm data will be added to the file. The resulting log file could become very large and therefore more difficult and slower to retrieve information from.  If the START MODE is set to CREATE then separate files will be created every time the system is enabled and closed when the system is disabled.  This again could result in large unmanageable alarm data files being created.

By using the CYCLE MODE option individual Alarm logged files would cover specific periods of time.  It will be easier when replaying the data to locate particular occurrences, or to examine a file for a certain period of time.  The Alarm Logger can be set to log for specific periods that match the operation cycle of the plant being monitored.

An Alarm Logger could, for example, be set to start logging alarm data at 07:00 every Monday morning and continue until 18:00 on Friday, not logging at the Weekend when the plant may be idle.  Alternatively the CYCLE MODE can be configured to record alarm data on 8-hour cycles to match production shift patterns.

After checking the CYCLE MODE check box the following fields are accessible:

Align Time
	YY / MM / DD		HH : MM
** / ** / **		** : **

If no change is made to the text box, and asterisks ( * ) are left in all the fields, then the align time will be when the system is enabled.
If a time is entered, but no date specified then a cycle will commence the next time the prescribed time is reached after the system has been enabled.  However, Alarm Data will still be logged between enabling the system and the align time being reached. 
Entering a date sometime in the future will have the same effect as that described for time.  
An align time of a date in the past is also acceptable. Again this will allow Alarm Logging to start when the system is next enabled, log to the end on the cycle period and then start at the beginning of a complete cycle. 
 
Cycle Every
From the drop down list select the period of the start time of a cycle with respect to the Align Time.  The predefined times are:

	½ HR
	8 HOURS
	2 WEEKS

	HOUR
	12 HOURS
	MONTH

	2 HOURS
	DAY
	2 MONTHS

	4 HOURS
	WEEK
	3 MONTHS



If a suitable time period is not shown select the TIME option, additional boxes will appear asking for a specified time period in the form of:

				MM/DD    HH:MM

Enter the time period in the months, days, hours and minutes fields as required.
Log For
From the drop down list select the length of time you want to log for on each cycle.  The options are the same as for the Cycle Every time.
Cycle Mode Configuration Examples
The following examples assume that the current date and time is 11-00, Tuesday 7th June 1994.

Daily Logs:	To log alarms from 06-00 to 18-00 every day a possible configuration would be:	
	START MODE:		APPEND
	ALIGN TIME: 		**/**/**	06:00
	CYCLE EVERY:	DAY	
	LOG FOR:		12 HOURS

The disadvantage of this configuration is if the system is enabled at e.g., 10:00hrs then the Alarm Logger would not start until 06-00 hr the next day, each time the system is re-enabled the Alarm logger will wait to the start of a complete cycle.

A more suitable configuration would be:

	START MODE:	APPEND
	ALIGN TIME:	94/6/6	06:00	
	CYCLE EVERY:	DAY	
	LOG FOR:		12 HOURS

With an align date and time specified, that has passed, whenever the system is enabled the Alarm logger will commence recording alarm information immediately. It will add the logged information onto the end of the alarm log file that may have already been started during the current cycle.  If an Alarm log file had not yet been started for that cycle one will be created immediately.

Weekly Logs:	To log alarms from 06-00  Monday to 22-00 on Friday every week the configuration 	would be:
	START MODE:		APPEND
	ALIGN TIME:		94/6/6	06-00
	CYCLE EVERY:	WEEK
	LOG FOR;		TIME:  00/05  00/00 
[bookmark: _Toc408991004]
Alarm Annunciation
In addition to reporting alarms to common alarm output, printers and loggers, it it possible to annunciate alarm activity to alarm annunciation destinations such as pagers, email and SMS. The user may configure any number of annunciators in the system. Each configuration must be provided with a unique name.
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When the user clicks on the “Add…” button the following screen will be displayed.

[image: ]


Enabled			
This field enables this configuration. This checkbox needs to be enabled in order for alarm notifications to be sent.

Annunciation Name		
This field allows the user to provide a unique identifier for this configuration.

Annunciation Type		
This field allows the user to select type of annunciator. This field cannot be modified after pressing “Select…” or “Options…” buttons.

Annunciation Destination	
This field shows the destination string (if applicable). The field cannot be modified directly. If a users wishes to modify destination then they must click the “Select…” button, which will display a dialog box that will allow all specific parameters to be modified.

Source
The source fields specifies which channels will drive the alarm annunciation. Two sources are provided “Channel Range” and “Priority”.
If “Channel Range” is selected from the drop down list then clicking the range button will display a dialog box that will allow the user to select an appropriate channel range. Channel ranges can only be a contiguous channel block. If the user wishes annunciations to be sent by multiple blocks then multiple annunciatiors must be configured.
If “Priority” is selected from the drop down list then clicking the range button will display a dialog box that will allow the user to select an appropriate priority range.

[image: ]

Alarm Annunciation
The first alarm in an alarm group will be annunciated if box is checked. However, a user may not always necessarily wish to annunciate subsequent alarms. Therefore the configuration utility will give the user the ability to allow this option. If the user wishes to annunciate subsequent alarms then they should simply check the “Annunciate each alarm” box.
The user may also repeat alarms by checking the “Repeat Alarm” check box and specifying the repeat interval in seconds in “Repeat Rate” edit box. Only alarms that are still in alarm state will be repeated.
The facility to annunciate when warnings are cleared is provided by checking “Annunciate alarm clear” or “Annunciate alarm ack” boxes. If the user wishes to annunciate subsequent clears or acknowledges then they should simply check the “Annunciate each clear” or “Annunciate each ack” boxes.
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Warning Annunciation
The first warning in an group will be annunciated if box is checked. However, a user may not always necessarily wish to annunciate subsequent warnings. Therefore the configuration utility will give the user the ability to allow this option. If the user wishes to annunciate subsequent warnings then they should simply check the “Annunciate each warnings” box.
The user may also repeat alarms by checking the “Repeat Warning” check box and specifying the repeat interval in seconds in “Repeat Rate” edit box. Only warnings that are still in active state will be repeated.
The facility to annunciate when warnings are cleared is provided by checking the “Annunciate warning clear” box. If the user wishes to annunciate subsequent clears then they should simply check the “Annunciate each clear” box.
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Mask Annunciation
System gives possibilities to annunciate masking or unmasking of alarms. To enable it user should check “Annunciate alarm mask” or “Annunciate alarm mask” boxes.

[image: ]

Watchdog Annunciation
Last annunciation feature is watchdog annunciation – if user wishes to be aware that system is working correctly, they can check “Annunciate watchdog” box and specify the repeat interval and optionally align time. Detailed description on repeat interval and align time settings is explained in Alarm Logging section.

Pager Destination Settings
The following settings may be specified for each pager configured in the system.

[image: ][image: ]

Pager Type
The user may choose to send pages to either an alphanumeric pager or to a simpler numeric pager. If “Numeric” is chosen then the “PIN” field will not appear as it is not required for numeric pagers. Instead two fields “Send delay” and “Timeout” appear.

Com Port
This field specifies the modem port to be used for sending information to the pager.

Pager Number
This field allows the user to specify the number of the pager to which the text message will be sent. Some systems, as in the one above, may require special characters in order to open a phone. If these are required then they should appear before the actual pager number.

PIN
If an AlphaNumeric pager has been selected then the user must specify an appropriate PIN. This will be used by the paging service provider when initial contact is made.

Send Delay
This field allows specify delay value in seconds between sending command and start of calling sequence.

Timeout
This field allows specify timeout value in seconds between pager centre answer and message input (It is the responsibility of the user to ensure that they verify with their own service provider that the access telephone number and settings required for each network).

Test configuration
The user can test current configuration pressing this buttonHID_TEST_MESSAGE.


SMS Destination Settings
The following settings may be specified for each SMS configured in the system.
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Com Port
This field specifies the Comport to be used for sending information to the mobile phone.

Phone Number
This field allows the user to specify the number of the mobile phone to which the text message will be sent. Number should be written in international form, eg, 353 (86) 8375786 = [country code] [(area code)] [number]

SMSC Number
This field allows the user to specify the number of the SMS processing centre phone to communicate to. Number should be written in callong form, eg, 9,869991111 = outside line area code number. 

Password
This field allows the user to specify optional password for SMS processing centre.
Test configuration
The user can test current configuration pressing this buttonHID_TEST_MESSAGE.


This is a list of known SMSC Numbers. NOT all networks have been tested. Some SMSCs (notably the Austrian ones) require additional numbers to be added to make a complete access phone number (often the user's pager number). It is the responsibility of the user to ensure that they verify with their own service provider that the access telephone number and settings required for each network SMSC that they want to use are correct. Additionally, some networks require a password to be entered that is dependant upon a subscription to the service before the service can be accessed

	Provider
	Number
	Modem Port Settings
	Notes

	A1 Austria
	43 669 14
	7,e,1
	

	AirPage Austria
	43 688 3232111
	7,e,1
	

	AirTouch USA
	1 800 3260038
	7,e,1
	

	Ameritech USA 
	1 312 5149243
	7,e,1
	

	ATT Wireless PCS USA
	1 888 7583036
	7,e,1
	

	Bellsouth
	1 800 8682835
	7,e,1
	

	BT Cellnet UK
	44 860 980480
	8,n,1
	

	BT EasyReach UK
	44 0901 1130000
	7,e,1
	

	BT Pager UK
	44 0345 581354
	7,e,1
	

	Callme Austria
	43 669 11
	7,e,1
	

	Callme Pro Austria
	43 666 + pager number
	7,e,1
	

	Cellone USA
	1 888 8787727
	7,e,1
	

	D1 Alpha Germany
	49 171 2092522
	8,n,1
	

	D1 Alpha ISDN Germany
	49 171 2521001
	8,n,1
	

	E-Plus Germany
	49 177 1167
	2400,7,e,1 
	No requests above 2400 baud

	Esat Digifone Ireland
	353 86 8525352
	8,n,1
	

	Hutchison Paging UK
	44 0941 100400
	7,e,1
	

	Libertel Netherlands
	31 654 545000
	7,e,1
	

	Lnk Australia
	61 738 326002
	8,n,1
	

	MetroCall USA
	1 800 9171168
	7,e,1
	

	MobileComm USA
	1 800 9464644
	7,e,1
	

	MobileComm USA password = M
	1 800 6556555
	7,e,1
	

	Mobile Media USA
	1 800 6225742
	7,e,1
	

	Netcom Norway
	47 920 00890
	7,e,1
	

	NexTel USA
	1 801 3016683
	7,e,1
	

	NexTel USA
	1 312 9076683
	7,e,1
	

	One2One Mobiles UK
	44 07958 879889
	7,e,1
	

	One2One UK
	44 07956 201072
	8,n,1
	

	Orange UK
	44 07973 100602
	8,n,1
	

	Orange Fleet UK
	44 07973 100601
	8,n,1 
	This is a subscription service requiring a password to access.

	Page New England USA
	1 800 6488233
	7,e,1
	

	PageMart USA
	1 800 8649499
	7,e,1
	

	PageNet USA
	1 800 7208398
	7,e,1
	

	PageOne Canada
	1 416 715 9999
	7,e,1
	

	PageOne Canada
	1 416 791 2499
	7,e,1
	

	PageOne UK
	44 0640 900199
	7,e,1
	

	PageOne Direct Access UK 
	44 01523 530300
	7,e,1
	password = 001001

	PageOne Direct Call UK 
	44 0991 910910
	7,e,1
	password = 001001

	PageOne MiniCall UK 
	44 0640 900139
	7,e,1
	password = HOMCPP

	Proximus Belgium
	32 751 61621
	8,n,1
	

	SkyTel  USA
	1 601 3600504
	7,e,1
	

	SkyTel USA
	1 800 7596366
	7,e,1
	

	Sprint PCS USA
	1 888 6561727
	7,e,1
	

	Telecom Paging New Zealand
	64 26 4001283
	7,e,1
	

	Telenor Mobil PS Norway
	47 968 90050
	7,e,1 
	This service is for Telenor Mobil pagers only, not SMS messaging

	Telepage Private Switzerland
	41 74 0900003
	7,e,1
	

	Telepage Swiss Switzerland
	41 74 0900103
	7,e,1
	

	TelMI Germany
	49 166 01010101
	7,e,1
	

	Telstra Australia 
	61 180 18767
	7,e,1
	password = mnmail

	Telus Canada
	1 403 2532266
	7,e,1
	

	TIM Italy
	39 335 9609600
	4800,8,n,1
	

	USA Mobile USA
	1 800 5899776
	7,e,1
	

	VIAG Interkom Germany
	49 179 7673425
	8,n,1
	

	Vodafone Mobiles (TAP) UK
	44 07785 499993
	8,n,1
	

	VodaZap UK
	44 07666 699699
	8,n,1
	

	VoiceStream USA
	1 800 9378941
	8,n,1
	



E-Mail Destination Settings
Upon choosing the select button for the first time, the logged in user will be prompted to provide the necessary account details in order to use the default mail client.

                                                [image: ]

User Name:
This optional field allows the user to specify name of default mail profile (it is required by Microsoft Outlook), and is automatically defaulted to the logged on users name.
Password
This field allows the user to specify optional password for default mail profile.
Domain
	This is the users domain, which is automatically defaulted to the logged on users domain



 The following settings may be specified for each E-Mail configured in the system.
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Email Addresses
This field specifies the name or e-mail from default system mailer address book to be used for sending information.
Email Addresses
Will resolve addresses entered for users default mail client. 
Note: this is not necessary for users to perform, as it will be done automatically.
Mailing Method:
Selecting MAPI or SMTP, will allow you to configure alarm mail settings for these type of mail clients 

Configure MAPI:
                                        [image: ]

This defaults all fields to the currently logged on users details.
You can set the configuration to use another users account, but only if they have previously logged onto the local computer.


Configure SMTP:

                         [image: ]

Name:
The desired screen alias of the sender
Email:
Account name of the sender

Server:
The address of the senders mail host

Timeout:
Defaulted to 30 seconds, this is the time the annunciator system will wait for the host to respond. Some hosts may require 60 seconds or more.

Server Authorisation:
	User can provide login ID and password for mail account if required by server.

Test configuration

The user can verify current configuration using the following dialog box. 

                           [image: ]
Message


When the user clicks on the “Options…” button a dialog will be displayed that allows the user configure a message to be sent to the pager. The user can use any alpha numeric characters except in the case where a numeric pager is being used. In this case only numeric characters should be used. To make life easier for the user a number of mnemonics are provided which can be used to construct a message. At runtime these mnemonics will be replaced with the appropriate values. The mnemonics are as follows:

	%I or %i	-	Channel id
%N or %n	-	Channel number
%X or %x	-	Channel prefix
%P or %p	-	Channel priority
%T or %t	-	Channel tag
%D or %d	-	Channel description
%C or %c	-	Alarm condition
%A or %a	-	Alarm date
%E or %e	-	Alarm time
%M or %m	-	Alarm message
%V or %v	-	Channel value

Test Message
[image: ]

Entering text and pressing “Send” button user can test current annunciator configuration to check for errors.
Program provides feedback, which helps to localize configuration or communication errors.

Do not interrupt test process, because it will cause resources locking!

[image: ] [image: ]

[image: ] 



When test completes, full text feedback is available in edit box.

[image: ]

The most common error messages:
“Waiting for semaphore resource nnnnn”
If test process is stopped at this message for 10 or more seconds, it means that resource nnnnn is locked by another process or previous interrupted attempt. Possible way to solve this error is to restart program.

“Could not get the attention of the modem”
Program can’t receive response from modem – check cable or power.

“Could not initialise the communications resource nnnnn”
Program can’t open resource nnnnn – check hardware or another program uses this resource.

“Could not connect to the SMSC”
Check SMS Centre number.

“Could not connect to the operator”
Check SMS Centre number.

“Could not login to the messaging center”
Check SMS Centre number or password.

 “Login failed”
Check password.

“Could not send packet to the messaging center”
Operator doesn’t support TAP protocol.

“MAPI Sendmail retcode nnn”, where nnn is

	Return Code
	Error Message

	0
	The call succeeded and the message was sent.

	1
	The user canceled one of the dialog boxes. No message was sent.

	2
	One or more unspecified errors occurred. No message was sent.

	3
	There was no default logon, and the user failed to log on successfully when the logon dialog box was displayed. No message was sent.

	5
	There was insufficient memory to proceed. No message was sent.

	10
	There were too many recipients. No message was sent.

	14
	A recipient did not appear in the address list. No message was sent.

	25
	One or more recipients were invalid or did not resolve to any address.








[bookmark: _Toc457899024][bookmark: _Toc408991005][bookmark: _Toc431115943]
System Error Processor Configuration
[bookmark: _Toc457899025][bookmark: _Toc408991006]Introduction
The System Error Processor Allows the User to Enable a Set of Channels, which will report any Errors that occour in the system and, if necessary, will generate alarms, or drive a common alarm.
[bookmark: _Toc431115944][bookmark: _Toc457899026][bookmark: _Toc408991007]Running System Error Processor
This section gives details of how to run the System error Processor
[bookmark: _Toc431115945][bookmark: _Toc457899027]From The Start Menu
Select the System Error Processor from the system sub-menu on the start menu, by moving the mouse pointer over the icon and clicking.
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[bookmark: _Toc431115946][bookmark: _Toc457899028]From the Main Menu
In the System Main Menu, first Select Processors, then select System Error Channels.

[bookmark: _Toc431115947][bookmark: _Toc457899029][bookmark: _Toc408991008]
System Error Processor Configuration
Once the System Error Processor has been successfully launched you will be faced with the following dialog.
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An Explanation of the configurable fields are as follows.

[bookmark: _Toc431115948][bookmark: _Toc457899030]AutoEnable System Error Channels
This Check Box must be set on (checked) to activate the System Error Channels. If the channels were previously disabled, the configuration must be saved and the system must be disabled then re-enabled in order for the Error Channels to be activated.

[bookmark: _Toc431115949][bookmark: _Toc457899031]Generate Alarm on Error
This Causes the System Error Channels to go into an Alarm State whenever an error occours. Enable this check box if you wish alarms to be generated on System Errors.

[bookmark: _Toc431115950][bookmark: _Toc457899032]Drive Common Alarm 
A common alarm is a single digital output which, will switch on when any channel with the Drive Common Alarm enabled goes into an alarm state. Check this box if a link to the Common Alarm is required. Check this box if a link to the Common Alarm is required.
[bookmark: _Toc431115951][bookmark: _Toc457899033]Alarm Priority 
Enter or edit the number in the text box to allocate the priority of the System Error Channels alarm. The Higher the Number the Higher the priority of the alarm.
[bookmark: _Toc431115952][bookmark: _Toc457899034]Alarm Delay
Enter the time, in seconds, between the channel value entering the Alarm State and the system flagging an alarm, this can be useful if you wish to avoid alarms on channels, which are constantly going in and out of alarm every few seconds.

 
[bookmark: _Toc431115953][bookmark: _Toc457899035][bookmark: _Toc408991009]Saving Configuration
There are three ways to save the configuration, once changes have been made these are :

[bookmark: _Toc431115954][bookmark: _Toc457899036]Saving on Exit
Simply Exit the Configuration Dialog, and you will be prompted to save changes. Select Yes from the Pop up dialog, to discard changes simply click no.

[bookmark: _Toc431115955][bookmark: _Toc457899037]Saving from File Menu
Select file from the dialog menu, then select save. Your configuration will be saved.

[bookmark: _Toc431115956][bookmark: _Toc457899038]Saving Using Toolbar
Simply Click on the diskette and your Configuration will be saved.

[bookmark: _Toc431115957][bookmark: _Toc457899039][bookmark: _Toc408991010]Printing Configuration.
There are two ways to print the configuration, From the file menu and from the toolbar , by selecting print from either of these a print dialog box will be displayed here you can select a printer, and specify various print options.

[bookmark: _Toc431115958][bookmark: _Toc457899040][bookmark: _Toc408991011]Getting Online Help
Part Three		Configuring Channels

Part Four		Configuring Processors

Press the F1 key at any time to bring up the Processors Online Help.
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[bookmark: _Toc457383828][bookmark: _Toc457385821][bookmark: _Toc457899041][bookmark: _Toc408991012]Part Five – Monitoring

[bookmark: _Hlt457383671]Part Five details the Monitor Windows: 	Channel Monitor
[bookmark: _Hlt457383666]			Alarm Monitor
			Configurable Monitor



[bookmark: _Toc394746000][bookmark: _Toc394916857][bookmark: _Toc395410330][bookmark: _Toc457383829][bookmark: _Toc457385822][bookmark: _Toc457899042][bookmark: _Toc408991013]                     
Channel Monitor Overview
[bookmark: _Toc457383830][bookmark: _Toc457385823][bookmark: _Toc457899043]Terminology:
Channel Monitor Main Window:			The Channel Monitor Main Window, manages a workspace 						of child Channel Monitor Windows.

Channel Monitor Window:			 Displays all channels for a Data Source on a given Server.
						 Is associated with a Channel Monitor Document (i.e. A         
						 Channel Monitor Window is actually a Document File.

Channel Monitor Document:		 	Stores configuration information about the monitor i.e. how 						and what it displays.

[bookmark: _Toc457383831][bookmark: _Toc457385824][bookmark: _Toc457899044]Introduction:

The Channel Monitor facility in ScadaPro provides real time monitoring of channels and status information.

The Channel Monitor Application consists of a number of Windows, each displaying an ScadaPro data source.

The channel information shown includes the ScadaPro Channel numbers, the tag and description. For digital channels the label describing the current status of the channel is displayed. For analogue channels the current floating point value followed by the units as configured in the configuration window for the channel type.
  
Processor and Device output channels can have their values changed from within the Channel Monitor Window. Alarms are also acknowledged from the Channel Monitor Windows.

The Channel Monitor Application has a client/server architecture, which allows it to monitor channels from remote ScadaPro servers.

To launch the Channel Monitor Application either double click the Channel Monitor icon within the ScadaPro program group or select Channel Monitor from the Monitor menu in the ScadaPro program window.


[image: ]



The user is then presented with the options to either “Monitor Selection” (run an existing monitor configuration), “Monitor Last” (revert to the last saved workspace) or “Configure” (generate a new configuration or modify an existing configuration).
[bookmark: _Toc394746039][bookmark: _Toc394916896][bookmark: _Toc395410364][bookmark: _Toc457383832][bookmark: _Toc457385825][bookmark: _Toc457899045]Monitor Selection
If the monitor option is taken the user is presented with a standard Windows file selection menu, the required configuration file should be highlighted and the OK button clicked. 
[bookmark: _Toc457383833][bookmark: _Toc457385826][bookmark: _Toc457899046]Monitor Last
If the “Monitor Last” option is taken, the persistent details from the last session of running the configurable monitor will be opened i.e. the last workspace. The persistent details are in relation to window layouts, monitors opened, toolbar layouts etc.
[bookmark: _Toc394746040][bookmark: _Toc394916897][bookmark: _Toc395410365][bookmark: _Toc457383834][bookmark: _Toc457385827][bookmark: _Toc457899047]Configure
If the ”configure” option is taken the user is presented with the Edit New Monitor Properties Property Page,  to generate a new monitor


Another option to launch the Channel Monitor Application is via the command prompt. This feature allows the user to specify the Server to connect to, and whether to display the Channel Monitor in Full Screen Mode. The command line parameters to pass are:

To indicate Server name		[ [/S <[“] ServerName [“]>] ]
To indicate file name			[ [”] FileName [”] ]
For full screen mode			[ /F ] 

Note: The brackets used in this example are not used when passing command line arguments, and the inverted commas are optional.
Examples:

[1]	This specifies a Server Name:

mon_nt.exe /S ServerName
or
mon_nt.exe /S ”ServerName”

[2]	This opens the file normally:

mon_nt.exe c:\ScadaPro\monitors\monitor1. mcm
or
mon_nt.exe”c:\ScadaPro\monitors\monitor1. mcm”


[3]	This starts the application with the New Monitor Properties Property Page, but once the user selects OK, the monitor will be in full screen mode.

mon_nt.exe /S ServerName /F	
or
mon_nt.exe /S ”ServerName” /F	


[4]	This opens the file in full screen mode:

mon_nt.exe c:\ScadaPro\monitors\monitor1. mcm /F	
or
mon_nt.exe”c:\ScadaPro\monitors\monitor1. mcm” /F
[bookmark: _Toc457383835][bookmark: _Toc457385828][bookmark: _Toc457899048][bookmark: _Toc408991014]
Channel Monitor Features
[bookmark: _Toc457383836][bookmark: _Toc457385829][bookmark: _Toc457899049]The Channel Monitor Window

The information held within the Channel Monitor Window is divided into separate rows and columns. A row will give the real time information about a particular channel. The Column indicates the separate fields that relate to the channel in question (see Section “Column Identification”).

The Channel Monitor Window comprises a main application window and a number of child monitor windows.  The amount of Channel Monitor Windows that may be open in the Channel Monitor Main Window depends on the amount of available memory of your system.

[image: ]


The Main Application Title Bar will display the title of the active window.  The Channel Monitor Window that is active will have its Title Bar displayed in a highlighted colour.  To make another Channel Monitor Window active point to it and click the mouse button the Title bars will change colour.  The Main Application title bar will show the name of the active window.

Windows can be reduced to an icon by pointing and clicking the mouse on the Minimise button.  Any Window can be maximised to fill the application window by pointing and clicking the Maximise button.

Often Windows get laid on top of each other obscuring other windows. To locate and bring another Window to the front select Window from the menu bar and select the Window required from the drop down list.  Alternatively Windows can be Tiled or Cascaded from the same menu option.

Windows can be closed by clicking on the X button of the title bar. Often all the contents of a Window cannot be displayed at once.  Scroll Bars are provided to facilitate moving the contents of the Window to display the information required. You can alternatively resize the columns by pointing the mouse pointer at the rightmost corner of the column header and, by holding down the left mouse button, drag the column to the width you require.

The menu bar comprises drop down lists of options.  To select an option, point to the heading on the menu bar and then choose the correct option from the drop down list.  The menus vary dependent on the Window being used.  The menu options for the ScadaPro Monitor Windows are discussed later in this section.

In some instances an alternative to using the menus is to choose options via the buttons on the Toolbar.  Each Window will have a different set of tool buttons.  Those used as part of the ScadaPro Monitor Window are described later in this section.

[bookmark: _Toc457383837][bookmark: _Toc457385830][bookmark: _Toc457899050]Column Identification 

From the previous image of a typical Channel Monitor Window, you can denote nine columns. The values displayed by the monitor are as follows:

	Column
	Analog Channel
	Digital Channel

	1
	Channel Id
	Channel Id

	2
	Tag
	Tag

	3
	Description
	Description

	4
	Value
	Digital Status (On/Off description)

	5
	Units
	

	6
	SIG
	

	7
	Event Status (EHI/ELO)
	Event Status (EHI/ELO)

	8
	*Alarm + WHI/WLO 
	*Alarm

	9
	Ack
	Ack



*Alarm = AHI/ALO/AER + Alarm Message

The acronyms are expanded as follows

	SIG
	Significant change
	WLO
	Warning Low

	AHI
	Alarm High
	EHI
	Event High

	ALO
	Alarm Low
	ELO
	Event Low

	AER
	Alarm & Channel is in error
	Ack
	Alarm Acknowledged

	WHI
	Warning High
	
	



[bookmark: _Toc457383838][bookmark: _Toc457385831][bookmark: _Toc457899051]
Create a new Channel Monitor Window

To add a new Channel Monitor Window choose NEW MONITOR from the File drop down menu list or providing a Channel Monitor Window is the active Window press the keys CTRL+N.  Using the Toolbar click on the New Monitor Tool [image: Help0013]

The Channel Monitor Application launches by displaying the Properties Dialog box, which provides the user with the tools to select a data source and service that runs on that data source, for their monitoring purposes. The user also has the option to alter other properties such as the number of visible columns, and the colour of the Channel Monitor Window and text within the window.


The Monitor Properties Dialog box will appear. 

[image: ]        [image: ]



It can be noted from the above image, that the Monitor Properties Dialog Box is composed of three tabs: 
The Data Source Selection tab, the Column Setup tab, and the Color Setup tab. We now explain all three:

[bookmark: _Toc457383839][bookmark: _Toc457385832][bookmark: _Toc457899052]DATASOURCE SELECTION:

DataSource Selection allows the user configure the following:
Server Name:			
Via the Browse the user can select from a range of Servers that are connected to their network (See figure 1.2 above).
Alternatively, the user can manually enter the name of a server in the Edit box provided. 


 Source Name:	
Provided within the  Source Name List Box, is a list of Data Sources that are resident on the Server you have chose from the Browse Button. To select a Data Source, point to it and click the mouse button, it will be highlighted, then choose the OK button.  Alternatively double click the mouse button whilst pointing to the Data Source required.  The new Channel Monitor Window will be introduced into the Channel Monitor Main Window.

Multiple Channel Monitor Windows can be opened to monitor the same data source. For example several Channel Monitor Windows can be invoked to monitor Device Channels.  This allows different blocks of Device channels to be displayed in different windows
Channel:
The Channel Edit Box provided within the Monitor Properties Dialog Box, allows the user enter a channel number to start on i.e. Channel 100 for instance. The Channel Monitor Window will open with the inputted Channel Identifier being highlighted and in view.

Users can enter a user defined channel by selecting the first Data Source (“USER DEFINED”) from the list and then can enter there own channel prefix.

If the Server or the Data Source being connected too is not recognized, or the selected server is down, then the “USER DEFINED” option provides a way to create a Channel Monitor Window for the Server and Data Source. If the Channel Monitor Application can not connect to the Server or the Data source after we pick the “USER DEFINED” option, a blank Channel Monitor Window will open. The user may save this Channel Monitor Window, and wait until the Channel Monitor Application can initiate a valid connection to the Server \ Data Source.

[bookmark: _Toc457383840][bookmark: _Toc457385833][bookmark: _Toc457899053]
COLUMNS SETUP:

[image: ]


The Column Setup part of the Monitor Properties Dialog Box allows the user select or de-select the number of visible columns per channel monitoring window. Click on each columns check box if you want that Column to displayed, and vice versa if you don’t want the column displayed.

The Channel Monitor Application will allow you to change your preferences, later if you require to do so.

Note also the Default button located within dialog. Pressing it indicates to the system that the user required all columns to be visible.


[bookmark: _Toc457383841][bookmark: _Toc457385834][bookmark: _Toc457899054]
COLOR SETUP:

The user can select which background and foreground colors to use with each individual Channel monitor window. The default colors the system operates on whatever system colors you have on your operating system.  The colors uses can be changed via clicking on the Color Combo boxes provided, which in turn provides you with a separate small color picking dialog box, providing the user with 40 alternate colors to choose from.  To pick one of these colors, the user clicks on the color and is returned immediately to the Color Setup Dialog Box.

[image: ]

Alternatively if the user is not satisfied with the colors provided by the small color picking dialog box, clicking on Custom will provide another more advanced color picking dialog box:

[image: ]

From this advanced Color Picking dialog box, the user can:
1)	Choose from 48 different colors
2)	Via the color palette provided on the left of the dialog, the user can by positioning the mouse pointer over the palette 	and holding the left mouse button down select a new color.
 
Clicking on the OK button returns you to the Color Setup Dialog Box 
[bookmark: _Toc457383842][bookmark: _Toc457385835][bookmark: _Toc457899055]
Organizing Windows

Within the Channel Monitor Main Window, Channel Monitor Windows can be organized to suit the users requirements.

[image: ]

Initially when a new Channel Monitor Window is created it will lay over the top of any other window within the Channel Monitor Main Window. Channel Monitor Windows can be brought to the front by either pointing to any exposed part of the required window or clicking or by choosing Window from the menu bar and then selecting the appropriate channel group window.


From the Window menu option windows can be arranged in a Cascade or Tile layout.

By creating a new window and then minimizing it, the Channel Monitor Main Window can comprise of one or more icons representing each channel monitor window.   Choosing the Arrange Icon option from the Window menu will organize any icons uniformly in the window.

All Channel Monitor Windows displayed are visibly updated, not just the active window

[bookmark: _Toc457383843][bookmark: _Toc457385836][bookmark: _Toc457899056]
Opening \ Saving  \ Closing Channel Monitor Windows 
[image: ]

[bookmark: _Toc457383844][bookmark: _Toc457385837][bookmark: _Toc457899057]Opening Channel Monitor Documents

To open a saved Channel Monitor Document within the Channel Monitor Main Window, choose Open Monitor from the File menu, or click the mouse on the Open Monitor icon on the toolbar. 

Immediately after this you are presented with the Standard Windows File Open Dialog Box, in which you can open a previously saved Channel Monitor Document by:
1)	Double clicking on the Saved Monitor’s Name (with the left mouse button)
2)	Click on the Saved Monitor’s Name and then click the OK button. (with the mouse button)
[bookmark: _Toc457383845][bookmark: _Toc457385838][bookmark: _Toc457899058][image: ]
Saving Channel Monitor Documents
  
To save a Channel Monitor Document within the Channel Monitor Main Window, first ensure the Window to be saved is the active window. Choose Save Monitor from the File menu, or click the mouse on the Save Monitor icon within the toolbar.

Immediately after this you are presented with the Standard Windows File Close Dialog Box, in which you can save the Channel Monitor Document by following the steps outlined.

1)	Enter a name for your monitor file in the File Name Edit box of the Dialog Box. Or alternatively you may use the name that it prompts you to use.
2)	Double clicking on a previously Saved Monitor’s Name (with the left mouse button), indicates to the 	application that you want to overwrite a saved monitors file.

[image: ]
[bookmark: _Toc457383846][bookmark: _Toc457385839][bookmark: _Toc457899059]Closing Channel Monitor Windows

To close a Channel Monitor Window within the Channel Monitor Main Window first ensure the Window to be closed is the active Window.  Choose Close from the File menu or click the mouse on the X button on the title bar of the window to be closed. You will then be prompted with a Save Dialog Box querying you on whether to save the active Channel Monitor Document or close it without saving changes (see Section Saving Channel Monitor Windows).

NB:	

The Channel Monitor Application works on the basis of Workspaces. The Workspace remembers each Channel Monitor Windows position, size and configurable details (number of visible columns, color settings etc.).  

To add a Channel Monitor to the workspace, you must save each new Channel Monitor Window to a Channel Monitor Document, via the Save option in the menu or toolbar (See Section Saving Channel Monitor Windows).

On Closing the Channel Monitor Application, you will be asked to save any unsaved / modified Channel Monitor Documents.

If you don’t save a new Channel Monitor Window, it will not be re-opened the next time you launch the Channel Monitor Application.
[bookmark: _Toc457383847][bookmark: _Toc457385840][bookmark: _Toc457899060]
Printing Channel Monitor Windows

Channel results can be printed on the systems printer if required.  Choose Print from the File menu or click the Print tool button.        


A print Dialog Box will appear. 

[image: ]

From this box under the grouping of Print Range select ALL if all channels are to be printed or Pages entering the start and stop page numbers if only a block of channels are to be printed.

It is normally acceptable to select the lower print quality of 75 dpi. Assuming the printer is properly configured selecting the OK button will result in a hard copy of the selected Monitor pages being produced.  


[bookmark: _Toc457383848][bookmark: _Toc457385841][bookmark: _Toc457899061]Exiting the Channel Monitor Application

To close the Channel Monitor Application either click the X button on the Application Window title bar or choose Exit from the File menu.  If there are any non-saved Channel Monitor Windows in your workspace, or if you have made any alterations to a Channel Monitor Window, you will be issued with save requests for them.

The layout of the Channel Monitor Main Windows will be maintained and when launched again will revert to the last configuration.

[bookmark: _Toc457383849][bookmark: _Toc457385842][bookmark: _Toc457899062]
Toggle Gridlines

An option provided by the Channel Monitor Application is to toggle whether the Channel Monitor Window displays the data in grid form. To place the data of the Channel Monitor Window into grid form, simply select Gridlines On from the View menu. To de-select the gridlines, select Gridlines Off from the View menu.

An alternative way to do this is to select the Gridlines Toggle icon from the toolbar.    [image: ]

Clicking on the icon once toggles from Gridlines On – Off and vice-versa. 

[image: ]
[bookmark: _Toc457383850][bookmark: _Toc457385843][bookmark: _Toc457899063]Modifying Channel Values

Any ScadaPro Output Channel, digital or analogue, including User Analogue channels can have their values changed manually from within the Channel Monitor Window.  To modify the value of a channel there are 5 alternate ways to do so:

NB:	It must be noted that to modify a Channels Value, Analog or Digital, the User performing the modification must have the right security access. Security Access comes in the form of Read or Read \ Write Privileges that are assigned to the device or processor.

1)	Point to the channel and double click the left mouse button.
2)	Select the required channel and from the Options menu choose Modify
3)	Select the channel and press the CTRL and M keys together.
4)	Select the channel and press the Enter Key on the keyboard.  
5)	Click with the mouse on the Modify Channel icon within the toolbar. i.e.  [image: ]
	


Whichever method is used a dialog box will be presented.  
[bookmark: _Toc457383851][bookmark: _Toc457385844][bookmark: _Toc457899064]
Analog Channels

If the channel chosen is an analogue output the dialog box will contain a text field.

[image: ]

Edit the value in that field and choose the OK button.  The channel value will be changed to the new value on the next scan.
[bookmark: _Toc457383852][bookmark: _Toc457385845][bookmark: _Toc457899065]Digital Channels

If the selected channel is a digital output channel or a User digital channel the dialog box will contain two radio buttons.  The button of the current status will be selected initially.

[image: ]

Choose the required button and then select the OK button to confirm the change.  The digital output will be set on the next scan.
[bookmark: _Toc457383853][bookmark: _Toc457385846][bookmark: _Toc457899066]Acknowledging Channel In Alarm

When a channel goes into alarm the Alarm Message for that channel will be shown on the status line of the ScadaPro main control Window. This message will be ‘latched’ on. Even if the Alarm only lasts one scan, the message will remain until acknowledged. Even though the alarm annotation AHI or ALO for the channel entry in the monitors page clears as soon as the alarm clears.

To acknowledge an Alarm and hence remove the Alarm Message from the ScadaPro Window select the appropriate channel in the Channel Monitor Window.  There are then 3 ways to acknowledge the Channel in Alarm, they are:
1)	Press the keys CTRL and A together
2)	Choose Acknowledge Alarm from the Options menu.
3)	Click with the mouse on the Acknowledge Alarm icon within the toolbar. 

The message will disappear off the ScadaPro Window.  If the Channel is still in an Alarm state when it is acknowledged the message will still be cleared off the ScadaPro Window.  In the Channel Monitor

Window the indicator ACK will be added to the channel information.  When the channel next goes into a non-alarm state the ACK indicator will be removed.
[bookmark: _Toc457383854][bookmark: _Toc457385847][bookmark: _Toc457899067]Common Alarm

The Common Alarm, similar to the Alarm Message, is latched on when a channel with that facility enabled goes into an alarm state.  To cancel the common alarm, choose the output channel that is configured as the common alarm, choose Cancel Common Alarm from the Options menu, or click on the Cancel Common alarm icon from within the toolbar. 

[bookmark: _Toc457383855][bookmark: _Toc457385848][bookmark: _Toc457899068]Navigating Channel Monitor Windows

Using the scroll bars in the active Window will allow individual channels to be selected.  To find a particular channel first make the Window that will contain that channel the active Window by clicking on any part of it.   From the View menu choose Channel, or alternatively click on the Goto Channel icon within the toolbar.  A Dialogue box will be presented.

[image: ]

Enter the channel number (no prefix is necessary) and choose the OK button.  The selected channel will be shown highlighted.

[bookmark: _Toc457383856][bookmark: _Toc457385849][bookmark: _Toc457899069]Properties Setup

The properties dialog has already been addressed in the section “Create A New Channel Monitor Window”. It can be found via the Configuration Menu and choosing Properties. Doing this provides the user with full manipulation over the color content of the Channel Monitor Window, and also the number of visible columns the Channel Monitor Window holds.  

The option is also available to alter the Server and/or Data Source your Channel Monitor Window is providing status information on.

[bookmark: _Toc457383857][bookmark: _Toc457385850][bookmark: _Toc457899070][bookmark: _Toc408991015]
Communications Setup
The network can be edited for the Channel Monitor software. Two attributes of the client can be configured. These are:
1)	Recovery Rate:	This specifies how long the client will wait for the server to recover
2)	Update Rate    :	This specifies the rate at which the client will request data from the server. This can be 	done on a Server or Source basis.


	Update Rate Option
	Description

	All Sources
	Update Rate set for ALL sources on one particular server

	Individual Sources
	Update Rate set for a particular source on a particular server


[bookmark: _Toc457383858][bookmark: _Toc457385851][bookmark: _Toc457899071]To Configure ScadaPro Communication Settings
1.	Choose the Communication Settings item from the Monitor menu.
2.	The following dialog will then appear:

[image: ]

3.	The network can then be configured as desired. By clicking on the desired button i.e. the All Sources or the Individual Sources, the communication setting for the source will appear in the Mins, Secs and Ms box’s provided.

[bookmark: _Toc457383859][bookmark: _Toc457385852][bookmark: _Toc457899072]
Setting Communications Rates

The recovery rate specifies how long the client will wait for the server to recover (i.e. the server has gone down). The update rate specifies how often Channel Monitor Application will retrieve values form the server.

[image: ]
[bookmark: _Toc457383860][bookmark: _Toc457385853][bookmark: _Toc457899073]Setting the Update Rate for Server

At the Edit Communications Links Dialog select the All Sources button.  Now select the server that you want to set the update rate for, by clicking on the drop down combo box that resides beside the servers in use caption. 

Once you have selected the server you require, the following data should be present:

1)	In the List box provided, under the Sources Column the caption “ALL SOURCES ON SERVER” should 	appear.
2)	Under the prefix column, the caption “**” should appear.
3)	Under the Rates [ms] column, the rate of the server should be displayed in milliseconds. 
4)	The update rate should be displayed in minutes, seconds and milliseconds on the bottom of the dialog, 	for manipulation.

To alter the update Rate for the server in question

1)	Click on the List box where it displays the information “ALL SOURCES ON SERVER”.

2)	In the Update Rate section, enter the new Update rate values into the minutes, seconds and 	milliseconds boxes (Mins, Secs, Ms).

3) Click OK to confirm or Cancel to quit.

[image: ]



You may however want to alter another Servers update Rate after you set one. To do this you simply follow the procedure explained above, but instead of clicking on OK on the dialog, repeat the process, but this time select a different server.

[image: ]


[bookmark: _Toc457383861][bookmark: _Toc457385854][bookmark: _Toc457899074]
Setting Update Rate for Source
Source Names, Prefix’s and Rates


At the Edit Communications Settings Dialog select the Individual Sources button.  Now select the server that you want to set the update rate for, by clicking on the drop down combo box that resides beside the servers in use caption. 

[image: ]

Once you have selected the server you require, the following data should be present:

1)	In the List box provided, under the Sources Column the names of all the sources that are open in the 	current application should appear.
2)	Under the prefix column, the source’s prefixes should appear.
3)	Under the Rates [ms] column, the rate of the source should be displayed in milliseconds. 
4)	The update rate should be displayed in minutes, seconds and milliseconds on the bottom of the dialog, 	for manipulation.

To alter the update Rate for the source in question

1)	Click on the List box where it displays the name of the source you wish to change
2)	In the Update Rate section, enter the new Update rate values into the minutes, seconds and 	milliseconds boxes (Mins, Secs, Ms).

[image: ]
  
3)	You can repeat the process 1) and 2) above to select different sources, and alter their update rate.

4)	The option is also available to change to a different server, by selecting a new one from the drop 	down combo box that holds the server names. Once again you can change the update rates for all 	these sources on that server.

5)	Click OK to confirm or Cancel to quit.

NB:	Whatever state you leave the Edit Communications Settings Dialog in, directly determines the rate at 	which your update rate will be called. E.g. If you leave the Dialog with the Individual Sources 	screen in view, the application will use these values as the update rates for communication. 	Likewise if you leave with the All Sources screen in view, all the sources on that server will use that 	update rate.

[bookmark: _Toc457383862][bookmark: _Toc457385855][bookmark: _Toc457899075]Setting the Recovery Rate

At the Edit Communications Links Dialog select the Set Recovery Rates Tab button.  You are immediately brought to the Recovery Rates Screen that provides you with information on the recovery rates of each server you are connected to.
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Select the server you require and then the following data should be present:

1)	In the Set Recovery Rate Section, the server name and the update rate should be displayed in minutes, 	seconds and milliseconds on the bottom of the dialog, for manipulation.

To alter the Recovery Rate for the server in question

1)	Click on the List box where it displays the name of the server you wish to change

2)	In the Set Recovery Rate section, enter the new Recovery rate values into the minutes, seconds and 	milliseconds boxes (Mins, Secs, Ms).

3)	You can repeat the process 1) and 2) above to select different servers, and alter their recovery rate.

4)	Click OK to confirm, or Cancel to quit.

[bookmark: _Toc457383863][bookmark: _Toc457385856][bookmark: _Toc457899076][bookmark: _Toc408991016]Column Sorting 
[image: ]  [image: ]

The Channel Monitor Application allows for each Channel Monitoring Window to be sorted in Ascending or Descending Order, in the following three columns:
1)	Channel
2)	Tag
3)	Description

A Sort takes place when the user clicks on the header of the column he/she wishes to sort. Once clicked, the application will sort the column in either Ascending or Descending order (depending on the previous state it was in). To indicate to the user what state the sorted column is in, a small triangular box appears on the side of the column header, pointing upwards if Ascending and downwards if Descending.  When sorting by tag, disabled channels can be sorted to the bottom of the column due to them having a tilde (~) key in their tag.  This allows for easier sorting and viewing of enabled channels.

Once A Sort takes place, the user can save the sorted Channel Monitor Window by clicking on the Save Monitor icon in the toolbar or alternatively selecting Save Monitor from the File Menu.
[bookmark: _Toc457383864][bookmark: _Toc457385857][bookmark: _Toc457899077]Column Positioning

Mentioned previously is the fact that each channel has different attributes that appear in the nine different columns of the channel monitor window. To suit the users needs, he/she may drag a column to a different position within the window i.e. move the order of the column on the screen per channel monitor window.
 
To drag a column, simply click on the header of the column you wish to move via the left mouse button. Hold the left mouse button down over the header, and drag the column to its new location. Release the left mouse button, and the column will now be positioned in the new order.
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[bookmark: _Toc457383865][bookmark: _Toc457385858][bookmark: _Toc457899078]Alter Active Channel Monitor Font

The Fonts of each window can be modified to the user’s preference. The font selected will also be that used to print results. To change the fonts on a window first make that window active. From the Options Menu select Choose Fonts, or click on the Font tool button a dialogue box will appear. From the options select the Font, Font Style and the Size of the font.
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[bookmark: _Toc457383866][bookmark: _Toc457385859][bookmark: _Toc457899079]Full Screen Mode

An option provided by the Channel Monitor application is to toggle whether the Channel Monitor Window takes up the whole screen or part of the screen. To switch to Full Screen mode, choose Full Screen from the View Menu. To switch back to normal mode, hit the escape key.

[bookmark: _Toc457383867][bookmark: _Toc457385860][bookmark: _Toc457899080]The Context Menu

This menu is displayed when the user right clicks on an Channel Monitor Window. Its basic purpose is to provide a shortcut to the functions offered by the Channel Monitor Application.

Once you right click on the window, you can select from a number of Channel Monitor options, and manipulate the current window.
[bookmark: _Toc457383868][bookmark: _Toc457385861][bookmark: _Toc457899081]Set-up an ActiveX Document and run it across the internet.

This topic will show you how to set up an HTML page that you may use to monitor Channel Monitor files over the Internet. The discussion is based around the Microsoft Package “FrontPage 98”

On your WEB_SERVER, create the directory “MSActiveXDocuments”, as this will be the directory you will store the monitor files into. You may choose any name for the directory, but for example purposes use this one.

Step	1:

1)	Launch the Channel Monitor Application. 
2)	Create a Channel Monitor Document and connect to a source such as User Analogs.
3)	Save the document with a suitable name i.e. useralalogs.mcm, to the 	WEB_SERVER\MSActiveDocuments directory.

Step	2:

1)	Run Microsoft FrontPage 98.
2)	Cancel the “GettingStarted” Dialog that you are prompted with.
3)	From the Menu, select ToolsShow FrontPage Editor.
4)	You are now presented with the FrontPage Editor

Step	3:

You should note that you can edit the blank page in two modes “Normal” or “HTML” (see the tabs positioned on the bottom left hand side of the application. “Preview” allows you to preview the work you have done so far.

To enter in a link to the Channel Monitor Document you created in Step 1, do the following:
1)	Enter a suitable name for the Link you are about to make to the Channel Monitor File i.e. 	UserAnalog 	Channels, for example.

2)	Once you have entered a suitable name for the link, highlight the entire link (the text you have just 	entered).

[image: ]3)	While the text is highlighted, from the Toolbar, select the Create or Edit Hyperlink icon:


You are then presented with the Edit HyperLink Dialog, allowing you to enter the URL, to jump to when you click on the link i.e. 
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4)	Enter your domain address i.e.
http://www.yourcompany.com/msactivedocuments/useranalogs.mcm


        Your Internet Address     The directory and file you created
Click OK.

Step 4

1)	Save your work.
2)	When you have saved your work, select preview from the tabs on the bottom left 	hand side of 		the screen.

3)	Click on your link, and the Channel Monitor Document will open, embedded within Microsoft FrontPage 	98.


You can now repeat the process to enter in as many Links as you require.

To allow the page to be accessed from the Internet, simply enter a link to the .htm file you have just created on your webpage i.e. your company webpage.
[bookmark: _Toc457383869][bookmark: _Toc457385862][bookmark: _Toc457899082] “Opening” an ActiveX Document and run it across the LAN.

An easy way to open the a Channel Monitor ActiveX Document via your web browser is from the File menu, select Open, and the browse to the Computer that contains the .mcm file you wish to open. When you choose open, the Channel Monitor File will open embedded into your web browser. 

Not that you can open a .mcm file across the network using the Channel Monitor Application, or any other ActiveX Document Server Applications i.e. Microsoft FrontPage 98 and Microsoft Binder for example.
[bookmark: _Toc457383870][bookmark: _Toc457385863][bookmark: _Toc457899083][bookmark: _Toc408991017]
Channel Monitor Menu Commands

[bookmark: _Toc457383871][bookmark: _Toc457385864][bookmark: _Toc457899084]File menu commands

The File menu offers the following commands:

	New Monitor
	Creates a New Channel Monitor Window Document

	Close Monitor
	Closes an opened Channel Monitoring Window Document.

	Open
	Opens an existing Channel Monitoring Window document.

	Save
	Saves an opened Channel Monitoring Window document using the same file name.

	Print
	Prints a Channel Monitoring document.

	Print Preview
	Displays the Channel Monitoring document on the screen as it would appear printed.

	Print Setup
	Selects a printer and printer connection.

	Exit	

	Exits Channel Monitor Application.



[bookmark: _Toc457383872][bookmark: _Toc457385865][bookmark: _Toc457899085]View menu commands

The View menu offers the following commands:

	Toolbar
	Shows or hides the toolbar.

	Status Bar
	Shows or hides the status bar.

	Gridlines
	Offers the ability to turn the Gridlines on or off.



[bookmark: _Toc457383873][bookmark: _Toc457385866][bookmark: _Toc457899086]Options menu commands

The Options menu offers the following commands:

	Modify Value
	Modifies the Selected Channels Value

	Acknowledge Alarm
	Acknowledges a Channel In Alarm

	Cancel Common Alarm
	Cancels the Common Alarm Channel

	Goto Channel
	Navigates to a selected Channel



[bookmark: _Toc457383874][bookmark: _Toc457385867][bookmark: _Toc457899087]Configuration menu commands

The Configuration menu offers the following commands:

	Properties
	Modifies the properties of the Channel Monitor Window.

	Communications
	Modifies the Update and Recovery Rate that the Application uses to communicate with the Servers and Sources.




[bookmark: _Toc457383875][bookmark: _Toc457385868][bookmark: _Toc457899088]
Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple documents in the application window:

	Cascade
	Arranges windows in an overlapped fashion.

	Tile
	Arranges windows in non-overlapped tiles.

	Arrange Icons
	Arranges icons of closed windows.

	Window 1, 2, ...
	Goes to specified window.



[bookmark: _Toc457383876][bookmark: _Toc457385869][bookmark: _Toc457899089]Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

	Help Topics
	Offers you an index to topics on which you can get help.

	About
	Displays the version number of this application.



[bookmark: _Toc457383877][bookmark: _Toc457385870][bookmark: _Toc457899090][bookmark: _Toc408991018]
Alarm Monitor Overview
[bookmark: _Toc457383878][bookmark: _Toc457385871][bookmark: _Toc457899091]Terminology:

Alarm Monitor Main Window:
The Alarm Monitor Main Window, manages a workspace of child Alarm Monitor Windows.

Alarm Monitor Window:
An Alarm Monitor Window displays all alarms that are being derived from a given Server. It is associated with a Alarm Monitor Document (i.e. An Alarm Monitor Window is actually a Document File.)

Alarm Monitor Document:
Stores persistent information about the monitor i.e. how and what it displays.


[bookmark: _Toc457383879][bookmark: _Toc457385872][bookmark: _Toc457899092]Introduction

The Alarm Monitor application in provides real time indications of channels that are in alarm, or have previously exceeded their configured alarm limits. The Alarm Monitor can display all alarm occurrences since the system was enabled. All alarms can be acknowledged and the common alarm cancelled. The Alarm Monitor has a client/server architecture which allows it to monitor alarms from remote system servers.

Windows Sound files can be associated with Alarm Monitor Windows so that the user can be provided with audio as well as visual feedback.

The Alarm Monitor can only show alarms if the Alarm System is enabled. (See Alarm System Configuration).

To invoke the Alarm Monitor double click on the Alarm Monitor icon from within Explorer, or alternatively choose ALARM MONITOR Configure from the Monitors Menu. 
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The user is then presented with the options to either “Monitor Selection” (run an existing monitor configuration), “Monitor Last” (revert to the last saved workspace) or “Configure” (generate a new configuration or modify an existing configuration).
[bookmark: _Toc457383880][bookmark: _Toc457385873][bookmark: _Toc457899093]Monitor Selection
If the monitor option is taken the user is presented with a standard Windows file selection menu, the required configuration file should be highlighted and the OK button clicked. 
[bookmark: _Toc457383881][bookmark: _Toc457385874][bookmark: _Toc457899094]Monitor Last
If the “Monitor Last” option is taken, the persistent details from the last session of running the configurable monitor will be opened i.e. the last workspace. The persistent details are in relation to window layouts, monitors opened, toolbar layouts etc.
[bookmark: _Toc457383882][bookmark: _Toc457385875][bookmark: _Toc457899095]Configure
If the ”configure” option is taken the user is presented with the Edit New Monitor Properties Property Page,  to generate a new monitor


When the Alarm Monitor Application is launched (i.e. Monitor Last or Configure Mode)  the user is presented with a New Monitor Properties Dialog. This dialog allows the user to choose the alarm selection criteria including a range of priorities, alarm types and the server to monitor from. Which data fields to display and which colours to use can also be configured here.


Another option to launch the Alarm Monitor Application is via the command prompt. This feature allows the user to specify the Server to connect to, and whether to display the Alarm Monitor in Full Screen Mode. The command line parameters to pass are:

To indicate Server name		[ [/S <[“] ServerName [“]>] ]
To indicate file name			[ [”] FileName [”] ]
For full screen mode			[ /F ] 

Note: The brackets used in this example are not used when passing command line arguments, and the inverted commas are optional.
Examples:

[1]	This specifies a Server Name:

almon_nt.exe /S ServerName
or
almon_nt.exe /S ”ServerName”

[2]	This opens the file normally:

almon_nt.exe c:\ScadaPro\monitors\monitor1.mal
or
almon_nt.exe ”c:\ScadaPro\monitors\monitor1.mal”


[3]	This starts the application with the New Monitor Properties Property Page, but once the user selects OK, the monitor will be in full screen mode.

almon_nt.exe /S ServerName /F	
or
almon_nt.exe /S ”ServerName” /F	


[4]	This opens the file in full screen mode:

almon_nt.exe c:\ScadaPro\monitors\monitor1.mal /F	
or
almon_nt.exe ”c:\ScadaPro\monitors\monitor1.mal” /F

[bookmark: _Toc457383883][bookmark: _Toc457385876][bookmark: _Toc457899096][bookmark: _Toc408991019]
Alarm Monitor Features
[bookmark: _Toc457383884][bookmark: _Toc457385877][bookmark: _Toc457899097]The Alarm Monitor Window

The information held within the Alarm Monitor Window is divided into separate rows and columns. A row will give the real time information about a particular channel. The Column indicates the separate fields that relate to the channel in question (see Section “Column Identification”).

The Alarm Monitor Window comprises a main application window and a number of child monitor windows.  The amount of Alarm Monitor Windows that may be open in the Alarm Monitor Main Window depends on the amount of available memory of your system.
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The Main Application Title Bar will display the title of the active window.  The Alarm Monitor Window that is active will have its Title Bar displayed in a highlighted colour.  To make another Alarm Monitor Window active point to it and click the mouse button the Title bars will change colour.  The Main Application title bar will show the name of the active window.

Windows can be reduced to an icon by pointing and clicking the mouse on the Minimize button.  Any Window can be maximized to fill the application window by pointing and clicking the Maximize button.

Often Windows get laid on top of each other obscuring other windows. To locate and bring another Window to the front select Window from the menu bar and select the Window required from the drop down list.  Alternatively Windows can be Tiled or Cascaded from the same menu option.

Windows can be closed by clicking on the X button of the title bar. Often all the contents of a Window cannot be displayed at once.  Scroll Bars are provided to facilitate moving the contents of the Window to display the information required. You can alternatively resize the columns by pointing the mouse pointer at the rightmost corner of the column header and, by holding down the left mouse button, drag the column to the width you require.

The menu bar comprises drop down lists of options.  To select an option, point to the heading on the menu bar and then choose the correct option from the drop down list.  The menus vary dependent on the Window being used.  The menu options for the ScadaPro Monitor Windows are discussed later in this section.

In some instances an alternative to using the menus is to choose options via the buttons on the Toolbar.  Each Window will have a different set of tool buttons.  Those used as part of the ScadaPro Monitor Window are described later in this section.
[bookmark: _Toc457383885][bookmark: _Toc457385878][bookmark: _Toc457899098]Column Identification 

The screenshot on the previous page shows various Alarm Monitor Windows. As mentioned each window holds information about the Alarms that are present on the server that the window is associated with. The number of visible columns (display fields) that the user has per monitoring window is user defined i.e. there are a maximum of 10 columns available, but the user can select/deselect columns at will.

The columns available are: 

	Column
	Description of the Column

	Channel ID
	The channel id of the channel in alarm

	Priority
	The priority of the alarm

	Tag
	The tag assigned to the channel in alarm

	Description
	The description assigned to the channel in alarm.

	Condition
	The condition of this alarm occurrence. It will be either LO>, HI> or ERR, indicating that this occurrence crossed either the Low or High alarm limit or that the channel is in Error.

	Alarm State
	This field displays one of the following: OK, ALM, ACK, WRN or MSK, dependant on the current Alarm State of the channel in alarm.  If OK is shown, then the channel is now within the limits, but has previously been in an alarm status.  If ALM is shown, then the channel is currently in an alarm state.  If ACK is shown, then the channel is in alarm state, but has been acknowledged. If WRN is displayed the channel is in warning, and if MSK is displayed the channel is masked.

	Value
	The value OR status of the channel in alarm.

	Alarm Time / Date
	The time / date the channel crossed the alarm threshold.

	Clear Ack Time / Date
	The time / date when the channel returned to a non-alarm state, or the time or was acknowledged.

	Alarm Message
	The alarm message.



An Alarm Monitor Window will continually update new alarms as long as it is in update mode. This mode of operation is selected from the Options Menu with the commands Start Updating and Stop Updating. 


If the Alarm Monitor application is minimized or not the currently active window, and there are unacknowledged alarms present in the Alarm Monitor, then the Alarm Monitor icon in the Windows Task Bar will flash continuously until all alarms have been either acknowledged or masked. This feature is not supported when the alarm monitor document is embedded in a third party application such as Internet Explorer or Microsoft Binder.
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See the section on Alarm Annunciation and Alarm Acknowledgement later in this section for more details.
Alarm Monitor Toolbar Options
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1)	Open a new Alarm Monitor window.
	Open an existing Alarm Monitor Document. The Alarm Monitor displays the 
Open dialog box, in which you can locate and open the desired file.

3)	Save the active document or template with its current name.  If you have not named the document, the Alarm Monitor displays the Save As dialog box.

4)	Print the active Alarm Monitor window.

5)	Displays the active document, as it would appear if it were printed.
	
6)	Allows the to user alter the properties of the Active Alarm Monitor Window

7)	Starts the Active Alarm Monitor updating with Alarms

8)	Stops the Active Alarm Monitor Window from updating with Alarms

9)	Acknowledge the currently selected alarm.

10)	Acknowledges all alarms in view

11)	Cancels the common alarm

12)	Masks the selected channel

13)	UnMasks the selected channel

14)	Toggles Gridlines on/off

15)	Places the Active Alarm Monitor Window in full screen mode

16)	Select a new font for the Alarm Monitor Window.

17)	Use this command to display the copyright notice and version number of your copy of Alarm Monitor.

18)	Get help on a topic.

[bookmark: _Toc457383886][bookmark: _Toc457385879][bookmark: _Toc457899099]
Organizing Windows

Within the main Alarm Monitor window, monitor child windows can be arranged to suit the user requirements. The title given to each Alarm Monitor window is name of the server whose alarms are being displayed.

Initially when a new monitor window is created it will display over the top of any other windows in the Alarm Monitor application window. Windows can be brought to the front by either pointing to any exposed part of the required window and clicking, or by choosing Window from the menu bar and then selecting the appropriate priority group window.

The window menu commands are further described in the topic ”Window Menu Commands”.

[bookmark: _Toc457383887][bookmark: _Toc457385880][bookmark: _Toc457899100]Opening \ Saving  \ Closing Alarm Monitor Windows 
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Opening Alarm Monitor Documents
To open a saved Alarm Monitor Document within the Alarm Monitor Main Window, choose Open from the File menu, or click the mouse on the Open icon on the toolbar. 

Immediately after this you are presented with the Standard Windows File Open Dialog Box, in which you can open a previously saved Alarm Monitor Document by:

Double clicking on the Saved Monitor’s Name (with the left mouse button)
Click on the Saved Monitor’s Name and then click the OK button (with the mouse button)
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[bookmark: _Toc457383888][bookmark: _Toc457385881][bookmark: _Toc457899101]Saving Alarm Monitor Documents
  
To save an Alarm Monitor Document within the Alarm Monitor Main Window, first ensure the Window to be saved is the active window. Choose Save Monitor from the File menu, or click the mouse on the Save Monitor icon within the toolbar.

Immediately after this you are presented with the Standard Windows File Close Dialog Box, in which you can save the Alarm Monitor Document by:
1)	Enter a name for your monitor file in the File Name Edit box of the Dialog Box. Or alternatively you may use the name that it prompts you to use.
2)	Double clicking on a previously Saved Monitor’s Name (with the left mouse button), indicates to the application that you want to overwrite a saved monitors file.
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[bookmark: _Toc457383889][bookmark: _Toc457385882][bookmark: _Toc457899102]Closing Alarm Monitor Windows

To close an Alarm Monitor Window within the Alarm Monitor Main Window first ensure the Window to be closed is the active Window.  Choose Close from the File menu or click the mouse on the X button on the title bar of the window to be closed. You will then be prompted with a Save Dialog Box querying you on whether to save the active Alarm Monitor Document or close it without saving changes (see Section Saving Alarm Monitor Windows).

NB:	

The Alarm Monitor Application works on the basis of Workspaces. The Workspace remembers each Alarm Monitor Windows position, size and configurable details (number of visible columns, color settings etc.).  

To add an Alarm Monitor to the workspace, you must save each new Alarm Monitor Window to an Alarm Monitor Document, via the Save option in the menu or toolbar (See Section Saving Alarm Monitor Windows).

On Closing the Alarm Monitor Application, you will be asked to save any unsaved / modified Alarm Monitor Documents.

If you don’t save a new Alarm Monitor Window, it will not be re-opened the next time you launch the Alarm Monitor Application.
[bookmark: _Toc457383890][bookmark: _Toc457385883][bookmark: _Toc457899103]
Exiting the Alarm Monitor Application

To close the Alarm Monitor Application either click the X button on the Application Window title bar or choose Exit from the File menu.  If there are any non-saved Alarm Monitor Windows in your workspace, or if you have made any alterations to an Alarm Monitor Window, you will be issued with save requests for them.

The layout of the Alarm Monitor Main Windows will be maintained and when launched again will revert to the last configuration.

[bookmark: _Toc457383891][bookmark: _Toc457385884][bookmark: _Toc457899104][bookmark: _Toc408991020]Printing Information
[bookmark: _Toc457383892][bookmark: _Toc457385885][bookmark: _Toc457899105]Printing the Active Alarm Monitor

Alarm results can be printed on the systems printer if required.  Choose Print from the File menu or click the Print tool button.  A print Dialog Box will appear. 
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From this box under the grouping of Print Range select ALL if all channels are to be printed or Pages entering the start and stop page numbers if only a block of alarms are to be printed.

It is normally acceptable to select the lower print quality of 75 dpi. Assuming the printer is properly configured selecting the OK button will result in a hard copy of the selected Monitor pages being produced.  

Print Previewing the Active Alarm Monitor

To obtain a preview on the computer screen of the page as it will appear when it is printed choose Print Preview from the File Menu. 
Use this command to display the active document, as it would appear when printed.  When you choose this command, the main window will be replaced with a print preview window in which one or two pages will be displayed in their printed format.  The print preview toolbar offers you options to view either one or two pages at a time; move back and forth through the document; zoom in and out of pages; and initiate a print job.

Page Setup 
From the File Menu choose Page Setup to set the page orientation, margins and the size of the trend to be printed 

[bookmark: _Toc457383894][bookmark: _Toc457385887][bookmark: _Toc457899106][bookmark: _Toc408991021]Creating A New Alarm Monitor Window

To create a new Monitor Window choose NEW from the File drop down menu list or providing the Alarm Monitor Main Window is the active Window press CTRL + N. Using the toolbar, click on the New Window button. [image: Help0013]

A New Monitor Properties Dialog box will appear.  
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[bookmark: _Toc457383895][bookmark: _Toc457385888][bookmark: _Toc457899107]Selection Criteria
Alarm Type
Select which alarm types that you want to display. By default four types of alarm will be selected, the exception being masked alarms.

Sort Criteria
Select the way in which alarms will be sorted within the window by clicking on the appropriate radio button. The sort options are as follows

	Sort by priority
	Sorts alarms according to their priority field

	Sort by type
	Sorts alarms according to their type in the order of ALM OK ACK WRN MSK

	Sort by type within priority
	Sorts alarms according to their priority. Alarms of the same priority are sorted according to their type.

	Sort by priority within type
	Sorts alarms according to their type as before. Alarms of the same type are sorted according to their priority.


Priority
Alarm Monitor Windows can be configured to show alarm occurrences of every alarm, or a selection of Alarm priorities. The Alarm priority of the channel is configured in the channel configuration window. Priorities range from 0 to 255, the former being the highest priority. If a Selection of Alarm priorities is required click the mouse on the Selection option and type in the text box the range of priorities to be displayed in this new window. 
Server Name
Enter the name of the ScadaPro server that you want to monitor alarms from. Click on the Browse button to select a server.


[bookmark: _Toc457383896][bookmark: _Toc457385889][bookmark: _Toc457899108][bookmark: _Toc408991022]
Configuring the Alarm Display Options

The information displayed in each Alarm Monitor Window can be selected from the Edit Monitor Properties dialog box under the Display Fields Tab. The page looks like the following:
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[bookmark: _Toc457383897][bookmark: _Toc457385890][bookmark: _Toc457899109]Field Settings
Selecting the various check boxes will turn on and off the optional fields. A check mark indicates an option is selected. 
[bookmark: _Toc457383898][bookmark: _Toc457385891][bookmark: _Toc457899110]Display Format Options
Long Date Format
Displays dates in their long format as defined in the ‘Regional Settings’ applet in Control Panel.
Width
The total number of figures, including the decimal point, to be used to display numeric fields in the alarm monitor.
Precision
The number of decimal places to be used to display floating point numeric fields in the alarm monitor
[bookmark: _Toc457383899][bookmark: _Toc457385892][bookmark: _Toc457899111][bookmark: _Toc408991023]Configuring Colour and Sound

The Color and Sound tab allows the user to change the visual and audio options for the Alarm Monitor. 
[bookmark: _Toc457383900][bookmark: _Toc457385893][bookmark: _Toc457899112]Color
The user can select which background and foreground colors to use when drawing the different alarm types. The default for all types is black text with a white background.  
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NOTE:  Your system may not be able to display some custom colors depending on the number of colors available on your system.  To check open the Control Panel and double click on the Display icon.  Click the settings tab.  In the Color Palette you should see the number of colors installed.  If you have 256 colors or less you may have problems using certain colors.
[bookmark: _Toc457383901][bookmark: _Toc457385894][bookmark: _Toc457899113]Sound
Click the Alarm Beep check box on if you want to sound a beep when unacknowledged alarms are present. Enter the level of the alarm beep in the edit field. On Windows 9X, ensure that speakers are turned as keyboard beep plays the default sound event if a sound card is installed.  An alarm sound file (WAVE Format) can also be associated with each Alarm Monitor Window. To enable this facility, click the Alarm Sound File check box on. The Browse... button will become enabled. Click on this button to launch a File Open dialog. Select the sound file with ‘.WAV’ extension that you want. This WAVE format file will be played while unacknowledged alarms are present in the Alarm Monitor Window. Click the OK button to create a new alarm window (or update the current window’s properties).
[bookmark: _Toc457383902][bookmark: _Toc457385895][bookmark: _Toc457899114][bookmark: _Toc408991024]
Alarm Handling

Alarms are “latched on” by the system until the user acknowledges the alarm. The following sections describe how the monitor informs the user that there are unacknowledged alarms and how to acknowledge them.

Alarm Annunciation

The Alarm Monitor has the ability to warn the user both visually and audibly. As described earlier it is possible to have the active Alarm Monitor window always visible on the screen providing visual indication of alarm occurrences.

To activate the audible alarm annunciation the appropriate options must be configured for each Monitor window using the Monitors Options dialog box. The audible indicator sounds whilst any alarm is unacknowledged in the active Alarm Monitor window. The Audible indication of an alarm occurs even if the Alarm Monitor window or the Alarm Monitor Application is minimized. In addition, if the application is not in the foreground or is minimized, then the alarm monitor title bar, as well as its icon in the desktop task bar, will flash continuously until all alarms in the monitor have been masked or acknowledged. Once again this feature is not supported when the alarm monitor document is embedded in a third party application such as Internet Explorer or Microsoft Binder.

Alarm Acknowledgement

Alarms once displayed in an alarm monitor window will remain visible until the alarm occurrence is acknowledged and the channel has returned to its normal state. This allows the user to be aware of all alarm occurrences, no matter what the time duration of the occurrence, or the time it occurred. The user can acknowledge alarms on an individual, or page basis.  

When an alarm occurrence is acknowledged it will be removed from the display providing it is not still in an alarm state. If the channel is still in an alarm state when acknowledged it will be marked as acknowledged and will remain on the display until the alarm clears.

There are 3 ways to acknowledge an alarm:
1)	Via the toolbar icons
2)	Via the menu
3)	Via right mouse clicking on the Alarm Monitor Window.
To acknowledge an alarm, simply click on the alarm entry on the display via the left or right mouse button. The selected occurrence will be highlighted. If you left clicked with the mouse button, select choose either the toolbar option of alarm acknowledgement or alternatively choose the menu option. 
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Acknowledge Page has the effect of acknowledging all alarms currently visible in the foremost alarm monitor window. Alarms, which are not visible within the window, are not acknowledged by this option. To acknowledge alarms that are not visible, scroll the window until the unacknowledged alarms are visible and select Acknowledge Page again.

If you right click on the Alarm Monitor Window, a context menu will appear, supplying you with all the functions that the Options menu provides.

[image: ]
[bookmark: _Toc457383903][bookmark: _Toc457385896][bookmark: _Toc457899115]Cancel Common Alarm

The common alarm can be cancelled, even if the channel triggering the status is still in alarm. 

There are three ways to cancel a common alarm:
[image: ]1)	By clicking on the toolbar icon  
2)	By using the shortcut - Ctrl + C
3)	From the options menu select Cancel Common Alarm 


[bookmark: _Toc457383904][bookmark: _Toc457385897][bookmark: _Toc457899116]Masking Alarms

A channel can be added to the masked alarms list in order to hide all alarms on that channel. 
There are three ways to mask an alarm:
[image: ]
1)	By clicking on the toolbar icon i.e.
2)	By using the shortcut key:  Ctrl + M
3)	From the options menu select Mask Alarm 


In order to unmask alarms, you must first set the Masked Alarms display option in the Monitor Properties page, select the masked alarm(s) that appear (MSK appears beside the alarm) . One can then unmask the alarm in either of three ways.
[image: ]
1)	By clicking on the toolbar icon i.e.
2)	By using the shortcut - Ctrl + U
3)	From the options menu select Unmask Alarm 



[bookmark: _Toc457383905][bookmark: _Toc457385898][bookmark: _Toc457899117][bookmark: _Toc408991025]Miscellaneous
[bookmark: _Toc457383906][bookmark: _Toc457385899][bookmark: _Toc457899118]Start/Stop updating

An option provided by the Alarm Monitor Application is to allow the user to Stop and Start the Updating of the Alarm Monitor Windows. This is particularly useful if the user wants to acknowledge/mask etc. a certain alarm, as it allows the window to stop updating, the user can then select the channel in question, and acknowledge/mask it etc.

Toggle Gridlines

[image: ]


An option provided by the Alarm Monitor Application is to toggle whether the Alarm Monitor Window displays the data in grid form. To place the data of the Alarm Monitor Window into grid form, simply select Gridlines On from the View menu. To de-select the gridlines, select Gridlines Off from the View menu.

[image: ]Two alternative ways to do this is to select the Gridlines Toggle icon from the toolbar, 

or hit the # key on the keyboard. Clicking on the icon once toggles from Gridlines On – Off and vice-versa. 
  
[bookmark: _Toc457383907][bookmark: _Toc457385900][bookmark: _Toc457899119]Alter Active Alarm Monitor Font

The Fonts of each window can be modified to the user’s preference. The font selected will also be that used to print results. To change the fonts on a window first make that window active. From the Options Menu select Choose Fonts, or click on the Font tool button a dialogue box will appear. From the options select the Font, Font Style and the Size of the font.

[image: ]

[bookmark: _Toc457383908][bookmark: _Toc457385901][bookmark: _Toc457899120]Full Screen Mode

An option provided by the Alarm Monitor application is to toggle whether the Alarm Monitor Window takes up the whole screen or part of the screen. To switch to Full Screen mode, choose Full Screen from the View Menu. To switch back to normal mode, hit the escape key.

[bookmark: _Toc457383909][bookmark: _Toc457385902][bookmark: _Toc457899121]Column Positioning

Mentioned previously is the fact that each alarm channel has different attributes that appear in the ten different columns of the alarm monitor window. To suit the users needs, he/she may drag a column to a different position within the window i.e. move the order of the column on the screen per channel monitor window.
 
To drag a column, simply click on the header of the column you wish to move via the left mouse button. Hold the left mouse button down over the header, and drag the column to its new location. Release the left mouse button, and the column will now be positioned in the new order.

[bookmark: _Toc457383910][bookmark: _Toc457385903][bookmark: _Toc457899122]The Context Menu

Previously mentioned was that we could Acknowledge Alarms via the context Menu. This menu is displayed when the user right clicks on an Alarm Monitor Window. Its basic purpose is to provide a shortcut to the functions offered by the Options Menu.

Once you right click on the window, you can select from a number of Alarm Monitor options, and manipulate the current window.


[bookmark: _Toc457383911][bookmark: _Toc457385904][bookmark: _Toc457899123]Set-up an ActiveX Document and run it across the internet.

This topic will show you how to set up an HTML page that you may use to monitor Alarm Monitor files over the Internet. The discussion is based around the Microsoft Package “FrontPage 98”

On your WEB_SERVER, create the directory “MSActiveXDocuments”, as this will be the directory you will store the monitor files into. You may choose any name for the directory, but for example purposes use this one.

Step	1:

1)	Launch the Alarm Monitor Application. 
2)	Create an Alarm Monitor Document and connect to a server.
3)	Save the document with a suitable name i.e. machinename.mal, to the 	WEB_SERVER\MSActiveDocuments directory.

Step	2:

1)	Run Microsoft FrontPage 98.
2)	Cancel the “GettingStarted” Dialog that you are prompted with.
3)	From the Menu, select ToolsShow FrontPage Editor.
4)	You are now presented with the FrontPage Editor

Step	3:

You should note that you can edit the blank page in two modes “Normal” or “HTML” (see the tabs positioned on the bottom left hand side of the application. “Preview” allows you to preview the work you have done so far.

To enter in a link to the Alarm Monitor Document you created in Step 1, do the following:

1)	Enter a suitable name for the Link you are about to make to the Alarm Monitor File i.e. “MachineName”, 	for example.

2)	Once you have entered a suitable name for the link, highlight the entire link (the text you have 		just entered).
[image: ]
3)	While the text is highlighted, from the Toolbar, select the Create or Edit Hyperlink icon:

[image: ]You are then presented with the Edit HyperLink Dialog, allowing you to enter the URL, to jump to when you click on the link i.e. 


4)	Enter your domain address i.e.
http://www.yourcompany.com/msactivedocuments/MachineName.mal


        Your Internet Address     The directory and file you created

Click OK.

Step 4

1)	Save your work.
2)	When you have saved your work, select preview from the tabs on the bottom left 	hand side of 		the screen.

3)	Click on your link, and the Alarm Monitor Document will open, embedded within Microsoft 	FrontPage 98.


You can now repeat the process to enter in as many Links as you require.

To allow the page to be accessed from the Internet, simply enter a link to the .htm file you have just created on your webpage i.e. your company webpage.
[bookmark: _Toc457383912][bookmark: _Toc457385905][bookmark: _Toc457899124] “Opening” an ActiveX Document and run it across the LAN.

An easy way to open an Alarm Monitor ActiveX Document via your web browser is from the File menu, select Open, and then browse to the Computer that contains the .mal file you wish to open. When you choose open, the Alarm Monitor File will open embedded into your web browser. 

Not that you can open a .mal file across the network using the Alarm Monitor Application, or any other ActiveX Document Server Applications i.e. Microsoft FrontPage 98 and Microsoft Binder for example.












[bookmark: _Toc457383913][bookmark: _Toc457385906][bookmark: _Toc457899125][bookmark: _Toc408991026]
Alarm Monitor Menu Commands

[bookmark: _Toc457383914][bookmark: _Toc457385907][bookmark: _Toc457899126]File Menu Commands

The File menu offers the following commands:

	New 
	Creates a New Alarm Monitor Window Document

	Open
	Opens an existing Alarm Monitoring Window document.

	Close Monitor
	Closes an opened Alarm Monitoring Window Document.

	Save
	Saves an opened Alarm Monitoring Window document using the same file name.

	Save As
	Saves the active Alarm Monitor document with a new file name.

	Page Setup
	Changes the printed page settings

	Print
	Prints an Alarm Monitoring document.

	Print Preview
	Displays the Alarm Monitoring document on the screen, as it would appear printed.

	Print Setup
	Selects a printer and printer connection.

	Exit	

	Exits Alarm Monitor Application.




[bookmark: _Toc457383915][bookmark: _Toc457385908][bookmark: _Toc457899127]View Menu Commands

The View menu offers the following commands:

	Toolbar
	Shows or hides the toolbar.

	Status Bar
	Shows or hides the status bar.

	Always On Top
	Shows the Alarm Monitor on top of all other windows

	Gridlines
	Offers the ability to turn the Gridlines on or off.

	Full Screen
	Toggles full screen mode (Standalone Only)



[bookmark: _Toc457383916][bookmark: _Toc457385909][bookmark: _Toc457899128]Options Menu Commands

The Options menu offers the following commands:

	Properties
	Edits alarm viewing options and selection criteria.

	Select Font
	Selects a font for an Alarm Monitor Window.

	Communication Settings
	Edit communication settings for an Alarm Monitor Window.

	Acknowledge Alarm
	Acknowledges the currently selected alarm.

	Acknowledge Page
	Acknowledges all alarms that are currently fully visible in the active page.

	Cancel Common Alarm
	Cancels the common alarm if it is on.

	Mask Alarm
	Masks the alarms of faulty or temporary channels in alarm.

	UnMask Alarm
	Unmasks the Alarms that have been previously masked by the mask command.

	Start Updating
	Starts updating alarms in the Alarm Monitor Window.

	Stop Updating
	Stops updating alarms in the Alarm Monitor Window.




[bookmark: _Toc457383917][bookmark: _Toc457385910][bookmark: _Toc457899129]Window Menu Commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple documents in the application window:

	Cascade
	Arranges windows in an overlapped fashion.

	Tile Horizontally
	Arranges windows in horizontal non-overlapped tiles.

	Tile Vertically
	Arrange windows in vertical non-overlapping tiles.

	Arrange Icons
	Arranges icons of closed windows.

	Window 1, 2, ...
	Goes to specified window.




[bookmark: _Toc457383918][bookmark: _Toc457385911][bookmark: _Toc457899130]Help Menu Commands

The Help menu offers the following commands, which provide you assistance with this application: 

	Help Topics
	Offers you an index to topics on which you can get help.

	About
	Displays the version number of this application.



[bookmark: _Toc457383919][bookmark: _Toc457385912][bookmark: _Toc457899131][bookmark: _Toc360531796][bookmark: _Toc408991027]
Configurable Monitor
The Configurable Monitor is a highly flexible software tool allowing ScadaPro’s client and server users to design specific displays combining text, rectangles, ellipses, polygons, lines and channel data from a range of different sources and save these configurations for reuse.

The Configurable Monitor provides a means of graphically displaying and updating ScadaPro channel data.

Channel data displayed is user configurable.

The user can draw shapes on the monitor window. Shapes include rectangles, ellipses, lines and text.
	
Configurable Monitor is Client-Server based software and hence exhibits the benefits of such software.

The Configurable Monitor uses the Windows interface.  A channel configuration Wizard is provided. This utility allows quick and easy configuration of multiple ScadaPro channels.

[image: ]To invoke the Configurable Monitor from its icon, double click the Configurable Monitor icon in the ScadaPro Program group.


To invoke configurable monitor from the ScadaPro main menu, click the monitor option and then select configurable monitor from the drop down selection box. 

[image: ]

The user is then presented with the options to either “Monitor Selection” (run an existing monitor configuration), “Monitor Last” (revert to the last saved workspace) or “Configure” (generate a new configuration or modify an existing configuration).
[bookmark: _Toc457383920][bookmark: _Toc457385913][bookmark: _Toc457899132]Monitor Selection
If the monitor selection option is taken the user is presented with a standard Windows file selection menu, the required configuration file should be highlighted and the OK button clicked. The monitor will then be displayed in monitor (“locked - value entry”) mode preventing configurations changes.


[image: menu]

Changes to configuration can be made from within monitor mode if required by selecting the monitor option and clicking the “configure mode” and “lock monitor” fields. This operation should be reversed when configuration changes are complete.
[bookmark: _Toc457383921][bookmark: _Toc457385914][bookmark: _Toc457899133]Monitor Last
If the “Monitor Last” option is taken, the persistent details from the last session of running the configurable monitor will be opened i.e. the last workspace. The persistent details are in relation to window layouts, monitors opened, toolbar layouts etc.
[bookmark: _Toc457383922][bookmark: _Toc457385915][bookmark: _Toc457899134]Configure
If the ”configure” option is taken the user is presented with the following monitor display, to generate a new monitor, maximize the “monitor 1” window and configure as required. To edit an existing monitor configuration either use the “file open” option or click the “file open” icon and select the required monitor configuration file.

[bookmark: _Toc457383923][bookmark: _Toc457385916][bookmark: _Toc457899135]Command Line 

Another option to launch the Configurable Monitor Application is via the command prompt. This feature allows the user to specify the Server to connect to, and whether to display the Configurable Monitor in Full Screen Mode. The command line parameters to pass are:

To indicate Server name		[ [/S <[“] ServerName [“]>] ]
To indicate file name			[ [”] FileName [”] ]
For full screen mode			[ /F ] 

Note: The brackets used in this example are not used when passing command line arguments, and the inverted commas are optional.
Examples:

[1]	This specifies a Server Name:

cfmon_nt.exe /S ServerName
or
cfmon_nt.exe /S ”ServerName”

[2]	This opens the file normally:

cfmon_nt.exe "c:\ScadaPro\cmonitors\monitor1.orm"
or
cfmon_nt.exe ”c:\ScadaPro\cmonitors\monitor1.orm”




[3]	This starts the application with a new monitor document. The monitor will be in full screen mode.

cfmon_nt.exe /S ServerName /F	
or
cfmon_nt.exe /S ”ServerName” /F	


[4]	This opens the file in full screen mode:

cfmon_nt.exe c:\ScadaPro\monitors\monitor1.orm /F	
or
cfmon_nt.exe ”c:\ScadaPro\monitors\monitor1.orm” /F

[image: Help0014]		File open icon

[image: ]
[bookmark: _Toc394746041][bookmark: _Toc394916898][bookmark: _Toc395410366][bookmark: _Toc457383924][bookmark: _Toc457385917][bookmark: _Toc457899136][bookmark: _Toc360531797][bookmark: _Toc408991028]Drawing and Configuring Channels
To define a channel data area within a monitor screen take the following steps:-

1.	Choose the Channel item from the Draw menu
			  	OR

	Select the Channel drawing tool from the main toolbar 

2.	Drag the mouse onto the monitor window. Position the mouse at the desired location for the channel 	object and release the mouse.

The channel object will be displayed on screen. 

[image: ]

To configure Channels the monitor must not be locked. The user draws a channel object by selecting the channel drawing tool and dragging the mouse in the monitor window. This operation will position and size the object. Channel properties can be categorized into three sections:
Data SourceHID_DATASOURCE, Display OptionsHID_DISPLAYOPTIONS and Visual PropertiesHID_VISUALPROPERTIES.

By double clicking on the channel object (or selecting the properties command from the Edit menu) the above channel properties can be edited.
[bookmark: _Toc394746042][bookmark: _Toc394916899][bookmark: _Toc395410367][bookmark: _Toc457383925][bookmark: _Toc457385918][bookmark: _Toc457899137]
Configuring Data Source Properties
[image: ]
[bookmark: _Toc394746043][bookmark: _Toc394916900]Source Type
The Data Source Type is of Channel Type. This will be selected by default.
[bookmark: _Toc394746044][bookmark: _Toc394916901]Source Selection
Allows either the Default ScadaPro server or User Defined data source to be selected. If Default is selected the server button will be greyed out. With User Defined the Server button is active. To user define a server other than the ScadaPro default click the Server button and select the required source from the Select Server window as shown below.
[bookmark: _Toc394746045][bookmark: _Toc394916902]
Server Name
The name of the server which contains the required Channel. The server does not have to be currently attached to the monitor. If the server can not send data back to this object then the object will display “Disabled” (after the OK button has been clicked)

[image: ]
[bookmark: _Toc394746046][bookmark: _Toc394916903]ScadaPro Source Name
This list displays all configured ScadaPro sources on a particular server. The user must select the name of the required source e.g. Device Channels, User Analog Channels etc.
[bookmark: _Toc394746047][bookmark: _Toc394916904]ScadaPro Channel Name
Displays a list of channel names for the selected ScadaPro Data Source. The user can select individual channels by clicking on this list. The channel name is actually the 16-character channel description.

As the user scrolls through the list of sources and channels the source prefix and channel number will be displayed along side.

Users can enter a user defined channel by selecting the first source (“USER DEFINED”) and first channel (“USER DEFINED”) in the lists and then entering there own channel number and prefix.

If the channel being configured is not recognised or the selected server is down then edit fields will replace the combo boxes so that the user can enter a user-defined channel
Configuring Multiple Data Source Properties
You can now configure the data source properties of multiple objects selected.  To do so simply select more than one object or a group of objects and right click to bring up the popup menu and highlight Data Source Properties. 
[image: ]

Set server and channel on all objects
This allows you to set the server and channel on all selected objects.  Once a server and channels have been set they will appear the same on all objects that were selected at the time.
[image: guide12]

[bookmark: _Toc394746048][bookmark: _Toc394916905][bookmark: _Toc395410368][bookmark: _Toc457383926][bookmark: _Toc457385919][bookmark: _Toc457899138]
Set server on all objects
This option only allows you to set the server for all objects that are currently selected at the time.
[image: ]
Set server and channel on each object
This option allows you to individually set the server and channel for each object that is selected.  You can navigate through the objects using the back and next button.  When navigating, the currently selected object will have a yellow focus indicator so you know which object you are editing.
[image: ]

Configuring Visual Properties

[image: guide11]

When editing a Channel Object for the first time the dialog box is first presented with the default visual properties already in place. The operator can then make specific changes if required.

[bookmark: _Toc394746049][bookmark: _Toc394916906]Object Text
The user can set the font (including colour and style) for any of the name or status properties of this object. Internal alignment properties can also be set within this group with more specific alignment locations such as top left, center all, or bottom right.
[bookmark: _Toc394746050][bookmark: _Toc394916907]Object Value
Here the user can set the font (including colour and style) for the actual numeric value of the object.
[bookmark: _Toc394746051][bookmark: _Toc394916908]Border
The border properties fill properties and 3-D properties for the object can be set in this group. If the 3D option is on the border colour is ignored. The 3D drawing in the configurable monitor will always use the colours dark grey and white to achieve its effect. For best results the monitor background colour has been set to a default of grey.  

[bookmark: _Toc394746052][bookmark: _Toc394916909]Object Alarm Indication
The alarm indication only applies to the value part of a channel object. The alarm indicator is enabled whenever the channel has an alarm status valid whether it is high alarm or low alarm.

The indication option INVERSE changes the colour of the value display to be that of the background of the object, changes the background to what the value had been and leaves them in that state until the alarm flag is reset.

The indication option FLASHING changes the colour of the value display to be that of the background of the object, changes the background to what the value had been and continues to alternate these two at a steady rate until the alarm flag is reset.

When the operator chooses COLOUR CHANGE two further selections should be available. The operator can select the Colour that the value will be shown in while in alarm condition and also the Style. The style should be the standard list, Normal, Italic, Bold or Bold Italic

The indication option OFF has also been added so that alarm indication can be turned off. 
[bookmark: _Toc394746053][bookmark: _Toc394916910][bookmark: _Toc395410369][bookmark: _Toc457383927][bookmark: _Toc457385920][bookmark: _Toc457899139]Configuring Display Options
[image: ]


The User can select which fields are to be displayed on the monitor by clicking each check box to the On state.
[bookmark: _Toc394746054][bookmark: _Toc394916911]Width
This field represents how wide analog Channel values are to be displayed. For digital Channels it represents how many letters of the On and Off State descriptions will be displayed.
[bookmark: _Toc394746055][bookmark: _Toc394916912]Precision
This field represents the precision to be used when displaying analogue channel values.
[bookmark: _Toc394746056][bookmark: _Toc394916913]Engineering Notation Enabled
This field will default to Off and must be clicked On in order to enable the display of data in engineering notation. If this is enabled the display will switch to engineering notation automatically when a number is very large or very small. Whenever it is left off the rules that apply are; if the precision chosen by the operator is not enough to show a value it will simply be truncated to the space available (simply showing zero if that is all that can be displayed). Whenever the number is too large to fit in the chosen field the display will show OVERFLOW or O/F depending on the size of the field. 
[bookmark: _Toc457383928][bookmark: _Toc457385921][bookmark: _Toc457899140][bookmark: _Toc394746057][bookmark: _Toc394916914][bookmark: _Toc395410370]Data Conversion
[image: ]

Introduction:
This property page allows a channel condition (non-zero) to be converted to simulate a shape. It allows for Digital to Analog conversion, Analog Scaling, and Statistical Process Control (SPS).

The displayed value on the control for the channel being monitored, will depend on the parameters of the conversion.

An example of the uses for this conversion is if we wanted an Angular Gauge to go from 0 to 60 when a certain Digital Channel goes into high state. We simply select the channel to be monitored to be the Digital Channel in question, then set the data conversion to be Digital To Analog, and enter in the parameters for the conversion. (see bitmap above for example).

Digital to Analog:
Range:
Start At		:	The conversion value to start at
Stop At		:	The conversion value to stop at

Step Value		:	The step value to increment the conversion process
Rate Of Change	:	The rate of change between each conversion step

Analog Scaling
Scale			:	The slope of the analog scaling
Offset			:	The offset to add to the scaling

Statistical Process Control:
Minimum		:	Sets the value to the minimum value read
Maximum		:	Sets the value to the maximum value read
Average		:	Sets the value to the average of the values read
Standard Deviation	:	Calculates the standard deviation of the values read

Notes:	

1)	The SPC values are derived from the current values being read from the channels assigned. The SPC values are real-time values that are calculated at an interval of the channels update rate.

2)	SPC operates differently when using the Strip Chart Control. The values are derived over a “period”.
An example is if you are viewing a set of values over 60 seconds i.e. the XSpan of the control is set to 	1/24/60, the period is derived as follows XSpan\ Sources UpdateRate.  So If we are monitoring a 	source over 60 seconds, at an update rate of 1 second, the SPC values are calculated from the last 60 	values read.







[bookmark: _Toc457383929][bookmark: _Toc457385922][bookmark: _Toc457899141]
STRIP CHART-Configuring Multiple Data Source Properties
[image: ] 

[image: ]
Introduction:

The Strip Chart control allows for up to 50 channels to be monitored in one control i.e. at any one time there can be up to 50 ScadaPro Channels being monitored on the Strip Chart.

Selecting channels is exactly the same as it is for single channel controls i.e. the Angular Gauge control, but with a few differences namely:

1)	Assign To TrackID
2)	Assign Channel To Drive:
2.1)	A Variable
2.2)	A Track Band

Track ID:

Track ID is a zero-based index that relates to the tracks the strip chart can display. Basically a Strip Chart can display up to 30 tracks (0 to 29), onto which you can show your variables on. By default your Track ID will be zero i.e. the first track on the strip chart. You may alter this via the spin buttons that lie directly horizontally to the Track ID edit box.

The two ways to show a channel:
Explanation:
There are two ways to display a channel (variable) on a strip chart. 

Selecting Assign Channel To Drive  A Variable assignes the channel to a variable on the strip chart control i.e. you can actually see the channel being drawn on the chart.

Selecting Assign Channel To Drive A Track Band assignes the channel to drive a track band i.e. you can set the channel to drive a track band to indicate the minimum or maximum value that has been derived from the channel your are monitoring.  

Variable ID:

Variable ID is a zero-based index of the channels you are monitoring. Each channel has a unique Variable ID attached to it, which will be between 0 and 49 (inclusive). 

To add a channel, simply select the Variable ID you require, and enter the channel details as you would before i.e. Server, Source Name, Channel Prefix etc. You navigate through the 50 Variables (channels) via the spin buttons that are directly horizontal to the Variable ID edit box. 

By default the channel will be assigned to drive a variable, but the user may select to make it drive a track band if they wish. The user then must enter whether to drive the minimum or maximum settings of the track band via the check box controls that appear. Selecting the channel to drive a track band immediately sets the data conversion settings to either minimum or maximum (depending on the users selection).

NB:	If you select the Strip Chart’s X-axis to be driven by a numeric value i.e. not time based, the track band settings you have selected will not work. They only work when the x-axis is driven by under time-based.

Note: 

1)	The variable will not be displayed on the Strip Chart unless the number of tracks is one greater than the 	Track ID you entered i.e. If you choose to put the variable  (channel) onto Track ID 2, there must be 3	tracks on the strip chart already. You may however do this, and then later edit the properties of the 	Strip Chart via the Visual/Display Properties of the control to include the number of tracks you require.
2)	If you setup a channel to drive a track band, the strip chart will not display the track band settings until 	the user has entered track bands onto the track. 





Source Type
The Data Source Type is of Channel Type. This will be selected by default.
Source Selection
Allows either the Default ScadaPro server or User Defined data source to be selected. If Default is selected the server button will be greyed out. With User Defined the Server button is active. To user define a server other than the ScadaPro default click the Server button and select the required source from the Select Server window as shown below.
Server Name
The name of the server which contains the required Channel. The server does not have to be currently attached to the monitor. If the server can not send data back to this object then the object will display “Disabled” (after the OK button has been clicked)

[image: ]
Source Name
This list displays all configured ScadaPro sources on a particular server. The user must select the name of the required source e.g. Device Channels, User Analog Channels etc.
Channel Name
Displays a list of channel names for the selected ScadaPro Data Source. The user can select individual channels by clicking on this list. The channel name is actually the 16-character channel description.

As the user scrolls through the list of sources and channels the source prefix and channel number will be displayed along side.

Users can enter a user defined channel by selecting the first source (“USER DEFINED”) and first channel (“USER DEFINED”) in the lists and then entering there own channel number and prefix.

If the channel being configured is not recognised or the selected server is down then edit fields will replace the combo boxes so that the user can enter a user-defined channel

[bookmark: _Toc457383930][bookmark: _Toc457385923][bookmark: _Toc457899142][bookmark: _Toc360531798][bookmark: _Toc408991029]
Drawing Shapes
The drawing of objects is achieved with the use of the Draw option on the monitor main window. This section is concerned with all objects except channel objects
[bookmark: _Toc394746058][bookmark: _Toc394916915][bookmark: _Toc395410371][bookmark: _Toc457383931][bookmark: _Toc457385924][bookmark: _Toc457899143]To Draw Shapes/Objects

1.	Choose Draw on the Configure Monitor main window

2.	You will be presented with a list of drawing objects that you can use
  	Select the shape you want by clicking on it

Note:
Alternatively you can select the appropriate icon on the monitor main window toolbar:


	Drawing Object
	Associated Icon


	Text

	


	Line

	


	Rectangle

	
 

	Round Rectangle

	


	Ellipse

	


	Polygon

	


	Callout
	[image: guide3]

	Date/Time
	[image: guide5]

	Aguage
	


	Knob
	


	LED
	


	Lguage
	


	NumericLED
	


	Percent
	


	Selector
	


	Slider
	


	Toggle
	


	Button
	


	Strip Chart
	[image: guide7]





		The following icon is also displayed on the toolbar menu: 
	
		This is used when you want to select an object 


3.	Position the mouse on the point where the top left point of the object is to be and drag the mouse to the position where the bottom right point of the object is to be. Release the mouse button

In the case of the polygon drawing object, click the mouse button where the first point of the object is to be and drag the mouse to draw the polygon. To finish drawing, release the mouse button and double click. The Select tool is automatically selected.. 
Object Grouping
Objects that have been drawn can now be grouped together.  To do so simply select more than one object and either right click on a selected object and select Group or alternatively select the object and click on Group Objects in the toolbar which has the following icon: [image: guide16]

Objects in a group can also be taken out of a group as well simply by selecting an object and right clicking on it and selecting Ungroup or alternatively clicking on Ungroup objects on the toolbar which has the following icon: [image: guide17]

Anchor to Window
This allows the user to position or anchor a group of objects to an alignment of the screen.  You can set a group to the left, ceter, right, or no alignment.  This means as the window is resized the objects will be fixed to that position on the screen. 
To use Anchor to Window simply group objects together then on the Object menu select “Anchor to Window” and your desired alignment.
[image: ]
Callout Object
The callout object allows the user to draw a callout box which can be used to point to something on the screen.  To draw a callout box you can select it on the toolbar or under the Draw menu.
[image: ]

Caption
Enabling caption allows you to display text on the callout box.  You can edit the text on it as well as the font style, size and colour.
Border
You can adjust the border colour and thickness here.
Fill On
Selecting it will fill the callout box with a colour otherwise there will be no fill.

Date/Time Object
The Date/Time object allows you to display the current date and time of the system onto configurable monitor.  A new feature that can now be used within the Date/Time object is to display the current time zone.  To display the Date/Time you can select it on the toolbar or under the Draw Menu.  To display the time zone go into the Date/Time properties and check “Timezone Offset On”.

[image: ]
[image: C:\Users\gerard.canning\Documents\VM Shared Folder\date_time 3.png]

[bookmark: _Toc399642527][bookmark: _Toc457383932][bookmark: _Toc457385925][bookmark: _Toc457899144][bookmark: _Toc360531799][bookmark: _Toc408991030][bookmark: _Toc394746059][bookmark: _Toc394916916][bookmark: _Toc395410372]Drawing Plug-In Shapes

Each Shape discussed next has a library property attached to it. This discussion will explain what this tool is used for.

Library

[image: ] 
[bookmark: _Toc457383933][bookmark: _Toc457385926][bookmark: _Toc457899145]How to use configurations

This discussion is intended to help the user understand the built-in utility for saving and loading different configurations. 

As mentioned, this library enables users to load and save configurations of the different components. It allows you to design and share your own configurations for any of the Plug-in Controls. For instance, if you are creating monitors for industrial automation and you have a pressure meter that you use frequently, you now have the ability to design the configuration using the Angular Gauge Control and save the configuration. The next time you need to use this gauge, you can drop a new Angular Gauge component on your monitor and with the click of the mouse have all those properties (including bitmaps) loaded into the component! 

The Library Property Page within the controls property pages includes a tree, which lists the current configurations available for the user. The user can browse through this list and select any of the configurations to automatically load all the properties for that particular configuration with a single click of the mouse. The user then needs to click the "Load" button to force the properties into memory and the component is configured to that Library configuration. The user can also save and modify their own configurations, import someone else's configurations, or export their configurations. 
[bookmark: _Toc457383934][bookmark: _Toc457385927][bookmark: _Toc457899146]
Loading Configurations

1)	Right Click on the control, and choose Visual/Display Properties
2)	Go the Library tabbed property page
3)	Using the tree on the left-hand side, browse through the different configurations and select the one you 	are interested in by double clicking on it.
4)		Click on the ”Load” button on the right hand side of the property page.

The properties for this configuration now appear within the other property pages. You may modify these properties and even change the configuration or save the newly modified configuration as something else. 
[bookmark: _Toc457383935][bookmark: _Toc457385928][bookmark: _Toc457899147]Saving Configurations

1)		Right Click on the control, and choose Visual/Display Properties
2)		Set up all your properties to configure the control to meet your needs
3)		Go the Library tabbed property page.
4)		If you would like to create a new directory in your tree to save your configuration, right click on the directory you wish to create a new subdirectory and select "New". Type in the directory name.
5)		Click on the directory you wish to place the new configuration.
6)		Place your cursor in the text box labeled "Configuration Name" and type in the name of the configuration you wish to create
7)	Click on the Store button
[bookmark: _Toc457383936][bookmark: _Toc457385929][bookmark: _Toc457899148]
Importing Configurations
[image: ] 

[image: ]
 
See the previous bitmap images

1)		Right Click on the control, and choose Visual/Display Properties
2)		Go the Library tabbed property page
3)		Click on the ”Import” button and find the .gms file you wish to import.
4)		The tree will reflect an "Import" directory and the new configuration(s) will reside within that directory. If you wish to move them out of that directory, drag the configuration(s) to the location within the tree where you wish them to reside 
[bookmark: _Toc457383937][bookmark: _Toc457385930][bookmark: _Toc457899149]Deleting Configurations

1)		Right Click on the control, and choose Visual/Display Properties
2)		Go the Library tabbed property page
3)		Click on the configuration or the directory of configurations you wish to delete
4)		Either hit the ”delete” key or right click on the configuration and select ”Delete”



[bookmark: _Toc457383938][bookmark: _Toc457385931][bookmark: _Toc457899150][bookmark: _Toc360531800][bookmark: _Toc408991031]
Plug-in Shapes 
[bookmark: _Toc399642528][bookmark: _Toc457383939][bookmark: _Toc457385932][bookmark: _Toc457899151][bookmark: _Toc360531801][bookmark: _Toc408991032]Angular Gauges

[image: ]
[bookmark: _Toc399642529]Description
AGauge is a multi-purpose, highly customisable angular gauge custom control.  Its dynamic property pages provide a powerful tool for designing gauges with full control of scales, needles, fonts, captions, annulars, and tics.  With its data-aware and mouse input features, AGauge is an ideal display element for technical interfaces.

[bookmark: _Toc399642530][bookmark: _Toc457383940][bookmark: _Toc457385933][bookmark: _Toc457899152]
Captions
The gauge can be embellished with multiple captions to indicate the type of measurement being displayed, units used or any other informative or decorative labeling.

[image: ]
[bookmark: _Toc399642531][bookmark: _Toc457383941][bookmark: _Toc457385934][bookmark: _Toc457899153]Caption
Determines the text displayed on the control for the caption currently selected by CaptionID.  The number of captions displayed is set by the Captions property.

[bookmark: _Toc399642532][bookmark: _Toc457383942][bookmark: _Toc457385935][bookmark: _Toc457899154]CaptionColour
Determines the text color for the caption currently selected by CaptionID.

[bookmark: _Toc399642533][bookmark: _Toc457383943][bookmark: _Toc457385936][bookmark: _Toc457899155]CaptionFlag
Determines if the caption currently selected by CaptionID is drawn in the control's static or dynamic buffer.

[bookmark: _Toc399642534][bookmark: _Toc457383944][bookmark: _Toc457385937][bookmark: _Toc457899156]CaptionFontID
Determines which font is used for the caption currently selected by CaptionID.

[bookmark: _Toc399642535][bookmark: _Toc457383945][bookmark: _Toc457385938][bookmark: _Toc457899157]CaptionID
When multiple captions exist, CaptionID is used to index the caption to which the other caption properties apply.  The total number of captions is determined by the Captions property and CaptionID has valid values from 0 to Captions-1.

[bookmark: _Toc399642536][bookmark: _Toc457383946][bookmark: _Toc457385939][bookmark: _Toc457899158]Captions
Determines the number of captions displayed on the control.  This property must be set before all other caption properties.  The CaptionID property is used to select the caption to which caption properties apply.

[bookmark: _Toc399642537][bookmark: _Toc457383947][bookmark: _Toc457385940][bookmark: _Toc457899159]Caption X Caption Y

Determines the vertical and horizontal positions of the caption currently selected by the CaptionID property.  These properties are based on a unitless scale and typically have values between -1.0 and 1.0 where a value of 0.0 is located at the center of the control.

[bookmark: _Toc399642538][bookmark: _Toc457383948][bookmark: _Toc457385941][bookmark: _Toc457899160]Hubs
Hubs are decorative caps over the axis of rotation of a given needle.  Properties are used to modify the hub's style, radius, and associated scale.

[image: ]
[bookmark: _Toc399642539][bookmark: _Toc457383949][bookmark: _Toc457385942][bookmark: _Toc457899161]Color
Determines the color for the hub currently selected by HubID.
[bookmark: _Toc399642540][bookmark: _Toc457383950][bookmark: _Toc457385943][bookmark: _Toc457899162]HubID
When multiple hubs exist, HubID is used to index the hub to which the other hub properties apply.  The total number of hubs is determined by the Hubs property and HubID has valid values from 0 to Hubs-1.
[bookmark: _Toc399642541][bookmark: _Toc457383951][bookmark: _Toc457385944][bookmark: _Toc457899163]HubRadius
Determines the radius of the hub currently selected by HubID.  This property is based on a unitless scale and typically has values between 0.0 and 1.0.
[bookmark: _Toc399642542][bookmark: _Toc457383952][bookmark: _Toc457385945][bookmark: _Toc457899164]Hubs
Determines the number of hubs displayed on the control.  This property must be set before all other hub properties.  The HubID property is used to select the hub to which hub properties apply.


[bookmark: _Toc399642543][bookmark: _Toc457383953][bookmark: _Toc457385946][bookmark: _Toc457899165]Needles
Needles can be displayed in a variety of shapes and sizes.  Properties are used to modify the needle's style, length, width, color and associated scale.  Multiple needles can be placed on a single gauge.

[image: ]
[bookmark: _Toc399642544][bookmark: _Toc457383954][bookmark: _Toc457385947][bookmark: _Toc457899166]Color
Determines the color for the needle currently selected by NeedleID.
[bookmark: _Toc399642545][bookmark: _Toc457383955][bookmark: _Toc457385948][bookmark: _Toc457899167]Needle Digital
Enables or disables the digital display of the value for the needle currently selected by NeedleID.
[bookmark: _Toc399642546][bookmark: _Toc457383956][bookmark: _Toc457385949][bookmark: _Toc457899168]NeedleDigitalColor
Enables or disables the digital display of the value for the needle currently selected by NeedleID.
[bookmark: _Toc399642547][bookmark: _Toc457383957][bookmark: _Toc457385950][bookmark: _Toc457899169]NeedlesDigitalDecimals
Determines how many decimal places are displayed in the digital display (if NeedleDigital=TRUE) of the needle currently selected by NeedleID.
[bookmark: _Toc399642548][bookmark: _Toc457383958][bookmark: _Toc457385951][bookmark: _Toc457899170]NeedleDigitalFontID
Determines which font is used in the digital display for the needle currently selected by NeedleID.
[bookmark: _Toc399642549][bookmark: _Toc457383959][bookmark: _Toc457385952][bookmark: _Toc457899171]Needle Digital X Needle Digital Y
Determines the vertical and horizontal positions of the digital display for the needle currently selected by the NeedleID property.  These properties are based on a unitless scale and typically have values between -1.0 and 1.0 where a value of 0.0 is located at the center of the instrument.
[bookmark: _Toc399642550][bookmark: _Toc457383960][bookmark: _Toc457385953][bookmark: _Toc457899172]NeedleID
When multiple needles exist, NeedleID is used to index the needle to which the other needle properties apply.  The total number of needles is determined by the Needles property and NeedleID has valid values from 0 to Needles-1.
[bookmark: _Toc399642551][bookmark: _Toc457383961][bookmark: _Toc457385954][bookmark: _Toc457899173]NeedleLength NeedleWidth
Determines the length and width of the needle currently selected by NeedleID.  These properties are based on a unitless scale and typically have values between 0.0 and 1.0.
[bookmark: _Toc399642552][bookmark: _Toc457383962][bookmark: _Toc457385955][bookmark: _Toc457899174]Needle Mouse Control
Determines the type of mouse input to the needle currently selected by NeedleID.
[bookmark: _Toc399642553][bookmark: _Toc457383963][bookmark: _Toc457385956][bookmark: _Toc457899175]Needle
Determines the number of needles displayed on the control.  This property must be set before needle properties are entered.  The NeedleID property is used to select the needle to which needle properties apply.
[bookmark: _Toc399642554][bookmark: _Toc457383964][bookmark: _Toc457385957][bookmark: _Toc457899176]NeedleScaleID
Determines the scale on which the needle currently selected by NeedleID is based.  The ScaleOriginX and ScaleOriginY properties determine the origin of the needle.  The ScaleMaxValue and ScaleMinValue properties define the valid operating range for the needle's value. 
[bookmark: _Toc399642555][bookmark: _Toc457383965][bookmark: _Toc457385958][bookmark: _Toc457899177]NeedleShape
Determines the shape of a user defined needle and only applies when NeedleStyle is set to "User Defined".  In general, this string defines a polygon made from a list of x, y coordinate pairs.  The needle shape is defined using a coordinate system in which (0,0) is located at the center of the instrument and the tip of the needle is typically defined as (0,1000).
[bookmark: _Toc399642556][bookmark: _Toc457383966][bookmark: _Toc457385959][bookmark: _Toc457899178]NeedleStyle
Determines the style of the needle currently selected by NeedleID.
[bookmark: _Toc399642557][bookmark: _Toc457383967][bookmark: _Toc457385960][bookmark: _Toc457899179]NeedleValue
Determines the value of the needle currently selected by NeedleID.  The NeedleValue is a number between ScaleMinValue and ScaleMaxValue.  The corresponding scale is referenced by the NeedleScaleID property.
[bookmark: _Toc399642558][bookmark: _Toc457383968][bookmark: _Toc457385961][bookmark: _Toc457899180]Scales
[bookmark: _Toc399642559][bookmark: _Toc457383969][bookmark: _Toc457385962][bookmark: _Toc457899181]Scales are used to define the extent of the units displayed by the gauge, the location of the gauge center, and the gauge's start and stop angles.  Multiple scales are supported.
[image: ]
Scale Direction
Determines the direction of increasing values (from ScaleMinValue to ScaleMaxValue) for the scale currently selected by ScaleID.
[bookmark: _Toc399642560][bookmark: _Toc457383970][bookmark: _Toc457385963][bookmark: _Toc457899182]ScaleID
When multiple scales exist, ScaleID is used to index the scale to which the other scale properties apply.  The total number of scales is determined by the Scales property and ScaleID has valid values from 0 to Scales-1.
[bookmark: _Toc399642561][bookmark: _Toc457383971][bookmark: _Toc457385964][bookmark: _Toc457899183]ScaleMaxValue ScaleMinValue
Determines the maximum and minimum values available in the scale currently selected by ScaleID.  If ScaleDirection is set to forward (clockwise), then ScaleMinValue is located at ScaleStartAngle and ScaleMaxValue is located at ScaleStopAngle.  The converse is true if ScaleDirection is set to backward (counter-clockwise).
[bookmark: _Toc399642562][bookmark: _Toc457383972][bookmark: _Toc457385965][bookmark: _Toc457899184]ScaleOriginX ScaleOriginY
Determines the vertical and horizontal positions of the center of the scale currently selected by ScaleID.  These properties are based on a unitless scale and typically have values between -1.0 and 1.0, where a value of 0.0 is located in the center of the control.
[bookmark: _Toc399642563][bookmark: _Toc457383973][bookmark: _Toc457385966][bookmark: _Toc457899185]Scales
Determines the number of scales used to define the control.  This property must be set before all other scale properties.  The ScaleID property is used to select the scale to which scale properties apply.
[bookmark: _Toc399642564][bookmark: _Toc457383974][bookmark: _Toc457385967][bookmark: _Toc457899186]ScaleStartAngle ScaleStopAngle
Determines the angular extents of the scale currently selected by ScaleID.  When ScaleDirection is set to forward, the ScaleStartAngle corresponds to ScaleMinValue and when ScaleDirection is set to backward, the ScaleStartAngle corresponds to ScaleMaxValue.  The ScaleStopAngle property behaves in a similar fashion.


[bookmark: _Toc399642565][bookmark: _Toc457383975][bookmark: _Toc457385968][bookmark: _Toc457899187]Tics

Tics are used to mark intervals on the gauge's face.  Properties are used to set the tic's style, start-stop values, interval, inner-outer radii, width, color, label positions, and associated scale.

[image: ]
[bookmark: _Toc399642566][bookmark: _Toc457383976][bookmark: _Toc457385969][bookmark: _Toc457899188]TicColor
Determines the color for the tic set currently selected by TicID.
[bookmark: _Toc399642567][bookmark: _Toc457383977][bookmark: _Toc457385970][bookmark: _Toc457899189]TicDelta
Determines the value of the gap between numbers for the tic set currently selected by TicID.
[bookmark: _Toc399642568][bookmark: _Toc457383978][bookmark: _Toc457385971][bookmark: _Toc457899190]TicFloatOffset
Determines the offset value of the tic set currently selected by TicID.  Essentially, this property is used to shift tic sets by adding the offset to TicStartValue.  For example, if TicStartValue=2, TicSopValue=4 and TicFloatOffset=1, then the tic set will range from three (3) to five (5) instead of two (2) to four (4).  This is useful when trying to display a "floating" instrument (an instrument where the needle remains stationary and the tics and/or annulars move) such as a compass.
[bookmark: _Toc399642569][bookmark: _Toc457383979][bookmark: _Toc457385972][bookmark: _Toc457899191]TicFontID
Determines which font is used for the labels of the tic set currently selected by TicID.
[bookmark: _Toc399642570][bookmark: _Toc457383980][bookmark: _Toc457385973][bookmark: _Toc457899192]TicID
When multiple tic sets exist, TicID is used to index the tic sets to which the other tic properties apply.  The total number of tic sets is determined by the Tics property and TicID has valid values from 0 to Tics-1.
[bookmark: _Toc399642571][bookmark: _Toc457383981][bookmark: _Toc457385974][bookmark: _Toc457899193]TicInnerRadius TicOuterRadius
Determines the inner and outer radii of the tic set currently selected by TicID.  These properties are based on a unitless scale and typically have values between 0.0 and 1.0.

[bookmark: _Toc399642572][bookmark: _Toc457383982][bookmark: _Toc457385975][bookmark: _Toc457899194]TicLabel
Enables or disables labels at each tic mark for the tic set currently selected by TicID.  The position of the tic labels is defined by the TicLabelRadius property.  
[bookmark: _Toc399642573][bookmark: _Toc457383983][bookmark: _Toc457385976][bookmark: _Toc457899195]TicLabelRadius
Determines the radius at which TicID displays the labels for the tic set currently selected.  This property is based on a unitless scale and typically has values between 0.0 and 1.0.
[bookmark: _Toc399642574][bookmark: _Toc457383984][bookmark: _Toc457385977][bookmark: _Toc457899196]TicLabelRotated
Determines whether the labels for the tic set currently selected by TicID are oriented with respect to the control or the tic mark.  Both orientations are shown in the figure below.  This feature is useful when trying to display a "floating" instrument (an instrument where the needle remains stationary and the tics and/or annulars move) such as a compass.
[bookmark: _Toc399642575][bookmark: _Toc457383985][bookmark: _Toc457385978][bookmark: _Toc457899197]Tics 
Determines the number of tic sets displayed on the control.  This property must be set before all other tic properties.  The TicID property is used to select the tic set to which tic properties apply.
[bookmark: _Toc399642576][bookmark: _Toc457383986][bookmark: _Toc457385979][bookmark: _Toc457899198]TicScaleID
Determines the scale on which the tic set currently selected by TicID is based.  The TicStartValue and TicStopValue properties must fall within the range defined by ScaleMaxValue and ScaleMinValue.
[bookmark: _Toc399642577][bookmark: _Toc457383987][bookmark: _Toc457385980][bookmark: _Toc457899199]TicStartValue TicStopValue
Determines the values at which the tic marks start and stop for the tic set currently selected by TicID.  These values are numbers between ScaleMinValue and ScaleMaxValue for the scale referenced by TicScaleID.
[bookmark: _Toc399642578][bookmark: _Toc457383988][bookmark: _Toc457385981][bookmark: _Toc457899200]TicStyle
Determines the style of the tic set currently selected by TicID.
[bookmark: _Toc399642579][bookmark: _Toc457383989][bookmark: _Toc457385982][bookmark: _Toc457899201]TicWidth
Determines the width of the tic marks for the tic set currently selected by TicID.  This property is based on a unitless scale and typically has values between 0.0 and 1.0.

[bookmark: _Toc399642580][bookmark: _Toc457383990][bookmark: _Toc457385983][bookmark: _Toc457899202][bookmark: _Toc360531802][bookmark: _Toc408991033]Drawing an Angular Gauge Example
In this section we will go through the steps required to make a simple gauge like the one below.
[bookmark: _Toc399642581]
[image: ]
[bookmark: _Toc457383991][bookmark: _Toc457385984][bookmark: _Toc457899203]Step 1.
[image: ]
After the Overlay has been installed run the configurable monitor, open a new monitor Document. Click on the icon for the angular gauge, a crosshair will appear. Click and hold the mouse button and drag the crosshair until the gauge is of the required size. A gauge will appear… this is the default setting for the angular gauge, but it may be reconfigured to be the same as the one above, we will now go through the steps required to do this.
[bookmark: _Toc399642582][bookmark: _Toc457383992][bookmark: _Toc457385985][bookmark: _Toc457899204]Step 2.
Right click on the Gauge you have just drawn a popup dialog will appear, choose visual / display properties from the pop-up menu.
[bookmark: _Toc399642583][bookmark: _Toc457383993][bookmark: _Toc457385986][bookmark: _Toc457899205]Step 3.
Firstly we will change the scale and direction of the gauge. Select the Scales Tab in the configuration Menu, and configure the fields as follows.

Value Limits: Min=1 Max=10
Direction = Backwards
Start Angle =358
Stop Angle = 92
Scales=1 (as there is only one scale for this example)
X Position = -1.49
Y Position = -1.09

The gauge may look a bit strange but this is ok. 
[bookmark: _Toc399642584][bookmark: _Toc457383994][bookmark: _Toc457385987][bookmark: _Toc457899206]Step 4.
Now we will change the annulars…those are the Red, Yellow and Blue Lines you see on the above example. We need three annulars for this example so set the Annulars field in the Annulars tab to be three. Let us configure the First Annular. In the AnnularID Field make sure the value is Zero then configure the fields as follows.

Start Value=1
Stop Value=10
Radius Inner=1.99
Radius Outer=2.05
FloatOffset=0
Click on Color and choose Blue.
Now Click Apply.
You will see the blue “Outline” for the gauge appear as in the above example

Now lets Configure the other Annulars. To configure the second Annular set the value of AnnularID to be one and set the Configuration Fields as follows.
Start Value=8
Stop Value=10
Radius Inner=1.85
Radius Outer=1.99
FloatOffset=0
Click on Color and choose Red.
Now Click Apply.

And for the Third and Final Annular. Set the Value of AnnularID to be two and configure the fields as follows.

Start Value=6
Stop Value=8
Radius Inner=1.85
Radius Outer=1.99
FloatOffset=0
Click on Color and choose Yellow.
Now Click Apply.

Now the Gauge is looking a bit more like our above example.
[bookmark: _Toc399642585][bookmark: _Toc457383995][bookmark: _Toc457385988][bookmark: _Toc457899207]Step 5
We will now configure the Tics on the Gauge, that is the lines on the gauge marking the position of the numbers. We Need Two sets of Tics for this example, one for the longer set and one for the short set. Set the Value in Tics to be two.

We will now configure the first set of tics, these are the larger ones, configure the fields as follows:

Style=Rectangular
Float Offset=0
Labels = ON/OFF Checked
Labels Postion=2.20
Inner=1.70
Outer=2.00
Width=0.00
Start Value=1
Stop Value=10
Delta=1
Click Apply.

You Will See the Large tics appear with the Labels, i.e. Numbers on the outer rim of the Gauge Now. Let us configure the second set of tics. Configure the fields as follows:

Style =Rectangular
Float Offset=0
Labels = ON/OFF NOT Checked
Labels Postion=2.20
Inner=1.90
Outer=2.00
Width=0.00
Start Value=1
Stop Value=10
Delta=0.2
Click Apply.
[bookmark: _Toc399642586][bookmark: _Toc457383996][bookmark: _Toc457385989][bookmark: _Toc457899208]Step 6.
We Will Now configure the needle. Select the Needles Tab and configure the fields as follows.

Needles=1
Mouse Control = None.
Style = 1.Triangle
Value=1
Length=2.00
Width=0.36
Color =Dark Blue.
Click Apply.

The Gauge is almost finished; we just have to add a “Hub” that is the circular part at the end of the needle.
[bookmark: _Toc399642587][bookmark: _Toc457383997][bookmark: _Toc457385990][bookmark: _Toc457899209]Step 7.
To configure the hub, select the hub tab and configure the fields as follows.

Hubs=1
HubID=0
ScaleID=0
Radius=0.181
Color =Black
Click Apply

That’s the Gauge Drawn. Now to make it functional we must add a channel to it

First we must configure a Channel for the Gauge…. Select Calculator from the Processors menu in the Main Application Menu. Set up a calculator as follows with the following Formula.

Ctime()-(floor(ctime()/10)*10)

Right Click on the Gauge and select Data source Properties and for the channel source select the channel you just calculator configured. Set the Monitor to Value Entry Mode and Enable the System…The Gauge will now reflect the value of the calculator channel.


[bookmark: _Toc399642588][bookmark: _Toc457383998][bookmark: _Toc457385991][bookmark: _Toc457899210][bookmark: _Toc360531803][bookmark: _Toc408991034]
Control Knobs
[image: ]
[bookmark: _Toc399642589][bookmark: _Toc457383999][bookmark: _Toc457385992][bookmark: _Toc457899211]Description
The Knob control is a highly customizable knob or dial control.  Its dynamic property pages provide a powerful tool for interactively designing knobs or dials with full control of styles, scales, tics, annulars, captions, border and background.  With its data-aware and mouse input features, Knob is a simple and intuitive input to technical interfaces.
[bookmark: _Toc399642590][bookmark: _Toc457384000][bookmark: _Toc457385993][bookmark: _Toc457899212]
Knobs
There are several styles of knobs.  Properties are provided to modify the knob's style, inner-outer radii, width, and color.  Additionally, user defined knob shapes may be specified.

[image: ]
[bookmark: _Toc399642591][bookmark: _Toc457384001][bookmark: _Toc457385994][bookmark: _Toc457899213]KnobColor
Determines the color of the control's knob.
[bookmark: _Toc399642592][bookmark: _Toc457384002][bookmark: _Toc457385995][bookmark: _Toc457899214]KnobMultiTurn
This property determines whether or not the knob can turn through multiple revolutions.  The number of revolutions is dependent on the KnobMultiTurnValue property.
[bookmark: _Toc399642593][bookmark: _Toc457384003][bookmark: _Toc457385996][bookmark: _Toc457899215]KnobMultiTurnValue
This property is used to determine how many revolutions a knob can turn.  The number of revolutions is determined by the knob's maximum value (ScaleMaxValue) divided by the KnobMultiTurnValue property.  For example, a knob where ScaleMaxValue=500 and KnobMultiTurnValue=100 can make 5 complete revolutions.
[bookmark: _Toc399642594][bookmark: _Toc457384004][bookmark: _Toc457385997][bookmark: _Toc457899216]KnobPicture
Determines the graphic to be displayed as the knob.  Unlike knobs, which are defined using the KnobStyle property, a knob defined by a picture does not rotate.  Rotating the knob’s mark simulates the rotating effect.
[bookmark: _Toc399642595][bookmark: _Toc457384005][bookmark: _Toc457385998][bookmark: _Toc457899217]KnobRadius
Determines the outer radius of the knob.  This property is based on a unitless scale and typically has values between 0.0 and 1.0.
[bookmark: _Toc399642596][bookmark: _Toc457384006][bookmark: _Toc457385999][bookmark: _Toc457899218]KnobSnap
Enables or disables the control's ability to display any value within the range defined by ScaleMinValue and ScaleMaxValue.  For example, if the scale ranges from 0 to 10, KnobSnap=TRUE and KnobSnapIncrement=2, then KnobValue can only have the values 0, 2, 4, 6, 8 and 10.
[bookmark: _Toc399642597][bookmark: _Toc457384007][bookmark: _Toc457386000][bookmark: _Toc457899219]KnobSnapIncrement
Determines the allowable incremental change of the knob's value (if KnobSnap =TRUE).  For example, a control where the knob scale ranges from 0 to 10 and KnobSnapIncrement=2 will only allow Knob Values of 0, 2, 4, 6, 8, and 10.
[bookmark: _Toc399642598][bookmark: _Toc457384008][bookmark: _Toc457386001][bookmark: _Toc457899220]KnobStyle
Determines the style of the knob.
[bookmark: _Toc399642599][bookmark: _Toc457384009][bookmark: _Toc457386002][bookmark: _Toc457899221]KnobUserDefined / Mark User Defined
Determines the shape of a user-defined knob or mark.  This property only applies when KnobStyle = 4 (for knobs) or when MarkStyle=4 (for marks).  This property defines a polygon made from a list of x, y coordinate pairs (comma delimited).  The shape is defined using a coordinate system in which (0,0) is located at the center of the knob and the "pointer" of the knob (or tip of the mark) is typically defined as (0,1000).
[bookmark: _Toc399642600][bookmark: _Toc457384010][bookmark: _Toc457386003][bookmark: _Toc457899222]KnobValue
Determines the value of the knob whose range is defined by the ScaleMinValue and ScaleMaxValue properties.
[bookmark: _Toc399642601][bookmark: _Toc457384011][bookmark: _Toc457386004][bookmark: _Toc457899223]MouseControl
Determines the type of mouse input to the control.
[bookmark: _Toc399642602][bookmark: _Toc457384012][bookmark: _Toc457386005][bookmark: _Toc457899224]Mark
Each knob may be adorned with a single mark.  Properties are provided to modify the mark's style, inner-outer radii, width, and color.  Additionally, user defined mark shapes may be incorporated into the control.

[bookmark: _Toc399642603][bookmark: _Toc457384013][bookmark: _Toc457386006][bookmark: _Toc457899225]MarkColor
Determines the knob mark's color.
[bookmark: _Toc399642604][bookmark: _Toc457384014][bookmark: _Toc457386007][bookmark: _Toc457899226]MarkInnerRadius / MarkOuterRadius
Determines the inner and outer radii of the knob's mark.  The scale of these properties is based on the knob's size. For example, an inner radius of 0.0 and an outer radius of 1.0 yields a mark from the knob's center to its outer edge.
[bookmark: _Toc399642605][bookmark: _Toc457384015][bookmark: _Toc457386008][bookmark: _Toc457899227]MarkPicture
Determines the graphic to be displayed as the mark on the control's knob.
[bookmark: _Toc399642606][bookmark: _Toc457384016][bookmark: _Toc457386009][bookmark: _Toc457899228]MarkStyle
Determines the style of the knob's mark.
[bookmark: _Toc399642607][bookmark: _Toc457384017][bookmark: _Toc457386010][bookmark: _Toc457899229]MarkUserDefined
Determines the shape of a user-defined knob or mark.  This property only applies when KnobStyle = 4 (for knobs) or when MarkStyle=4 (for marks).  This property defines a polygon made from a list of x, y coordinate pairs (comma delimited).  The shape is defined using a coordinate system in which (0,0) is located at the center of the knob and the "pointer" of the knob (or tip of the mark) is typically defined as (0,1000).
[bookmark: _Toc399642608][bookmark: _Toc457384018][bookmark: _Toc457386011][bookmark: _Toc457899230]MarkWidth
Determines the width of the knob's mark.  This property is based on a unitless scale and typically has values between 0.0 and 1.0.

[bookmark: _Toc399642609][bookmark: _Toc457384019][bookmark: _Toc457386012][bookmark: _Toc457899231]Scale
Scale is used to define the extent of the units displayed on the knob, the location of the knob center, and the knob's start and stop angles.

[image: ]
[bookmark: _Toc399642610][bookmark: _Toc457384020][bookmark: _Toc457386013][bookmark: _Toc457899232]ScaleDirection
Determines the direction of increasing values (from ScaleMinValue to ScaleMaxValue).
[bookmark: _Toc399642611][bookmark: _Toc457384021][bookmark: _Toc457386014][bookmark: _Toc457899233]ScaleMaxValue / ScaleMinValue
Determines the maximum and minimum values available in the scale.  If ScaleDirection is set to forward (clockwise), then ScaleMinValue is located at ScaleStartAngle and ScaleMaxValue is located at ScaleStopAngle.  The converse is true if ScaleDirection is set to backward (counter-clockwise).
[bookmark: _Toc399642612][bookmark: _Toc457384022][bookmark: _Toc457386015][bookmark: _Toc457899234]ScaleOriginX / ScaleOriginY
Determines the vertical and horizontal positions of the center of the scale.  These properties are based on a unitless scale and typically have values between -1.0 and 1.0, where a value of 0.0 is located in the center of the control.
[bookmark: _Toc399642613][bookmark: _Toc457384023][bookmark: _Toc457386016][bookmark: _Toc457899235]ScaleStartAngle / ScaleStopAngle
Determines the angular extents of the scale.  When ScaleDirection is set to forward, the ScaleStartAngle corresponds to ScaleMinValue and when ScaleDirection is set to backward, the ScaleStartAngle corresponds to ScaleMaxValue.  The ScaleStopAngle property behaves in a similar fashion.
[bookmark: _Toc399642614][bookmark: _Toc457384024][bookmark: _Toc457386017][bookmark: _Toc457899236]Tics
Tics are used to mark intervals on the control face.  Properties are provided to set the tic's style, start-stop values, interval, inner-outer radii, width, color, and label positions.

[image: ]
[bookmark: _Toc399642615][bookmark: _Toc457384025][bookmark: _Toc457386018][bookmark: _Toc457899237]Attached
Determines whether or not the tic set currently selected by TicID moves with the control's knob.
[bookmark: _Toc399642616][bookmark: _Toc457384026][bookmark: _Toc457386019][bookmark: _Toc457899238]Color
Determines the color for the tic set currently selected by TicID.
[bookmark: _Toc399642617][bookmark: _Toc457384027][bookmark: _Toc457386020][bookmark: _Toc457899239]DeltaValue
Determines the interval value between tic marks for the tic set currently selected by TicID.
[bookmark: _Toc399642618][bookmark: _Toc457384028][bookmark: _Toc457386021][bookmark: _Toc457899240]FontID
Determines which font is used for the labels of the tic set currently selected by TicID.
[bookmark: _Toc399642619][bookmark: _Toc457384029][bookmark: _Toc457386022][bookmark: _Toc457899241]TicID
When multiple tic sets exist, TicID is used to index the tic sets to which the other tic properties apply.  The total number of tic sets is determined by the Tics property and TicID has valid values from 0 to Tics-1.
[bookmark: _Toc399642620][bookmark: _Toc457384030][bookmark: _Toc457386023][bookmark: _Toc457899242]Inner / Outer Radius
Determines the inner and outer radii of the tic set currently selected by TicID.  These properties are based on a unitless scale and typically have values between 0.0 and 1.0.
[bookmark: _Toc399642621][bookmark: _Toc457384031][bookmark: _Toc457386024][bookmark: _Toc457899243]Tic Label
Enables or disables labels at each tic mark for the tic set currently selected by TicID.  The position of the tic labels is defined by the TicLabelRadius property.

[bookmark: _Toc399642622][bookmark: _Toc457384032][bookmark: _Toc457386025][bookmark: _Toc457899244]Tic Label Radius
Determines the radius at which TicID displays the labels for the tic set currently selected.  This property is based on a unitless scale and typically has values between 0.0 and 1.0.
[bookmark: _Toc399642623][bookmark: _Toc457384033][bookmark: _Toc457386026][bookmark: _Toc457899245]Tic Label Rotated
Determines whether the labels for the tic set currently selected by TicID are oriented with respect to the control or the tic mark.  Both orientations are shown in the figure below.  This feature is useful when trying to display a "floating" instrument (an instrument where the needle remains stationary and the tics and/or annulars move) such as a compass.
[bookmark: _Toc399642624][bookmark: _Toc457384034][bookmark: _Toc457386027][bookmark: _Toc457899246]Tics Property
Determines the number of tic sets displayed on the control.  This property must be set before all other tic properties.  The TicID property is used to select the tic set to which tic properties apply.
[bookmark: _Toc399642625][bookmark: _Toc457384035][bookmark: _Toc457386028][bookmark: _Toc457899247]Start Value / Stop Value
Determines the values at which the tic marks start and stop for the tic set currently selected by TicID.  These values are numbers between ScaleMinValue and ScaleMaxValue.  
[bookmark: _Toc399642626][bookmark: _Toc457384036][bookmark: _Toc457386029][bookmark: _Toc457899248]Tic Style
Determines the style of the tic set currently selected by TicID.
[bookmark: _Toc399642627][bookmark: _Toc457384037][bookmark: _Toc457386030][bookmark: _Toc457899249]Tic Width
Determines the width of the tic marks for the tic set currently selected by TicID.  This property is based on a unitless scale and typically has values between 0.0 and 1.0.
[bookmark: _Toc399642628][bookmark: _Toc457384038][bookmark: _Toc457386031][bookmark: _Toc457899250]Annulars
Annulars are used for aesthetics as well as indicators of operating ranges.  Properties are provided to modify annular's start-stop values, inner-outer radii, and color.  Multiple annular regions can be placed on a single control.
[image: ]
[bookmark: _Toc399642629][bookmark: _Toc457384039][bookmark: _Toc457386032][bookmark: _Toc457899251]Color
Determines the color of the annular currently selected by AnnularID.
[bookmark: _Toc399642630][bookmark: _Toc457384040][bookmark: _Toc457386033][bookmark: _Toc457899252]Annulars
Determines the number of annular regions displayed on the control.  This property must be set before all other annular properties.  The AnnularID property is used to select the region to which annular properties apply.
[bookmark: _Toc399642631][bookmark: _Toc457384041][bookmark: _Toc457386034][bookmark: _Toc457899253]AnnularID
When multiple annulars exist, AnnularID is used to index the annular to which the other annular properties apply.  The total number of annulars is determined by the Annulars property and AnnularID has valid values from 0 to Annulars-1.
[bookmark: _Toc399642632][bookmark: _Toc457384042][bookmark: _Toc457386035][bookmark: _Toc457899254]Inner / Outer Radius
Determines the inner and outer radii of the annular currently selected by AnnularID.  These properties are based on a unitless scale and typically have values between 0.0 and 1.0.
[bookmark: _Toc399642633][bookmark: _Toc457384043][bookmark: _Toc457386036][bookmark: _Toc457899255]Annular Start/ Stop Value
Determines the values at which the annular region begins and ends.  The values are numbers between ScaleMinValue and ScaleMaxValue.
[bookmark: _Toc457384044][bookmark: _Toc457386037][bookmark: _Toc457899256]Note:
See Caption Section on generic configuration fields for details on captions, digital, fonts, background and frame.
[bookmark: _Toc399642635][bookmark: _Toc457384045][bookmark: _Toc457386038][bookmark: _Toc457899257][bookmark: _Toc360531804][bookmark: _Toc408991035]
Drawing A Control Knob Example
In this section we will go through the steps necessary to create a control knob like the one below.
[image: knobexample]
[bookmark: _Toc399642636][bookmark: _Toc457384046][bookmark: _Toc457386039][bookmark: _Toc457899258]Step 1
[image: knobicon]
After the Overlay has been installed run the configurable monitor, open a new monitor Document click on the icon for the control knob, a crosshair will appear. Click and hold the mouse button and drag the crosshair until the knob is of the required size. A knob will appear… this is the default setting for the knob, but it may be reconfigured to be the same as the one above, we will now go through the steps required to do this.
[bookmark: _Toc399642637][bookmark: _Toc457384047][bookmark: _Toc457386040][bookmark: _Toc457899259]Step 2.
First We Will Reconfigure the Scale. To Do this Right Click on the Knob and select Visual / Display Properties form the Pop-Up Menu. Select the Scale Tab. There is only one Scale for this Particular Example so set the Scales Field to be Zero. Configure the rest of the fields as follows.

Min=1
Max=10
Direction =forward
Start angle=220
Stop Angle=140

The Knob will look strange at the moment but will fix itself as we progress through the example.
[bookmark: _Toc399642638][bookmark: _Toc457384048][bookmark: _Toc457386041][bookmark: _Toc457899260]Step 3.
We will now configure the annulars, i.e. the Green, Yellow and Red Bars on the Knob. Select the Annulars Tab, and set the value in Annulars as 3, one for green, one for Yellow and one for Red.
To set up the first annular set the annular ID to be 0, and configure the fields as follows.

Start Value = 0
Stop Value = 5
Inner Radius =0.72
Outer Radius =0.86
Color =Green
 
Now lets configure the other two, for AnnularID 1 set the configuration fields as follows
Start Value =5
Stop Value =7
Inner Radius =0.72
Outer Radius =0.86
Color =Yellow


For AnnularID 2 set the configuration fields as follows

Start Value =7
Stop Value =10
Inner Radius =0.72
Outer Radius =0.86
Color =Red
[bookmark: _Toc399642639][bookmark: _Toc457384049][bookmark: _Toc457386042][bookmark: _Toc457899261]Step 4
We will now configure the knob, Choose the Knob tab from the menu. Set the configuration fields as follows.

Color =Black
KnobMultiTurn =NOT Checked
KnobSnap = NOT Checked
Style = Complex
KnobRadius=0.65
[bookmark: _Toc399642640][bookmark: _Toc457384050][bookmark: _Toc457386043][bookmark: _Toc457899262]Step 5.
Now we will configure the Mark on the Knob, i.e. the small red mark on the knob. Set the configuration fields as follows.

Color =Red
Inner Radius=0.5
Outer Radius=0.8
Width=0.4
Style =Triangle

That’s the knob configured; now to make it functional we must assign a channel to it.
[bookmark: _Toc399642641][bookmark: _Toc457384051][bookmark: _Toc457386044][bookmark: _Toc457899263]Step 6.
Configure a User Analog channel, right click the control, select data source properties and assign it the channel you just created. Set the monitor on value entry mode and use the mouse to turn it!

If you like you could set up the above knob, along with the gauge in the previous example and assign the same channel to them. This will demonstrate the functionality of both of the controls.
[bookmark: _Toc399642642][bookmark: _Toc457384052][bookmark: _Toc457386045][bookmark: _Toc457899264][bookmark: _Toc360531805][bookmark: _Toc408991036]
Linear Gauges
LGauge is a multi-purpose, highly customizable linear gauge that can be configured as a slider for input or as a meter for output.  Its dynamic property pages provide a powerful tool for designing gauges with full control of scales, pointers, fonts, operation bands, and tics.  With its data-aware and mouse input features, LGauge is an ideal display element for technical interfaces.

[image: ]

[bookmark: _Toc399642643][bookmark: _Toc457384053][bookmark: _Toc457386046][bookmark: _Toc457899265]
Bands
Bands are used for aesthetics as well as indicators of operating ranges.  Properties are provided to modify the band's start-stop values, inner-outer positions, color, and associated scale.  Multiple bands can be placed on a single gauge.
[image: ]
[bookmark: _Toc399642644][bookmark: _Toc457384054][bookmark: _Toc457386047][bookmark: _Toc457899266]BandColor
Determines the color of the band currently selected by BandID.
[bookmark: _Toc399642645][bookmark: _Toc457384055][bookmark: _Toc457386048][bookmark: _Toc457899267]BandID
When multiple bands exist, BandID is used to index the band to which the other band properties apply.  The total number of bands is determined by the Bands property and BandID has valid values from 0 to Bands-1.
[bookmark: _Toc399642646][bookmark: _Toc457384056][bookmark: _Toc457386049][bookmark: _Toc457899268]BandInner / BandOuter
Determines the inner and outer extents of the band currently selected by BandID.  If the instrument's orientation is horizontal these values are measured from top to bottom.  Otherwise they are measured from left to right.  These properties are based on a unitless scale and typically have values between 0.0 and 1.0.
[bookmark: _Toc457384057][bookmark: _Toc457386050][bookmark: _Toc457899269]BandPicture
Determines the graphic to be displayed in the band area (defined by BandInner, BandOuter, BandStart and BandStop) for the band currently selected by BandID.
[bookmark: _Toc457384058][bookmark: _Toc457386051][bookmark: _Toc457899270]Bands
Determines the number of bands displayed on the control.  This property must be set before all other band properties.  The BandID property is used to select the band to which band properties apply.
[bookmark: _Toc399642647][bookmark: _Toc457384059][bookmark: _Toc457386052][bookmark: _Toc457899271]BandScaleID
Determines the scale on which the band currently selected by BandID is based.  The BandStart and BandStop properties must fall within the range defined by ScaleMax and ScaleMin.

[bookmark: _Toc399642648][bookmark: _Toc457384060][bookmark: _Toc457386053][bookmark: _Toc457899272]BandShape
Determines the shape of a user defined band.  This property only applies when BandStyle is set to "User Defined" and defines a polygon made from a list of x, y coordinate pairs.  The shape is defined using a coordinate system in which (0,0) is located at the upper, left corner of the control.
[bookmark: _Toc399642649][bookmark: _Toc457384061][bookmark: _Toc457386054][bookmark: _Toc457899273]BandStart / BandStop
Determines the start and stop values for the band currently selected by BandID.  These values are numbers between ScaleMin and ScaleMax for the scale referenced by BandScaleID.
[bookmark: _Toc399642650][bookmark: _Toc457384062][bookmark: _Toc457386055][bookmark: _Toc457899274]BandStyle
Determines the style of the band currently selected by BandID.
[bookmark: _Toc399642651][bookmark: _Toc457384063][bookmark: _Toc457386056][bookmark: _Toc457899275]BevelInner / BevelOuter
Determines the inner or outer shadow styles of the control.
[bookmark: _Toc399642652][bookmark: _Toc457384064][bookmark: _Toc457386057][bookmark: _Toc457899276]BevelWidth
Determines the shadow sizes of the inner and outer bevels of the control.
[bookmark: _Toc399642653][bookmark: _Toc457384065][bookmark: _Toc457386058][bookmark: _Toc457899277]BorderWidth
Determines the border size between the inner and outer bevels of the control.
[bookmark: _Toc399642654][bookmark: _Toc457384066][bookmark: _Toc457386059][bookmark: _Toc457899278]Captions
The gauge can be embellished with multiple captions to indicate the type of measurement being displayed, units used or any other informative or decorative labelling.
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[bookmark: _Toc399642655][bookmark: _Toc457384067][bookmark: _Toc457386060][bookmark: _Toc457899279]Caption
Determines the text displayed on the control for the caption currently selected by CaptionID.  The number of captions displayed is set by the Captions property.

[bookmark: _Toc399642656][bookmark: _Toc457384068][bookmark: _Toc457386061][bookmark: _Toc457899280]CaptionColor
Determines the text color for the caption currently selected by CaptionID.
[bookmark: _Toc399642657][bookmark: _Toc457384069][bookmark: _Toc457386062][bookmark: _Toc457899281]FontID
Determines which font is used for the caption currently selected by CaptionID.
[bookmark: _Toc399642658][bookmark: _Toc457384070][bookmark: _Toc457386063][bookmark: _Toc457899282]CaptionID
When multiple captions exist, CaptionID is used to index the caption to which the other caption properties apply.  The total number of captions is determined by the Captions property and CaptionID has valid values from 0 to Captions-1.
[bookmark: _Toc399642659][bookmark: _Toc457384071][bookmark: _Toc457386064][bookmark: _Toc457899283]Captions
Determines the number of captions displayed on the control.  This property must be set before all other caption properties.  The CaptionID property is used to select the caption to which caption properties apply.
[bookmark: _Toc399642660][bookmark: _Toc457384072][bookmark: _Toc457386065][bookmark: _Toc457899284]X Position / Y Position
Determines the vertical and horizontal positions of the caption currently selected by the CaptionID property.  These properties are based on a unitless scale and typically have values between 0.0 and 1.0 where a value of 0.0 is located at the upper, left corner of the control.
[bookmark: _Toc399642661][bookmark: _Toc457384073][bookmark: _Toc457386066][bookmark: _Toc457899285]Pointers
Pointers can be displayed in a variety of shapes and sizes.  Properties are used to modify the pointer’s style, size, width, color and associated scale.  Multiple pointers can be placed on a single gauge.

[image: ]

[bookmark: _Toc399642662][bookmark: _Toc457384074][bookmark: _Toc457386067][bookmark: _Toc457899286]Pointer Color
Determines the color for the pointer currently selected by PointerID.

[bookmark: _Toc399642663][bookmark: _Toc457384075][bookmark: _Toc457386068][bookmark: _Toc457899287]PointerID
When multiple pointers exist, PointerID is used to index the pointer to which the other pointer properties apply.  The total number of pointers is determined by the Pointers property and PointerID has valid values from 0 to Pointers-1.
[bookmark: _Toc399642664][bookmark: _Toc457384076][bookmark: _Toc457386069][bookmark: _Toc457899288]Pointer Inner / Outer
Determines the inner and outer extents of the pointer currently selected by PointerID.  If the control's orientation is horizontal, these values are measured from top to bottom.  Otherwise they are measured from left to right.  These properties are based on a unitless scale and typically have values between 0.0 and 1.0.
[bookmark: _Toc399642665][bookmark: _Toc457384077][bookmark: _Toc457386070][bookmark: _Toc457899289]Mouse Control
Determines the type of mouse input for the pointer currently selected by PointerID.
[bookmark: _Toc399642666][bookmark: _Toc457384078][bookmark: _Toc457386071][bookmark: _Toc457899290]PointerPicture
Determines the graphic to be displayed as the pointer for the pointer currently selected by PointerID.  The graphic is stretched to fit the pointer area as defined by PointerInner, PointerOuter, PointerStart, PointerStop and PointerWidth.
[bookmark: _Toc399642667][bookmark: _Toc457384079][bookmark: _Toc457386072][bookmark: _Toc457899291]Pointers
Determines the number of pointers displayed on the control.  This property must be set before all other pointer properties.  The PointerID property is used to select the pointer to which pointer properties apply.
[bookmark: _Toc399642668][bookmark: _Toc457384080][bookmark: _Toc457386073][bookmark: _Toc457899292]ScaleID
Determines the scale on which the pointer currently selected by PointerID is based.  The PointerStart and PointerStop properties must fall within the range defined by ScaleMax and ScaleMin.
[bookmark: _Toc457384081][bookmark: _Toc457386074][bookmark: _Toc457899293]Pointer Shape
Determines the shape of a user-defined pointer.  This property only applies when PointerStyle is set to "User Defined" and defines a polygon made from a list of x, y coordinate pairs.  The shape is defined using a coordinate system in which (0,0) is located at the upper, left corner of the control.
[bookmark: _Toc399642669][bookmark: _Toc457384082][bookmark: _Toc457386075][bookmark: _Toc457899294]Snap
Enables or disables the control's ability to display any value within the range defined by ScaleMin and ScaleMax (through PointerScaleID) for the pointer currently selected by PointerID.  For example, if the scale ranges from 0 to 10, PointerSnap =TRUE and PointerSnapIncrement=2, then the instrument can only display the values 0, 2, 4, 6, 8 and 10.
[bookmark: _Toc399642670][bookmark: _Toc457384083][bookmark: _Toc457386076][bookmark: _Toc457899295]Snap Increment
Determines the allowable incremental change of the control's value (if PointerSnap =TRUE) for the pointer currently selected by PointerID .  For example, a control where the pointer scale is 0 to 10 and PointerSnapIncrement=2 will only display values of 0, 2, 4, 6, 8, and 10.
[bookmark: _Toc399642671][bookmark: _Toc457384084][bookmark: _Toc457386077][bookmark: _Toc457899296]Pointer Start / Stop
Determines the start and stop values (if PointerType is set to "Range") for the pointer currently selected by PointerID.  These values are numbers between ScaleMin and ScaleMax for the scale referenced by PointerScaleID.
[bookmark: _Toc399642672][bookmark: _Toc457384085][bookmark: _Toc457386078][bookmark: _Toc457899297]PointerStyle
Determines the style of the pointer currently selected by PointerID.

[bookmark: _Toc399642673][bookmark: _Toc457384086][bookmark: _Toc457386079][bookmark: _Toc457899298]PointerType
Determines the type of the pointer currently selected by PointerID.  In some cases, the "value" setting is used.  If needed, however, ranges may be shown by setting this property to "range" and using PointerStart and PointerStop to define the area.
[bookmark: _Toc399642674][bookmark: _Toc457384087][bookmark: _Toc457386080][bookmark: _Toc457899299]Pointer Value
Sets or returns the value (if PointerType is set to "Value") of the pointer currently selected by PointerID.  The PointerValue is a number between ScaleMin and ScaleMax as defined by PointerScaleID.
[bookmark: _Toc399642675][bookmark: _Toc457384088][bookmark: _Toc457386081][bookmark: _Toc457899300]Pointer Width
Determines the width (if PointerType is set to "Value") of the pointer currently selected by PointerID.  This property is based on a unitless scale and typically has values between 0.0 and 1.0.
[bookmark: _Toc399642676][bookmark: _Toc457384089][bookmark: _Toc457386082][bookmark: _Toc457899301]PointerDigital
Enables or disables the digital display of the value for the pointer currently selected by PointerID.
[bookmark: _Toc399642677][bookmark: _Toc457384090][bookmark: _Toc457386083][bookmark: _Toc457899302]PointerDigitalAttach
Determines whether or not the digital display of the value for the pointer currently selected by PointerID moves with its corresponding pointer.
[bookmark: _Toc399642678][bookmark: _Toc457384091][bookmark: _Toc457386084][bookmark: _Toc457899303]PointerDigitalColour
Determines the color of the digital display (if PointerDigital=TRUE) for the pointer currently selected by PointerID.
[bookmark: _Toc399642679][bookmark: _Toc457384092][bookmark: _Toc457386085][bookmark: _Toc457899304]PointerDigitalDecimals
Determines how many decimal places are displayed in the digital display (if PointerDigital=TRUE) for the pointer currently selected by PointerID.
[bookmark: _Toc399642680][bookmark: _Toc457384093][bookmark: _Toc457386086][bookmark: _Toc457899305]PointerDigitalFontID
Determines which font is used in the digital display (if PointerDigital=TRUE) for the pointer currently selected by PointerID.
[bookmark: _Toc399642681][bookmark: _Toc457384094][bookmark: _Toc457386087][bookmark: _Toc457899306]Pointer Digital X / Digital Y
Determines the vertical and horizontal positions of the digital display (if PointerDigital=TRUE) for the pointer currently selected by PointerID.  These properties are based on a unitless scale and typically have values between 0 and 1.0 where 0.0 is located at the top, left corner of the control.
[bookmark: _Toc399642682][bookmark: _Toc457384095][bookmark: _Toc457386088][bookmark: _Toc457899307]Scales
Scales are used to define the extent of the units displayed by the gauge, the location of the gauge center, and the gauge's start and stop positions.  Multiple scales are supported.

[bookmark: _Toc399642683][bookmark: _Toc457384096][bookmark: _Toc457386089][bookmark: _Toc457899308]ScaleDirection 
Determines the direction of increasing values (from ScaleMinValue to ScaleMaxValue) for the scale currently selected by ScaleID.
[bookmark: _Toc399642684][bookmark: _Toc457384097][bookmark: _Toc457386090][bookmark: _Toc457899309][image: ]
ScaleID
When multiple scales exist, ScaleID is used to index the scale to which the other scale properties apply.  The total number of scales is determined by the Scales property and ScaleID has valid values from 0 to Scales-1.
[bookmark: _Toc399642685][bookmark: _Toc457384098][bookmark: _Toc457386091][bookmark: _Toc457899310]ScaleMax/ScaleMin
Determines the maximum and minimum values available in the scale.  If ScaleDirection is set to "Forward", then ScaleMin is located at ScalePositionStart and ScaleMax is located at ScalePositionStop.  The converse is true if ScaleDirection is set to "Backward".
[bookmark: _Toc399642686][bookmark: _Toc457384099][bookmark: _Toc457386092][bookmark: _Toc457899311]ScalePositionStart / ScalePositionStop
Determines the extents of the control.  When ScaleDirection is set to "Forward", the ScalePositionStart corresponds to ScaleMin and when ScaleDirection is set to "Backward", the ScalePositionStart corresponds to ScaleMax.  Typical values for this property are between 0.0 and 1.0.

[bookmark: _Toc399642687][bookmark: _Toc457384100][bookmark: _Toc457386093][bookmark: _Toc457899312]Scales
Determines the number of scales used to define the control.  This property must be set before all other scale properties.  The ScaleID property is used to select the scale to which scale properties apply.

[bookmark: _Toc399642688][bookmark: _Toc457384101][bookmark: _Toc457386094][bookmark: _Toc457899313]Tics

Tics are used to mark intervals on the gauge's face.  Properties are used to set the tic's style, start-stop values, interval, inner-outer positions, width, color, label positions, and associated scale.


[image: ]
[bookmark: _Toc399642689][bookmark: _Toc457384102][bookmark: _Toc457386095][bookmark: _Toc457899314]Color
Determines the color for the tic set currently selected by TicID.
[bookmark: _Toc399642690][bookmark: _Toc457384103][bookmark: _Toc457386096][bookmark: _Toc457899315]DeltaValue
Determines the interval value between tic marks for the tic set currently selected by TicID.
[bookmark: _Toc399642691][bookmark: _Toc457384104][bookmark: _Toc457386097][bookmark: _Toc457899316]FontID
Determines which font is used for the labels of the tic set currently selected by TicID.
[bookmark: _Toc399642692][bookmark: _Toc457384105][bookmark: _Toc457386098][bookmark: _Toc457899317]TicID
When multiple tic sets exist, TicID is used to index the tic sets to which the other tic properties apply.  The total number of tic sets is determined by the Tics property and TicID has valid values from 0 to Tics-1.
[bookmark: _Toc399642693][bookmark: _Toc457384106][bookmark: _Toc457386099][bookmark: _Toc457899318]Inner/Outer
Determines the inner and outer extents of the tic set currently selected by TicID.  These properties are based on a unitless scale and typically have values between 0.0 and 1.0.
[bookmark: _Toc399642694][bookmark: _Toc457384107][bookmark: _Toc457386100][bookmark: _Toc457899319]Label On/Off
Enables or disables labels at each tic mark for the tic set currently selected by TicID.  The position of the tic labels is defined by the TicLabelPosition property.
[bookmark: _Toc399642695][bookmark: _Toc457384108][bookmark: _Toc457386101][bookmark: _Toc457899320]Label Position
Sets or returns the position where labels are displayed for the tic set currently selected by TicID.  This property is based on a unitless scale and typically has values between 0.0 and 1.0.



[bookmark: _Toc399642696][bookmark: _Toc457384109][bookmark: _Toc457386102][bookmark: _Toc457899321]Tics
Determines the number of tic sets displayed on the control.  This property must be set before all other tic properties.  The TicID property is used to select the tic set to which tic properties apply.
[bookmark: _Toc399642697][bookmark: _Toc457384110][bookmark: _Toc457386103][bookmark: _Toc457899322]ScaleID
Determines the scale on which the tic set currently selected by TicID is based.  The TicStartValue and TicStopValue properties must fall within the range defined by ScaleMaxValue and ScaleMinValue.
[bookmark: _Toc399642698][bookmark: _Toc457384111][bookmark: _Toc457386104][bookmark: _Toc457899323]Shape
Determines the shape of a user-defined tic set.  This property only applies when TicStyle is set to "User Defined" and defines a polygon made from a list of x, y coordinate pairs.  The shape is defined using a coordinate system in which (0,0) is located at the upper, left corner of the area defined by the tic size parameters (TicWidth, etc.).
[bookmark: _Toc399642699][bookmark: _Toc457384112][bookmark: _Toc457386105][bookmark: _Toc457899324]Start / Stop Property
Determines the values at which the tic marks start and stop for the tic set currently selected by TicID.  These values are numbers between ScaleMin and ScaleMax for the scale referenced by TicScaleID.
[bookmark: _Toc399642700][bookmark: _Toc457384113][bookmark: _Toc457386106][bookmark: _Toc457899325]Style
Determines the style of the tic set currently selected by TicID.
[bookmark: _Toc399642701][bookmark: _Toc457384114][bookmark: _Toc457386107][bookmark: _Toc457899326]Width
Determines the width of the tic marks for the tic set currently selected by TicID.  This property is based on a unitless scale and typically has values between 0.0 and 1.0.
[bookmark: _Toc399642702][bookmark: _Toc457384115][bookmark: _Toc457386108][bookmark: _Toc457899327]Note:
See Generic Configuration Fields for information on fonts, background and digital.

[bookmark: _Toc399642703][bookmark: _Toc457384116][bookmark: _Toc457386109][bookmark: _Toc457899328][bookmark: _Toc360531806][bookmark: _Toc408991037]
Drawing a Linear Gauge Example
We will now go through an example of drawing a linear gauge similar to the one below.

[image: lineargaugeexample]
[bookmark: _Toc399642704][bookmark: _Toc457384117][bookmark: _Toc457386110][bookmark: _Toc457899329]Step 1.
[image: lineargaugeicon]
After the Overlay has been installed run the configurable monitor, open a new monitor Document. Click on the icon for the linear gauge, a crosshair will appear. Click and hold the mouse button and drag the crosshair until the gauge is of the required size. A gauge will appear… this is the default setting for the gauge, but it may be reconfigured to be the same as the one above, we will now go through the steps required to do this.
[bookmark: _Toc399642705][bookmark: _Toc457384118][bookmark: _Toc457386111][bookmark: _Toc457899330]Step 2.
Firstly We Will Configure the scale for the Gauge, to do this right click on the shape and select the scales tab. configure the fields as follows

Direction =Forward
Orientation =Horizontal
Scale Min =0
Scale Max =10
ScalePositionStart =0.07
ScalePostionStop =0.93
[bookmark: _Toc399642706][bookmark: _Toc457384119][bookmark: _Toc457386112][bookmark: _Toc457899331]Step 3.
Now we will configure the Bands, that is the colored sections on the gauge. We need four bands, one for red, yellow and green respectively and one for the Black “bar” along the top. First we will configure the Black “Bar”, set the bands field to be equal to 4, and the BandID to be one. Configure the rest of the fields as follows:

Style =Rectangular
BandInner =0.35
BandOuter =0.45
BandStart =1
BandStop =10
BandColor =Black

Click Apply

We will now configure the other Bands Change the BandID to 1 and configure the fields as follows

Style =Rectangular
BandInner =0.40
BandOuter =0.60
BandStart =1
BandStop =5
BandColor =Green 


Set the BandID to 2 and configure the fields as follows 
Style =Rectangular
BandInner =0.40
BandOuter =0.60
BandStart =5
BandStop =7
BandColor =Yellow 

Set the BandID to 3 and configure the fields as follows

Style =Rectangular
BandInner =0.40
BandOuter =0.60
BandStart =7
BandStop =10
BandColor =Red
[bookmark: _Toc399642707][bookmark: _Toc457384120][bookmark: _Toc457386113][bookmark: _Toc457899332]Step 4.
Next we will configure the tics, that is the numeric labeling on the gauge.
Select the tic tab, and configure the fields as follows
Tics =1
ScaleID =0
TicID =0
FontID =0
Label =on
Label Position =0.20
StartValue =1
StopValue =10
DeltaValue =1
Inner  =0.4
Outer =0.6
Width =0.0
Color =Black
[bookmark: _Toc399642708][bookmark: _Toc457384121][bookmark: _Toc457386114][bookmark: _Toc457899333]Step 5.
Now we will configure the Pointers, select the pointers tab and configure the fields as follows
Pointers =1
PointerID =0
ScaleID =0
Style =Pointer
Type =Value
Mouse Control =Relative
Inner =0.45
Outer =0.85
Width =0.04
Value =1
StartPosition =1
StopPosition =10
[bookmark: _Toc399642709][bookmark: _Toc457384122][bookmark: _Toc457386115][bookmark: _Toc457899334]Step 6.
The Gauge has now been configured, now we must assign a channel to it, right click on the gauge and select data source properties form the popup menu. Assign the Channel that we used in the previous example, Use the Knob we made in a previous example to change the values, and see these changes reflected on the gauge.
Numeric LED’s
The Numeric LED control provides a highly customizable digital display.  Its dynamic property pages provide full control of the control’s sizes, colors and bitmaps.  It may be used to display either numeric or alphanumeric values.  With its data-aware features, the Numeric LED is an ideal element for technical interfaces.
[image: NumLED]

[bookmark: _Toc399642710][bookmark: _Toc457384123][bookmark: _Toc457386116][bookmark: _Toc457899335]General
[image: ]
[bookmark: _Toc399642711][bookmark: _Toc457384124][bookmark: _Toc457386117][bookmark: _Toc457899336]Digits
Determines the total number of figures displayed in the control.
[bookmark: _Toc399642712][bookmark: _Toc457384125][bookmark: _Toc457386118][bookmark: _Toc457899337]Decimal Position
Determines how many decimal places the displayed value will have if FixedDecimal is TRUE.
[bookmark: _Toc399642713][bookmark: _Toc457384126][bookmark: _Toc457386119][bookmark: _Toc457899338]Decimals
Determines the number of digits, which display decimal values in the control.

[bookmark: _Toc399642714][bookmark: _Toc457384127][bookmark: _Toc457386120][bookmark: _Toc457899339]Decimal Size
Determines the size (in pixels) of the decimal point if it is displayed.
[bookmark: _Toc399642715][bookmark: _Toc457384128][bookmark: _Toc457386121][bookmark: _Toc457899340]Italic Offset
Determines the slant of the digital display, which simulates an italic font.
[bookmark: _Toc399642716][bookmark: _Toc457384129][bookmark: _Toc457386122][bookmark: _Toc457899341]Off/On Colour
Determines the colors used in the "On" and "Off" portions of the control.
[bookmark: _Toc399642717][bookmark: _Toc457384130][bookmark: _Toc457386123][bookmark: _Toc457899342]Leading Zeros
Determines whether or not the display is filled with leading zeros.
[bookmark: _Toc399642718][bookmark: _Toc457384131][bookmark: _Toc457386124][bookmark: _Toc457899343]Leading Plus/Minus
Determines whether or not the display has the plus/minus symbols.
[bookmark: _Toc399642719][bookmark: _Toc457384132][bookmark: _Toc457386125][bookmark: _Toc457899344]Leading One Digit
Determines whether or not the digital display has a leading one (1).
[bookmark: _Toc399642720][bookmark: _Toc457384133][bookmark: _Toc457386126][bookmark: _Toc457899345]Fixed Decimal
Determines whether or not the decimal's position is constant or variable.
[bookmark: _Toc399642721][bookmark: _Toc457384134][bookmark: _Toc457386127][bookmark: _Toc457899346]Display Mode
Determines the type of value, which may be displayed by the control.
[bookmark: _Toc399642722][bookmark: _Toc457384135][bookmark: _Toc457386128][bookmark: _Toc457899347]Value / Alphanumeric
Sets or returns the control's displayed value when DisplayMode is set to Numeric.
[bookmark: _Toc399642723][bookmark: _Toc457384136][bookmark: _Toc457386129][bookmark: _Toc457899348]Segment Separation
Determines the spacing (in pixels) between the segments that make up a single digit.
[bookmark: _Toc399642724][bookmark: _Toc457384137][bookmark: _Toc457386130][bookmark: _Toc457899349]Segment Width
Determines the width (in pixels) of each segment.
[bookmark: _Toc399642725][bookmark: _Toc457384138][bookmark: _Toc457386131][bookmark: _Toc457899350]Spacing Horizontal
Determines the distance (in pixels) between each digit.  It also is the distance between the border and end (first and last) digits.
[bookmark: _Toc399642726][bookmark: _Toc457384139][bookmark: _Toc457386132][bookmark: _Toc457899351]Spacing Vertical
Determines the distance (in pixels) between the upper and lower borders and the digital display.
[bookmark: _Toc399642727][bookmark: _Toc457384140][bookmark: _Toc457386133][bookmark: _Toc457899352]Note:
See Generic configuration Fields for information on background.

[bookmark: _Toc399642728][bookmark: _Toc457384141][bookmark: _Toc457386134][bookmark: _Toc457899353][bookmark: _Toc360531807][bookmark: _Toc408991038]
Drawing a numeric LED Example
We will now go through an example of drawing a numeric LED similar to the one below.

[image: NUMLedexample]
[bookmark: _Toc399642729][bookmark: _Toc457384142][bookmark: _Toc457386135][bookmark: _Toc457899354]Step 1.
[image: NumLEDicon]
After the Overlay has been installed run the configurable monitor, open a new monitor Document. Click on the icon for the Numeric LED, a crosshair will appear. Click and hold the mouse button and drag the crosshair until the LED is of the required size. An LED will appear… this is the default setting for the LED, but it may be reconfigured to be the same as the one above, we will now go through the steps required to do this.
[bookmark: _Toc399642730][bookmark: _Toc457384143][bookmark: _Toc457386136][bookmark: _Toc457899355]Step 2.
We will now configure the Background Properties of the LED, Select the Background Tab and configure the fields as follows.
Bevel =10
BorderWidth =0
BevelInner =Lowered
BevelOuter =Raised
BackColor =Black

Click Apply
This gives the LED the Window Frame Style Effect.
[bookmark: _Toc399642731][bookmark: _Toc457384144][bookmark: _Toc457386137][bookmark: _Toc457899356]Step 3.
Now we will configure the Numeric Display Properties of the LED, select the General Tab and configure the fields as follows.

Digits =9
Decimals =1
DecimalPostion =0
Decimal Size =7
ItalicOffset =0
LeadingPlusMinus =Checked
Segments (pixels) =Width :4    Seperation :2.
Spacing (pixels) = Horizontal / Vertical: 5 / 5
Display Mode =Numeric

Click Apply.
[bookmark: _Toc399642732][bookmark: _Toc457384145][bookmark: _Toc457386138][bookmark: _Toc457899357]Step 4. 
Now that the LED has been configured we must now assign a channel to it, to do this right click on the LED and select Data Source Properties from the Pop-Up menu. Assign the channel we used in the last example to the LED, use this shape in conjunction with the Knob we made in a previous example to see the LED in action.
[bookmark: _Toc399642733][bookmark: _Toc457384146][bookmark: _Toc457386139][bookmark: _Toc457899358][bookmark: _Toc360531808][bookmark: _Toc408991039]
Percent
The Percent control is a versatile percentage interface used to indicate a level or progress.  Percent levels can be set directly by the user or indirectly by allowing the control to calculate them.  The user can define the number of percentage areas and shapes (bar, ellipse, tank, user-defined).  It is data-aware.
[image: percent]

[bookmark: _Toc457384147][bookmark: _Toc457386140][bookmark: _Toc457899359]
Miscellaneous
[image: ]
[bookmark: _Toc399642735][bookmark: _Toc457384148][bookmark: _Toc457386141][bookmark: _Toc457899360]Direction
Selects either a forward or backward fill direction for the control.
[bookmark: _Toc399642736][bookmark: _Toc457384149][bookmark: _Toc457386142][bookmark: _Toc457899361]Orientation
Determines whether the control is displayed horizontally or vertically.
[bookmark: _Toc399642737][bookmark: _Toc457384150][bookmark: _Toc457386143][bookmark: _Toc457899362]Display Mode
Determines if the control fills linearly or radially (pie).
[bookmark: _Toc399642738][bookmark: _Toc457384151][bookmark: _Toc457386144][bookmark: _Toc457899363]Percent Mode
Determines the mode, which is used to size displayed portions.
[bookmark: _Toc399642739][bookmark: _Toc457384152][bookmark: _Toc457386145][bookmark: _Toc457899364]Mouse Control
Determines the type of mouse input to the control.
[bookmark: _Toc399642740][bookmark: _Toc457384153][bookmark: _Toc457386146][bookmark: _Toc457899365]Start Angle
Determines the starting angle of portions displayed when DisplayMode is set to Radial (pie).
[bookmark: _Toc399642741][bookmark: _Toc457384154][bookmark: _Toc457386147][bookmark: _Toc457899366][bookmark: _Toc399642742]Min / Max
Sets or returns the maximum or minimum value for the percentage indicator.  The percentage caption displays the Percent property and is calculated by changing the Value property:
[bookmark: _Toc457384155][bookmark: _Toc457386148][bookmark: _Toc457899367]Portion Tab
[image: ]
[bookmark: _Toc457384156][bookmark: _Toc457386149][bookmark: _Toc457899368][bookmark: _Toc399642743]Portions
Determines the number of portions displayed on the control.  This property must be set before all other portion properties.  The PortionID property is used to select the portion to which other portion properties apply.
[bookmark: _Toc399642744][bookmark: _Toc457384157][bookmark: _Toc457386150][bookmark: _Toc457899369]Portion Color
Determines the color of the portion currently selected by PortionID.
[bookmark: _Toc399642745][bookmark: _Toc457384158][bookmark: _Toc457386151][bookmark: _Toc457899370]Portion Digital Color
Determines the color of the numeric value of the portion currently selected by PortionID.

Portion Digital X / Portion Digital Y
Determines the color of the numeric value of the portion currently selected by PortionID.
[bookmark: _Toc399642746][bookmark: _Toc457384159][bookmark: _Toc457386152][bookmark: _Toc457899371]PortionID
When multiple portions exist, PortionID is used to index the portion to which the other portion properties apply.  The total number of portions is determined by the Portions property and PortionID has valid values from 0 to Portions-1.
[bookmark: _Toc399642747][bookmark: _Toc457384160][bookmark: _Toc457386153][bookmark: _Toc457899372]Portion Percent
Determines the percent value of the portion currently selected by PortionID.
[bookmark: _Toc399642748][bookmark: _Toc457384161][bookmark: _Toc457386154][bookmark: _Toc457899373]PortionPicture
Determines the graphic to be displayed in the portion currently selected by PortionID.

[bookmark: _Toc399642749][bookmark: _Toc457384162][bookmark: _Toc457386155][bookmark: _Toc457899374]Portion Value
Determines the numeric value associated with the portion currently selected by PortionID.  The size of each portion is determined by the PortionValue and the PercentMode that is currently selected.

When PercentMode is set to 0 (Simple) or 1 (Percent), portion sizes are determined by setting PortionValue to a percentage value (0-100 %).

When PercentMode is set to 2 (Value), portion sizes are determined by setting PortionValue to a numeric value between Min and Max.


When PercentMode is set to 3 (Ratio), each portion's size is determined by the ratio of its PortionValue to the sum of PortionValues of all portions.
[bookmark: _Toc399642750][bookmark: _Toc457384163][bookmark: _Toc457386156][bookmark: _Toc457899375]Digital Format
Determines the format of the numbers associated with the control.  This format is similar to that used in C.  For example:
"%0.2f" = x.xx
"%0.0f %%"= xx %
"%0.3f Percent" = x.xxx Percent
[bookmark: _Toc399642751][bookmark: _Toc457384164][bookmark: _Toc457386157][bookmark: _Toc457899376]Digital Position
Determines the radius or offset position of the digital numeric value displayed when DigitalStyle is set to 2 (Floating).
[bookmark: _Toc399642752][bookmark: _Toc457384165][bookmark: _Toc457386158][bookmark: _Toc457899377]Note
See Generic Configuration Fields for information on Backgrounds Font and Frames
[bookmark: _Toc399642753][bookmark: _Toc457384166][bookmark: _Toc457386159][bookmark: _Toc457899378][bookmark: _Toc360531809][bookmark: _Toc408991040]
Drawing a Percent Control Example
We will now go through an example of drawing a Percentage Gauge similar to the one below.

[image: percentexample]
[bookmark: _Toc399642754][bookmark: _Toc457384167][bookmark: _Toc457386160][bookmark: _Toc457899379]Step 1.
[image: percenticon]
After the Overlay has been installed run the configurable monitor, open a new monitor Document. Click on the icon for the Percentage Gauge, a crosshair will appear. Click and hold the mouse button and drag the crosshair until the Percentage Gauge is of the required size. A Percentage Gauge will appear… this is the default setting for the Percentage Gauge, but it may be reconfigured to be the same as the one above, we will now go through the steps required to do this.

[bookmark: _Toc399642755][bookmark: _Toc457384168][bookmark: _Toc457386161][bookmark: _Toc457899380]Step 2. 
We will now configure the shape of the percentage gauge, let us make it “tank” shaped. Select the Frame tab and configure the fields as follows:
Frame Style =User Defined
Color =Black
Frame Coordinates:
Top =0.05
Bottom =0.95
Right =0.95
Left = 0.05
User Defined = 0,200,200,0,800,0,1000,200,1000,800,800,1000,200,1000,0,800
[bookmark: _Toc399642756][bookmark: _Toc457384169][bookmark: _Toc457386162][bookmark: _Toc457899381]Step 3.
We will now configure the Portions; select the portions tab and configure the fields as follows.
Portions =1
PortionID = 0
PortionColor =Bright Green
Digital Style =Fixed
DigitalFormat=%0.1f%%
PortionDigitalColor =Red
[bookmark: _Toc399642757][bookmark: _Toc457384170][bookmark: _Toc457386163][bookmark: _Toc457899382]Step 4.
We will now configure the orientation and direction of the percentage gauge, we want this to fill from the bottom up so select the Misc.  Tab and configure the fields as follows.

Direction =Backward
Orientation =Vertical
Display Mode =Linear
PercentMode =Percent
MouseControl –Snap To
Start Angle =0
(Note we will be using this percentage gauge with the channel as used with the other examples therefore the max value will be 10)
Min =0
Max =10
[bookmark: _Toc399642758][bookmark: _Toc457384171][bookmark: _Toc457386164][bookmark: _Toc457899383]Step 5.
We will now configure the Outline and Background Color of the percentage gauge, select the Background Tab and configure the fields as follows.
BevelWidth =2
BoderWidth =2
BevelInner =None
BevelOuter =Lowered
[bookmark: _Toc399642759][bookmark: _Toc457384172][bookmark: _Toc457386165][bookmark: _Toc457899384]Step 6.
Now that the Percentage Gauge has been configured we must assign it a data channel, use the channel from the previous examples, by right clicking on the percentage gauge and selecting Data Source Properties form the Pop-Up box, and select the channel from the list available.

[bookmark: _Toc399642760][bookmark: _Toc457384173][bookmark: _Toc457386166][bookmark: _Toc457899385][bookmark: _Toc360531810][bookmark: _Toc408991041]
Selectors
[bookmark: _Toc399642761][bookmark: _Toc457384174][bookmark: _Toc457386167][bookmark: _Toc457899386]Description
The Selector control is a knob-style control that can be used to choose between discrete options. It can be used as a replacement for option buttons and provides the user with an easy-to-use and intuitive mouse input.

[image: selectors]
[bookmark: _Toc399642762][bookmark: _Toc457384175][bookmark: _Toc457386168][bookmark: _Toc457899387]
Captions
The control can be embellished with multiple captions to indicate the type of measurement being displayed, units used or any other informative or decorative labeling.  These captions are in no way related to the captions defined for each selection.

[image: ]
[bookmark: _Toc399642763][bookmark: _Toc457384176][bookmark: _Toc457386169][bookmark: _Toc457899388]Caption
Determines the text displayed on the control for the caption currently selected by CaptionID.  The number of captions displayed is set by the Captions property.
[bookmark: _Toc399642764][bookmark: _Toc457384177][bookmark: _Toc457386170][bookmark: _Toc457899389]Color
Determines the text color for the caption currently selected by CaptionID.
[bookmark: _Toc399642765][bookmark: _Toc457384178][bookmark: _Toc457386171][bookmark: _Toc457899390]Flag
Determines if the caption currently selected by CaptionID is drawn in the control's static or dynamic buffer.
[bookmark: _Toc399642766][bookmark: _Toc457384179][bookmark: _Toc457386172][bookmark: _Toc457899391]FontID
Determines which font is used for the caption currently selected by CaptionID.
[bookmark: _Toc399642767][bookmark: _Toc457384180][bookmark: _Toc457386173][bookmark: _Toc457899392]CaptionID
When multiple captions exist, CaptionID is used to index the caption to which the other caption properties apply.  The total number of captions is determined by the Captions property and CaptionID has valid values from 0 to Captions-1.
[bookmark: _Toc399642768][bookmark: _Toc457384181][bookmark: _Toc457386174][bookmark: _Toc457899393]Captions
Determines the number of captions displayed on the control.  This property must be set before all other caption properties.  The CaptionID property is used to select the caption to which caption properties apply.

[bookmark: _Toc399642769][bookmark: _Toc457384182][bookmark: _Toc457386175][bookmark: _Toc457899394]Caption X / Y Position
Determines the vertical and horizontal positions of the caption currently selected by the CaptionID property.  These properties are based on a unitless scale and typically have values between -1.0 and 1.0 where a value of 0.0 is located at the center of the control.
[bookmark: _Toc399642770][bookmark: _Toc457384183][bookmark: _Toc457386176][bookmark: _Toc457899395]Knob
There are several styles of knobs that may be used in the selector switch control.  Properties are provided to modify the knob's style, inner-outer radii, width, and color.  Additionally, user defined shapes may be specified.

[image: ]
[bookmark: _Toc399642771][bookmark: _Toc457384184][bookmark: _Toc457386177][bookmark: _Toc457899396]KnobColor
Determines the color of the control's knob.
[bookmark: _Toc399642772][bookmark: _Toc457384185][bookmark: _Toc457386178][bookmark: _Toc457899397]KnobOffsetX / KnobOffsetY
Determines the vertical and horizontal positions of the knob's center.  These properties are based on a unitless scale and typically have values between -1.0 and 1.0, where a value of 0.0 is located in the center of the instrument.
[bookmark: _Toc399642773][bookmark: _Toc457384186][bookmark: _Toc457386179][bookmark: _Toc457899398]Knob Picture
Determines the graphic to be displayed as the knob.  Unlike knobs, which are defined using the KnobStyle property, a knob defined by a picture does not rotate.  Rotating the knob’s mark simulates the rotating effect.
[bookmark: _Toc399642774][bookmark: _Toc457384187][bookmark: _Toc457386180][bookmark: _Toc457899399]KnobRadius 
Determines the outer radius of the knob.  This property is based on a unitless scale and typically has values between 0.0 and 1.0.
[bookmark: _Toc399642775][bookmark: _Toc457384188][bookmark: _Toc457386181][bookmark: _Toc457899400]Knob Style
Determines the style of the knob.

[bookmark: _Toc399642776][bookmark: _Toc457384189][bookmark: _Toc457386182][bookmark: _Toc457899401]Knob User-Defined
Determines the shape of a user-defined knob or mark.  This property only applies when KnobStyle = 4 (for knobs) or when MarkStyle=4 (for marks).  This property defines a polygon made from a list of x, y coordinate pairs (comma delimited).  The shape is defined using a coordinate system in which (0,0) is located at the center of the knob and the "pointer" of the knob (or tip of the mark) is typically defined as (0,1000).
[bookmark: _Toc399642777][bookmark: _Toc457384190][bookmark: _Toc457386183][bookmark: _Toc457899402]Mouse Control
Determines the type of mouse input to the control.
[bookmark: _Toc399642778][bookmark: _Toc457384191][bookmark: _Toc457386184][bookmark: _Toc457899403]Mark
Each knob may be adorned with a single mark.  Properties are provided to modify the mark's style, inner-outer radii, width, and color.  Additionally, user defined mark shapes may be incorporated into the control.

[image: ]
[bookmark: _Toc399642779][bookmark: _Toc457384192][bookmark: _Toc457386185][bookmark: _Toc457899404]MarkColor
Determines the knob mark's color.
[bookmark: _Toc399642780][bookmark: _Toc457384193][bookmark: _Toc457386186][bookmark: _Toc457899405]MarkInnerRadius / MarkOuterRadius
Determines the inner and outer radii of the knob's mark.  The scale of these properties is based on the knob's size. For example, an inner radius of 0.0 and an outer radius of 1.0 yields a mark from the knob's center to its outer edge.
[bookmark: _Toc399642781][bookmark: _Toc457384194][bookmark: _Toc457386187][bookmark: _Toc457899406]MarkPicture
Determines the graphic to be displayed as the mark on the control's knob.
[bookmark: _Toc399642782][bookmark: _Toc457384195][bookmark: _Toc457386188][bookmark: _Toc457899407]MarkStyle
Determines the style of the knob's mark.
[bookmark: _Toc399642783][bookmark: _Toc457384196][bookmark: _Toc457386189][bookmark: _Toc457899408]MarkWidth
Determines the width of the knob's mark.  This property is based on a unitless scale and typically has values between 0.0 and 1.0.
[bookmark: _Toc457384197][bookmark: _Toc457386190][bookmark: _Toc457899409]MarkUserDefined
Determines the shape of a user-defined knob or mark.  This property only applies when KnobStyle = 4 (for knobs) or when MarkStyle=4 (for marks).  This property defines a polygon made from a list of x, y coordinate pairs (comma delimited).  The shape is defined using a coordinate system in which (0,0) is located at the center of the knob and the "pointer" of the knob (or tip of the mark) is typically defined as (0,1000).
[bookmark: _Toc399642784][bookmark: _Toc457384198][bookmark: _Toc457386191][bookmark: _Toc457899410]Selections
Each switch may have several possible selections.  The user controls the caption, color, alignment, and offset of each selection.  Additionally, there are automatic features that define the control with minimal work required.

[image: ]
[bookmark: _Toc399642785][bookmark: _Toc457384199][bookmark: _Toc457386192][bookmark: _Toc457899411]SelectionAlign
Sets the justification of the selection's caption currently specified by SelectionID.
[bookmark: _Toc399642786][bookmark: _Toc457384200][bookmark: _Toc457386193][bookmark: _Toc457899412]SelectionAngle
Determines the angle (zero is north, positive clockwise) of the selection currently specified by SelectionID.  If AutoAngle=TRUE, this property is ignored.
[bookmark: _Toc399642787][bookmark: _Toc457384201][bookmark: _Toc457386194][bookmark: _Toc457899413]SelectionCaption
Determines the text displayed for the selection specified by SelectionID.  The number of selections displayed on the control is set by the Selections property.
[bookmark: _Toc399642788][bookmark: _Toc457384202][bookmark: _Toc457386195][bookmark: _Toc457899414]Color
Determines the color of the SelectionCaption (and its associated line) currently specified by SelectionID.
[bookmark: _Toc399642789][bookmark: _Toc457384203][bookmark: _Toc457386196][bookmark: _Toc457899415]FontID
Determines which font is used in the caption for the selection currently specified by SelectionID.
[bookmark: _Toc399642790][bookmark: _Toc457384204][bookmark: _Toc457386197][bookmark: _Toc457899416]Selections
Determines the number of selections displayed on the control.  This property must be set before all other selection properties.  The SelectionID property is used to choose the selection to which the selection properties apply.

[bookmark: _Toc399642791][bookmark: _Toc457384205][bookmark: _Toc457386198][bookmark: _Toc457899417]SelectionID
When multiple selections exist, SelectionID is used to index the selection to which the other selection properties apply.  The total number of selections is determined by the Selections property and SelectionID has valid values from 0 to Selections-1.
[bookmark: _Toc399642792][bookmark: _Toc457384206][bookmark: _Toc457386199][bookmark: _Toc457899418]SelectionOffset X / Y
Defines an (x, y) pair that is used to determine the length of the offset (when AutoOffset=FALSE) of the current selection defined by SelectionID.  If the LineDisplay=TRUE, then there is an (x, y) pair that is defined by SelectionAngle and SelectionRadius.  This point is shown below as a red dot.  The control uses SelectionOffsetX and SelectionOffsetY to define an additional (x, y) pair relative to the first pair (shown as a blue dot).  These two points define the line that is drawn as the offset.  These properties are based on a unitless scale and typically have values between -1.0 and 1.0.
[bookmark: _Toc399642793][bookmark: _Toc457384207][bookmark: _Toc457386200][bookmark: _Toc457899419]Selection Radius
Determines the radius (from the center of the selector) at which the labels are displayed for the current selection (specified by SelectionID).  This property is based on a unitless scale and typically has values between 0.0 and 1.0.  Additionally, the SelectionOffsetX and SelectionOffsetY properties (if AutoOffset=FALSE) may be used to modify the label location in order to increase readability or for purely cosmetic reasons.
[bookmark: _Toc399642794][bookmark: _Toc457384208][bookmark: _Toc457386201][bookmark: _Toc457899420]Highlight
Determines whether the selection's original color is altered to HighlightColor when it is selected.
[bookmark: _Toc399642795][bookmark: _Toc457384209][bookmark: _Toc457386202][bookmark: _Toc457899421]Highlight Color
Determines the color of the currently designated selection's line and caption.

[bookmark: _Toc399642796][bookmark: _Toc457384210][bookmark: _Toc457386203][bookmark: _Toc457899422]Auto
[image: ]
[bookmark: _Toc399642797][bookmark: _Toc457384211][bookmark: _Toc457386204][bookmark: _Toc457899423]AutoAlign
Determines whether the selection caption alignment is controlled manually or automatically.  If AutoAlign=TRUE, then the control will automatically right justify all selections on the left of the control, left justify all selections on the right of the control, and center all selections at the top and bottom of the control.  If, however, AutoAlign=FALSE, the user must enter the desired justification for each individual selection using the SelectionAlign property.
[bookmark: _Toc399642798][bookmark: _Toc457384212][bookmark: _Toc457386205][bookmark: _Toc457899424]Autoangle
Determines whether the selection angles are controlled manually or automatically.  If AutoAngle=TRUE then the control will evenly space the selected number of Selections between the angular extremes of the control as defined by the AutoStartAngle and AutoStopAngle properties.  If, however, AutoAngle=FALSE, the user must enter the desired angle for each individual selection using the SelectionID and SelectionAngle properties.
[bookmark: _Toc399642799][bookmark: _Toc457384213][bookmark: _Toc457386206][bookmark: _Toc457899425]AutoAngleConfine
Determines if the knob can be rotated outside of the extents defined by AutoStartAngle and AutoStopAngle.
[bookmark: _Toc399642800][bookmark: _Toc457384214][bookmark: _Toc457386207][bookmark: _Toc457899426]AutoOffset
Determines whether the selection caption offset is controlled manually or automatically.  If AutoOffset=TRUE then the control will use the AutoOffsetStyle and AutoOffsetDistance properties to draw the control.  If, however, AutoOffset=FALSE, the user must enter the desired offsets for each individual selection using the SelectionID, SelectionOffsetX and SelectionOffsetY properties.
[bookmark: _Toc399642801][bookmark: _Toc457384215][bookmark: _Toc457386208][bookmark: _Toc457899427]AutoOffsetDistance
Determines the length of the offset (from the control's center) when AutoOffsetStyle is not zero.  This property is based on a unitless scale and typically has values between 0.0 and 1.0.  If the AutoOffsetStyle=0 then this property has no effect on the control.  If AutoOffsetStyle is not zero, however, than a line is drawn either horizontally or vertically using the appropriate distance.
[bookmark: _Toc399642802][bookmark: _Toc457384216][bookmark: _Toc457386209][bookmark: _Toc457899428]AutoOffsetStyle
Sets the type of offset for all selections.
[bookmark: _Toc399642803][bookmark: _Toc457384217][bookmark: _Toc457386210][bookmark: _Toc457899429]AutoRadius
Determines the radius (from the center of the knob) at which the labels are displayed.  This property is based on a unitless scale and typically has values between 0.0 and 1.0.  Additionally, the AutoOffsetDistance (if AutoOffset=TRUE) may be used to modify the label location in order to increase readability or for purely cosmetic reasons.
[bookmark: _Toc399642804][bookmark: _Toc457384218][bookmark: _Toc457386211][bookmark: _Toc457899430]AutoStartAngle / AutoStopAngle
Determines the angular extremes of the selector switch.  These properties are ignored when AutoAngle=FALSE.
[bookmark: _Toc399642805][bookmark: _Toc457384219][bookmark: _Toc457386212][bookmark: _Toc457899431]Line Display
Determines whether the lines to each selection are shown.
[bookmark: _Toc399642806][bookmark: _Toc457384220][bookmark: _Toc457386213][bookmark: _Toc457899432]Line Inner Radius
Determines the inner radius of the lines to each selection.  This property is based on a unitless scale and typically has values between 0.0 and 1.0.
[bookmark: _Toc399642807][bookmark: _Toc457384221][bookmark: _Toc457386214][bookmark: _Toc457899433]Line Thickness
Determines the thickness of the line(s) on the control.  This property is measured in pixels.
[bookmark: _Toc399642808][bookmark: _Toc457384222][bookmark: _Toc457386215][bookmark: _Toc457899434]Note
See Generic Configuration Fields for information on Background Fonts and Frame.

[bookmark: _Toc399642809][bookmark: _Toc457384223][bookmark: _Toc457386216][bookmark: _Toc457899435][bookmark: _Toc360531811][bookmark: _Toc408991042]
Drawing a Selector Example
We will now go through an example of drawing a Selector similar to the one below.
[image: selectorexample]
[bookmark: _Toc399642810][bookmark: _Toc457384224][bookmark: _Toc457386217][bookmark: _Toc457899436]Step 1.
[image: selectoricon]
After the Overlay has been installed run the configurable monitor, open a new monitor Document. Click on the icon for the Selector, a crosshair will appear. Click and hold the mouse button and drag the crosshair until the Selector is of the required size. A Selector will appear… this is the default setting for the Selector, but it may be reconfigured to be the same as the one above, we will now go through the steps required to do this.
[bookmark: _Toc399642811][bookmark: _Toc457384225][bookmark: _Toc457386218][bookmark: _Toc457899437]Step 2.
Now we will configure the Selections available to the user. We will need Two selections one for on and one for off so set the Selections value to be equal to two. Let us configure the first selection, select the Selections tab, and set the Selections field to be equal to 2, then set the SelectionsID to be 0 and configure the fields as follows.
SelectionAlign =Right
Color =Black
SelectionAngle =210
SelectionOffsetX =-0.60
SelectionOffsetY =0.00
SelectionRadius =0.80
Caption =OFF
Highlight Selection = ON
Highlight Color = Red

Now we will configure the second selection. Set the SelectionsID to be equal to 1 and configure the fields as follows.
SelectionAlign =Right
Color =Black
SelectionAngle =330
SelectionOffsetX =-0.60
SelectionOffsetY =0.00
SelectionRadius =0.80
Caption =OFF
Highlight Selection = ON
Highlight Color = Red
[bookmark: _Toc399642812][bookmark: _Toc457384226][bookmark: _Toc457386219][bookmark: _Toc457899438]Step 3.
Now we will configure the Knob, select the knob tab and configure the fields as follows:
KnobColor =Black
KnobRadius =0.65
KnobOffsetX =0.00
KnobOffsetY =0.00
KnobStyle =Complex
MouseControl =Snap To
[bookmark: _Toc399642813][bookmark: _Toc457384227][bookmark: _Toc457386220][bookmark: _Toc457899439]Step 4. 
Now we will configure the Mark, select the mark tab and configure the fields as follows :
MarkColor =Red
MarkInnerRadius =0.50
MarkOuterRadius =0.80
MarkWidth =0.40
MarkStyle =Triangle
[bookmark: _Toc399642814][bookmark: _Toc457384228][bookmark: _Toc457386221][bookmark: _Toc457899440]Step 5.
Now that the selector is configured we must assign a channel to it; this will be a switch for a digital channel so configure a digital channel in the applications main menu. Now return to the monitor, right click on the selector and select Data Source Properties from the main menu and assign the digital channel you just configured to the selector.


[bookmark: _Toc457384229][bookmark: _Toc457386222][bookmark: _Toc457899441][bookmark: _Toc360531812][bookmark: _Toc408991043]
Sliders
[bookmark: _Toc399642815][bookmark: _Toc457384230][bookmark: _Toc457386223][bookmark: _Toc457899442]Description
The Slider control is a versatile input/output tool used to create sliders gauges meters, etc. that incorporate a sliding mechanism.  It uses dynamic property pages for easy design of unique sliding displays in short time.  Its mouse control and data-aware features make it an ideal element for technical interfaces.

[bookmark: _Toc399642816][bookmark: _Toc457384231][bookmark: _Toc457386224][bookmark: _Toc457899443][image: sliders]Bars
The slider bar properties allow the user to manipulate the On/Off characteristics of the slider separately.  Colors or bitmaps may be used to fill the ON or OFF bar area.  Also, the orientation, width, border, and position of the bar can be controlled through properties.
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[bookmark: _Toc399642817][bookmark: _Toc457384232][bookmark: _Toc457386225][bookmark: _Toc457899444]Bar Inner / Outer
If the Orientation property is set to horizontal, then these properties determine the top and bottom extents of the slider as shown in the figure below.  If the Orientation property is set to vertical, then they determine the left and right extents of the slider.  These properties are based on a unitless scale and typically have values between 0.0 and 1.0.
[bookmark: _Toc399642818][bookmark: _Toc457384233][bookmark: _Toc457386226][bookmark: _Toc457899445]Bar Start / Stop
If the Orientation property is set to horizontal, then these properties determine the border sizes along the left and right sides of the slider as shown in the figure below.  If the Orientation property is set to vertical, then they determine the border sizes along the top and bottom of the slider.  This creates space on the control for captions, tics, etc.  These properties are based on a unitless scale and typically have values between 0.0 and 1.0.
[bookmark: _Toc399642819][bookmark: _Toc457384234][bookmark: _Toc457386227][bookmark: _Toc457899446]Bar Shape
Defines the Shape of the Bar, may be user defined.

[bookmark: _Toc399642820][bookmark: _Toc457384235][bookmark: _Toc457386228][bookmark: _Toc457899447]
Knob
There are also properties available to manipulate the knob's appearance.  Knob properties exist for scaling, offset, color, shape, and bitmap.
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[bookmark: _Toc399642821][bookmark: _Toc457384236][bookmark: _Toc457386229][bookmark: _Toc457899448]Color
Determines the color of the control's knob.
[bookmark: _Toc399642822][bookmark: _Toc457384237][bookmark: _Toc457386230][bookmark: _Toc457899449]Inner / Outer Value
Determines the inner and outer extents of the control's knob.  These properties are based on a unitless scale and typically have values between 0.0 and 1.0.
[bookmark: _Toc399642823][bookmark: _Toc457384238][bookmark: _Toc457386231][bookmark: _Toc457899450]Picture
Determines the graphic to be displayed as the knob.  Unlike knobs, which are defined using the KnobStyle property, a knob defined by a picture does not rotate.
[bookmark: _Toc399642824][bookmark: _Toc457384239][bookmark: _Toc457386232][bookmark: _Toc457899451]Style
Sets or returns the style of the knob.
[bookmark: _Toc399642825][bookmark: _Toc457384240][bookmark: _Toc457386233][bookmark: _Toc457899452]User Defined.
Determines the shape of a user-defined knob.  This property only applies when KnobStyle is set to "User Defined Shape".  This property defines a polygon made from a list of x, y coordinate pairs (comma delimited).  The shape is defined using a coordinate system in which the origin is located at the upper, left corner of the area defined by BarInner, BarOuter and KnobWidth.

[bookmark: _Toc399642826][bookmark: _Toc457384241][bookmark: _Toc457386234][bookmark: _Toc457899453]Width
Determines the width of the control's knob.  This property is based on a unitless scale and typically has values between 0.0 and 1.0.
[bookmark: _Toc399642827][bookmark: _Toc457384242][bookmark: _Toc457386235][bookmark: _Toc457899454]Mouse Control
Determines the type of mouse input to the control.

[bookmark: _Toc399642828][bookmark: _Toc457384243][bookmark: _Toc457386236][bookmark: _Toc457899455]Tics
Tic properties were set up in an array fashion.  The user can place as many sets of tic marks on any slider control as he likes.  Each set of tic marks can be adjusted with color, increment, start and stop value, size, and placement.

[image: ]
[bookmark: _Toc399642829][bookmark: _Toc457384244][bookmark: _Toc457386237][bookmark: _Toc457899456]Color
Determines the color for the tic set currently selected by TicID.
[bookmark: _Toc399642830][bookmark: _Toc457384245][bookmark: _Toc457386238][bookmark: _Toc457899457]Delta
Determines the interval value between tic marks for the tic set currently selected by TicID.
[bookmark: _Toc399642831][bookmark: _Toc457384246][bookmark: _Toc457386239][bookmark: _Toc457899458]FontID
Determines which font is used for the labels of the tic set currently selected by TicID.
[bookmark: _Toc399642832][bookmark: _Toc457384247][bookmark: _Toc457386240][bookmark: _Toc457899459]TicID
When multiple tic sets exist, TicID is used to index the tic sets to which the other tic properties apply.  The total number of tic sets is determined by the Tics property and TicID has valid values from 0 to Tics-1.
[bookmark: _Toc399642833][bookmark: _Toc457384248][bookmark: _Toc457386241][bookmark: _Toc457899460]Inner / Outer
Determines the inner and outer extents of the tic set currently selected by TicID.  These properties are based on a unitless scale and typically have values between 0.0 and 1.0.
[bookmark: _Toc399642834][bookmark: _Toc457384249][bookmark: _Toc457386242][bookmark: _Toc457899461]Label On
Enables or disables labels at each tic mark for the tic set currently selected by TicID.  The position of the tic labels is defined by the TicLabelPosition property.

[bookmark: _Toc399642835][bookmark: _Toc457384250][bookmark: _Toc457386243][bookmark: _Toc457899462]Label Postion
Sets or returns the position where labels are displayed for the tic set currently selected by TicID.  This property is based on a unitless scale and typically has values between 0.0 and 1.0.
[bookmark: _Toc399642836][bookmark: _Toc457384251][bookmark: _Toc457386244][bookmark: _Toc457899463]Tics
Determines the number of tic sets displayed on the control.  This property must be set before all other tic properties.  The TicID property is used to select the tic set to which tic properties apply.
[bookmark: _Toc399642837][bookmark: _Toc457384252][bookmark: _Toc457386245][bookmark: _Toc457899464]Tics Shape
Determines the shape of a user defined tic set.  This property only applies when TicStyle is set to "User Defined" and defines a polygon made from a list of x,y coordinate pairs.  The shape is defined using a coordinate system in which (0,0) is located at the upper, left corner of the area defined by the tic size parameters (TicWidth, etc.).
[bookmark: _Toc399642838][bookmark: _Toc457384253][bookmark: _Toc457386246][bookmark: _Toc457899465]TicStart / Stop
Determines the values at which the tic marks start and stop for the tic set currently selected by TicID.  These values are numbers between Min and Max.
[bookmark: _Toc399642839][bookmark: _Toc457384254][bookmark: _Toc457386247][bookmark: _Toc457899466]TicStyle
Determines the style of the tic set currently selected by TicID.
[bookmark: _Toc399642840][bookmark: _Toc457384255][bookmark: _Toc457386248][bookmark: _Toc457899467]TicWidth
Determines the width of the tic marks for the tic set currently selected by TicID.  This property is based on a unitless scale and typically has values between 0.0 and 1.0.
[bookmark: _Toc399642841][bookmark: _Toc457384256][bookmark: _Toc457386249][bookmark: _Toc457899468]Note
[bookmark: _Toc399642842][bookmark: _Toc457384257][bookmark: _Toc457386250][bookmark: _Toc457899469]See Generic Configuration Fields for Information On Background Digital and Fonts.
Drawing a Slider Example
We will now go through the steps to draw a slider, similar to the one below.

[image: sliderexample]
[bookmark: _Toc399642843][bookmark: _Toc457384258][bookmark: _Toc457386251][bookmark: _Toc457899470]Step 1.
[image: slidericon]
After the Overlay has been installed run the configurable monitor, open a new monitor Document. Click on the icon for the Slider, a crosshair will appear. Click and hold the mouse button and drag the crosshair until the Slider is of the required size. A Slider will appear… this is the default setting for the Slider, but it may be reconfigured to be the same as the one above, we will now go through the steps required to do this.
[bookmark: _Toc399642844][bookmark: _Toc457384259][bookmark: _Toc457386252][bookmark: _Toc457899471]Step 2.
First we will configure the Bar…. Select the Bar tabs and configure the fields as follows:
BarInner =0.04
BarOuter =0.36
BarStart =0.04
BarStop =0.95
BarShape =Rectangular
ONColor =Grey
OffColour =White
[bookmark: _Toc399642845][bookmark: _Toc457384260][bookmark: _Toc457386253][bookmark: _Toc457899472]Step 3.
We will now configure the general options, select the general tab and configure the fields as follows.
Min Value =0
Max Value =10
Value =0
Orientation =Vertical
Direction =Backward
[bookmark: _Toc399642846][bookmark: _Toc457384261][bookmark: _Toc457386254][bookmark: _Toc457899473]Step 4. 
Now we will configure the knob, select the knob tab and configure the fields as follows.
MouseControl =Snap To
Style =Rectangular
Width =0.02
InnerValue =0.20
OuterValue =0.80
Color =Red
[bookmark: _Toc399642847][bookmark: _Toc457384262][bookmark: _Toc457386255][bookmark: _Toc457899474]Step 5 
Now we will configure the tics for the slider, select the tics tabs and do the following. We need to sets of tics so set the Tics Field to be 2, let us configure the first field. Set the TicID field to be 0 and configure the fields as follows.

Style =Rectangular
Label =On
Position =0.90
Inner =0.40
Outer =0.80
Width =0.000
Startvalue =0
StopValue =100
DeltaValue =10

Now set the TicID to be 1 and configure the fields as follows:

Style =Rectangular
Label =Off
Position =0.90
Inner =0.40
Outer =0.60
Width =0.000
Startvalue =0
StopValue =100
DeltaValue =2
[bookmark: _Toc399642848][bookmark: _Toc457384263][bookmark: _Toc457386256][bookmark: _Toc457899475]Step 6.
Now that the slider is configured we must assign a channel to it. Configure an analogue channel and a ssign it to the slider by right clicking on the slider and selecting data source properties.
[bookmark: _Toc399642849][bookmark: _Toc457384264][bookmark: _Toc457386257][bookmark: _Toc457899476][bookmark: _Toc360531813][bookmark: _Toc408991044]
Toggle
[bookmark: _Toc399642850][bookmark: _Toc457384265][bookmark: _Toc457386258][bookmark: _Toc457899477]Description
The Toggle Switch control is a TRUE/FALSE, YES/NO, or ON/OFF indicator.  It displays either captions or pictures to represent the switch’s state.  It has sound playing capabilities to indicate the switch turning on or off and timers to provide automatic cut off and blinking to draw attention to the control.
[bookmark: _Toc457384266][bookmark: _Toc457386259][bookmark: _Toc457899478][bookmark: _Toc399642851][image: toggles]OffBackColor Property/ OffForeColor Property / OnBackColor Property / OnForeColor Property
Determines the background or foreground color of the control in its ON (Value=TRUE) or OFF (Value=FALSE) states.
[bookmark: _Toc399642852][bookmark: _Toc457384267][bookmark: _Toc457386260][bookmark: _Toc457899479]OffCaption/ OnCaption
Determines the text displayed on the control in its ON (Value=TRUE) or OFF (Value=FALSE) states.  If a ? is placed at the end of the ON or OFF caption the user will be asked for confirmation before the value is changed.
[bookmark: _Toc399642853][bookmark: _Toc457384268][bookmark: _Toc457386261][bookmark: _Toc457899480]Off Picture / On Picture
Determines the graphic to be displayed in the control's ON (Value=TRUE) or OFF (Value=FALSE) states.
[bookmark: _Toc399642854][bookmark: _Toc457384269][bookmark: _Toc457386262][bookmark: _Toc457899481]OffWave / OnWave
Determines the wave file (*.wav) to be played in the control's ON (Value=TRUE) or OFF (Value=FALSE) states.
[bookmark: _Toc399642855][bookmark: _Toc457384270][bookmark: _Toc457386263][bookmark: _Toc457899482]OffX Property / OffY Property / OnX Property  / OnY Property
 Defines the horizontal or vertical offset (in pixels) of the caption from the center of the control for both the ON (Value=TRUE) or OFF (Value=
FALSE) states.  These properties only apply when OffPicture or OnPicture are not defined.
[bookmark: _Toc399642856][bookmark: _Toc457384271][bookmark: _Toc457386264][bookmark: _Toc457899483]Ontimer
Determines how long (in milliseconds) the toggle control will remain "On" (Value=TRUE).
[bookmark: _Toc399642857][bookmark: _Toc457384272][bookmark: _Toc457386265][bookmark: _Toc457899484]Note
See Generic Configuration Fields For Information on Background, Fonts and General.
[bookmark: _Toc457384273][bookmark: _Toc457386266][bookmark: _Toc457899485][bookmark: _Toc360531814][bookmark: _Toc408991045]
[image: toggleexample]Drawing a Toggle Example.

[bookmark: _Toc399642859][bookmark: _Toc457384274][bookmark: _Toc457386267][bookmark: _Toc457899486]Step 1.
[image: toggleicon]
After the Overlay has been installed run the configurable monitor, open a new monitor Document. Click on the icon for the Toggle, a crosshair will appear. Click and hold the mouse button and drag the crosshair until the Toggle is of the required size. A Slider will appear… this is the default setting for the Toggle, There are not too many fields for the toggle, play around with them and you should get a feel for them. 
[bookmark: _Toc399642860][bookmark: _Toc457384275][bookmark: _Toc457386268][bookmark: _Toc457899487][bookmark: _Toc360531815][bookmark: _Toc408991046]
Led’s
[bookmark: _Toc399642861][bookmark: _Toc457384276][bookmark: _Toc457386269][bookmark: _Toc457899488]Description
LED provides a highly customizable Light-Emitting Diode (LED) interface.  Its dynamic property pages provide full control of the LED’s size, shape, colors and bitmaps.  Horizontal or vertical arrays of LEDs may be used to display meter levels or dip switch settings.  With its data-aware and mouse input features, LED is an ideal element for technical interfaces.
[image: LEDs]

[bookmark: _Toc399642862][bookmark: _Toc457384277][bookmark: _Toc457386270][bookmark: _Toc457899489]
LED’s /General
[image: ]
[bookmark: _Toc399642863][bookmark: _Toc457384278][bookmark: _Toc457386271][bookmark: _Toc457899490]NumLEDs
Determines the number of LEDs to be used.
[bookmark: _Toc399642864][bookmark: _Toc457384279][bookmark: _Toc457386272][bookmark: _Toc457899491]LEDIndex
Determines the Index of the LED currently Being configured
[bookmark: _Toc399642865][bookmark: _Toc457384280][bookmark: _Toc457386273][bookmark: _Toc457899492]LEDStyleID
Determines the style of the currently selected LED
[bookmark: _Toc399642866][bookmark: _Toc457384281][bookmark: _Toc457386274][bookmark: _Toc457899493]Value
Determines the Value of the Current LED
[bookmark: _Toc399642867][bookmark: _Toc457384282][bookmark: _Toc457386275][bookmark: _Toc457899494]MouseControl
Determines Whether Mouse Control is to be used or not
[bookmark: _Toc399642868][bookmark: _Toc457384283][bookmark: _Toc457386276][bookmark: _Toc457899495]Mode
Select the Mode of the LED
[bookmark: _Toc399642869][bookmark: _Toc457384284][bookmark: _Toc457386277][bookmark: _Toc457899496]Direction
Selects the Direction on which the LED lights up.
[bookmark: _Toc399642870][bookmark: _Toc457384285][bookmark: _Toc457386278][bookmark: _Toc457899497]Orientation
Selects the Orientation of the LED

[bookmark: _Toc399642871][bookmark: _Toc457384286][bookmark: _Toc457386279][bookmark: _Toc457899498]AutoSize
Selects the Way in which the LEDs are Auto-sized.
[bookmark: _Toc399642872][bookmark: _Toc457384287][bookmark: _Toc457386280][bookmark: _Toc457899499]LEDWidth
Determines the Width of a single LED
[bookmark: _Toc399642873][bookmark: _Toc457384288][bookmark: _Toc457386281][bookmark: _Toc457899500]LEDHeight
Determines the Height of a single LED
[bookmark: _Toc399642874][bookmark: _Toc457384289][bookmark: _Toc457386282][bookmark: _Toc457899501]LEDSeperation
Determines the space between each LED
[bookmark: _Toc399642875][bookmark: _Toc457384290][bookmark: _Toc457386283][bookmark: _Toc457899502]MaxDecay
Determines the Max Decay
[bookmark: _Toc399642876][bookmark: _Toc457384291][bookmark: _Toc457386284][bookmark: _Toc457899503]DecayRate
Determines the Decay Rate of the LED.

[bookmark: _Toc399642877][bookmark: _Toc457384292][bookmark: _Toc457386285][bookmark: _Toc457899504]
Drawing and LED Example.
As with the toggle, there aren’t many fields to be configured. Draw the default LED and play around with the fields to get a feel for them.


[bookmark: _Toc399642878][bookmark: _Toc457384293][bookmark: _Toc457386286][bookmark: _Toc457899505][bookmark: _Toc360531816][bookmark: _Toc408991047]
Navigation Buttons
[bookmark: _Toc399642879][bookmark: _Toc457384294][bookmark: _Toc457386287][bookmark: _Toc457899506]Description
[image: buttons]A Navigation button is an on/off Toggle used to launch other monitors from the one you are currently using.

[bookmark: _Toc399642880][bookmark: _Toc457384295][bookmark: _Toc457386288][bookmark: _Toc457899507]Note:
See the Toggles Configuration Fields for Details on the Visual Display Properties, as they are identical.

[bookmark: _Toc399642881][bookmark: _Toc457384296][bookmark: _Toc457386289][bookmark: _Toc457899508]Navigation Properties.
To bring up this dialog right-click on the button and choose Navigation Properties. Below is an explanation of the fields.
[bookmark: _Toc399642882][bookmark: _Toc457384297][bookmark: _Toc457386290][bookmark: _Toc457899509][image: ]

Navigation Setting
Select the action that you want the button to perform. You can either configure it to run another monitor or to run a command line (i .e Program).

Command line text can include the following system values

<Channel>
<ComputerName>
<SkypeUser>
<TeamViewerId>

eg

"C:\Program Files (x86)\TeamViewer\Version6\TeamViewer" -i <Q1> - Launch teamviewer with the teamviewer id in Q1

Skype /callto:<Q2> - Call the user contained in Q2 via Skype





Confirmation
Add a confirmation dialog with Yes/No options and a confirmation text string when the button is clicked.  This acts as a mechanism to confirm the procedure of the button.

Assign Function Key
Use this button to set-up a Function Key to act as a trigger mechanism to launch the Navigation buttons operation. You can assign the Keys F1; F12 to a navigation button.

Channel Navigation
A channel is linked to the button and when either a Low-High or High-Low state change happens navigation will occur.  If a channel linked to a navigation button has an alarm and Flash on any unacknowledged alarm is selected, the navigation button will flash.  As shown below:

[image: ]

  By default channel navigation is disabled.
[bookmark: _Toc399642883][bookmark: _Toc457384298][bookmark: _Toc457386291][bookmark: _Toc457899510]Run Command Settings
The command line option allows an EXE i.e. a program to run when the button is clicked.  The options to run the program as iconized and to add additional arguments is provided 
Run Monitor Settings
Use this to configure the way in which you want the new monitor to run. Select the Window in which you want it to run, and the format of the window.
[bookmark: _Toc457384300][bookmark: _Toc457386293][bookmark: _Toc457899512][bookmark: _Toc360531817][bookmark: _Toc408991048]
Strip Chart
[image: ]
[bookmark: _Toc457384301][bookmark: _Toc457386294][bookmark: _Toc457899513]Description
The Strip Chart Control is a dynamic two-dimensional charting control that provides an ideal interface for viewing one or more streams of real-time data.  Panning and zooming functionality allows for quick review and in-depth analysis of data trends.  Its dynamic property pages provide a powerful tool for designing charts with full control of scales, captions, fonts, and tics.
[bookmark: _Toc457384302][bookmark: _Toc457386295][bookmark: _Toc457899514]
Tracks
[bookmark: _Toc457384303][bookmark: _Toc457386296][bookmark: _Toc457899515]The Strip Chart Control allows the user to include up to 30 individual tracks per strip chart. It determines the number of individual plots maintained by the control.  This property must be set before all other track properties.  The TrackID property is used to select the track to which track properties apply.
[image: ]
TrackID
When multiple tracks exist, TrackID is used to index the track to which the other track properties apply.  The total number of tracks is determined by the Tracks property and TrackID has valid values from 0 to Tracks-1.
[bookmark: _Toc457384304][bookmark: _Toc457386297][bookmark: _Toc457899516]Invert Axis
Determines the direction the track plots i.e. it inverts the Y-axis.
[bookmark: _Toc457384305][bookmark: _Toc457386298][bookmark: _Toc457899517]XTics
Determines the position of the tic marks for the X and Y axes, respectively.  These properties allow the user to set the X and Y Tic marks on the top, bottom, left, right, etc. for each track.
[bookmark: _Toc457384306][bookmark: _Toc457386299][bookmark: _Toc457899518]Ytics
Determines the position of the tic marks for the X and Y axes, respectively.  These properties allow the user to set the X and Y Tic marks on the top, bottom, left, right, etc. for each track.
[bookmark: _Toc457384307][bookmark: _Toc457386300][bookmark: _Toc457899519]TrackColor
Determines the background color of the track currently selected by TrackID.  It is ignored if TrackBackPicture is set.
[bookmark: _Toc457384308][bookmark: _Toc457386301][bookmark: _Toc457899520]TrackPicture
Determines the graphic to be displayed in the background of the track currently selected by TrackID.
	
[bookmark: _Toc457384309][bookmark: _Toc457386302][bookmark: _Toc457899521]TrackOutline
Determines whether or not the track currently selected by TrackID is bounded by outline.
[bookmark: _Toc457384310][bookmark: _Toc457386303][bookmark: _Toc457899522]OutlineColor
Determines the color used to draw the outline around the track currently selected by TrackID.
[bookmark: _Toc457384311][bookmark: _Toc457386304][bookmark: _Toc457899523]Separation
If multiple tracks exist, this property determines the spacing between tracks.  This property is based on a unitless scale ranging from 0 to 1 scaled into the drawing area defined by AreaBottom, AreaLeft, AreaRight and AreaTop.  The maximum value for this property is 0.25.
[bookmark: _Toc457384312][bookmark: _Toc457386305][bookmark: _Toc457899524]Y Axis Labels
Labels
Determines whether or not tic labels are displayed for the track currently selected by TrackID.

TicColor
Determines the color used when drawing the tic marks and tic labels for the track currently selected by TrackID.

FontID
Determines which font is used in the tic labels for the track currently specified by TrackID.

Align
Determines the alignment and orientation of the tic labels.  These are used to improve the readability of the labels on the graph.  Choices are AlignLeft, AlignRight, and AlignCenter.

Orientation
Determines the alignment and orientation of the tic labels.  These are used to improve the readability of the labels on the graph.  Choices are Horizontal or Vertical.

Offset
Determines the spacing between the "Y" axis and the tic labels for the track currently selected by TrackID.  It is based on a unitless scale where 0 is no offset and a offset of 1 is equal to the width of the drawing region defined by AreaBottom, AreaLeft, AreaRight and AreaTop.

[bookmark: _Toc457384313][bookmark: _Toc457386306][bookmark: _Toc457899525]Max, Min
Determines the absolute extents of the Y-Axis drawn on the track currently selected by TrackID.

[bookmark: _Toc457384314][bookmark: _Toc457386307][bookmark: _Toc457899526]Display Max, Display Min
Determines the display extents of the Y-Axis drawn on the track currently selected by TrackID.
[bookmark: _Toc457384315][bookmark: _Toc457386308][bookmark: _Toc457899527]Major Tics
Determines the desired number of major tic marks for the track currently selected by TrackID.  The control will force the tic delta to be within a specific power of ten and will space the tics at the closest natural interval (multiples of 1, 2, or 5) depending on TrackMajorTics and the display extents (TrackDisplayMin and TrackDisplayMax) on which the tics are based.

[bookmark: _Toc457384316][bookmark: _Toc457386309][bookmark: _Toc457899528]Minor Tics
Determines the number of minor tic marks between major tic marks for the track currently selected by TrackID.
[bookmark: _Toc457384317][bookmark: _Toc457386310][bookmark: _Toc457899529]Track Bands
[image: ]
[bookmark: _Toc457384318][bookmark: _Toc457386311][bookmark: _Toc457899530]TrackID
When multiple tracks exist, TrackID is used to index the track to which the other track properties apply.  The total number of tracks is determined by the Tracks property and TrackID has valid values from 0 to Tracks-1.
[bookmark: _Toc457384319][bookmark: _Toc457386312][bookmark: _Toc457899531]TrackBands
Determines the total number of Track Bands displayed on the control for each Track.  This property must be set before all other TrackBand properties.  The TrackBandID property is used to select which TrackBand you apply the TrackBand properties to (i.e. TrackBandColor, TrackBandStart, TrackBandStop, or TrackBandPicture).  The TrackID will determine which Track the TrackBands are assigned to.  If you have more than one Track, each Track will have its own TrackBands settings.
[bookmark: _Toc457384320][bookmark: _Toc457386313][bookmark: _Toc457899532]TrackBandID
Determines the current TrackBand to apply TrackBand property changes to.  It is the index to the TrackBand.
[bookmark: _Toc457384321][bookmark: _Toc457386314][bookmark: _Toc457899533]TrackBandStart, TrackBandStop
Determines the range of the TrackBand.  Scaling units are in Track units based on TrackMin and TrackMax.
[bookmark: _Toc457384322][bookmark: _Toc457386315][bookmark: _Toc457899534]BandColor
Determines the color of the current TrackBandID.
[bookmark: _Toc457384323][bookmark: _Toc457386316][bookmark: _Toc457899535]BandPicture
Sets the picture for the current TrackBandID.
[bookmark: _Toc457384324][bookmark: _Toc457386317][bookmark: _Toc457899536]Variables (Channels)
[bookmark: _Toc457384325][bookmark: _Toc457386318][bookmark: _Toc457899537]Determines the number of variables maintained by the control.  This property must be set before all other variable properties.  The VariableID property is used to select the variable to which variable properties apply.
[image: ]
VariableID
When multiple variables exist, VariableID is used to index the variable to which the other variable properties apply.  The total number of variables is determined by the Variables property and VariableID has valid values from 0 to Variables-1.
[bookmark: _Toc457384326][bookmark: _Toc457386319][bookmark: _Toc457899538]TrackID
When multiple tracks exist, TrackID is used to index the track to which the other track properties apply.  The total number of tracks is determined by the Tracks property and TrackID has valid values from 0 to Tracks-1.
[bookmark: _Toc457384327][bookmark: _Toc457386320][bookmark: _Toc457899539]Type
Determines the data type for the variable currently selected by VariableID.  The choices are Analog, Logical, or Discrete.  The Analog setting is the most common type of data and means that the data is free-form, like a sine wave.  The Logical setting is used when the data is Boolean - on or off.  The Discrete setting is for use when the data is stepped (i.e. the variable value is either 1, 2, 3, 4, etc.).  The Discrete setting will give you a stepped-looking plot.
[bookmark: _Toc457384328][bookmark: _Toc457386321][bookmark: _Toc457899540]VariableFill
Determines whether or not the data is represented by a shaded area bounded by the X axis and the curve.  Data will fill from the zero Y Value.
[bookmark: _Toc457384329][bookmark: _Toc457386322][bookmark: _Toc457899541]VariableVisible
Determines if the variable currently selected by VariableID is displayed on the control.
[bookmark: _Toc457384330][bookmark: _Toc457386323][bookmark: _Toc457899542]LastX
Holds the value of the last "X" value for the variable (data set) currently selected by VariableID.
[bookmark: _Toc457384331][bookmark: _Toc457386324][bookmark: _Toc457899543]LineWidth
Determines the thickness (in pixels) of the line used for the variable (data set) currently selected by VariableID.
[bookmark: _Toc457384332][bookmark: _Toc457386325][bookmark: _Toc457899544]Color
Determines the color of the pen used for the variable currently selected by VariableID.
[bookmark: _Toc457384333][bookmark: _Toc457386326][bookmark: _Toc457899545]LineStyle
Determines the style of the line used to connect the data points for the variable (data set) currently selected by VariableID.

[bookmark: _Toc457384334][bookmark: _Toc457386327][bookmark: _Toc457899546]Symbol
Determines the graphical representation of each data point for the variable (data set) currently selected by VariableID.

[bookmark: _Toc457384335][bookmark: _Toc457386328][bookmark: _Toc457899547]VariableSymbolUserDefinedShape
Determines the shape of the symbol used to represent the variable (data set) currently selected by VariableID. In general, it defines a polygon made from a list of x, y coordinate pairs drawn in a -1000 to 1000 square region. VariableSymbolSize may be used to adjust the symbol's size.

[bookmark: _Toc457384336][bookmark: _Toc457386329][bookmark: _Toc457899548]X Axis

[bookmark: _Toc457384337][bookmark: _Toc457386330][bookmark: _Toc457899549]XTicMode
Determines what mode you want the X-Axis to represent.  It can be set to Numeric, Date_Time, or Local_Date_Time.  

The Numeric setting is intended to be used when the X-Axis represents something other than Time.  This setting is ideal in situations where you are counting incrementally. 

Use the Time_Date or Local_Time_Date mode whenever you are collecting data to be compared vs. Time. The Local_Time_Date setting will take any X value you send and convert it to Local Time based on your system.  You would normally save the data in Greenwich Mean Time (GMT) and then allow the control to convert the data to local time.  

Using the Time_Date setting will assume that the data is in the correct time units already and no conversion will take place.  This is normally the way that the control is used.
[bookmark: _Toc457384338][bookmark: _Toc457386331][bookmark: _Toc457899550]Labels
Determines whether or not tic labels are displayed along the X-Axis.
[bookmark: _Toc457384339][bookmark: _Toc457386332][bookmark: _Toc457899551]FontID
Determines which font is used for the X-Axis labels.
[bookmark: _Toc457384340][bookmark: _Toc457386333][bookmark: _Toc457899552]Align
Determines the text alignment for the X tic labels.  Choices are AlignLeft, AlignRight, and AlignCenter.
[bookmark: _Toc457384341][bookmark: _Toc457386334][bookmark: _Toc457899553]Orientation
Determines the text orientation for the X tic labels.  Choices are Horizontal, VerticalLeft, and VerticalRight.

[bookmark: _Toc457384342][bookmark: _Toc457386335][bookmark: _Toc457899554]Offset
Determines the spacing between the "X" axis and the tic labels.  It is based on a unitless scale where 0 is no offset and a offset of 1 is equal to the height of the drawing region defined by AreaBottom, AreaLeft, AreaRight and AreaTop.
[bookmark: _Toc457384343][bookmark: _Toc457386336][bookmark: _Toc457899555]TicColor
Determines the color used for the tic marks and tic labels for the X-Axis of the control.
[bookmark: _Toc457384344][bookmark: _Toc457386337][bookmark: _Toc457899556]Xspan
The XSpan property sets the viewable extents of the X-Axis.  When you are using the X-Axis to display Time, setting XSpan=1 is equivalent to setting it to 24 hours.  For instance, if you want to display 5 seconds of data on the viewable area, you would set XSpan = 0.00005787037037037 (1/24/60/60*5). XSpan sets the width extents of the plot when the plot is configured horizontally and the height extents when it is configured vertically.  
[bookmark: _Toc457384345][bookmark: _Toc457386338][bookmark: _Toc457899557]Last X
Holds the value of the last "X" value. When XTicMode is set to Time_Date, you will usually want to set LastX to the current time. This is done automatically for you.
[bookmark: _Toc457384346][bookmark: _Toc457386339][bookmark: _Toc457899558]Major Tics
Determines the desired number of major tic marks for the X-Axis of the control.  The control will force the tic delta to be within a specific power of ten and will space the tics at the closest natural interval (multiples of 1, 2, or 5) depending on XSpan.
[bookmark: _Toc457384347][bookmark: _Toc457386340][bookmark: _Toc457899559]Minor Tics
Determines the number of minor tic marks drawn between major tic marks.
[bookmark: _Toc457384348][bookmark: _Toc457386341][bookmark: _Toc457899560]Time & Date Formats
As you zoom in and out about the data displayed on the Strip Chart control, different requirements are met.  The Strip Chart control automatically assumes the most appropriate Time scale (seconds, minutes, hours, days, etc.) for the current viewable data set.  This property defines the format used when the Strip Chart control is scaled to displaying the Date format.  The formatting codes for these properties are as follows:

%a Abbreviated weekday name

%A Full weekday name

%b Abbreviated month name

%B Full month name

%c Date and time representation appropriate for locale

%d Day of month as decimal number

%H Hour in 24-hour format

%I Hour in 12-hour format

%j Day of year as decimal number

%m Month as decimal number

%M Minute as decimal number

%p Current locale's A.M./P.M. indicator for 12-hour clock

%S Second as decimal number

%U Week of year as decimal number, with Sunday as first day of week

%w Weekday as decimal number

%W Week of year as decimal number, with Monday as first day of week

%x Date representation for current locale

%X Time representation for current locale

%y Year without century, as decimal number

%Y Year with century, as decimal number

%z, %Z Time-zone name or abbreviation; no characters if time zone is unknown

%% Percent sign

Additionally, the # code may be used to remove leading zeros (i.e. %#d, %#H, etc.) or to get long date and time formats. For example, "%#c" yields a time similar to "Monday, October 13, 1997, 10:19:19".



[bookmark: _Toc457384349][bookmark: _Toc457386342][bookmark: _Toc457899561]
General
[image: ]
[bookmark: _Toc457384350][bookmark: _Toc457386343][bookmark: _Toc457899562]MaxBufferSize
Determines the total size of the holding array buffer for the data.  In other words, if you set the MaxBufferSize to 1000, the Strip Chart control will allocate enough memory for 1000 data points.  MaxBufferSize uses a FIFO (First in First Out) memory structure.  
[bookmark: _Toc457384351][bookmark: _Toc457386344][bookmark: _Toc457899563]DisplayMode
Determines how the Strip Chart displays the data set.  Setting the DisplayMode to Pan will scroll the data continuously across the screen like a standard Strip Chart.  The Wrap setting allows the data to remain static on the screen while a line moves across the plot area and everything behind the line is repainted with the new data.
[bookmark: _Toc457384352][bookmark: _Toc457386345][bookmark: _Toc457899564]Orientation
Determines whether the control is displayed horizontally or vertically.
[bookmark: _Toc457384353][bookmark: _Toc457386346][bookmark: _Toc457899565]Cursor Mode
Determines the movement or placement of the cursor line on the control.  When the CursorMode is set to CursorEnabled or CursorSnap, a line will appear along the X Axis which allows the user to move the cursor along data.  This feature would typically be enabled if the user wanted to retrieve values for points plotted in the display area.
[bookmark: _Toc457384354][bookmark: _Toc457386347][bookmark: _Toc457899566]Handles
Determines whether or not handles are displayed on the controls.  The vertical handles may be used to modify the minimum and maximum of a track's display.  These handles are bounded by the appropriate TrackMin and TrackMax.  The horizontal handles may be used to modify the XSpan for the tracks.  Initially these handles display the area bounded by LastX and XSpan. 
[bookmark: _Toc457384355][bookmark: _Toc457386348][bookmark: _Toc457899567]Grids
Determines which grid lines will be displayed on the control.
[bookmark: _Toc457384356][bookmark: _Toc457386349][bookmark: _Toc457899568]Grid Color
Determines the color used for the grid when it is displayed.

[bookmark: _Toc457384357][bookmark: _Toc457386350][bookmark: _Toc457899569]Enable Panning
Determines whether or not the user may manually pan through the data in a track.  Panning is done by pressing the right mouse button and dragging the mouse through the data.

[bookmark: _Toc457384358][bookmark: _Toc457386351][bookmark: _Toc457899570]Enable Track Sizing
Defines whether or not the user may change track size at run-time.  If the left mouse button is used, only the adjacent tracks are resized.  If the right mouse button is used, all the tracks are affected.

[bookmark: _Toc457384359][bookmark: _Toc457386352][bookmark: _Toc457899571]WrapCursorColor
Determines the color of the marker used to indicate the current data point when DisplayMode is set to WrapMode.

[bookmark: _Toc457384360][bookmark: _Toc457386353][bookmark: _Toc457899572]WrapCursorWidth
Determines the width (in pixels) of the marker used to indicate the current data point when DisplayMode is set to WrapMode.

[bookmark: _Toc457384361][bookmark: _Toc457386354][bookmark: _Toc457899573]Area (Top, Bottom, Left, Right)
Determines the drawing region extents of the control (excluding border area).  These properties are based on a unitless scale where 0, 0 is the upper, left corner and 1, 1 is the lower, right corner of the control.  They define the region used for the track(s) only so care must be taken to ensure enough space for any axis labeling or captions.

[bookmark: _Toc457384362][bookmark: _Toc457386355][bookmark: _Toc457899574]
Stamps
[image: ]
[bookmark: _Toc457384363][bookmark: _Toc457386356][bookmark: _Toc457899575]Description
The Strip Chart allows the user stamp the chart at different locations with either a Time stamp or a symbol stamp. Stamping the Strip chart is done in value-entry mode, by right clicking the strip chart and choosing Stamp Time, or Stamp Symbol.
[bookmark: _Toc457384364][bookmark: _Toc457386357][bookmark: _Toc457899576]Stamp Mode
Determines whether the stamp is placed relative to a specific plot (track) or relative to the control itself.  If the stamps are placed with respect to the tracks, then the display is dependent on the TrackDisplayMax and TrackDisplayMin.
Stamp FontID
Determines which font is used for all text based stamps.
[bookmark: _Toc457384365][bookmark: _Toc457386358][bookmark: _Toc457899577]Stamp Symbol
Determines the graphical representation used as a stamp.
[bookmark: _Toc457384366][bookmark: _Toc457386359][bookmark: _Toc457899578]StampColor
Determines the color used for all stamps placed on the control.
[bookmark: _Toc457384367][bookmark: _Toc457386360][bookmark: _Toc457899579]StampSymbolSize
Determines the size of the symbol used in the stamp.

[bookmark: _Toc457384368][bookmark: _Toc457386361][bookmark: _Toc457899580]StampSymbolUserDefined
Determines the shape of the symbol used as a stamp. In general, it defines a polygon made from a list of x,y coordinate pairs drawn in a -1000 to 1000 square region. StampSymbolSize may be used to adjust the symbol's size.

[bookmark: _Toc457384369][bookmark: _Toc457386362][bookmark: _Toc457899581][bookmark: _Toc360531818][bookmark: _Toc408991049]Drawing a Strip Chart Example

In this section we will go through the steps required to make a simple strip chart like the one below.
[image: ]
[bookmark: _Toc457384370][bookmark: _Toc457386363][bookmark: _Toc457899582]Step 1.
[image: ]
After the Overlay has been installed run the configurable monitor, open a new monitor Document. Click on the icon for the strip chart, a crosshair will appear. Click and hold the mouse button and drag the crosshair until the strip chart is of the required size. A strip chart will appear… this is the default setting for the strip chart gauge, but it may be reconfigured to be the same as the one above, we will now go through the steps required to do this.

[bookmark: _Toc457384371][bookmark: _Toc457386364][bookmark: _Toc457899583]Step 2.
Right click on the strip chart you have just drawn a popup dialog will appear, choose Visual / Display Properties from the pop-up menu.

[bookmark: _Toc457384372][bookmark: _Toc457386365][bookmark: _Toc457899584]
Step 3.
First we set up the Tracks of the strip Chart. Select the Tracks tab and configure the fields as follows.

Tracks:			2

Now set-up each track as follows
	TrackID
	TrackColor
	Max
	Min
	Display Max
	Display Min
	Major Tics
	Minor Tics
	TicColor

	0
	Light Blue
	1
	-1
	1
	-1
	10
	2
	White

	1
	Red
	5
	-5
	5
	-5
	3
	1
	White



Click Apply.
[bookmark: _Toc457384373][bookmark: _Toc457386366][bookmark: _Toc457899585]Step 4.
Next we set up the Track Bands for each Track of the Strip Chart. Select the Track Bands tab and configure the fields as follows.

TrackID:		0
TrackBands:		3

	TrackBandID
	TrackBandStart
	TrackBandStop
	BandColor

	0
	-1
	-.4
	Red

	1
	-.4
	.4
	Yellow

	2
	.4
	1
	Green



TrackID:		1
TrackBands:		2

	TrackBandID
	TrackBandStart
	TrackBandStop
	BandColor

	0
	4
	-4
	Light Blue

	1
	3
	-3
	Yellow



Click Apply.
[bookmark: _Toc457384374][bookmark: _Toc457386367][bookmark: _Toc457899586]Step 5.
Next we set up the Variables of the Strip Chart. Select the Variables tab and configure the fields as follows.


Variables:		50	(Allows for max number of channels)

VariableID:

	VariableID
	TrackID
	Type
	VariableFill
	Color

	0
	0
	0-Analog
	Enabled
	Pink

	1
	1
	2-Discrete
	disabled
	Black



Click Apply.

[bookmark: _Toc457384375][bookmark: _Toc457386368][bookmark: _Toc457899587]
Step 6.
Next we set up the X-axis of the Strip Chart. Select the X-Axis tab and configure the fields as follows.

XTicMode:	1-Date /Time (Standard)
XSpan:		.0006944 (1 minute 1/24/60)
MajorTics:	5
MinorTics:	1

Time and Date Formats:

Seconds Format:	%I:%M:%S %p
Minutes Format:	%I:%M %p
Hours Format:		%I:%M %p
Days format:		%m/%d/%y
Months Format:		%b, %y
Years Format:		%Y
Date Format:		%m/%d/%y

TicColor:		White

Click Apply.
[bookmark: _Toc457384376][bookmark: _Toc457386369][bookmark: _Toc457899588]Step 7.
Next we set up the General Parameters of the Strip Chart. Select the General tab and configure the fields as follows.

MaxBufferSize:		2000
DisplayMode:		0-Pan
Orientation:		0:Horizontal
CursorMode:		0-Disabled
Handles:		3-Both
Grids:			3-Both

Click Apply.

[bookmark: _Toc457384377][bookmark: _Toc457386370][bookmark: _Toc457899589]Step 8.
Next we set up the Stamp Parameters of the Strip Chart. Select the Stamp tab and configure the fields as follows.

Stamp Mode:		1-Track Context
Stamp Symbol:		4-Diamond
Stamp Color:		Black
StampSymbolSize:	0.03

Click Apply.

[bookmark: _Toc457384378][bookmark: _Toc457386371][bookmark: _Toc457899590]
Step 9.
Next we set up the Caption of the Strip Chart. Select the Caption tab and configure the fields as follows.

Captions:		1
CaptionID:		0
FontID:			0	
Color:			White
X Position:		. 52
Y Position:		. 04
Caption:		Strip Chart Example

Click Apply.

[bookmark: _Toc457384379][bookmark: _Toc457386372][bookmark: _Toc457899591]Step 10.
Lastly we set up the Background of the Strip Chart. Select the Background tab and configure the fields as follows.

BackColor:		Dark Green.

Click Apply, and then the OK button.

That’s the Strip Chart Drawn!

Now to make it functional we must add a channel \ channels to it.

1)	Select Calculator from the Processors menu in the Main Menu Application menu. 
2)	Set-up a calculator channel C1 as follows with the following Formula 
ctime()*2
3)	Set-up another calculator channel C2 as follows with the following Formula 
DSIN((C1-(floor(C1/20)*20))*18)

Right click on the Strip Chart and select Data source Properties. You will be prompted with the Data Source Properties Dialog Box. Setup the channel to be C2 (the last channel you have configured). Next click on the spin control the lies horizontal to the VariableID edit box, you will notice the VariableID edit box changing from 0 to 1. Setup this channel to be C2 also. Click the Apply button and the OK button.

The Strip Chart will now reflect the values of the calculator channel(s) you have assigned it to.
[bookmark: _Toc360531819][bookmark: _Toc408991050]
Check Box
[bookmark: HID_DRAW_CHECKBOX]The Check box control can be attached to a digital or analog channel. 
If an analog channel is mapped, an unchecked value is less than zero and a checked value is greater than one. 
If a digital channel is mapped, a checked/unchecked value corresponds to a TRUE/FALSE, YES/NO, or ON/OFF digital value. 
Value entry can be switchd on to allow changes in value.  Status can be set for digital channels, and values can be entered for analog channels.

[image: ]
Example

[image: ]

[bookmark: _Toc360531820][bookmark: _Toc408991051]
Edit Box
The Edit box control is a channel object with only the value displayed, with value entry on and in place editing of the value on. 

If a digital channel is mapped to an edit box it behaves as a text entry facility, enter the current low/high, on/off state description as a piece of text.

If an analog channel is mapped to edit box, it behaves as a number entry facility to enter a float. 

Examples
The first edit box shows a digital channel mapped, the second and third show analog channels mapped.  The third text box shows value entry occurring through in place editing with the value 600 being entered into the edit box.

[image: ]
















[bookmark: _Toc360531821][bookmark: _Toc408991052]Document
The Document control is an object which allows you to create or load in a Monitor or Trends Document such as Alarm Monitor, Channel Monitor, or Configurable Monitor inside configurable monitor.

In the object properties you can select a document to run and once that is done you can then adjust the size of the Document object to extend to the right or down the current configurable monitor window. 
Example
The example below shows off a Trends document which has been extended down and to the right on the configurable monitor window.

[bookmark: _Toc360531822][image: guide19]
List Box 
Description
The List box control can be used to set an analog or digital channel value from from a list of items. Items can be entered manually or loaded from a text file in the monitor.  A list that has been loaded and edited or manually entered can be saved.

If an analog channel is mapped to a list box, the list begins from value entry base of zero up to the amount of items in the list. 

If digital mapped to list box, and digital value entry is on enter 0 to for first and 1 for all other entries. If digtal value entry is off, the item is copied into current low or high state description of the channel and which to facilitate text entry. 
[image: ]
Example

[image: ]
[bookmark: _Toc457384380][bookmark: _Toc457386373][bookmark: _Toc457899592]Generic Configuration Fields
[bookmark: _Toc399642884][bookmark: _Toc457384381][bookmark: _Toc457386374][bookmark: _Toc457899593]Description
These Configuration Fields are ones that are found throughout the various different controls, and are referenced in the relevant sections under notes.

[bookmark: _Toc399642885][bookmark: _Toc457384382][bookmark: _Toc457386375][bookmark: _Toc457899594]Background
[image: ]
[bookmark: _Toc399642886][bookmark: _Toc457384383][bookmark: _Toc457386376][bookmark: _Toc457899595]BevelInner / BevelOuter
Determines the inner or outer shadow styles of the control.

[bookmark: _Toc399642887][bookmark: _Toc457384384][bookmark: _Toc457386377][bookmark: _Toc457899596]BevelWidth
Determines the shadow sizes of the inner and outer bevels of the control.

[bookmark: _Toc399642888][bookmark: _Toc457384385][bookmark: _Toc457386378][bookmark: _Toc457899597]BorderWidth
Determines the border size between the inner and outer bevels of the control.
[bookmark: _Toc399642889][bookmark: _Toc457384386][bookmark: _Toc457386379][bookmark: _Toc457899598]Outline
Determines whether or not to display an outline around the control's face.
[bookmark: _Toc399642890][bookmark: _Toc457384387][bookmark: _Toc457386380][bookmark: _Toc457899599]OutlineColor
Determines the color of the outline frame (and OutlineTitle) surrounding the control when Outline=TRUE.
Fonts
[bookmark: _Toc399642892][bookmark: _Toc457384389][bookmark: _Toc457386382][bookmark: _Toc457899601] [image: ]
Fonts
Determines the number of fonts available for display on the control.  This property must be set before all other font properties.  The FontID property is used to select the font to which other font properties apply.

[bookmark: _Toc399642893][bookmark: _Toc457384390][bookmark: _Toc457386383][bookmark: _Toc457899602]SetFont
When evoked, this property displays the standard Windows font dialog box. Use normal Windows Techniques to edit and change font settings.

[bookmark: _Toc399642894][bookmark: _Toc457384391][bookmark: _Toc457386384][bookmark: _Toc457899603]FontID
When multiple fonts exist, FontID is used to index the font to which the other font properties apply.  The total number of fonts is determined by the Fonts property and FontID has valid values from 0 to Fonts-1.

[bookmark: _Toc399642895][bookmark: _Toc457384392][bookmark: _Toc457386385][bookmark: _Toc457899604]
Frame
[image: ]
[bookmark: _Toc399642896][bookmark: _Toc457384393][bookmark: _Toc457386386][bookmark: _Toc457899605]FrameBottom Property / FrameLeft Property / FrameRight Property  / FrameTop Property
Determines left, right, bottom, and top extents of the frame if FrameStyle is other than 0.  These properties are based on a unitless scale and typically have values between -1.0 and 1.0 where a value of 0.0 is located at the center of the control.

[bookmark: _Toc399642897][bookmark: _Toc457384394][bookmark: _Toc457386387][bookmark: _Toc457899606]Color
Determines the color of the frame surrounding the control's face.

[bookmark: _Toc399642898][bookmark: _Toc457384395][bookmark: _Toc457386388][bookmark: _Toc457899607]Picture
Determines the graphic to be displayed in the frame surrounding the control's face.

[bookmark: _Toc399642899][bookmark: _Toc457384396][bookmark: _Toc457386389][bookmark: _Toc457899608]Frame Shape /User Defined
Determines the shape of a user defined frame and only applies when FrameStyle is set to "User Defined". In general, it defines a polygon made from a list of x, y coordinate pairs.  This polygon is then scaled into the rectangle defined by FrameBottom, FrameTop, FrameLeft, and FrameRight where the upper, left corner is 0,0 and the lower, right corner is 1000,1000.

[bookmark: _Toc399642900][bookmark: _Toc457384397][bookmark: _Toc457386390][bookmark: _Toc457899609]Frame Style
Determines the style of the control's frame.


[bookmark: _Toc457384398][bookmark: _Toc457386391][bookmark: _Toc457899610]Configuring Shapes
By Right Clicking on the selected object and selecting Properties from the menu which appears, an appropriate configuration dialog will appear. Different dialogs will be displayed depending on the type of object selected. Text shapes have different attributes than the other shapes (Line, Rectangle, Round Rectangle, Ellipse and Polygon)
[bookmark: _Toc394746060][bookmark: _Toc394916917][image: ]
Text Properties Configuration Dialog
Text properties are divided into 3 sections:

(a)	Text

	Field
	Description

	Caption
	A Text description of your text object, e.g. Channel 1

	Alignment
	Specifies the alignment of text within the text object. Options are: Left, Right or centred.

	Font Name & Font Size
	The Font button controls these. The font button displays the font-changing dialog.



(b)	Colours

	Field(s)
	Description

	Border 
	Determines the colour and thickness of the objects border..

	Fill
	Determines the colour of the background within the object.



(c) 	Three-D Settings
		If Three-D is set to ‘On’ then the Border Colour will be ignored.
[bookmark: _Toc394746061][bookmark: _Toc394916918]Shape Properties Configuration Dialog.
[image: ]

Shape properties are divided into 2 sections:

	Field
	Description

	Border Thickness
	Specifies the thickness of the border (0-32)

	Colour
	Drop down list of colours

	Fill On
	Checking this will enable Flood Fill on your selected object

	Three-D On
	If the 3D option is on the border colour is ignored. The 3D drawing in the configurable monitor will always use the colours dark grey and white to achieve it’s effect. 


[bookmark: _Toc394746062][bookmark: _Toc394916919]
Manipulating Shapes on Screen
Shapes can be “layered” in different ways within the Configurable Monitor.
Use the mouse to select the Object on screen and then and select the “Objects” menu item:

The options are:

	Option
	Description

	Move to Front
	Move the selected object to the front of the drawing

	Move to Back
	Moves the selected object to the back of the drawing.

	Move Forward
	Moves the selected object to the next position in the z-order

	Move Back
	Move the selected object to the previous position in the z-order

	Alignment
	This includes Left Right Top and Bottom alignment of objects.



Note:	z-order: The order in which objects are placed on top of each other in windows.
[bookmark: _Toc394746063][bookmark: _Toc394916920][bookmark: _Toc360531823][bookmark: _Toc408991053][bookmark: _Toc395410373][bookmark: _Toc457384399][bookmark: _Toc457386392][bookmark: _Toc457899611]
DF Plug-In Controls

[bookmark: HID_DRAW_DFANGULARGAUGE][bookmark: _Toc360531824][bookmark: _Toc408991054]DF Angular Gauge 
Description
DF Angular Gauge is a multi-purpose, highly customizable angular gauge custom control. Its dynamic property pages provide a powerful tool for designing gauges with full control of scales, needles, fonts, captions, annulars, and tics. With its data-aware and mouse input features, DF Angular Gauge is an ideal display element for technical interfaces.

General
The general tab configures and sets the caption, unit and physical appearance of the DF Angular Gauge.
Scale
Scales are used to define the extent of the units displayed by the gauge. It defines the min and max tic amounts and the position of the ticker alignment together with the position of the scale text. Precision is also set here, along with the option to set the scale on the inverse direction or the oppsosed scale side. 

Colour
Set the colours for the different properties of the DF Angular Gauge, which include the back panel, background, gauge, pointer, text and ticker colours.

Font
Set the font for the control, the options include the typeface, size and effects.

ColourBar
Easily set the range and configuration of colours for the the DF Angular Gauge, by specifying the minimum and maximum value of the range and the colour for that portion.

[image: ]
Examples
[image: ]

[bookmark: _Toc360531825][bookmark: _Toc408991055]DF Ball Indicator 
Description
DF Ball Indicator implements LED indicators in the shape of circles or ellipses.
General
The general tab configures the back style of the DF Ball Indicator control to transparent or opaque.  It also enables/disables a circular border for the DF Ball Indicator.
Colour
Set the colours for the different properties of the DF Ball Indicator, which include the background, border, on and off colours.
Examples
[image: ]
[bookmark: _Toc360531826][bookmark: _Toc408991056]
DF BMP Indicator 
Description
DF BMP Indicator implements many types of image indicators.  Some default ON/OFF images are provided by the component which include a lamp, LED, lock and mail image as well as 18 other default images. The ability to customise the control with on and off bmps is available. 
General
The general tab configures and sets various properites of the control such as the back style of the bmp (transparent or opaque); enable/disable the original size of the image, the edge style, outer and inner border length, on/off text, and set the default bmp image.
Picture
Set a customisable on and off image for DF BMP Indicator control. 
Colour
Set the colours for the different properties of the DF BMP Indicator, which include the background, light/dark border and on/off text colours.
Font
Set the font for the control, the options include the typeface, size and effects.

Examples
[image: ]
[bookmark: _Toc360531827][bookmark: _Toc408991057]DF Circular Gauge 
Description
[bookmark: HID_DRAW_DFCIRCULARGAUGE]DF Circular Gauge is a multi-purpose, highly customizable circular gauge custom control. Its dynamic property pages provide a powerful tool for designing gauges with full control of scales, needles, fonts, captions, annulars, and tics. With its data-aware and mouse input features, DF Circular Gauge is an ideal display element for technical interfaces.

General
The general tab configures and sets the DF Circular Gauge and the unit type, the border type, and the outer text length and height, the value text length, background style (transparent and opaque) the needle pie angle and type and enable/disable of the panel gradient. 

Scale
Scales are used to define the extent of the units displayed by the DF Circular Gauge. It defines the min and max tic amounts and the posistion of the ticker alignment together with the position of the scale text. Precision is also set here, along with the option to set the scale on the inverse direction or the oppsosed scale side. 
Colour
Set the colours for the different properties of the DF Circular Gauge, which include the background, circle, panel, gauge, pointer, text and ticker colours.
Font
Set the font for the control, the options include the typeface, size and effects.
ColourBar
Easily set the range and configuration of colours for the the DF Circular Gauge, by specifying the minimum and maximum value of the range and the colour for that portion.

Examples
[image: ]

[bookmark: _Toc360531828][bookmark: _Toc408991058]
DF Digitial LED 
Description
The DF Digital LED allows users to create realistic alpha-numeric display using the seven-segment LED standard.
General
The general tab configures a number of properties for the DF Digital LED.  These include enable/disable of the gradient, sign, unit, all zero display and time style.  Precision of the digits, unit type with its corresponding width, inner and outer border length and the background style (transparent or opaque).
Digit
The digit configuration properites of the DF Digital LED are set here. These include the option to incline the digits, enable/disable the frame, enable/disable flashing and set it duration, set the font with, and the digit area width and height. The number of digits in the DF Digital LED and the digit display type.

[image: ]
Colour
Set the colours for the different properties of the DF Digital LED, which include the background, circle, light and dark border colours, digit colour and the frame colour.
Examples
[image: ]

[bookmark: HID_DRAW_DFKNOB][bookmark: _Toc360531829][bookmark: _Toc408991059]
DF Knob 
Description
The DF Knob control is a highly customizable knob or dial control. Its dynamic property pages provide a powerful tool for interactively designing knobs or dials with full control of styles, scales, captions, border and background. With its data-aware and mouse input features, Knob is a simple and intuitive input to technical interfaces. 
General
The general properties tab configures the border, panel, panel border, slider, background, and indicator type.  Outer text height and width, inner and outer border length, indicator size and slider width are all configurable.  The start and end angle of the border can be set aswell as the panel border length. Finally, the rate of the gradient is also customisable.

Scale
Scale configuration for the DF Knob control is customisable. Some of these properties include the min and max value of the scale, the ticker and sub ticker value and alignment, the precision, unit name, the border properties of the scale and the indicator.

[image: guide15]
Colour
Set the colours for the different properties of the DF Knob, which include the background, circle, light and dark border colours, circle, indicator, marker, panel border dark and light, panel colour, the scale ring colour, slider, text and ticker colour.
Font
Set the font for the control, the options include the typeface, size and effects.

Examples

[bookmark: _Toc360531830][bookmark: _Toc408991060]
DF LED Matrix 
Description
The DF LED Matrix control is a new control which provides the function that group all the indicators in one LED panel
General
The general properties tab configures the number of rows and columns, the outer and inner border length, background, border, LED, LED border and LED gradient shapes and types, the padding of the LEDs, the grid visibility and width, as well as the radius width.

Colour
Set the colours for the different properties of the DF LED Matrix, which include the background, circle, light and dark border colours, grid, on/off colour and on/off gradient colour.
Examples



[bookmark: _Toc360531831][bookmark: _Toc408991061]
DF Progress Bar 
Description
The DF Progress Bar is used to show any progress status, the display will show the status of the ongoing progress including when the process will be finished.
General
The general tab configures the maximum and minimum value for the progress bar, the image style, the precision of the value, ticker and sub ticker numbers, the background style, enable/disable properties for gradient, inverse direction, value, vertical display, inner percentage and inner text.
Colour
Set the colours for the different properties of the DF Progress Bar, which includes the background, foreground and text colour.
Font
Set the font for the control, the options include the typeface, size and effects. 
Picture
Set the background image and the progress image for the progress bar.
Examples

[bookmark: _Toc360531832][bookmark: _Toc408991062]DF Progress Pie 
Description
The DF Progress Pie is used to show any progress status in a circular pie, the display will show the status of the ongoing progress including when the process will be finished.
General
The general tab configures the maximum and minimum value for the progress pie, the image style, the precision of the value, the text position within the circle and the background style.
Colour
Set the colours for the different properties of the DF Progress Pie, which includes the circle colour, the default background colour, line, progress and text colour.
Font
Set the font for the control, the options include the typeface, size and effects. 
Picture
Set the background image and the progress image for the progress pie.
Examples


[bookmark: _Toc360531833][bookmark: _Toc408991063]DF Ruler 
Description
The DF Ruler control allows users to visually show some dynamic values on a scaled ruler. 
General
The general tab configures the maximum and minimum value for the ruler, the ticker and sub ticker values, the gap of the border and the precision, enable/disable the display of the scale direction, position and vertical/horizontal alignment also the value display, gradient and background style.

Colour

Set the colours for the different properties of the DF Ruler, which includes the the default background colour, foreground and text colour.
Font
Set the font for the control, the options include the typeface, size and effects. 
Examples


[bookmark: _Toc360531834][bookmark: _Toc408991064]
DF Shape Indicator 
Description
The DF Shape Indicator control provides multiple indicator shapes to configure different kinds of the discrete Boolean status displays. 
General
The general tab configures the caption, shape type, indicator width and height, the border length, the border gradient type, and the gradient of the indicator type, rate and focus rate, visibility of text, its position and its alignment to the indicator, and the background type.
Colour
Set the colours for the different properties of the DF Shape Indicator, which includes the the default background colour, dark and light broder colour, on and off display colour, gradient on and off colour and text colour.
Font
Set the font for the control, the options include the typeface, size and effects. 
Examples


[bookmark: _Toc360531835][bookmark: _Toc408991065]
DF Counter 
Description
DF Counter is used to graphically display counters or odometers to record all kinds of numeric data. 

General
The general tab configures the number of digits in the display, the precision of those digits, the inner and other border length, and the background style, display of the sign and enable/disable highlight or gradient displays.
Colour
Set the colours for the different properties of the DF Counter, including the background colour, the light and dark border colour, the hightlight and text colour.
Font
Set the font for the control, the options include the typeface, size and effects. 
Examples


[bookmark: _Toc360531836][bookmark: _Toc408991066]
DF Slider 
Description
DF Slider is a versatile input/output instrument graphic component.  The slider is used to graphically adjust or setup the values of different control variables. The sliders can be as well used as gauges of indicators to display the values or statuses. 
General
The general tab configures the direction of the scale the marker, background, border and range border style, the border length, marker width and height, and the range field width and end gap.

Others
The scale configuration is set in the others tab, such as the Min and Max values of the scale, the ticker, subticker and precision settings, and enable/disable of percentage scale, setpoint visibility, and actual range and value visibility.
Colour
Set the colours for the different properties of the DF Slider including, background, light and dark border colours, marker, range and text colours.
Font
Set the font for the control, the options include the typeface, size and effects. 

Examples


[bookmark: _Toc360531837][bookmark: _Toc408991067]DF Switch 
Description
The DF Switch is a multi-purpose and highly customizable instrument graphic component that is a TRUE/FALSE, YES/NO, or ON/OFF toggle switch.
General
The general tab configures the switch type, light direction on the switch, the background style, image style, text display for on and off,  enable 3D text, button height and border length.
Others
Numerous properties are set in the others tab, such as, the toggle height, the rounding height and width, status indicator X and Y offset values, and enable/disable of the indicator visibility, vertical/horizontal toggle, circle status indicator and foreground gradient toggle.
Colour
Set the colours for the different properties of the DF Switch such as background colour, light and dark border colour, edge, on/off text, side dark and light colour, text and status colours.

Picture
Set and image for on and off switch display.
Font
Set the font for the control, the options include the typeface, size and effects. 
Examples

[bookmark: _Toc360531838][bookmark: _Toc408991068]DF Temperature Meter 
Description
The DF Temperature Meter control allows users to show the temperature in a visual meter.
General
The general tab configures the maximum and minimum value of the meter, the ticker and sub ticker value, the meter style and precision, set the unity and the visibility of the unit, enable/disable bulb display and set vertical or horizontal display.
Alarm/Warning
Alarm and Warning settings and can be enabled/disabled for the Temperature Meter.  An alarm/warning maximum and minimum limit can be set and the alarm/warning marker and value can be displayed.



Colour
Set the colours for the different properties of the DF Temperature Meter such as, the alarm hight and low colour, the background, foreground, text and the warning high and low colours.
Font
Set the font for the control, the options include the typeface, size and effects. 
Examples



[bookmark: _Toc360531839][bookmark: _Toc408991069]
Using the Channel Configuration Wizard
The channel configuration wizard provides a quick, easy and efficient way of configuring ScadaPro channels

The wizard facility allows the user to configure options for one individual channel. Every time the user clicks on the Add button, a new channel object is created and automatically sized and positioned. If we are dealing with six channels then the channel number is incremented by one with each Add operation.

The user can sequentially add channel(s) from a SourceSOURCES_DEF without having to configure individual channels each time

You must be in Configure Mode to use the Channel Configuration Wizard
[bookmark: _Toc394746064][bookmark: _Toc394916921][bookmark: _Toc395410374][bookmark: _Toc457384400][bookmark: _Toc457386393][bookmark: _Toc457899612]Steps To Configure a Channel using the Channel Configuration Wizard

1.	Choose the Channel Wizard item from the Monitor menu

2.	The Channel Configuration wizard will appear:

3.	Configure your channel, filling in the various options (Server, Display Options, etc.)

4.	Click Add to place the configured channel

5.	Continue clicking Add until the desired number of channels has been configured

6.	Click Close to acknowledge the configuration(s).

[bookmark: _Toc394746065][bookmark: _Toc394916922][bookmark: _Toc395410375][bookmark: _Toc457384401][bookmark: _Toc457386394][bookmark: _Toc457899613][bookmark: _Toc360531840][bookmark: _Toc408991070]Layout Commands
Configurable monitor provides a range of icon driven “layout commands” to assist with object alignment and sizing.
[bookmark: _Toc394746066][bookmark: _Toc394916923][bookmark: _Toc395410376][bookmark: _Toc457384402][bookmark: _Toc457386395][bookmark: _Toc457899614]Layout Functions
	Aligns left edges of selected objects with the dominant object. 
	Aligns right edges of selected objects with the dominant object
	Aligns top edges of selected objects with the dominant object
	Aligns bottom edges of selected objects with the dominant object
	Resize selected objects to be the same width as the dominant object
	Resize selected objects to be the same height as the dominant object
		Resize selected objects to be the same width and height as the 	dominant object
	Display/Hide monitor grid.

Alignment and re-sizing of selected objects are carried out with reference to a dominant object.

The dominant object (highlighted in red) is selected by moving the pointing device to the required item and clicking once; objects to be aligned / resized are then selected by holding down the “shift” key and single clicking the required objects (highlighted in grey).

Extent selection is also possible by dragging the mouse around the outside of all the objects to be selected.

Now click the required alignment/resize icon.
[bookmark: _Toc394746067][bookmark: _Toc394916924][bookmark: _Toc395410377][bookmark: _Toc457384403][bookmark: _Toc457386396][bookmark: _Toc457899615][bookmark: _Toc360531841][bookmark: _Toc408991071]Value Entry Mode
In value entry mode, it is possible to change the value of channels and acknowledge alarms from within Configurable monitor.
[bookmark: _Toc394746068][bookmark: _Toc394916925][bookmark: _Toc395410378][bookmark: _Toc457384404][bookmark: _Toc457386397][bookmark: _Toc457899616]Changing a channel value
Ensure the monitor is not locked (in the Monitor Menu, Lock Monitor should not be checked). 

Right click the mouse on the channel object which represents the channel whose value we want to alter.

Select Change Value from the menu that appears. You are then presented with a dialog box allowing you to enter the new value for the channel.



Change the value and click the OK button. The value will change on the next scan of the system.

[bookmark: _Toc394746069][bookmark: _Toc394916926][bookmark: _Toc395410379][bookmark: _Toc457384405][bookmark: _Toc457386398][bookmark: _Toc457899617]Acknowledging an Alarm.
Ensure the monitor is not locked (in the Monitor Menu, Lock Monitor should not be checked). 

Right click the mouse on the channel object which represents the channel whose value we want to alter.

Click on the Acknowledge Alarm option. If in the Display options of the Channel Properties dialog, you have the ACK Alarm field checked, ACK appears beside the channel value. 



[bookmark: _Toc394746070][bookmark: _Toc394916927][bookmark: _Toc395410380][bookmark: _Toc457384406][bookmark: _Toc457386399][bookmark: _Toc457899618][bookmark: _Toc360531842][bookmark: _Toc408991072]Configuring Communication Settings

The network can be edited for the Configurable Monitor software. Two attributes of the client can be configured. These are:

	Recovery Rate
	Update Rate

[bookmark: _Toc395410381][bookmark: _Toc457384407][bookmark: _Toc457386400][bookmark: _Toc457899619] Recovery Rate
This specifies how long the client will wait for the server to recover
[bookmark: _Toc395410382][bookmark: _Toc457384408][bookmark: _Toc457386401][bookmark: _Toc457899620]Update Rate
This specifies the rate at which the client will request data from the server. This can be done on a Server or Source basis. 

	Update Rate Option
	Description


	Server
	Update Rate set for ALL sources on one particular server

	Source
	Update Rate set for a particular source on a particular server




To Configure ScadaPro Communication Settings
1.	Choose the Communication Settings item from the Monitor menu.
2.	The following dialog will then appear:


[image: ]
	
For servers to appear in this dialog, al least one channel object must be configured and mapped to a server.

3.	The network can then be configured as desired. By clicking on the desired button, the 
dialog for that communication setting will appear (See below for related topics)
[bookmark: _Toc394746071][bookmark: _Toc394916928][bookmark: _Toc395410383][bookmark: _Toc457384409][bookmark: _Toc457386402][bookmark: _Toc457899621]Setting Communications Rates
The recovery rate specifies how long the client will wait for the server to recover (i.e. the server has gone down). The update rate specifies how often Configurable monitor will retrieve values form the server.
[bookmark: _Toc394746072][bookmark: _Toc394916929][bookmark: _Toc395410384][bookmark: _Toc457384410][bookmark: _Toc457386403][bookmark: _Toc457899622]Setting the Recovery Rate
Choose  Communications settings from the Monitor menu.

Carry out the following operations

1.	At the Monitor Communications dialog, select the server you want to set the recovery rate for. Highlighting the appropriate server using the mouse or keyboard can do this.

2.	Click on the Set Recovery Rate Button

3.	The Set Recovery Rate- Server Name dialog appears:

[image: ]

4.	Enter your recovery rate in minutes, seconds and milliseconds.

5.	Click OK to confirm, or Cancel to quit.
[bookmark: _Toc394746073][bookmark: _Toc394916930][bookmark: _Toc395410385][bookmark: _Toc457384411][bookmark: _Toc457386404][bookmark: _Toc457899623]Setting the Update Rate
The update rate is the rate at which the client monitors requests for data from a particular server.

The Update Rate Dialog looks like this:

[image: ]

The update rate can be set in one of two ways: Server basis and Source basis.

The format of this dialog will vary depending on which one you select.
[bookmark: _Toc394746074][bookmark: _Toc394916931][bookmark: _Toc395410386][bookmark: _Toc457384412][bookmark: _Toc457386405][bookmark: _Toc457899624]Setting the Update Rate for Server
At the Monitor Communications dialog select the server that you want to set the update rate for.

1.	Click on the Set Update Rate button

2,	The Update Rate Settings dialog appears the fields will look as follows:

Server:		Selected Server
Sources:	All (All sources on server being set)

3.	Enter your Update Rate in minutes, seconds and milliseconds.

4.	Click OK to confirm or Cancel to quit.
[bookmark: _Toc394746075][bookmark: _Toc394916932][bookmark: _Toc395410387][bookmark: _Toc457384413][bookmark: _Toc457386406][bookmark: _Toc457899625]Setting Update Rate for Source
At the Monitor Communications dialog, select the server that you want to set the update rate for.

1.	Then click on the Sources... button

2.	The Sources Update Rates - Server Name dialog will appear. This shows all the sources on a particular server together with their associated prefixes and any update rates already set.

3.	Choose the source that you want to set the update rate for. Click with the mouse OR use the keyboard.

4.	Click the Set Update Rate button

5.	The Update Rate Settings dialog appears. The fields will look as follows

Server:	Selected Server
Source(s):	Selected Source

6.	Enter the update rate for the source in minutes, seconds and milliseconds

7.	Choose OK to confirm or Cancel to quit
[bookmark: _Toc394746076][bookmark: _Toc394916933][bookmark: _Toc395410388][bookmark: _Toc457384414][bookmark: _Toc457386407][bookmark: _Toc457899626][bookmark: _Toc360531843][bookmark: _Toc408991073]Editing View Options 
The way in which the Configurable Monitor appears can be altered. 

To change the way the monitor looks choose the View option on the monitor main window.

The following options are available:

	View Option

	Description


	Grid Lines
	Allows you to view grid lines on the opened monitor

	Monitor Colour
	Allows you to change the background colour of the active monitor.

	Show Objects
	Allows you to turn OLE object indication on and off.

	Toolbar
	Allows you to turn the toolbar on and off.

	Status Bar
	Allows you to turn the status bar on and off.

	Full Screen
	Option maximises the application window to the full screen size and hides all frame objects (menu, title bar, toolbar, etc.) with the exception of the vertical scrollbar.




[bookmark: _Toc394746077][bookmark: _Toc394916934][bookmark: _Toc395410389][bookmark: _Toc457384415][bookmark: _Toc457386408][bookmark: _Toc457899627][bookmark: _Toc360531844][bookmark: _Toc408991074]Configure Grid Settings
When a new monitor is generated a grid is created but by default not displayed. Use the “Grid lines” option from the View menu to toggle the grid display between on and off. The monitor also defaults to snap to grid mode. The grid size will default to the page size of the current printer setting.

To modify the default grid settings select the “Grid Settings” option from the Monitor drop down menu. The following window will be displayed: -

[image: ]

By default when a new monitor is created a grid will not be displayed on the monitor. The monitor also defaults to snap to grid mode. The grid size will default to the page size of the current printer setting.

The spacing between grid lines and the grid colour can be configured using the Grid Settings Dialog. The snap to grid mode can also be disabled here.

[bookmark: _Toc394746078][bookmark: _Toc394916935][bookmark: _Toc395410390][bookmark: _Toc457384416][bookmark: _Toc457386409][bookmark: _Toc457899628][bookmark: _Toc360531845][bookmark: _Toc408991075]Set Default Visual Properties

All Monitor objects share some common attributes such as border width, background colour etc. The Default Visual Properties dialog allows the user to set or change certain properties which all newly created objects in the monitor will have, unless specifically changed on an object by object basis. These include Text Visual Properties, Value Visual Properties, Border and Fill Properties and Alarm Indication.

[image: ]

The alarm indication and object value groups apply to channel objects only. Default visual properties are saved with the monitor document.

If the Three-D option is on the border colour is ignored. The 3D drawing in the configurable monitor will always use the colours dark grey and white to achieve it’s effect. For best results the monitor background colour has been set to a default of grey.

If Alarm Indication is changed then the changes apply to all existing objects.

[bookmark: _Toc457384417][bookmark: _Toc457386410][bookmark: _Toc457899629]
Set-up an ActiveX Document and run it across the internet.

This topic will show you how to set up an HTML page that you may use to monitor Configurable Monitor files over the Internet. The discussion is based around the Microsoft Package “FrontPage 98”

On your WEB_SERVER, create the directory “MSActiveXDocuments”, as this will be the directory you will store the monitor files into. You may choose any name for the directory, but for example purposes use this one.

Step	1:

1)	Launch the Configurable Monitor Application. 
2)		Create a Configurable Monitor Document and put a control on it such as the angular gauge.
3)		Save the document with a suitable name i.e. configmon.orm, to the 	WEB_SERVER\MSActiveDocuments directory.

Step	2:

1)	Run Microsoft FrontPage 98.
2)	Cancel the “GettingStarted” Dialog that you are prompted with.
3)	From the Menu, select ToolsShow FrontPage Editor.
4)	You are now presented with the FrontPage Editor

Step	3:

You should note that you can edit the blank page in two modes “Normal” or “HTML” (see the tabs positioned on the bottom left hand side of the application. “Preview” allows you to preview the work you have done so far.

To enter in a link to the Configurable Monitor Document you created in Step 1, do the following:

1)	Enter a suitable name for the Link you are about to make to the Configurable Monitor File 		i.e. ConfigMonDoc1, for example.

2)	Once you have entered a suitable name for the link, highlight the entire link (the text you have 		just entered).
[image: ]
3)	While the text is highlighted, from the Toolbar, select the Create or Edit Hyperlink icon:

[image: ]You are then presented with the Edit HyperLink Dialog, allowing you to enter the URL, to jump to when you click on the link i.e. 


4)	Enter your domain address i.e.
http://www.yourcompany.com/msactivedocuments/ ConfigMonDoc1.orm


        Your Internet Address     The directory and file you created
Click OK.


Step 4

1)	Save your work.
2)	When you have saved your work, select preview from the tabs on the bottom left 	hand side of 		the screen.

3)	Click on your link, and the Configurable Monitor Document will open, embedded within Microsoft 	FrontPage98.


You can now repeat the process to enter in as many Links as you require.

To allow the page to be accessed from the Internet, simply enter a link to the .htm file you have just created on your webpage i.e. your company webpage.
[bookmark: _Toc457384418][bookmark: _Toc457386411][bookmark: _Toc457899630] “Opening” an ActiveX Document and run it across the LAN.

An easy way to open the a Configurable Monitor ActiveX Document via your web browser is from the File menu, select Open, and the browse to the Computer that contains the .orm file you wish to open. When you choose open, the Configurable Monitor File will open embedded into your web browser. 

[bookmark: _Toc394746079][bookmark: _Toc394916936]Not that you can open a .orm file across the network using the Configurable Monitor Application, or any other ActiveX Document Server Applications i.e. Microsoft FrontPage 98 and Microsoft Binder for example.
[bookmark: _Toc408991076]Unit Selection
[bookmark: _Toc395410391][bookmark: _Toc457384419][bookmark: _Toc457386412][bookmark: _Toc457899631][bookmark: _Toc360531846]Unit Selection takes the available unit categories and then displays their base name and conversion name units.  The user will be able to select between the base name and conversion names for each unit category.

[image: ]

[bookmark: _Toc408991077]Overview of Menu Items
[bookmark: _Toc394746080][bookmark: _Toc394916937][bookmark: _Toc395410392][bookmark: _Toc457384420][bookmark: _Toc457386413][bookmark: _Toc457899632]File Menu Commands
The File menu offers the following commands:

	New
	Creates a new  Monitor document and displays an associated window inside the main window.

	Open
	You are presented with the standard Windows File Open dialog box, which allows you to open an existing  Configurable Monitor document. When opened an associated window is displayed inside he main window.

	Close
	Closes the active document and asks to save any changes.

	Save
	Saves any changes to the currently active document.

	Save As
	Saves an opened document to a specified file name. You are presented with the standard Windows File Save As dialog box, which allows you to save the Configurable Monitor Document for reuse. A Configurable Monitor document is given a .ORM file extension.

	Print
	Prints the currently active document.

	Print Preview
	Displays full pages of the currently active document, as they would be printed.

	Print Set-up
	Changes the printer and printer options.

	Export Image
	Alls you to export the current screen as an image.  Supports JPEG, GIF, or PNG.

	Most Recent File List
	Displays a list of the monitors most recently used. When one of these is selected, the monitor it represents will be opened.

	Exit	

	Exits the Configurable Monitor and prompts to save any document with unsaved changes.







[bookmark: _Toc394746081][bookmark: _Toc394916938][bookmark: _Toc395410393][bookmark: _Toc457384421][bookmark: _Toc457386414][bookmark: _Toc457899633]Edit Menu Commands
The Edit menu offers the following commands:

	Undo Position
	Undo’s any changes you’ve made to an objects position or size and resets it back to where it was first drawn or first saved.

	Cut
	Cuts the selection from the active monitor and puts it on the clipboard.

	Copy
	Copies the selection and puts it on the clipboard.

	Paste
	Inserts the clipboard contents into the active monitor.

	Delete
	Deletes the selection from the active monitor.

	Select All
	Select all objects in the active monitor.

	Properties
	Displays the properties of the currently selected object.

	Insert New Object
	Inserts a new OLE (Object Linking and Embedding) object into the active monitor.

	Links
	List and edit links to embedded documents.

	Object
	Activates embedded or linked objects






[bookmark: _Toc394746082][bookmark: _Toc394916939][bookmark: _Toc395410394][bookmark: _Toc457384422][bookmark: _Toc457386415][bookmark: _Toc457899634]View Menu Commands
The View menu offers the following commands:

	Grid Lines
	Shows or hides grid lines on the active monitor.

	Monitor Colour
	Changes the background colour of the active monitor.

	Show Objects
	This toggles OLE object indication.

	Toolbar
	Toggles the toolbar on/off.

	Status Bar
	Toggles the status bar on/off.

	Layout Bar
	Toggles the layout bar on/off.

	Instrument Bar 1
	Toggles the first instrument bar on/off

	Instrument Bar 2
	Toggles the second instrument bar on/off

	Entry Form Objects Bar
	Toggles the entry form object bar on/off

	Full Screen
	Toggles full screen mode




[bookmark: _Toc394746083][bookmark: _Toc394916940][bookmark: _Toc395410395][bookmark: _Toc457384423][bookmark: _Toc457386416][bookmark: _Toc457899635]Draw Menu Commands
The Draw menu offers the following commands, which enable you to draw various shapes (objects) within the Configurable Monitor.

	Select
	The select tool allows the user to select a single or multiple objects using the mouse.

	Channel
	The channel tool allows the user to draw a channel object.

	Text
	The Text tool allows the user to draw a text object.

	Line
	The Line tool allows the user to draw a line object.

	Rectangle
	The Rectangle tool allows the user to draw a rectangle object

	Round Rectangle
	The Round Rectangle tool allows the user to draw a round rectangle object

	Ellipse
	The Ellipse tool allows the user to draw an ellipse object.

	Polygon
	The Polygon tool allows the user to draw a polygon object.

	Callout
	The Callout tool allows the user to draw a callout object

	Date/Time
	The Date/Time tool allows the user to draw a date/time object

	Instrument 1
	The Instrument 1 tool allows the user to draw an object from the Instrument 1 toolbar

	Instrument 2
	The Instrument 2 tool allows the user to draw an object from the Instrument 2 toolbar

	Entry Form Objects
	The Entry Form Objects tool allows the user to draw an object from the Entry Form Objects toolbar.





[bookmark: _Toc394746084][bookmark: _Toc394916941][bookmark: _Toc395410396][bookmark: _Toc457384424][bookmark: _Toc457386417][bookmark: _Toc457899636]Object Menu Commands
The Object menu offers the following commands, which enable you to manipulate the way that shapes (objects) are presented visually on screen

	Move To FrontHID_OBJECT_MOVETOFRONT
	Moves the selected object to the front of the drawing. 

	Move To BackHID_OBJECT_MOVETOBACK
	Moves the selected object to the back of drawing. 

	Move ForwardHID_OBJECT_MOVEFORWARD
	Moves the selected object to next position in z-order (Order in which objects are placed on top of one another in Windows).

	Move BackHID_OBJECT_MOVEBACK
	Move the selected object to previous position in z-order.

	
Alignment
	
Left AlignHID_OBJECT_LEFTALIGN
Right AlignHID_OBJECT_RIGHTALIGN
Top AlignHID_OBJECT_TOPALIGN
Bottom AlignHID_OBJECT_BOTTOMALIGN

	
Make Same Size
	
WidthHID_OBJECT_MAKESAMESIZE_WIDTH
HeightHID_OBJECT_MAKESAMESIZE_HEIGHT
SizeHID_OBJECT_MAKESAMESIZE_SIZE

	Tab Order
	Sets object tab order

	Group
	Groups all selected objects together

	Ungroup
	Ungroups an object
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The Monitor menu offers the following commands, which enable you to Change modes of operation, control updating on channels, use the Configurable Monitor Wizard and set-up your network.


	Configure ModeHID_OPTIONS_CONFIGUREMODE


	Sets the active monitor to configure mode. Channel values can not be set in this mode.

	Value Entry ModeHID_OPTIONS_VALUEENTRYMODE


	Sets the active monitor to value entry mode. Objects cannot be configured in this mode.

	View ModeHID_MONITOR_LOCKMONITOR


	Allows the user to lock the currently active monitor.

	Grid SettingsHID_MONITOR_GRIDSETTINGS


	Allows the user to set the Grid Settings for the active Monitor.  There is now the option to snap to grid.


	Start UpdatingHID_OPTIONS_STARTUPDATING


	The monitor will start updating channel objects when this command is selected.

	Stop UpdatingHID_OPTIONS_STOPUPDATING


	The monitor will stop updating channel objects when this command is selected.

	Default Visual PropertiesHID_MONITOR_DEFAULTVISUALPROPERTIES


	Allows the user to set the default properties of the objects in 
the currently active monitor.

	Channel WizardHID_MONITOROPTIONS_CONFIGURATIONWIZZARD


	This command runs the configuration channel utility.

	Select  ServerHID_MONITOR_SELECTSCADAPROSERVER


	Allows the user to select a server.

	CommunicationsHID_OPTIONS_NETWORKSETTINGS


	Allows the user to set server update rates and recovery rates for the application

	Internet Server
	Allows the user to set the internet server security.
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The Window menu offers the following commands, which enable you to arrange multiple views of multiple documents in the application window:

	New WindowHID_WINDOW_NEW
	Opens another window for the active monitor document.

	CascadeHID_WINDOW_CASCADE
	Arranges windows in an overlapped fashion.

	TileHID_WINDOW_TILE
	Arranges windows in non-overlapped tiles.

	Arrange IconsHID_WINDOW_ARRANGE
	Arranges icons at the bottom of the screen

	1,2,3….. Command
	Switch Between Different Configurable monitor Windows.
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The Help menu offers the following commands, which provide you assistance with this application: 

	IndexHID_HELP_INDEX
	Lists all on-line topics available. 

	Using HelpHID_HELP_USING
	Displays instructions about how to use the on-line help. 

	AboutHID_APP_ABOUT
	Displays program information, version number, copyright, etc. 
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Part Six provides details on the Logging Utilities available within ScadaPro
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Logger Configuration
Up to 64 loggers are available in the ScadaPro Software package. During the installation of the software package a lesser number may have been chosen. 

A loggerGlossLogger.77 stores information on the hard disk about selected channels for analysis after recording has finished.  Each logger is configured and enabled independently allowing the user to define, which channels are logged and the way in which the logger operates.  This section deals with the configuration and use of the loggers. See Part Seven (Replaying Logged Data) for ways in which the logged data can be used and replayed.
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Loggers can be selected for configuration in several ways.

Go to the Start Menu, then Programs, ScadaPro, Loggers. Each loggerGlossLogger.77 is identified by an icon bearing the name LOGGER 1, LOGGER 2…LOGGER N up to the nth number of loggers selected during the installation of the software package. To select a logger point to the icon representing the logger required and release the left mouse button over it.
			         or

Go to the Start Menu, then Programs and release the mouse over the ScadaPro icon. Once ScadaPro launches, you can select the Loggers menu. You can select the Logger you wish to run from this list. 
or

From the Logger menu select the first option in the list Control Loggers.... The resulting dialog box shows the current status of all available loggers.
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From this dialog box point to the logger to configure and double click the mouse button.

The result from either method of selecting a logger to configure is the same, a Logger Configuration Dialog box.

Once loggers have been configured the name of the logger in both the menu list and the Logger Control Dialog box will change to the current configuration name of the logger.

A general description of each of the Standard Logger Configuration tabs is as follows :
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General 
Allows for specification of start/stop times and mode of logging for each logger. 
Channels
Allows the channels which need to be logged to be selected
		Events
Allows selection of channels to act as triggers for logging.
Text
Allows text automatically to be added to the log file(s).
Export
Allows for log files to be converted into spreadsheet and text file for viewing and analysis.
Advanced
Allows for specification of the way data is written to disk and provides a disk space checking function.
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Enter a name for the loggerGlossLogger.77 that describes the information being collected. Up to 25 alphanumeric characters can be used in the name.  The name selected cannot be the same as any already chosen for other loggers.  The name must not be blank and must follow Microsoft Windows file naming conventions.
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If the Autostart check box is checked this loggerGlossLogger.77 will start collecting data automatically when the ScadaPro System is started.  
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Three different types of logging are available for each loggerGlossLogger.77.  The dialog box will change depending on which type is chosen.  From the drop down list choose the type required.

Storage Type
Two types of storage are supposed in ScadaPro; odl files and databases.  Odl files can only be opened using replays such as Trends, or Data Export.  Databases are not currently supported on Embedded Linux or Windows CE platforms
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If the Period mode is selected logging will occur at a fixed rate irrespective of the status of the data being logged.  Edit the Logging Rate text boxes to determine the rate of logging.
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Period EventGlossEvent.76 Logging allows the loggerGlossLogger.77 to record information to disk at a periodic rate, similar to the Period Logger mode.  If an event occurs then the logger can respond and log at a different rate, until the event subsides.
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When this mode is selected the logger type section of the dialog box changes to the above.
In the text boxes adjacent to the Pre EventGlossPreEvent.80: label, enter the rate in minutes, seconds and milliseconds that the logger is required to store information whilst there is no EVENT.  
When an EVENT occurs the logger can be configured to respond in one of two ways.  If SINGLE is chosen from the drop down list under the title During EventGlossDuringEvent.75: then when an EVENT occurs the logger will cause a single recordGlossSingleRecord.81 to be logged and then revert back to the periodic rate.  If Multiple is chosen then additional time text boxes will appear.  Edit these boxes to set the rate at which logging is required during an EVENT.  When an EVENT occurs the logger will operate at the new rate, when the EVENT clears the log rate will revert to the periodic rate.
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A loggerGlossLogger.77 configured to this mode is triggered only by EVENTS occurring.
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It is often of interest to know information about a number of channels immediately before and after an EVENTGlossEvent.76 occurs. The Event Logger satisfies this need by recording information on selected channels in three phases: before the event occurs; during the event; and after the event has cleared.  Each of these phases can be configured separately.  To use this mode, select Multiple from drop down list adjacent to During EventGlossDuringEvent.75.
Pre Event.
When the loggerGlossLogger.77 is enabled a circular buffer will be created in memory.  A number of records defined by the entry in the Number of Logs text box, and the values in the Logging Rate box will be stored in the circular buffer.  When an EVENTGlossEvent.76 occurs the contents of the buffer i.e. the last x number of readings at a defined rate will be stored on the hard disk. 
If this facility is not required a value of 0 can be entered.
During Event.
Whilst the EVENTGlossEvent.76 is occurring the loggerGlossLogger.77 will record information at the rate defined in the During EventGlossDuringEvent.75 time boxes. 
Post Event
When the eventGlossEvent.76 clears the pre eventGlossPreEvent.80 circular buffer will resume, and the defined number of logs at the Post EventGlossPostEvent.79 time will be stored on disk.  
If an event occurs again during the post event phase the post event will be suspended and the cycle started at the during eventGlossDuringEvent.75 phase.
If no Post Event logs are needed a value of 0 can be entered.
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In some instances only a single recordGlossSingleRecord.81 of a number of channels is required when an EVENTGlossEvent.76 occurs rather than the three phases described above.  From the drop down list adjacent to During EventGlossDuringEvent.75 choose Single no times need to be configured.     
Rate of Change
A loggerGlossLogger.77 configured to this mode is triggered only by a channel changing by a rate of change.
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This area of the LoggerGlossLogger.77 Configuration dialog box deals with the operational requirements of the logger, the times for which a logger should operate, whether new logs are created, or appended to the end of old files whenever loggers start.
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Old logs can also be automatically deleted if required. All of these features are configured within this section.
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Two modes are available Create LogsGlossCreateLogs.73 and Append LogsGlossAppendLogs.72. If Create Logs is selected from the drop down list a new data file will be created every time the loggerGlossLogger.77 is enabled.  
In the Append mode when the logger is enabled the logged data will be added to the end of the most recent log file created by that logger.  If no file exists one will be created. 

In create mode a log is automatically written at the start of the log file. 

In append mode a log is not automatically written to the appended file when the logger is enabled and the log will only be written at the next log time.

N.B. When the system is enabled any loggers which are enabled at that time are not triggered to log until the next scheduled log time.
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These optional fields can be used to start a loggerGlossLogger.77 some time in the future.  It is not necessary to complete every entry.  The Wild Card Symbol ' * ' can be used.
For example in the following entry when enabled the logger will commence logging at the next occurrence of 08-00. 

A stop time for a logger can be configured in a similar way.
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If the Delete Logs check box is checked a drop down list is available to select a period of time after which logged data will be automatically deleted.  The predefined times are:

	½ Hour
	8 Hours
	2 Weeks

	Hour
	12 Hours
	Month

	2 Hours
	Day
	2 Months

	4 Hours
	Week
	3 Months



If a suitable time period is not shown select the Time option, additional boxes will appear.  Edit the text boxes entering the data in the form:     
		MM/DD     HH:MM

NB
It is recommended that Delete Logs option is used wherever possible to prevent the hard disk from becoming full
[bookmark: _Toc394746102][bookmark: _Toc395410414][bookmark: _Toc427127930][bookmark: _Toc427553797][bookmark: _Toc427571254][bookmark: _Toc427571315][bookmark: _Toc427571376][bookmark: _Toc427571481][bookmark: _Toc427634210][bookmark: _Toc427634380][bookmark: _Toc427639219][bookmark: _Toc427985773][bookmark: _Toc428095650][bookmark: _Toc428095750][bookmark: _Toc457182153][bookmark: _Toc457384443][bookmark: _Toc457386436][bookmark: _Toc457899655]Cycle Mode
If this field is set to None then when files are manually started they will continue until either being manually disabled or the Stop Time is met.  If a loggerGlossLogger.77 is intended to collect data for a long period of time it is recommended that the Cycle ModeGlossCycleMode.74 is used.  
By using the Cycle Mode facility log files will cover specific periods of time.  Logged files would be smaller and more manageable, specific occurrences will be quicker to find.  Log files can be set to cover specific periods of time that match the operational times of the process being monitored.
A logger could, for example be set to log data between 07:00 and 19:00 every day.  Alternatively a logger could be configured to start at 06:00 every Monday and log data until 18:00 on a Friday.  Not logging data at Weekends.
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To configure the Cycle ModeGlossCycleMode.74 from the drop down list select On Time.  From the Every drop down list select, a suitable periodic start time.  The options are:

	½ Hour
	8 Hours
	2 Weeks

	Hour
	12 Hours
	Month

	2 Hours
	Day
	2 Months

	4 Hours
	Week
	3 Months




If a suitable time period is not shown select the Time option, additional boxes will appear.  Edit the text boxes entering the data in the form:     
		MM/DD     HH:MM
From the Log For: drop down list choose a suitable log period the options are as listed above.
In Cycle Mode the start time is used to define the alignment time.  This time would normally be configured as a time in the past that a selection will be aligned to. A Stop Time should not normally be configured, as the cycles will not continue past any configured time.   
In Cycle Mode it is normal to select a Start Mode of APPEND.  This will allow the system to continue logging immediately if necessary after a system reboot. If not set the log file will wait until the start of the next cycle to commence logging.
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If either Period-EventGlossEvent.76 or Event Loggers are selected, an additional field in the Cycle ModeGlossCycleMode.74 drop down list will be available.  Selecting On Event will cause a new log file to be created every time an event occurs. Each file will therefore be active for the duration of an event.
This facility is useful where it is better to align log files to a process rather than a time.  For example in a batch process a log file can store data for a complete batch manufacturing cycle.  An Event will indicate the start of the process and remain until completed. 
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The Channel Tab
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To configure the channels to be included click on the Channels tab at the top of the Standard LoggerGlossLogger.77 Configuration Window. 


The following dialog is displayed:
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64 different blocks of channels can be configured for each loggerGlossLogger.77.  Each block could contain up to 1000 channels.  To configure a block of channels point to the block and click the mouse button.  If there is enough space on the button a block which contains a single channel will display the channel’s tag identifier. An Enter Log Channel Range Dialog box will appear.
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The box will contain a list of the ScadaPro Channel Groups. Choose the group from which the channels are required. Edit the From and To text boxes within the dialog box to select the channels. If a single channel is required in any block then the From and To entries will be the same. To see a list of channels within a source, double click the source. 
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To select a single channel, simply click the channel and click the OK button. To select a block of channels, click the first channel, press and hold down the Shift key on the keyboard and click the last channel in the block. Release the Shift key and click the OK button on the dialog.

Choose the OK button to confirm the selection.

The previous Configure Logger Channels Window will be shown with the selected channels displayed in the Channel Block. If a single channel is to be logged, the channel tag is displayed in the channel block button, if it will fit within the button.

Alongside each channel block is a check box marked Avg.  If this box remains unchecked the ScadaPro System will record to disk the current value of the channels at the time of the log.  If the Avg. check box is checked the logger will store the average value of the channels since the last log.
For Example:	The Device Scan rate is set to 1 second, the Period log rate to 5 minutes and the Average feature selected.  Every 5 minutes the logger will record the average of the last 300 scans of each of the selected channels.

Alongside each channel block is a check box marked Lag.  If this box remains unchecked or the logger is not a rate of change logger, the ScadaPro System will record to disk the current value of the channels at the time of the log.  If the Lag. check box is checked on a rate of change logger, the logger will store the value of the channel when the lagged rate of change channel changes by the required amount.

When configuration of the Channels is complete accept the selections by clicking on the OK button at the bottom of the Window.  If the Cancel button is chosen any changes made to the configuration will be discarded.


[bookmark: _Toc75327252][bookmark: _Toc408991082][bookmark: _Toc428095656][bookmark: _Toc428095756][bookmark: _Toc457182159][bookmark: _Toc457384449][bookmark: _Toc457386442]The Events Tab
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If EventGlossEvent.76 Mode or Period Event Mode is selected, in the Event Channels there is a drop down list title Trigger with two selections,  Logged Channels or Event Channels.

If there is enough space on the button a block that contains a single channel, the channel’s tag identifier will be displayed instead of the channel range.
Trigger - Logged Channels:
If Logged Channels is selected then any channel configured for this logger will trigger the logger when it goes into an Event mode.
Trigger - Event Channels:
If Event Channels is chosen then a selection of channels can be chosen any of which will cause the trigger.  The same technique is employed to select Event Channel blocks as for the Logged Channel Blocks.
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The chosen Event Channels can be different from those channels selected for logging to disk.

When configuration of the Channels is complete accept the selections by clicking on the OK button at the bottom of the Window.  If the Cancel button is chosen any changes made to the configuration will be nullified.
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Log By Tag
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To Enable Logging by Tab you must add settings to the Windows Registry. These settings can only be made on the ScadaPro Server and should not be made on a client machine. You can do this as follows:

Click on the Start Menu, go to Run, type Regedit in the text box and click OK. 
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Look for HKEY_LOCAL_MACHINE. 
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Expand this branch, go to SOFTWARE, expand it, and then find the Measuresoft key and expand it.
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Inside the ScadaPro key, you will see the current ScadaPro registry settings. You should not modify any of these settings. To enter in the setting for Logging by tag, go to the Edit menu, select New followed by String Value.
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You will notice that on the right of the Registry Editor, a key called New Value #1 has appeared. Change this value to LogByTag. Once you have changed it, right click on the LogByTag value and select Modify from the popup menu.

In the value data field enter the word ON and click OK. If the values you have entered do not correspond to the illustration below, then you must re-enter the values.
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As the system is logging data by tag, the user is free to alter the channel associated with the tag. The start and end tag will be displayed on the block button if the size of the tags do not exceed the button extent. Otherwise, the channel range will be displayed. If there is only one channel on the range the tag will be displayed if it does not exceed the button extent. When the logger is enabled the channels from the start to the end tag will be logged.
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The start channel number can not be greater than the end channel number .i.e. if the start tag refers to P30, then the end tag must refer to a channel greater than or equal to P30. If this situation arises, the tag range will be removed from the logged channels range. 

The tag name can be changed at will. However, the start tag must refer to a channel which is less than or equal to the end tag. 
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The Rate of Change Tab
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Rate of Change Configuration
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Trigger Channel
This is the channel which is used to trigger a log of non lagged data if it changes by the rate of change.

Change
This is rate of change specified either by a value of the current value of a channel.

Lagged Trigger Channel
This is the channel which is used to trigger a log of lagged data if it changes by the rate of change.

Rewind
Rewind can be a value or channel.  This is the amount the trigger channel can decrease by without forcing a new log to be started.
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The Text Tab
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Text logging allows the user to add text labels at certain points of a log file. Predefined messages can be inserted at any point in the log or custom messages can be added. Header text can also be inserted to give context to the data in the log file. While a logger is running or on historical log data, ScadaPro Trend Replays can be used to insert text items at certain time frame reference points in the log file. For details see part Seven of this manual. 

To configure text logging, click on the Configure Text button in the main logger window. 

Use the Logger Text Configuration dialog to configure text logging.
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Click the Enable Text Logging checkbox to enable text logging for the logger.

Enter a Header message that will be displayed when the log file is replayed.
You can Add/Edit/Delete predefined messages by clicking on the appropriate button. The user can select these messages when entering text logs using ScadaPro Trend Replays.

Logger text can include channel values. See Including Channel Values below.

[bookmark: _Toc427571262][bookmark: _Toc427571323][bookmark: _Toc427571384][bookmark: _Toc427571489][bookmark: _Toc427634218][bookmark: _Toc427634388][bookmark: _Toc427639227][bookmark: _Toc427985781][bookmark: _Toc428095661][bookmark: _Toc428095761][bookmark: _Toc457182164][bookmark: _Toc457384454][bookmark: _Toc457386447][bookmark: _Toc457899666][bookmark: _Toc75327255][bookmark: _Toc252978537][bookmark: _Toc408991085][bookmark: _Toc427553805][bookmark: _Toc394746121][bookmark: _Toc395410433][bookmark: _Toc427127938][bookmark: _Toc394746109][bookmark: _Toc395410420]The Export Tab		
[image: ]
[bookmark: _Toc427553806][bookmark: _Toc427571263][bookmark: _Toc427571324][bookmark: _Toc427571385][bookmark: _Toc427571490][bookmark: _Toc427634219][bookmark: _Toc427634389][bookmark: _Toc427639228][bookmark: _Toc427985782][bookmark: _Toc428095662][bookmark: _Toc428095762][bookmark: _Toc457182165][bookmark: _Toc457384455][bookmark: _Toc457386448][bookmark: _Toc457899667]Data Export
Data filesGlossDatafiles.36 stored on the hard disk by any ScadaPro loggers can be converted into file formats suitable for importing into industry standard spreadsheets such as Microsoft ExcelGlossExcel.37 or other standard spreadsheet applicationsGloss1.2.3.35. The ScadaPro Data Export facility allows the user to carry out such conversions. To enable the data export facility, you need to click the Logger Export check box.
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By default, the Export Data To File option is selected. The Run Command Option will be discussed shortly.
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The complete logged file does not have to be exported.  A time portion can be chosen as well as selected channels.  Descriptive information about the channels can be omitted if required.  The resolution of the results can be modified as can the format of the data. The following details the configuration of each section.


Header 
There are three options available for export of Text Header information, None, User Defined, and Logged Header Text.

If Logged Header Text is selected information from the Logger Header Text will be included for export. This information is stored with the log, and is specified in the Header of the Text section for that log. If User Defined is selected the edit region will allow manually entry of text for inclusion in the export. If None is selected no Header information is included for export.


Logger Header/Sheet

CSV, TXT and DIF export files 
If logger Header/sheet is included the logged data file name, the logger name and the start and stop times of the logger will be included in the exported data at the top of the file.

Excel Worksheet (XLS) files 
A worksheet wil be created called LOGGERS which will give detailed information in column format, about the logged data this includes logger name, start and stop times, header information and logger sequence. 

Channels Header/Sheet
This will display the channel number (prefix plus number), tags, descriptions, units and Low and High state descriptions of the channels selected for export.

Excel Worksheet (XLS) files 

A worksheet wil be created called _CHANNELS this will display in column format the details of the channels selected for export, such as the channel number (prefix plus number), tags, descriptions, units and Low and High state descriptions, min and max scales and more. 

Text Logs Header/Sheet

CSV, TXT and DIF export files 
Text logs from the data log file will be exported. By default they are exported per time basis only, check Date of Text Logs to have the date associated with the data.

Excel Worksheet (XLS) files 
Text logs from the data log file will be exported into a worksheet called _TEXTLOGS. The default includes the time beside the text log.

Date/Time of Text Logs 
Check this box to specify the date and time of the text log.

Date Format
The date format drop down box allows you to select the way you want your date to be presented in the data export.  The available date formats include:
· Short Format   E.G. 08/27/04 15:45:23
· Long Format   E.G.: Monday, August 01, 2004 11:25:39
· dd/MM/yyyy
· dd/MM/yy
· MM/dd/yyyy
· MM/dd/yy
· yy/MM/dd
· yyyy/MM/dd
· yyyy-MM-dd
· yy-MM-dd
· dd-MM-yyyy
· dd-MM-yy


Data Logs/Sheet
To include actual logged data, check the Data Logs/Sheet check box, the following options in this section include additional ways to format the data for export.

Column Headers 
Column Headers alone, display the channel number and prefix of the logged channel. Check Header Tags, to display the tag of the channel and not the channel number, check Header Units to include the units on the next line.

Date/Time Column 
Time Base - Three time base options are available. The time selected appears in the spreadsheets first column of each scan. The choices are: Elapsed Time, Differential Time and Absolute Time 

Date – If this check box is checked the date column will be included in the exported data logs. 

Date – Long Date Format, if this check box is checked dates will have the long format. Long and short date formats are defined in the ‘Regional Settings’ applet of the Control Panel. 

Ms Column – Include a column for miliseconds in the exported data. 

Text Logs With Data 
Check Text Logs With Data to include text logs from the log file for export. They are appended with the data on the last column of the row.

Text Logs on Separate Rows 
Check Text Logs on Separate Rows to display text logs on a new line within the exported data file.

Statistics 

Selecting statistics will append statistics for the selected channels at the bottom of the exported data. Statistics include:

· Root Mean Square (RMS) 
· Average (AVG) 
· Minimum (MIN) 
· Maximum (MAX) 
· Standard Deviation (STD DEV) 
· Difference between Minimum and Maximum (DIFF) 

Export - Sample Skip
 
· Export All 
· Skip Every (logs/scans) 
· Skip Time Frequency (seconds) 
· Skip Duplicates 

With large data files users may wish to export only a certain amount of data. The Sample Skip option allows the user to decide how may samples will be exported. If a sample rate of say, n, is entered then every nth sample will be exported. The Sample Skip combo box has Three options Export All and Skip Every and Skip Time Frequency. Select Skip Every and an edit box will appear, type in the skip factor in terms of logs/scans. Select Skip Time Frequency and an edit box will appear type in the skip factor in terms of seconds. Select Skip Duplicates to skip duplicated data

Email
Data Export can be configured to send the logged data as an email via SMTP or MAPI.
SMTP
1. Click the Settings Button
2. Enter a Network Username and Password
3. Enter the email address(s) you wish to send the logged data to
4. Select SMTP and click the configure button
5. Enter the name which email will be sent from
6. Enter the email address email will be sent from
7. Enter the name or IP address of the mail server.   SMTP Mail Server usually use port 25, but this is not guaranteed to be the case.  You can verify this with your Mail Server Administrator.
8. If your Mail Server Requires authentication enter your Login Name and Password.

MAPI
In order to use MAPI you must have a MAPI Compatible Mail Client installed and configured on the local computer.  Examples of MAPI compatible mail clients include: Outlook, Outlook Express, AOL Version 7.0 or later and Eudora.

1. Click the Settings Button
2. Enter the email address(s) you wish to send the logged data to
3. Select use MAPI and click Configure MAPI
4. Select the Mail Profile from the drop down list.  If no mail profiles are available, then no MAPI compatible clients are configured on the local computer.
5. Enter the password for the mail profile you have selected.
6. You can use logon as service, although some MAPI accounts may not allow this depending on Network Security settings in which case you must use an account with adequate permissions.

If you have successfully configured your MAPI or SMTP settings an email should be sent each time your logger cycles or stops logging.
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Exporting Data
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During configuration of a file for export to ExcelGlossExcel.37 choose a Delimiter as a Comma and the End Line separator as CR/LF.  The File Type should be defined as Data Exchange Format (. DIF).

Within the Excel Spreadsheet package to import the file Choose the File Open command and in the List Files of Type drop down list choose Data Interchange Format (*.DIF).  Choose the correct file and it will import correctly into the spreadsheet.
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During configuration of a file for export to other spreadsheet applications (like Lotus 1-2-3), choose a Delimiter as a Comma and the End Line separator as CR/LF.  The File Type should be defined as Spreadsheet (.PRN).
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The Data Export utility can be used to prepare logged data to be printed using the Notepad Program within Windows.  

Configure the data for Export in the way described in this chapter.  Choose either Comma, or Tab as the Delimiter.  When a Tab file is selected the value width is set to 8 by default.  The End Line separator should be defined as CR/LF.  The File Type in the Select Data Export Output File should be set as Text File (. TXT).   The resulting file can be opened in Notepad and then printed.  
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To export a file all that needs to be done is to specify the path and name of the file you wish the logged information to be exported too.  There are two ways of doing this :-

Click the Select Export File button.

Before completing this dialog box one must know the type of file acceptable to the spreadsheet or other software package that is to accept this file.
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Enter the filename of the resulting exported file.  The extension used should be of the correct type. %n can be used to substitute the log file name.

Note: %n is not supported when logging to Databases

The export file name can include channel values. See Including Channel Values below.
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Using normal Windows techniques choose the directory where the exported file is to be placed.
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This field defines the ultimate format of the file.  The correct type of file must be selected so the software package that is to import this file can do so correctly.

The choices are:
		Spreadsheet Files (.CSV)
		Text Files   (.TXT)
		Data Interchange Format (.DIF)
		Excel Spreadsheet (.XLS)
		Other Files (*.*)
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Exported files can be stored anywhere the service has access to on a Network.  In the Save in field a list of other drives on the network available to the user will appear. The Network Neighbourhood icon, in the Save in field allows the user to connect to a remote drive.  This facility would be used to make a connection over a modem link to another system using the Remote Access features of Windows. 

If you are sure of the directory path and file name required for the data export file, you can type it in manually into the text box on the left of the Select Export File button.
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DO NOT ATTEMPT TO SELECT A NETWORK DRIVE. USE UNC FORMAT \\<server>\<share>\… INSTEAD.

Note that when configuring from a client the directory is the name as it applies from the server e.g. the C: drive is the C: drive on the server and not the C: drive on the client. The ScadaPro service must have access to the file path. This can be achieved by specifying the ScadaPro service to log on as a user in the Services applet in the Control Panel.
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Above, you saw how to enter in the name of the data export output file. However, there is another option available. Instead of specifying a filename like ‘data.dif’, you could name the file ‘%n.dif’. When the output file is being created, the logger will already have created the logged data file. The %n specifier informs the Standard Logger that the data export file should be named using the same date and time field as the logged data file. i.e. if the logger is set to log data every half hour, the first time it is enabled, it will operate for a half an hour shift and create a logged data file similar to the following :

980819_110051_980819_120052.odl

At this point, the data export file needs to be created. The Standard Logger reads the name of the data export file to be created and notices that the %n specifier has been used. Upon reading this it substitutes the name of the logged data file for the %n parameter name names the data export file as :

980819_110051_980819_120052.ext

where ext is the extension of the data export file .i.e. DIF, PRN or TXT.

Split into separate files for Excel column limit
Microsoft Excel is limited to 255 columns in .dif format and 256 columns in .csv format.  If you require to use more than the above number of columns select this check box.  Data Export will create the necessary number of Export files.

Export an Excel Spread sheet to Windows Live SkyDrive.

Window’s Live SkyDrive is part of Microsoft’s Live online services. SkyDrive is a tool that allows online storage and sharing capabilities, meaning important documents and folders can be uploaded and shared using Cloud storage. SkyDrive uses Windows Live ID to control access to User files. SkyDrive can be used to save, share and edit an Excel spread sheet by following these steps:
1. Load up Microsoft Excel with the spread sheet that you require to be shared or uploaded to SkyDrive.
2. When any necessary changes have been made to the workbook, navigate to the File button located at the top right of the window and click.
3. When the drop down menu appears, move the cursor to the Save & Send option and click. [image: ]
4. Move the cursor to Save to Web and press the Sign In button located on the right hand side of the window.
5. Enter your Windows Live ID credentials in the relevant fields:                                                                                      [image: ]															 Note: A Windows Live ID is any Hotmail or LIVE e-mail account																	
6. Select the folder you want to upload the file to, either public or private and continue.
7. Copy the Path from the pop-up screen (for use later) and save the file as a relevant name. [image: ]
8. When the file has been uploaded, open Windows Explorer by going to Start\Computer.
9. On the Network option on the left hand side of the Window, Right-Click network and navigate to Map Network Drive.[image: ]
10. In the pop-up window, paste the path length obtained from Step 7. [image: ]
11.  Check the box beside Reconnect at Logon.
12. Rename your SkyDrive disk with a relevant name. [image: ]
13. This will allow you to upload files directly, by saving them to the SkyDrive disk.
14. Note: If you want to change the destination folder for SkyDrive, this must be done from the Excel workbook which you want to place in a different folder.
15. SkyDrive will also inform you if someone is currently editing the document you need.
To re-access the SkyDrive after a log-off or shutdown, you need to navigate to the drives location and double click. This will prompt you for your e-mail and password. After entering your credentials
[bookmark: _Toc427553826][bookmark: _Toc427571283][bookmark: _Toc427571344][bookmark: _Toc427571405][bookmark: _Toc427571510][bookmark: _Toc427634239][bookmark: _Toc427634409][bookmark: _Toc427639248][bookmark: _Toc427985802][bookmark: _Toc428095682][bookmark: _Toc428095782][bookmark: _Toc457182186][bookmark: _Toc457384476][bookmark: _Toc457386469][bookmark: _Toc457899688][bookmark: _Toc75327259][bookmark: _Toc408991089]Selecting Data Export File Creation Options

There are three ways in which logged data can be exported to files. Each time the Standard Logger Configuration creates a log file of the current data, if a data export file has been specified then this data export file will be created at this time. 
[bookmark: _Toc457182187][bookmark: _Toc457384477][bookmark: _Toc457386470][bookmark: _Toc457899689]Overwrite old files
This option ensures that each time the Logger creates a data export file, it will overwrite the old data export file (if one exists) with the latest file. 
[bookmark: _Toc457182188][bookmark: _Toc457384478][bookmark: _Toc457386471][bookmark: _Toc457899690]Append old Files
With this option, the Logger exports information and creates the export file for the first time. All subsequent exports are appended to the end of the file. 

N.B. This option will not work with Data Interchange Files (.DIF)
[bookmark: _Toc457182189][bookmark: _Toc457384479][bookmark: _Toc457386472][bookmark: _Toc457899691]Create new file always 
In contrast to the Overwrite old files option, here a backup of the last data export file will be created followed by the creation of the new data export file. For example, consider the following situation. You want the export file to be named ‘data.dif’. When the logger creates its first output file, the logger also creates the data export file called ‘data.dif’. When the logger creates its second log file, it will then rename the file called ‘data.dif’ to ‘data.1.dif’ and then create the file ‘data.dif’. Similarly on the creation of the third logger file, the existing ‘data.dif’ file will be renamed to ‘data.2.dif’. This process can continue renaming files up 999 times (resulting in a list of files from ‘data.1.dif’ to ‘data.999.dif’). After 999 files have been created, the file ‘data.999.dif’ will be deleted on the creation of a new file so as to allow renaming to continue as long as required.
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To enable the Run Command option, the Logger Export and Run Command options need to be selected. Run Command enables the user to specify the name of an application which they wish to have launched and the name(s) of files which can be used as input for this application. For example, if you have a series of .DIF files in a directory, you can specify by using the Browse EXE … button, the name of an application (like Microsoft Excel) will can be launched to handle and display a series of .DIF files specified by using the Parameters button.
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N.B. If you specify any parameter files as input to an application and the application can not open one or more of these files for some reason, then the application will present you with an error message. Also it is possible to use name specifiers when passing parameter files as input to an application. %l  can be used to specify a data log file name that corresponds to the current logger, and %t can be used to specify a text log file.


[bookmark: _Toc75327261][bookmark: _Toc408991091]Email log files


The first time that you select the email checkbox and choose settings, you will be presented with the following dialog:

              [image: ]                         

You will need to enter the user name and password for each logger that you  configure to mail an export file. Once this has been completed correctly, you can then configure the email properties.

        [image: ]                

Email address(es):
		Enter into this field the recipients email address.
Selecting MAPI or SMTP, will allow you to configure alarm mail settings for these type of mail clients 

Configure MAPI:
                                        
[image: ]
This defaults all fields to the currently logged on users details.
You can set the configuration to use another users account, but only if they have previously logged onto the local computer.


Configure SMTP:

                         [image: ]

Name:
The desired screen alias of the sender
Email:
Account name of the sender

Server:
The address of the senders mail host

Timeout:
Defaulted to 30 seconds, this is the time the annunciator system will wait for the host to respond. Some hosts may require 60 seconds or more.

Server Authorisation:
	User can provide login ID and password for mail account if required by server.

Test configuration

                           [image: ]

	The user can test current configuration pressing this buttonHID_TEST_MESSAGE.

Message Settings:

A number of mnemonics are provided which can be used to construct a message Subject and Text. User can use %l or %L to specify a data log file name, corresponding to the current logger. %t or %T can be used to specify a text log file name and %n or %N specifies name of the data export file without extension. In addition, the subject and message can include channel value. See Including Channel Values below.


Attach			Then user selects this option, file will be sent as attachment.

Append	Then user selects this option, file content will be added to message text (text files only).

Delete file after emailing	Then checked program will delete sent file.




[bookmark: _Toc427571285][bookmark: _Toc427571346][bookmark: _Toc427571407][bookmark: _Toc427571512][bookmark: _Toc427634241][bookmark: _Toc427634411][bookmark: _Toc427639250][bookmark: _Toc427985804][bookmark: _Toc428095684][bookmark: _Toc428095784][bookmark: _Toc457182191][bookmark: _Toc427553828][bookmark: _Toc457384481][bookmark: _Toc457386474][bookmark: _Toc457899693][bookmark: _Toc75327262][bookmark: _Toc408991092]
The Advanced Tab   	
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In fast logging situations it is more economical on system resources to store the logged data into cache buffers, created in memory, and then write the data to disk at a slower rate. To configure the way the logger will write to disk choose the Advanced Configuration Tab at the top of the Logger Configuration window.


When you click on the Advanced Configuration button the following dialog is displayed:

[image: ]

The following fields may be configured to determine the way in which logged data is written to the disk.
[bookmark: _Toc394746110][bookmark: _Toc395410421][bookmark: _Toc427127940][bookmark: _Toc427553830][bookmark: _Toc427571287][bookmark: _Toc427571348][bookmark: _Toc427571409][bookmark: _Toc427571514][bookmark: _Toc427634243][bookmark: _Toc427634413][bookmark: _Toc427639252][bookmark: _Toc427985806][bookmark: _Toc428095686][bookmark: _Toc428095786][bookmark: _Toc457182193][bookmark: _Toc457384483][bookmark: _Toc457386476][bookmark: _Toc457899695]Write To Disk Time
This field determines how often a set of logs is written to disk. It is expressed in seconds.
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This field depends on how often the logging system logs data and writes to disk. A faster logging rate requires more buffers. A slower write to disk time requires fewer buffers.

Example:

No. Buffers = 3 * (Write To Disk Time (secs) * 1000 / Min. Logging Rate)

If the minimum logging rate is 100ms and the Write To Disk Time is 1 Second then the recommended minimum number of buffers would be:

		3 * (1 * 1000 / 100) 	= 30
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The Logger Directory button provides the means by which loggers can be created in a specific user defined directory. The default switch saves the specific logger and log file in the default ScadaPro directory, namely <drive>:\ScadaPro\LOGGED_DATA.

The user-defined switch provides the means of specifying an alternative user defined directory, which MUST be held on the main ScadaPro server. The browse button provides the means to browsing the local drive.

DO NOT ATTEMPT TO SELECT A NETWORK DRIVE. USE UNC FORMAT \\<server>\<share>\… INSTEAD.

Note that when configuring from a client the directory is the name as it applies from the server e.g. the C: drive is the C: drive on the server and not the C: drive on the client. The ScadaPro service must have access to the file path. This can be achieved by specifying the ScadaPro service to log on as a user in the Services applet in the Control Panel.

The logger directory can include channel values. See Including Channel Values below.

[bookmark: _Toc427639256][bookmark: _Toc427985810][bookmark: _Toc428095690][bookmark: _Toc428095790][bookmark: _Toc457182197]Logger Database
When Database is selected from the Storage Type drop down on the General tab the Logger Database properties become available.  ScadaPro can log to potentially all types of Databases provided that the Windows drivers for the database type have been installed.  Configuring a logger to work with Microsoft Access, Microsoft SQL Server, Microsoft Excel and Oracle have been tested and documented below.
Logging to a Microsoft Access Database
From the General tab of the logger configuration select Database from the storage type drop down list.  On the advanced tab the Database properties should now be configurable.  By default the logger will log to an Access (.mdb) Database file.  The connection string can be edited manually by changing the text in the user defined text box below.  The logger can automatically create the connection string by clicking the select button and selecting the properties you require.
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When the select button is pressed the following dialog will open.

[image: ]

Type the name of the database file manually into the database text box or click the   button and browse to the location of the database file.  It is not necessary for the database to exist before enabling the logger.  The logger can automatically create the database, but if a database already exists the logger will add a new tables to the database.

Some databases may have security restrictions on them.  If this is the case it may be necessary to provide authentication information.

The test connection button will check that the logger can connect to the Database.

For Microsoft Access the Provider should be set to Microsoft Jet 4.0 OLE DB Provider.

On the advanced tab access permissions for the Database can be granted.

*Note it is not necessary to have Microsoft Access installed on the machine where the data is being logged.  The logger can create and log to an Access database even if Access is not present.
Logging to a SQL Server Database
From the General tab of the logger configuration select Database from the storage type drop down list.  On the advanced tab the Database properties should now be configurable.  The connection string can be edited manually by changing the text in the user defined text box below.  The logger can automatically create the connection string by clicking the select button and selecting the properties you require.

Target
Is the connection string to the target database on which the logger will replicate tables.  The connection string can be changed using the select button.

Replication
Replication is only available on SQL Server
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To connect to an SQL Server database click the provider tab and select Microsoft OLE DB Provider for SQL Server as shown below:
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The Data Link properties tab will now look like the image below
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Enter the name of the SQL Server you wish to log to.  In section 2 specify Windows NT Integrated Security or specify a specific Username and Password.  Check with your SQL Server administrator which type of authentication is required.  From the Select the Database on the Server drop down list all the available databases on the SQL Server are displayed.  Select the required database.  It is also possible to attach to a SQL Server Database file by selecting the database file (.mdf file).

It is a good idea to click the test connection button as this will indicate if there are any problems connecting to the database.

Logging to a Microsoft Excel Spreadsheet
From the General tab of the logger configuration select Database from the storage type drop down list.  On the advanced tab the Database properties should now be configurable.  The connection string can be edited manually by changing the text in the user defined text box below.  The logger can automatically create the connection string by clicking the select button and selecting the properties you require.
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When the select button is pressed the Data Link dialog opens.


Click the provider tab and select Microsoft OLE DB Provider for ODBC Drivers as shown below:
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Click the next button.  The Data Link dialog will appear as shown below:
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From the Data Source drop down select Excel Files.  If authentication is required enter a username and password in the logon section.  Enter the name of the Excel file to be used in section 3.

On the advanced tab access permissions for the Spreadsheet can be granted.

*Note:  The ScadaPro Service must be configured to log on as a user.  To configure the Service to log on a user click Start, Programs and Control Panel.  From the Control Panel select Administrative Tools.  Select the Computer Management applet.  Double Click on Services.  Find the ScadaPro Service from the list, right click on the service and select properties.  Click the Log On tab.   Enter a username and password as shown in the image below.
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It is necessary to stop and start the service before this change will take effect.  To stop the Service, click on the General Tab and click the stop button then on the start button.

*Note: Microsoft Excel must be installed on the machine where the data is being logged.  

*Note: Logging to an Excel Spreadsheet is not suitable for a situation where large numbers of channels are to be logged.  It is recommended that no more than 100 channels are logged to an Excel spreadsheet.

*Note: The Logger puts the date and time into one field, by default Excel will only show the date a sample was taken at.  To view the date and time follow the steps below:

· Ensure the logger is disabled.
· Open the spreadsheet and select the data worksheet
· Highlight the DT Column 
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· From the format menu select cells.
· From the category list select custom
· From the type list find dd/mm/yyyy hh:mm and select it
· Edit the type and add :ss to the end.
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· Click ok.  The date and time each sample was taken at will be visible.  
· Save the spreadsheet

Logging to an Oracle Database
From the General tab of the logger configuration select Database from the storage type drop down list.  On the advanced tab the Database properties should now be configurable.  The connection string can be edited manually by changing the text in the user defined text box below.  The logger can automatically create the connection string by clicking the select button and selecting the properties you require.
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To connect to an Oracle database click the provider tab and select Oracle Provider for OLE DB as shown below:
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Click the next button.

The Data Link properties tab will now look like the image below
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In the Server name box enter the name of the Oracle database to be used.  In section 2 specify a Username and Password with appropriate permissions.  

It is a good idea to click the test connection button as this will indicate if there are any problems connecting to the database.

Tables are automatically created in the SYSTEM Schema.  The LOGGERS table is always stored in the SYSTEM Schema.  All other tables can be stored in a schema by setting the table prefix to SchemaName.Prefix eg. SCOTT.LOGGER_1

*Note: The Product Service must be logged on as a user for logging to an Oracle Database to work.
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This option allows the user to specify a disk space limit which they wish to be informed about if the disk space on the logger drive goes below. To enable this option, click on the Disk Space checking checkbox. The Current Space Available is checked frequently and the amount of free space is displayed at that time. 
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Once a value is entered in the Notification When Free Disk Space Reaches box, the system checks and compares the current free space value against the notification value. If the notification value is less than the current free space value then an error message similar to the one below will appear in the Standard Logger Configuration status bar.

*Note* In Database mode the logger checks disk space on the drive specified in the Logger Directory on the Advanced tab.
[bookmark: _Toc75327263][bookmark: _Toc457384487][bookmark: _Toc457386480][bookmark: _Toc457899699]

[bookmark: _Toc310245132][bookmark: _Toc408991093]Site to Office Overview

Site to Office allows for the transfer of logged data from a site machine to a designated Site to Office server via the internet.



[image: Site to Office Diagram copy]


Data gets written to disk by a source logger, the publication logger then takes this logged data and uploads it via the internet to a subscriber, where the logged data is made immediately available to other customers.

Replication is the capability to copy (i.e. replicate) logged data and changes to that data from one location to another. 

The publisher logger is responsible for moving data held in the log files/database to subscribers.

The logged data to be replicated is called a publication.

A publisher source is a logger that makes data available for other servers, i.e. it is the logger that makes data available for replication.

A subscriber is a server that receives logged data. Each subscriber is associated with a publisher.

The publication logger takes the logged data from the source logger then transfers this to the subscriber server

[bookmark: _Toc408991094]BackFill
When the link to the Site To Office server is lost, the publisher logger continues to attempt to make a connection with the server. Meanwhile data continues to be logged locally. When the connection is re-established the publisher goes into a mode where it has to perform backfill.

In backfill mode the publisher transmits the most recent real-time logged scan and historical data which has not yet been transmitted. The operator on the rig will see the real-time scan and the historical scan numbers of the publisher logger increase as the publisher logger performs the backfill. The historical scan number will lag the real-time scan number when in backfill mode. When the real-time scan and historical scans are the same backfill is complete and the logger is no longer playing catchup.

Backfill is also initialled if a manual input updates the log file. The historical scan is set to the scan number of the manual input and backfill is performed on all the scans which have been updated. If a second manual input is performed during backfill, the backfill process will restart is the scan number of the second manual input is lower than the current historical scan number.

Once backfill is complete trends currently being displayed by Site to Office users on the central server are automatically refreshed.

[bookmark: _Toc310245133][bookmark: _Toc408991095]Source Logger

To check or change the configuration of any logger, double click on it to bring up the logger menu.
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The source logger is a standard logger that will write information to disk which the publication logger then uploads to the Site to Office server.

Selecting the “autostart” check box and saving the configuration will ensure that the Logger begins as soon as the ScadaPro service is started
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[bookmark: _Toc310245134][bookmark: _Toc408991096]Create Publication Logger

To change the configuration of a Logger between Standard and Publisher, open the Control Loggers window.

[image: 38]

Select the logger you wish to change by highlighting it and then pressing the type button.
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You can then configure the source for the logger by double clicking on the logger from the Control Loggers menu.
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Open the ScadaPro Main Menu and select “Control Loggers” from the loggers option
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From the Control Loggers menu select “Publication Logger” to view or make changes to the configuration
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[bookmark: _Toc310245136][bookmark: _Toc408991098]Enable Publication Logger

Please note that the Job Logger must be started before the Publication Logger as the Publication logger uses the Job logger as the source for its data.  To enable the logger, simply press the Enable button along the top of the Publication Window at any time.
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Save a change to a configuration

To save a change to a Publication Logger configuration, make the necessary change and select the “Save” icon located at the top of the window
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[bookmark: _Toc310245137][bookmark: _Toc408991099]Publication Logger General Tab

Logger Name

This is the name for this logger, in this example PUBLICATION_LOGGER
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Source Type

This is the location of the logged data that the publication logger will move to the subscribers. In this case, LOGGER_1
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Destination

This determines where the publication logger sends the logged data to, in effect the location on the subscriber server
[image: ]

Connection Type

The publication logger can transmit logs via HTTP (Site to Office Service) or by LAN and VPN. To choose the type of connection, simply select the appropriate option from the drop down menu:
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Storage Type

Storage Type determines if the logged data is stored as a file or Database. Each method can be selected from the drop down menu:
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Server

This enables the user to select the subscriber server where the publication logger sends the data, to Select a different Subscriber server, press the “select button” and enter in the relevant details
[image: 11]
The format of the Server name is 
https:// <server computer name>\”Q41”Logger:”Q41”@web server name/ScadaPro
where “Q41” is a placeholder for the company name.

Destination Log Files/Tables

This value is the Test Number and can be used to allow updating to source text logs from the Site to Office webpage.
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This tab allows you to determine what rate the publication logger logs data as well as to configure start times.

Publish rate

This section determines the speed at which logged data is uploaded to the subscriber server 

[image: 14]

Publish Times

This allows you to schedule when publishing of logs will begin
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Deletion Times

This section allows for the scheduling of deletion of data
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Deletion can be scheduled from as little as half an hour to as long as three months if required.
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	½ Hour
	8 Hours
	2 Weeks

	Hour
	12 Hours
	Month

	2 Hours
	Day
	2 Months

	4 Hours
	Week
	3 Months



[bookmark: _Toc310245139][bookmark: _Toc408991101]Site to Office Tab
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The Site to Office tab allows the capability to rename the Subscription logger on the Subscriber server.
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To rename the subscription logger, tick the checkbox and name the logger with a relevant title.
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[bookmark: _Toc310245140][bookmark: _Toc408991102]Connection Tab
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This tab determines the buffer size of logs being uploaded to the subscriber server. This will determine the increments the publication logger uses to catch up to the source logger.

[image: 16]

This field determines how many scans of the source logger are transmitted to the Site to Office central server in a single network transaction.

If it is set too low then it will take a lot of time to update a file, as too many transactions will be needed.

If it is set too high then it will take a lot of time to get feedback on progress, as each transaction will take a lot of time to transmit.

For example assuming the optimum transaction size if 500Kb and a scan size of 500 bytes then the optimum publish buffer size should be set at 500Kb/500bytes per scan = 1000 scans.

For example assuming the optimum transaction size if 500Kb and a scan size of 100 bytes then the optimum publish buffer size should be set at 500Kb/100bytes per scan = 5000 scans.

The optimum setting is dependent on the network type and the scan size of the source logger or channel filter being used.

[bookmark: _Toc408991103]Channel Filter
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In order to maximise badwidth usage, a channel filter can be applied to only transfer specific logged channels to the Site to Office central server. 

Select the drop down to ON and choose which channels from the logger to transfer to the Site to Office central server.

A scan size total will be displayed at the bottom in Bytes to help to ascertain the exact size being transferred. 

[image: ]
[bookmark: _Toc310245141][bookmark: _Toc408991104]Status Tab

[image: 17]

The status tab will display any jobs that have not completed logging successfully under the “Incomplete Publications” window. This will also provide details on the data, time and name of the logger that has not completed uploading logged data.
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Current Activity and Scan Number reflect the same values that can be seen from the control Loggers window.

Current Activity will have the values Not Started, Formatting  or Logging. Scan Number will display the number of scans that have been logged, this number will always be slightly lower than the source logger.

When a job is started, enable the publication logger and the status tab will automatically detect that a job has been started
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Select “Yes” to reload the incomplete list, it will subsequently show the details of any jobs that have not yet been completed.
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To remove the incomplete publication from the list, you can stop the job logger and allow the Publication logger to catch up or highlight the entry you wish to remove and select delete from the options on the right hand side of the tab.
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If the publication logger is unable to transfer the data to the subscriber server, the logger will remain in the Incomplete Publications list; this can then be started from the status tab to prevent loss of data. To start an Incomplete Publication, highlight it and select start from the side menu.
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The logger will then continue logging and the data is not lost























[bookmark: _Toc310245142][bookmark: _Toc408991105]Logging Data with Site to Office 

In these examples, Logger_1 will be the logger used as a source and Logger_3 will be used as the publication logger.

Logger 1 will take in data from pre-defined channels, this will then act as a source for the publication logger (logger 3) to upload to the subscriber (the server holding the logged data)

To start logging data, launch ScadaPro and select “Control Loggers” from the Loggers menu
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From the Control Loggers menu you can Enable or Disable loggers.
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To choose a destination for the Publication Logger, you will need to open the Job Info Configurable Monitor, to do this go to Monitors/Configurable Monitors and Monitor Selection from the ScadaPro Main Menu.
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Locate Job Info and select it.
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When the Job Info configurable monitor has loaded enter in the Company Name in the client field and a Well Number in the Test Name field.
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Once the destination has been configured, you can enable the Publication Logger

[image: 31]

Please note that for the Publication Logger to work, the Client must have a field user on the destination server.

This logged data can then be viewed in Real-Time on the Site to Office web page

[bookmark: _Toc408991106]Log Files
This section allows the user to save the ScadaPro configuration to the logger directory.  There is also an option to make the Log Files read-only. The prefix is used to prefix log files with text. The logger file prefix can include channel values. See Including Channel Values below.


[bookmark: _Toc75327264][bookmark: _Toc408991107]Synchronous Device Scanning
The logger can be forced to log at the same rate as the scan rate of the device channels are being logged from.  A warning can also be triggered if the device stops updating. Devices that are scanning channels to be logged can be automatically enabled when the logger is enabled.
[bookmark: _Toc75327265]
[bookmark: _Toc408991108]Including Channel and System Values
Various logger options can be modified when the logger is enabled to include channel values. This is convenient where channel values are used to store reference values such as product numbers or shift number. Logger options which can include channel values include
	
	Logger Directory Name
	Logger File prefix
	Logger Header Text
	Logger Predefined Messages
	Logger Export File Name
	Logger Export Email Subject

Channels are included by inserting the channel identifier or tags prefixed with underscore in double quotation marks e.g PRODUCT_”P1” or PRODUCT_”_TAGNAME”. If the channel is analog then the current channel value is included. If the channel is digital then the current channel value description is included. 

User analog channels can be mapped to string values using a values.txt file store in <Installation Directory>\CURRENT_CONFIG\USERA\values.txt. The following example maps User Analog channel 1 (normally P1) to product strings and Analog channel 2 (normally P2) to

[Channel1]
*
* Product Values
*
1=PEPSI
2=COKE
3=FANTA
4=SPRITE
5=RIVER ROCK
6=DIET COKE
7=DIET FANTA
8=2 DIET COKE
9=DR. PEPPER


[Channel2]
*
* Shift Values
*
1=SHIFT A
2=SHIFT B
3=SHIFT C
4=SHIFT D

The string inserted can be modified by preceding the channel identifier or tag within the quotation marks with a format specification

A format specification, which consists of optional and required fields, has the following form:
%[flags] [width] [.precision] [type]
Each field of the format specification is a single character or a number signifying a particular format option. The simplest format specification contains only the percent sign and a type character (for example, %s). If a percent sign is followed by a character that has no meaning as a format field, the character is used. For example, to print a percent-sign character, use %%.
Example
For example, P1 is set to 1.2320534 and values.txt maps 1 to the string WIDGETS
	“%sP1” will output WIDGETS
	“%dP1” will 1
	“%fP1” will output 1.232053

For example, Q1 is set to high and description is set to STOPPED
	“%sQ1” will output STOPPED
	“%dQ1” will output 1
	“%fQ1” will output 1.000000



type
Required character that determines whether the associated channel value is interpreted as a string or a number.


	Character
	Output Format

	d
	Signed decimal integer.

	i
	Signed decimal integer.

	o
	Unsigned octal integer.

	u
	Unsigned decimal integer.

	x
	Unsigned hexadecimal integer, using “abcdef.”

	X
	Unsigned hexadecimal integer, using “ABCDEF.”

	e 
	Signed value having the form [ – ]d.dddd e [sign]ddd where d is a single decimal digit, dddd is one or more decimal digits, ddd is exactly three decimal digits, and sign is + or –.

	E
	Identical to the e format except that E rather than e introduces the exponent.

	F
	Signed value having the form [ – ]dddd.dddd, where dddd is one or more decimal digits. The number of digits before the decimal point depends on the magnitude of the number, and the number of digits after the decimal point depends on the requested precision.

	g
	Signed value printed in f or e format, whichever is more compact for the given value and precision. The e format is used only when the exponent of the value is less than –4 or greater than or equal to the precision argument. Trailing zeros are truncated, and the decimal point appears only if one or more digits follow it.

	G
	Identical to the g format, except that E, rather than e, introduces the exponent (where appropriate).

	s
	Specifies a character string. Characters are printed up to the first null character or until the precision value is reached.





flags
Optional character or characters that control justification of output and printing of signs, blanks, decimal points, and octal and hexadecimal prefixes More than one flag can appear in a format specification.
A flag directive is a character that justifies output and prints signs, blanks, decimal points, and octal and hexadecimal prefixes. More than one flag directive may appear in a format specification. 
	[bookmark: _crt_table_r..4]Flag
	Meaning
	Default

	–
	Left align the result within the given field width. 
	Right align.

	+
	Prefix the output value with a sign (+ or –) if the output value is of a signed type.
	Sign appears only for negative signed values (–).

	0
	If width is prefixed with 0, zeros are added until the minimum width is reached. If 0 and – appear, the 0 is ignored. If 0 is specified with an integer format (i, u, x, X, o, d) the 0 is ignored. 
	No padding.

	blank (' ')
	Prefix the output value with a blank if the output value is signed and positive; the blank is ignored if both the blank and + flags appear.
	No blank appears.

	#
	When used with the o, x, or X format, the # flag prefixes any nonzero output value with 0, 0x, or 0X, respectively.
	No blank appears.

	
	When used with the e, E, or f format, the # flag forces the output value to contain a decimal point in all cases. 
	Decimal point appears only if digits follow it.

	
	When used with the g or G format, the # flag forces the output value to contain a decimal point in all cases and prevents the truncation of trailing zeros. 
Ignored when used with c, d, i, u, or s.
	Decimal point appears only if digits follow it. Trailing zeros are truncated.



width
Optional number that specifies the minimum number of characters output. 
The width argument is a nonnegative decimal integer controlling the minimum number of characters printed. If the number of characters in the output value is less than the specified width, blanks are added to the left or the right of the values — depending on whether the – flag (for left alignment) is specified — until the minimum width is reached. If width is prefixed with 0, zeros are added until the minimum width is reached (not useful for left-aligned numbers).
The width specification never causes a value to be truncated. If the number of characters in the output value is greater than the specified width, or if width is not given, all characters of the value are used subject to the precision specification.

precision
Optional number that specifies the maximum number of characters printed for all or part of the output field, or the minimum number of digits printed for integer values 

It specifies a nonnegative decimal integer, preceded by a period (.), which specifies the number of characters to be used the number of decimal places, or the number of significant digits. Unlike the width specification, the precision specification can cause either truncation of the output value or rounding of a floating-point value. If precision is specified as 0 and the channel value to be converted is 0, the result is no characters output, as shown below:
"%.0dP1" where P1 is equal to 0 then no characters output
The type determines the interpretation of precision and the default when precision is omitted, as shown in the table below.
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	Type
	Meaning
	Default

	d, i, u, o, x, X
	The precision specifies the minimum number of digits to be printed. If the number of digits in the argument is less than precision, the output value is padded on the left with zeros. The value is not truncated when the number of digits exceeds precision.
	Default precision is 1.

	e, E
	The precision specifies the number of digits to be printed after the decimal point. The last digit is rounded.
	Default precision is 6; if precision is 0 or the period (.) appears without a number following it, no decimal point is used. 

	f 
	The precision value specifies the number of digits after the decimal point. If a decimal point appears, at least one digit appears before it. The value is rounded to the appropriate number of digits. 
	Default precision is 6; if precision is 0, or if the period (.) appears without a number following it, no decimal point is used.

	g, G
	The precision specifies the maximum number of significant digits.
	Six significant digits are output, with any trailing zeros truncated.

	s
	The precision specifies the maximum number of characters to be printed. Characters in excess of precision are not used.
	All characters are used.





The following system values can be included.

“ComputerName”
“SkypeUser”
“TeamViewerId”
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Reloading Logger Configuration
To reload the initial configuration which the logger had when it was first run, either click on the    button on the toolbar or chose New from the File menu bar.
A logger can be used without saving the configuration but if the computer system is rebooted then the configuration will be lost.


[bookmark: _Toc394746113][bookmark: _Toc395410424][bookmark: _Toc427127944][bookmark: _Toc427553834][bookmark: _Toc427571291][bookmark: _Toc427571352][bookmark: _Toc427571413][bookmark: _Toc427571518][bookmark: _Toc427634247][bookmark: _Toc427634417][bookmark: _Toc427639257][bookmark: _Toc427985811][bookmark: _Toc428095691][bookmark: _Toc428095791][bookmark: _Toc457182198][bookmark: _Toc457384488][bookmark: _Toc457386481][bookmark: _Toc457899700][bookmark: _Toc75327267][bookmark: _Toc408991110]Saving Logger Configuration
To retain the configuration of a loggerGlossLogger.77 it must be saved to disk.  To save the configuration either click on the  button on the toolbar or chose Save from the File menu bar, no name is required.
A logger can be used without saving the configuration but if the computer system is rebooted then the configuration will be lost.
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The loggers can be controlled from two different locations within the ScadaPro Software Package.  Loggers can be controlled from within their own Logger Configuration Window or by choosing Control Loggers  from the Loggers menu in the ScadaPro main Window. The control functions available are the same in both Windows.
[bookmark: _Toc394746115][bookmark: _Toc395410426][bookmark: _Toc427127946][bookmark: _Toc427553836][bookmark: _Toc427571293][bookmark: _Toc427571354][bookmark: _Toc427571415][bookmark: _Toc427571520][bookmark: _Toc427634249][bookmark: _Toc427634419][bookmark: _Toc427639259][bookmark: _Toc427985813][bookmark: _Toc428095693][bookmark: _Toc428095793][bookmark: _Toc457182200][bookmark: _Toc457384490][bookmark: _Toc457386483][bookmark: _Toc457899702]Logger Control Functions.
Enable Logger
This function will start a loggerGlossLogger.77 operating.  If a start time, or cycle time has been set then the logger will wait until that time is reached before logging data to disk.  If the ScadaPro system is not itself enabled then the logger will start operating but will not log any data until the system is enabled.

Disable Logger
The loggerGlossLogger.77 will cease logging and the log file closed down.  The logger will be available to be re-enabled at anytime.

NB.
If a logger stops because a configured Stop Time is reached the logger must still be manually disabled to close the log file down.
Force
No matter which mode a loggerGlossLogger.77 is operating in providing it is enabled, Force will cause a one shot log to the log file of the configured channels.
Cycle
Selecting Cycle from the control options will cause a loggerGlossLogger.77 to stop logging during the current time cycle, but to commence logging at the start of the next cycle.
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Individual loggers can be controlled from within their own LoggerGlossLogger.77 Configuration Window.  To Enable the logger click on the  button.  To Disable the logger choose the  button.  The intensity of the legend on the buttons will depend on the current status of the logger.  If the legend is dark then the option is available. If lighter it is not available whilst the logger is in the current condition.
As an alternative to using the toolbar all the control options including Force and Cycle are available from the Control  menu.
When a logger's configuration window is the active window the following fast keys can be used:

	CTRL+E
	Enable Logger

	CTRL+D
	Disable Logger

	CTRL+C
	Suspend Current Cycle

	CTRL+F
	Force Log
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Control of all loggers can be performed from a single window invoked by choosing LoggerGlossLogger.77 Control from the Loggers menu in the ScadaPro Main Control Window.

[image: ]

The Logger Window will show the current name of all the loggers; their status; current activity; and the number of scans logged to disk.

To control a logger from this window point select a logger from the list, it will be highlighted.  The buttons on the right of the Window will if selected operate on the chosen logger.  The intensity of the legend on the buttons will depend on the current status of the logger.  If the legend is dark then the option is available. If light it is not available whilst the logger is in the current status.
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Log Files
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To calculate the size of a logged data file you need to know the following:

	no_blocks
	The number of blocks or groups of Channels Configured (1-16).

	no_analogs
	The total number of Analogue Channels to be logged. 

	no_digitals
	The total number of Digital Channels to be logged.

	no_chans
	The total number of channels to be logged. i.e. no_analogs + no_digitals

	no_scans
	The expected number of scans to be logged.



At the start of every log file there is block of information recorded about each channel to be logged.  This information includes the tag, description and units of each channel.  Also in this header is information necessary for the accurate replaying of the data at a later date.

The size of this block can be represented by:
File_hdr  = 900 + (no_blocks * 4) + (no_channels * 216)

Each log scan records not only the value of each of the logged channel, but also their status and exact time of the scan.

The size of each scan is represented as:
scan_sz = 18+(no_blocks*2)+(no_digitals*4)+(no_analogs*8)

NB.
All Device channels are stored as Analogue Channels

The complete file size can now be calculated as:
file_sz = file_hdr + (no_scans * scan_sz).

As an example let us assume we want to log the following information every minute for 24 hours.

	DS1 -32
	Device – Analog inputs

	DS65-72
	Device – Digital inputs

	P1-16
	User Analogs

	C5-15
	Calculator Values (Analog)

	Q1-8 
	User Digitals



	no_blocks	= 					5
	no_analogs	= 32 + 8 + 16 + 10 =			66
	no_digitals 	=					8
	no_chans	= 					74
	no_scans	= 1 * 60 * 24 =				1440
	File_hdr 	= 900 + ( 5*4 ) + ( 74 * 216) = 		16,904
	scan_sz 	= 18 + ( 5 * 2 ) + ( 16 * 4 ) + ( 66 * 8 ) = 	620
	file_sz		= 16,904 + ( 1440 * 620 )  = 		909,704 bytes 
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When loggers are enabled the files they create are named automatically and stored on the disk for easy management and retrieval.  All Directories and sub directories are created automatically as required.

All files concerned with the ScadaPro Software Package are found in a directory called ScadaPro in the root directory.  All files created by the logging utilities are placed in a sub-directory called LOGGED_DATA within the ScadaPro directory.

Whenever a loggerGlossLogger.77 is enabled with a new name a sub-directory unique to that logger name will be created in the LOGGED_DATA directory.  A file containing the logged information will be placed in the new directory.  If subsequent files are created with the same logger name they will be added to the existing sub directory

File names are automatically assigned to logged data files.  The filename is created from the start and stop time and dates.  The file name can be represented as:
	YYMMDD_HHMMSS_ZZNNEE_OOIIEE.odl
Where:	YYMMDD = start date: Year, Month, Day
	HHMMSS = start time: Hours, Minutes, Seconds
	ZZNNEE  = stop date: Year, Month, Day
	OOIIEE   = stop time: Hours, Minutes, Seconds
E.g. A file started at 00:01 on 4th July 1994 and ending at 18:00 on 8th July 1994 would have the filename of:
	940704_000100_940708_180000.odl

The file name nomenclature allows easy retrieval of specific logged instances.

While the logger is enabled the file name will only be that of start date and start time. The stop date and time is only added when the file is successfully completed.  Again this easily identifies active files. 

The Windows Explorer can be used to manage the logged data files if required. 
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Database Logs

When loggers are enabled the logs they create are named automatically and stored in the database for easy management and retrieval. The databases and tables are created automatically as required.

A fixed LOGGERS table is used to store the names, start and stop times and sequence number of each log created in the database.

The sequence number is a numerically ascending sequence of the log. If a logger is set to append on startup and append on cycle with a fixed channel set, a sequence number of zero is used for the first log created and the following tables are created.

<LOGGER NAME/PREFIX>_DATA
<LOGGER NAME/PREFIX>_TEXT
<LOGGER NAME/PREFIX>_CHANNELS

If a logger is set to create on startup or create on cycle, a starting sequence number of one is used for the first log created and the following tables are created

<LOGGER NAME/PREFIX>_<SEQUENCE>_DATA
<LOGGER NAME/PREFIX>_<SEQUENCE>_TEXT
<LOGGER NAME/PREFIX>_<SEQUENCE>_CHANNELS

The DATA table is the main table used for store channel values and text logs

The TEXT table is used to store predefine text logs.

The CHANNELS table is used to store the configuration of each channel.

For Oracle, the database to use can set by setting the prefix to <DATABASE NAME>.<TABLE PREFIX>
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Data Import
The Data Import application will Import an ACSII text file with columns of data and create a System Data Log (.ODL) file from the data. Prior to import, the ASCII file must be described by the user. This description can then be saved as an Import Configuration File (ORI) which can be reused. A text header can be also imported.
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It is important to give a good description of the ASCII file to be imported so that the data is interpreted correctly. The user must also describe how the data should be formatted in the output log file

The following information is required :
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A unique channel number and is used to identify individual columns of data. Each channel may represent a data point from a device or processor. A prefix and source name is used to identify the processor or device.
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Enter up to two alphabetical characters for the source prefix of the data to be imported. 
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Data is stored in ranges in a data log file. Enter a channel number between 1 and 10,000 for the start of the range.
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Enter up to 25 characters for a name to describe the data being imported.
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There may be lines of text at the start of the ASCII file to import which could be used to describe the data. This header information can be imported into a text file with the correct System format. This header information can also be ignored.
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Click this check box on if you require header information to be imported.
[bookmark: _Toc427985827][bookmark: _Toc428095707][bookmark: _Toc428095807][bookmark: _Toc457182214][bookmark: _Toc457384504][bookmark: _Toc457386497][bookmark: _Toc457899716]No. Header Lines
Enter the number of header lines at the start of the ASCII file.
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It is important to fill in the No. Header Lines field even if you do not require header information to be imported. It informs the application which line the data starts at.
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This information describes how each column of data is formatted in the ASCII file.
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Three options and a User Defined alternative are available in this drop down list.  The delimiter separates each field in a row.  The correct delimiter is required for the data to be interpreted correctly.  The choices are:
	 	Comma  
		Space
		Tab.  
		User
As an alternative to the fixed choices a User option is available.  If this is chosen enter the delimiting character in the text box that appears alongside the list.
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Similar to the Delimiter there are choices for the end of line separator.  The choices are: 
		CR ( Carriage Return) 
		LF ( Line Feed ) 
		CR/LF.  
		User
A User option is again an option.
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You must add a column entry for every column of data you wish to import.
Click on the Add button to launch a dialog which allows you to enter this information.

For each column of data enter the following :
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The column number in which the data appears in the ACSII file.
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Enter up to 16 characters of tag information.
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Enter up to 32 characters of description information.
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Enter up to 4 characters of units information.

A column may be imported more than once at a time. For performance it is recommended that columns be imported sequentially. When done click on the OK button. The entry will be added to the list.

Click on the Import button to continue configuration.

A dialog will be launched which asks for further import details. The following information is required :
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Click this check box on if the scan time is contained in a column in the ASCII file.
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Enter the column number of the scan time if it is contained in a column in the ASCII file.
[bookmark: _Toc427985839][bookmark: _Toc428095719][bookmark: _Toc428095819][bookmark: _Toc457182226][bookmark: _Toc457384516][bookmark: _Toc457386509][bookmark: _Toc457899728]Time Type
If the scan time is contained in a column in the ASCII file select the type of time this column contains :

Differential or Elapsed
[bookmark: _Toc427985840][bookmark: _Toc428095720][bookmark: _Toc428095820][bookmark: _Toc457182227][bookmark: _Toc457384517][bookmark: _Toc457386510][bookmark: _Toc457899729]Time Interval Per Scan
If the scan time is not contained in a column in the ASCII file enter the number of seconds between each scan.
[bookmark: _Toc427985841][bookmark: _Toc428095721][bookmark: _Toc428095821][bookmark: _Toc457182228][bookmark: _Toc457384518][bookmark: _Toc457386511][bookmark: _Toc457899730]Start Time
Enter the start time for the new log file. Click on the Current Time button to set the Start Time to the current time.
[bookmark: _Toc427985842][bookmark: _Toc428095722][bookmark: _Toc428095822][bookmark: _Toc457182229][bookmark: _Toc457384519][bookmark: _Toc457386512][bookmark: _Toc457899731]Logger Directory
Enter the directory where the output log file should be created.

Then click on the Import button to select the required ASCII file. The import task is launched as soon as the ASCII file has been successfully selected. An Import In Progress will be displayed. If you wish to stop the operation click on the Cancel button. 
[bookmark: _Toc427985843][bookmark: _Toc428095723][bookmark: _Toc428095823][bookmark: _Toc457182230][bookmark: _Toc457384520][bookmark: _Toc457386513][bookmark: _Toc457899732][bookmark: _Toc75327271][bookmark: _Toc408991115]
Program Arguments
This application can accept command line arguments in 2 ways :

The Import Configuration file only (.ORI) 
The application opens the previously saved configuration file and is ready to import an ASCII file.

The ASCII file (*.*) and the Import Configuration file (.ORI) ,in that order.
The application opens the previously saved configuration file and immediately launches the import task on the ASCII file.

File names with spaces must have quotes (“”) wrapped around them to allow the names to be interpreted correctly.
[bookmark: _Toc427985844][bookmark: _Toc428095724][bookmark: _Toc428095824][bookmark: _Toc457182231][bookmark: _Toc457384521][bookmark: _Toc457386514][bookmark: _Toc457899733][bookmark: _Toc75327272][bookmark: _Toc408991116]
Editing Channel properties
For each column of data enter the following :
[bookmark: _Toc427985845][bookmark: _Toc428095725][bookmark: _Toc428095825][bookmark: _Toc457182232][bookmark: _Toc457384522][bookmark: _Toc457386515][bookmark: _Toc457899734]Column Number
The column number in which the data appears in the ACSII file.
[bookmark: _Toc427985846][bookmark: _Toc428095726][bookmark: _Toc428095826][bookmark: _Toc457182233][bookmark: _Toc457384523][bookmark: _Toc457386516][bookmark: _Toc457899735]Tag
Enter up to 16 characters of tag information.
[bookmark: _Toc427985847][bookmark: _Toc428095727][bookmark: _Toc428095827][bookmark: _Toc457182234][bookmark: _Toc457384524][bookmark: _Toc457386517][bookmark: _Toc457899736]Description
Enter up to 32 characters of description information.
[bookmark: _Toc427985848][bookmark: _Toc428095728][bookmark: _Toc428095828][bookmark: _Toc457182235][bookmark: _Toc457384525][bookmark: _Toc457386518][bookmark: _Toc457899737]Units
Enter up to 4 characters of units information.


A column may be imported more than once at a time. For performance it is recommended that columns be imported sequentially. When done click on the OK button. The entry will be added to the list. 
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[bookmark: _Toc394746120][bookmark: _Toc395410432][bookmark: _Toc457899738][bookmark: _Toc408991117]Part Seven – Replay options

Part Seven details the use of the Replay Options available in ScadaPro

Data Export
Trend Replays
Data Import
Log File Merge Utility
Log File Synchronisation Utility

[bookmark: _Toc457899739][bookmark: _Toc97010958][bookmark: _Toc252978557][bookmark: _Toc408991118][bookmark: _Toc457899753][bookmark: _Toc97010960]
Data Export
Logged data filesGlossDatafiles.36 stored by any SCADAPRO loggers can be converted into file formats suitable for importing into industry standard spreadsheets such as Microsoft ExcelGlossExcel.37 or Lotus 1-2-3Gloss1.2.3.35. The SCADAPRO Data Export facility allows the user to carry out such conversions.

When the Data Export facility is selected, the user is prompted as follows


[image: C:\Users\gerard.canning\AppData\Local\Microsoft\Windows\Temporary Internet Files\Content.Outlook\WQWKG03H\Untitled.png]

Replay Log Files

If the Replay File selection is chosen, the following file dialog is displayed.


[image: ]

The directories box will show the logged_data directory open and a list of all the logger sub-directories. Each sub-directory will bear the logger name that created the directory. Select the appropriate directory by either pointing to it and double clicking the mouse, or select the directory and press OK.

[image: ]

In the File Name Box a list of files created by that logger will be listed. The filename was created from the start and stop times and dates when the logger started and stopped the recording. The Description field at the bottom of the dialog box will decode the filename to display the actual start and stop time of the file.

While the logger is enabled and logging data the filename will be that of the date and start time only. The stop date and time is added when the file is successfully closed.

Choose the file to export and select the OK button. 

If the connection is via TCP/IP to a Windows CE CE or Linux device the following dialog appears when selecting the log file to export:


[bookmark: _Toc457899740][bookmark: _Toc97010959][image: ]
Replay Log Files

If the Replay Database Log selection is chosen, the following file dialog is displayed.

[image: ]


The database to use is selected in same way as the database logger is configured.

The logger box displays the list of all loggers which have data store in the selected database.

A list of logs created by that logger will be listed. The sequence number of the log and the start and stop time of the log are displayed.

While the logger is enabled and logging data the start time only is displayed.

Choose the log to export and select the OK button. 
[bookmark: _Toc252978558][bookmark: _Toc408991119]
Configuring Data for Export
A Data Export dialog box will be shown.

[image: ]

The complete log does not have to be exported.  A time portion can be chosen as well as selected channels.  Descriptive information about the channels can be omitted if required.  The resolution of the results can be modified as can the format of the data. The following details the configuration of each section.

Configuration Files
Select from the drop down list a predefined Configuration file, which contains settings to be applied to the current log. Configuration Files can be edited and are saved automatically on generation of the export or by clicking exit.  Click new to create a new configuration file, delete to delete one, rename to edit the name of the configuration file, or copy to copy the settings to a new file.

[bookmark: _Toc394746123][bookmark: _Toc395410435][bookmark: _Toc457899741]Single Time Period / Multiple Time Period
Choose from the drop down whether the source log file will be exported as a single time period / or as multiple time periods. If a single time period is choosen, select the start and stop information as below.  One set of data will then be exported.  Multiple time periods allow mulitiple sets of data for export, with different time periods, channels and data intervals. Time periods are identified and set in the logged data using trends.
Start Time
If this box is not checked the data will be converted from the first scan of the file. If a different start time is needed check this box. Edit the resulting date and time boxes to the start time needed. 

[image: ]
[bookmark: _Toc394746124][bookmark: _Toc395410436][bookmark: _Toc457899742]Stop Time
If this box is not checked the data will be converted up to the last scan of the file.  If a different stop time is needed check this box. Edit the resulting date and time boxes to the stop time needed. 

[image: ]
[bookmark: _Toc457899743]Text Header 
There are three options available for export of Text Header information, None, User Defined, and Logged Header Text.

If Logged Hearder Text is selected information from the Logger Header Text will be included for export. This information is stored with the log, and is specified in the Header of the Text section for that log. If User Defined is selected the edit region will allow manually entry of text for inclusion in the export. If None is selected no Header information is included for export.

Replay Channels (Single Time Period Only)
Either all channels in the original logged data file can be exported or just a selection.

If All Channels is selected then the Channel blocks will show all the channels to be converted.  If all channels are not required chose Selected Channels from the drop down list.  Initially all the channels in the logged data file will be shown in their blocks.  
To edit each block point to it and click the mouse. An Enter Selected Log Channels dialog box will appear.  


[image: ]

Channel lists can also be used for export, click the drop down and choose a predefined channel list which will contain a list of channels for use in the export.  Click Configure Channel Lists to configure/create a list for export.

Trend images can be used for export to excel spreadsheets, if associated with a channel list name. For example, in the image below, two trend buttons Trend1 and Trend2 can be seen. To incorporate a trend image for export, a naming convention with channel lists must be used. This is the name of the two trends required separated by an ampersand &. 

[image: ]

In the example above two trends called Daily_Choke.ort and Daily_Rates.ort are stored in the Trends directory. The channel list is named to specifiy both these trends separated by an ampersand, i.e. Daily_Choke & Daily_Rates.  This channel list specifies the channels required for export.  If the trend files did not exist the trend buttons would not appear. Click Trend1 to open the first trend Daily_Choke.ort, it will zoom to the start and stop time indicated in the Start and Stop time section. Click the export image button to export the image of the trend accept the default name of the image. Exported images are stored in the Exported_Images directory by default.

[image: ]

In the excel spreadsheet template add the following keywords

C:\EDGEX\EXPORTED_IMAGES\%chanlist_1.jpg
C:\EDGEX\EXPORTED_IMAGES\%chanlist_2.jpg


This will automate the trends to place them in the position required when automating the export.
Replay Periods (Multiple Time Periods Only)
The replay periods section, allows selection of the time periods specified in the log, in order to configure the channels and data intervals required for those periods.
[image: ]
In order to configure the channels for export for each of the individual time periods click the name of the period in the Replay Periods section. The following dialog will appear.

[image: ]

Click enable to enable the replay period.

The first drop down indicitates the start period name, underneath this is the start time of that period which can be edited here for the data export. 

The next drop down indicates the name of the end period. If a different period name is choosen, the stop time will reference the stop time of that period. A different period name would be choosen as the stop period in order to incorporate multiple data lists for the one period.

The replay channels section is performed as described above.

Data Interval

Users may wish to export only a certain amount of data. The Sample Skip option allows the user to decide how many samples will be exported. If a sample rate of say, n, is entered then every nth sample will be exported. The Sample Skip combo box has Three options Export All and Skip Every and Skip Time Frequency. Select Skip Every and an edit box will appear, type in the skip factor in terms of logs/scans. Select Skip Time Frequency and an edit box will appear type in the skip factor in terms of seconds. Select Skip Duplicates to skip duplicated data. 


Export - Options

[image: ]


Logger Header/Sheet

CSV, TXT and DIF export files 
If logger Header/sheet is included the logged data file name, the logger name and the start and stop times of the logger will be included in the exported data at the top of the file.

Excel Worksheet (XLS) files 
A worksheet wil be created called LOGGERS which will give detailed information in column format, about the logged data this includes logger name, start and stop times, header information and logger sequence. 

Channels Header/Sheet

This will display the channel number (prefix plus number), tags, descriptions, units and Low and High state descriptions of the channels selected for export.

Excel Worksheet (XLS) files 

A worksheet wil be created called _CHANNELS this will display in column format the details of the channels selected for export, such as the channel number (prefix plus number), tags, descriptions, units and Low and High state descriptions, min and max scales and more. 

Text Logs Header/Sheet

CSV, TXT and DIF export files 
Text logs from the data log file will be exported. By default they are exported per time basis only, check Date of Text Logs to have the date associated with the data.

Excel Worksheet (XLS) files 
Text logs from the data log file will be exported into a worksheet called _TEXTLOGS. The default includes the time beside the text log.

Date/Time of Text Logs 
Check this box to specify the date and time of the text log.

Date Format
The date format drop down box allows you to select the way you want your date to be presented in the data export.  The available date formats include:
· Short Format   E.G. 08/27/04 15:45:23
· Long Format   E.G.: Monday, August 01, 2004 11:25:39
· dd/MM/yyyy
· dd/MM/yy
· MM/dd/yyyy
· MM/dd/yy
· yy/MM/dd
· yyyy/MM/dd
· yyyy-MM-dd
· yy-MM-dd
· dd-MM-yyyy
· dd-MM-yy
Data Logs/Sheet
To include actual logged data, check the Data Logs/Sheet check box, the following options in this section include additional ways to format the data for export.

Column Headers 
Column Headers alone, display the channel number and prefix of the logged channel. Check Header Tags, to display the tag of the channel and not the channel number, check Header Units to include the units on the next line.

Date/Time Column 

Time Base - Three time base options are available. The time selected appears in the spreadsheets first column of each scan. The choices are: Elapsed Time, Differential Time and Absolute Time 

Date – If this check box is checked the date column will be included in the exported data logs. 

Date – Long Date Format, if this check box is checked dates will have the long format. Long and short date formats are defined in the ‘Regional Settings’ applet of the Control Panel. 

Ms Column – Include a column for miliseconds in the exported data. 

Text Logs With Data 
Check Text Logs With Data to include text logs from the log file for export. They are appended with the data on the last column of the row.

Text Logs on Separate Rows 
Check Text Logs on Separate Rows to display text logs on a new line within the exported data file.

Statistics 

Selecting statistics will append statistics for the selected channels at the bottom of the exported data. Statistics include:

· Mean Square Root (MSR) 
· Average (AVG) 
· Minimum (MIN) 
· Maximum (MAX) 
· Standard Deviation (STD DEV) 
· Difference between Minimum and Maximum (DIFF) 

Report Negative Values as Zero
Check this if you would like to report any negative values as zero in the export.


Export - Sample Skip – Single Time Period Only
 
· Export All 
· Skip Every (logs/scans) 
· Skip Time Frequency (seconds) 
· Skip Duplicates 

With large data files users may wish to export only a certain amount of data. The Sample Skip option allows the user to decide how may samples will be exported. If a sample rate of say, n, is entered then every nth sample will be exported. The Sample Skip combo box has Three options Export All and Skip Every and Skip Time Frequency. Select Skip Every and an edit box will appear, type in the skip factor in terms of logs/scans. Select Skip Time Frequency and an edit box will appear type in the skip factor in terms of seconds. Select Skip Duplicates to skip duplicated data



Destination Options

After selecting the logged data or database file and configuring it for export, the Destination File must be selected to specify the type of file you wish to export to. The following image displays the Destination File section of Data Export.

[image: ]

The types of file available for export are:

· Spreadsheet File (*.CSV) 
· Data Interchange Format (*.DIF) 
· Text Files (*.TXT) 
· Excel Workbook (*.XLS) 


Split into Multiple Files for Excel Column Limit
When importing csv text files, Excel can only read 255 columns and when importing dif files Excel can only read 254 columns. Select this option if exporting a large number of channels to Excel. Data will be exported in files appended with a sequence number.

Split into Multiple Files for Time Periods
When exporting to Excel Spreadsheet, if using multiple time periods, these periods can be separated into single spreadsheet files for each period.


Template (Excel Workbook (*.XLS) Format Only)

When an Excel Workbook (.xls) format is chosen for data export, a Template check box appears to allow selection of an Excel Workbook file for use as the template. 
Excel Templates are stored in the REPLAY_OPTIONS\TEMPLATES system folder by default. 
Data export will use this Excel Template file to persist formating options defined by the user.  

Data is exported into the _DATA worksheet of an XLS workbook. To specifiy where to place the starting point of the data, insert the keyword _START, into the template files corresponding _DATA worksheet. 

To insert images, place they keyword _PICTURE= followed by the path to the image.

For example in the image below the template contains the _PICTURE and _START keywords, some formatting as also been applied to the document.

[image: ]

When applied by data export this formats the information as below:

[image: ]
Open Destination
Data Export will attempt to open the exported file with an associated application.  For example if you export the file in Data Interchange format (.DIF) Data Export will launch Microsoft Excel to open the exported file.  If no application is associated with the file type then no application will be launched.  If you need to associate an application with a file type search for File Associations in Windows Help.

[bookmark: _Toc457899752][bookmark: _Toc457899749]End Line
Similar to the Delimiter there is choices for the end of line separator.  The choices are: 
		CR (Carriage Return) 
		LF (Line Feed) 
		CR/LF.  
		User

As an alternative to the fixed choices a User option is available.  If this is chosen enter the delimiting character in the text box that appears alongside the list.
Value Width
Results are stored in the SCADAPRO Log Files with full floating point precision.  The actual width of the number passed can be modified.  In the Value Width text box enter or edit the total number of digits, including the decimal point required.  If the value when converted is greater than the width defined the value will be converted to Scientific notation.  If a Tab file is selected in the delimiter the value width is set to 8 by default.
[bookmark: _Toc457899750]Value Precision
In this box enter the number of digits after the decimal point.
[bookmark: _Toc457899751]Delimiter
Three options and a User Defined alternative are available in this drop down list.  The delimiter separates each field in a row.  The correct delimiter is required for the spreadsheet package to import the data correctly.  The choices are:
	 	Comma  
		Space
		Tab.  
		User

Most modern spreadsheets including ExcelGlossExcel.37 and Lotus use the Comma separator.

As an alternative to the fixed choices a User option is available.  If this is chosen enter the delimiting character in the text box that appears alongside the list.
[bookmark: _Toc408991120]Exporting Data
When all configurations have been completed choose the Export button.  A Select Data Export Output File dialog box will be presented.

[image: ]


Before completing this dialog box one must know the type of file acceptable to the spreadsheet or other software package that is to accept this file.
[bookmark: _Toc457899754]File Name
Enter the filename of the resulting exported file.  The extension used should be of the correct type, see "Save File As Type" later in this section.
[bookmark: _Toc457899755]Save in
Using normal Windows techniques choose the directory where the exported file is to be placed.
[bookmark: _Toc457899756]Save File as Type
This field defines the ultimate format of the file.  The correct type of file must be selected so the software package that is to import this file can do so correctly.
	
The choices are:
		Speadsheet Files (.CSV)
		Text Files   (.TXT)
		Data Interchange Format (.DIF)
		Excel Spreadsheet (.XLS)
		Other Files (*.*)
[bookmark: _Toc457899757]Network:
Exported files can be stored anywhere the user has access to on a Network.  In the Save in field a list of other drives on the network available to the user will appear. The Network Neighbourhood icon, in the Save in field allows the user to connect to a remote drive.  This facility would be used to make a connection over a modem link to another system using the Remote Access features of Windows.
[bookmark: _Toc457899758][bookmark: _Toc97010961][bookmark: _Toc408991121]Exporting to Microsoft Excel
During configuration of a file for export to ExcelGlossExcel.37 choose a Delimiter as a Comma and the End Line separator as CR/LF.  The File Type should be defined as Data Exchange Format (. DIF).

Within the Excel Spreadsheet package to import the file choose the File Open command and in the List Files of Type drop down list choose Data Interchange Format (*.DIF).  Choose the correct file and it will import correctly into the spreadsheet.
[bookmark: _Toc457899759][bookmark: _Toc97010962][bookmark: _Toc408991122]Exporting to Lotus 1-2-3
During configuration of a file for export to Lotus 1-2-3Gloss1.2.3.35 choose a Delimiter as a Comma and the End Line separator as CR/LF.  The File Type should be defined as Lotus Files (.PRN).

To import an SCADAPRO Exported file to Lotus 1-2-3 for Windows v4.0 or later, from the 1-2-3 menu line choose the File option, and then Open from the drop down menu list. In the Open File dialog box in the File Type field choose files of type *.PRN. The file will be imported into a spreadsheet and converted automatically.

For earlier Lotus 1-2-3 Windows versions from menu bar choose File and then Import. Select Numbers followed by the file name. The file will now import into the current worksheet starting at the current cursor position.
[bookmark: _Toc457899760]Printing Logged Data
The Data Export utility can be used to prepare logged data to be printed using the Notepad Program within Windows.  

Configure the data for Export in the way described in this chapter.  Choose either Comma, or Tab as the Delimiter.  The End Line separator should be defined as CR/LF.  The File Type in the Select Data Export Output File should be set as Text File (. TXT).   The resulting file can be opened in Notepad and then printed.  
[bookmark: _Toc457899761][bookmark: _Toc97010963][bookmark: _Toc408991123]
Data Import
The Data Import application will Import an ACSII text file with columns of data and create a System Data Log (.ODL) file from the data. Prior to import, the ASCII file must be described by the user. This description can then be saved as an Import Configuration File (ORI) which can be reused. A text header can be also imported.
Importing An ASCII File
It is important to give a good description of the ASCII file to be imported so that the data is interpreted correctly. The user must also describe how the data should be formatted in the output log file

The following information is required :
Source Information
A unique channel number  is used to identify individual columns of data. Each channel may represent a data point from a device or processor. A prefix and source name is used to identify the processor or device.
Prefix
Enter up to two alphabetical characters for the source prefix of the data to be imported. 
Start Chan No
Data is stored in ranges in a data log file. Enter a channel number between 1 and 10,000 for the start of the range.
Source Name
Enter up to 25 characters for a name to describe the data being imported.
Header Information
There may be lines of text at the start of the ASCII file to import which could be used to describe the data. This header information can be imported into a text file with the correct System format. This header information can also be ignored.
Import Header
Click this check box on if you require header information to be imported.
No. Header Lines
Enter the number of header lines at the start of the ASCII file.
*Note:
It is important to fill in the No. Header Lines field even if you do not require header information to be imported. It informs the application which line the data starts at.
[bookmark: _Toc457899762]
Line Information
This information describes how each column of data is formatted in the ASCII file.
Delimiter
Three options and a User Defined alternative are available in this drop down list.  The delimiter separates each field in a row.  The correct delimiter is required for the data to be interpreted correctly.  The choices are:
	 	Comma  
		Space
		Tab.  
		User
As an alternative to the fixed choices a User option is available.  If this is chosen enter the delimiting character in the text box that appears alongside the list.
End Line
Similar to the Delimiter there are choices for the end of line separator.  The choices are: 
		CR ( Carriage Return) 
		LF ( Line Feed ) 
		CR/LF.  
		User
A User option is again an option.
[bookmark: _Toc457899763]Adding Columns
You must add a column entry for every column of data you wish to import.
Click on the Add button to launch a dialog which allows you to enter this information.

For each column of data enter the following :
Column Number
The column number in which the data appears in the ACSII file.
Tag
Enter up to 16 characters of tag information.
Description
Enter up to 32 characters of description information.
Units
Enter up to 4 characters of units information.

A column may be imported more than once at a time. For performance it is recommended that columns be imported sequentially. When done click on the OK button. The entry will be added to the list.

Click on the Import button to continue configuration.

A dialog will be launched which asks for further import details. The following information is required :
Time In Column
Click this check box on if the scan time is contained in a column in the ASCII file.
Column Number
Enter the column number of the scan time if it is contained in a column in the ASCII file.
Time Type
If the scan time is contained in a column in the ASCII file select the type of time this column contains :

Differential or Elapsed
Time Interval Per Scan
If the scan time is not contained in a column in the ASCII file enter the number of seconds between each scan.
Start Time
Enter the start time for the new log file. Click on the Current Time button to set the Start Time to the current time.
Logger Directory
Enter the directory where the output log file should be created.

[bookmark: _Toc394746148][bookmark: _Toc395410455]Then click on the Import button to select the required ASCII file. The import task is launched as soon as the ASCII file has been successfully selected. An Import In Progress will be displayed. If you wish to stop the operation click on the Cancel button. 
[bookmark: _Toc457899764]Program Arguments
This application can accept command line arguments in 2 ways :

The Import Configuration file only (.ORI) 
The application opens the previously saved configuration file and is ready to import an ASCII file.

The ASCII file (*.*) and the Import Configuration file (.ORI) ,in that order.
The application opens the previously saved configuration file and immediately launches the import task on the ASCII file.

File names with spaces must have quotes (“”) wrapped around them to allow the names to be interpreted correctly.
[bookmark: _Toc457899765]Editing Channel properties
For each column of data enter the following :
Column Number
The column number in which the data appears in the ACSII file.
Tag
Enter up to 16 characters of tag information.
Description
Enter up to 32 characters of description information.
Units
Enter up to 4 characters of units information.

A column may be imported more than once at a time. For performance it is recommended that columns be imported sequentially. When done click on the OK button. The entry will be added to the list. 
[bookmark: _Toc457899766][bookmark: _Toc97010964][bookmark: _Toc408991124]
Log File Synchronization

This utility is used to synchronise two log files with different channel sets. In most cases the log files will have been created with different configurations, including log file type, duration and logging rates. In addition, two loggers configured identically and started at the same time may take logs at slightly different times depending on the load and performance of your system. For these reasons a number of rules had to be decided upon for the behavior of the utility in various scenarios. These rules are described below. We have assumed that two files are loaded, say Log A and Log B, and these files are to be synchronized and merged into Log C.


[bookmark: _Toc457899767]Rules:

  Log A is to be used to define the scan times for the duration of Log A.  

  Log B is to be used to define the scan times for any period outside the duration of Log A. 
 
  If there is no value for Log B at a required scan time, then the values from Log B will be interpolated, using the value immediately before and after the required scan time. If there is no value before or after the required scan time then the value is indeterminate and marked as in error.
[bookmark: _Toc457899768]Notes:
  In the case of log files which were logged at very different rates. It is usually advisable to select the log file with the highest logging rate as the first log file, i.e. Log A. If Log A was selected to be the log file with the slowest scan rate. It is possible that scans from Log B will be ignored rather than interpolated.

  All scans times in Log B will be shifted before any calculations are done, such that a scan time at the Alignment Time 2 will be shifted to Alignment Time 1. If these two times are identical, no shift will take place.
[bookmark: _Toc457899769][bookmark: _Toc97010965][bookmark: _Toc408991125]
Log File Merge Utility

This utility is used to merge two log files with same channel sets.

[image: ]

Select the Source directory by using the Browse button. Once the appropriate directory has been selected a list of the available log files will be displayed in the ‘Available Log Files’ list box.  To select one or more log files for merging simply click on them with the Left Mouse button. Once this operation is completed click on the ->> button to transfer the files into the ‘Merge Log Files’ list box.

Files Can be removed from the ‘Merge Log Files’ list box by first selecting them and then clicking on the <<- button.

Once all the files for merging have been selected use the Merge button to perform the merge. This button will allow you to select the appropriate directory to merge to.


[image: ]

[bookmark: _Toc408991126]
Enter Text Logs
This utility is used to add/edit text logs to a log.  The user is prompted to select a log file. When the log file is selected the following menu is displayed.


[image: ]


Logged Text - The list of messages entered for the log. This list is presented in chronological order. Predefined Messages from the logger, or new manually entered text logs can be entered by clicking the Add button below the Logged Text menu. 

To locate an event click the Find button and enter a date and time within the job start and stop times.
[bookmark: _Toc457899770][bookmark: _Toc97010966][bookmark: _Toc408991127]
SCADAPRO Trend Replays
The most useful method of analysing recorded data is to view it graphically. The Engineering Trends Replay facility of the SCADAPRO system allows detailed analysis of data recorded by any SCADAPRO logger.

The utility allows Trends to be created and examined. Both the vertical (Y) axis and the horizontal (X) axis can be expanded. The graphs along with full legend and file time information can be printed. Particular areas of the Trend that are of interest can be selected and examined in more detail or exported to a spreadsheet format file.

The Trends application has a multiple document interface (MDI) which allows several Trends to be open at the same time. Trends can be used to replay data in real time. Trend Configurations or layouts can be saved independently of the logged data. This allows the same configuration to be used on different logged data files.
[bookmark: _Toc394746149][bookmark: _Toc395410456][bookmark: _Toc457899771][bookmark: _Toc97010967][bookmark: _Toc408991128]Launching Trends
SCADAPRO Trends can be launched in one of two ways.

[image: trends]

Select the Trends icon by going to Start Menu >> Programs >> SCADAPRO >> Trends or from the SCADAPRO main program window select the Replays option from the menu bar and then choose Trends.

If the latter method is used a secondary menu will drop down offering a choice as follows:

[image: ]

If Configure is selected a blank trend is presented for configuration.
If Replay File Selection is made, the user is prompted for a log file and a trend configuration file.
If Replay Database Selection is made, the user is prompted for a database log and a trend configuration file.
If Replay Last is selected the last layout trends is presented.

Another option is to launch Trends via the command prompt. This feature allows the user to specify the Trends document to open.  It is also possible to use the command line to create a JPEG snapshot of the trends window

To indicate file name				[ [”] FileName [”] ]
For full screen mode				[ /F ]
To create a JPEG				[ /x ]
To create a JPEG and close Trends		[ /X ]

 

Note: The brackets used in this example are not used when passing command line arguments, and the inverted commas are optional.
Examples:


[1]	This opens the file normally:

trend_nt.exe c:\scadapro\trends\TrendName.ort
or
trend_nt.exe "c:\scadapro\trends\TrendName.ort"


[2]	This starts the application in full screen mode

trend_nt.exe /F


[3]	This command creates a JPEG snapshot of the trends window in the file c:\output.jpg

trend_nt.exe /x:c:/output.jpg


[4]	This command creates a JPEG snapshot of the trends window in the file c:\output.jpg then closes Trends

trend_nt.exe /X:c:/output.jpg

[bookmark: _Toc395410457][bookmark: _Toc457899772][bookmark: _Toc97010968][bookmark: _Toc408991129]Trends Window
The trends window is split into several areas which are described in the following sections. You may refer to the figure below for the names and positions of the different parts of the Trends Window.

[image: ]

[bookmark: _Toc394746150]Each of the constituent parts of the trends window (with the exception of the Trend Area) can be switched on or off depending on the user’s preference.
[bookmark: _Toc395410458][bookmark: _Toc457899773][bookmark: _Toc97010969][bookmark: _Toc408991130]Quick Start to Trends.
If you are anxious to start examining your logged data this section lists in brief the steps necessary to display a trend on your computer’s screen.

Launch SCADAPRO Trends by choosing the icon. A trend window will appear. From the File menu choose New. A blank Trend Window will appear. Again from the File menu choose Select Log File. From the Open File Dialog box, identify the file to replay. The name of the log file with the start and stop time will be added to the Window. Also the time base will be set.

To include at least one channel choose Add Line from the Edit menu. An Add Line to Trend Dialog box will appear. From the drop down list select the channel group that contains the channel required. Immediately below this enter the actual channel in the text box. Click on the Add button and then choose the Done button. A trace will appear in the window. To alter the scaling and colour of the trace from the Edit menu choose Edit Line. Edit the resulting dialog box to modify the trace. The following sections detail all the facilities available in SCADAPRO Trends.
[bookmark: _Toc394746151][bookmark: _Toc395410459][bookmark: _Toc457899774][bookmark: _Toc97010970][bookmark: _Toc408991131]Configuring a Trend
This section of the manual assumes that no configuration has been stored. Instructions to access the various options are given to use both the tool buttons and options in the menu list.

The intensity of both the tool buttons legend and the Menu options will vary dependent on the stage of configuration. A Menu or Tool option whose legend is dark will be accessible and usable. The legend on tools or menu options that have a lighter intensity will not be usable at this time.
[bookmark: _Toc394746152][bookmark: _Toc395410460][bookmark: _Toc457899775]Trend Options
The layout and the features of the Trend Window can be modified to the users requirements.  To do so, from the Edit menu choose the Trend OptionsGlossTrendOptions.137 command or else click on the [image: ] toolbar button.  From either option the result will be a Trend Options Dialog box.  

This tabbed dialog is broken down into four pages. Each page allows the user to configure a particular group of options. By clicking on the Apply button you can see any changes take effect immediately without closing the dialog.
[bookmark: _Toc394746153][bookmark: _Toc395410461][bookmark: _Toc457899776]Trend Options Page
Trend Type
Two different types of graph can be configured in the Trends application. Click on the appropriate radio button to choose the type of Trend required.
Time Based
The first type is a Time Based graph, which means that all lines will be plotted against time. This is the default Trend type. 
Channel Based
The second type of graph is Channel Based. This means that lines are plotted against each other. This is known as an X-Y graph where multiple Y channels can be plotted against one X channel.
[bookmark: _Toc394746154]Trend Orientation
Two different types of graph orientation can be configured in the Trends application. Click on the appropriate radio button to choose the type of Trend required.
Horizontal
The first type is a Horizontal orientation, which means that all lines will are plotted from right to left. 
Vertical
The second type of orientation is Vertical. This means that lines are plotted from the top of the page to the bottom.
Display Options
Log Bar
This box turns on or off the Log bar. If selected it appears immediately below the tool buttons.  The bar displays the name of the logger that created the file, the start and stop times of the scans within the logged data GlossLoggedDataFile.133.
Digital Axis
Unchecking this box can turn off the axis of any digital channel.  A single vertical axis for all digital channels appears at the beginning of the trend.  The ON and OFF status message as well as the tag number is shown alongside each digital line.
Time Axis / X Axis
The Time axis scale display can be turned off if required.

If the Trend is channel based then this field is called the X-axis.
Legend Menu
Shows or hides the legend menu which is located at the bottom of the trends window. The Legend menu shows a sample of the line colour for each channel in the trend. it also shows details of that channel such as channel identifier, tag description units and minimum and maximum value for that channel on the trend.
Header Text
If the logged data being displayed has header text associated with it, checking this box will show the header text at the top of the trend window.
Header Logo
When header text is switched on it is possible to add a logo to the header bar.  When header Logo is check the header logo properties can be configured at the bottom of the Trends Options dialog.  These options are described in the Advanced Options section below.
Logged Text Below Graph
If the logger is configured as a Text Logger, then switching on this option displays any logged text below the trend chart and allows the user to enter logged text.

Logged Text On Graph
If the logger is configured as a Text Logger, then switching on this option displays any logged text on the trend chart and allows the user to enter logged text.

Time Based Options
These options are specific to Time Based Trends:
Time Scroll Bar
The scroll bar allowing horizontal panning can be de-selected.
Initial Time Frame
Selecting a suitable Time Frame from the drop down list defines the width of the x-axis.

If OFF is chosen and the logger that created the file is not active (disabled), the best time base frame suitable for the file will be chosen automatically.

The Time frame options are:

	50 years
	6 months
	16 days
	24 hours
	60 mins
	60 secs

	25 years
	2 months
	 8 days 
	16 hours
	30 mins
	30 secs

	12 years
	1 month
	 4 days
	 8 hours
	15 mins
	15 secs

	8 years
	
	 2 days
	 4 hours
	8 mins
	8 secs

	4 years
	
	
	2 hours
	4 mins
	4 secs

	2 years
	
	
	
	2 mins
	 2 secs

	1 year
	
	
	
	
	1 sec



If a logger is still adding scans to the log then a suitable time frame should be selected before the logged file is selected.

Absolute Time/Elapsed Time
[bookmark: _Toc394746155]The time axis annotation determines how labels are displayed on the time axis. Click on the Absolute Time radio button to display the absolute time of the data (this is the default selection). Click on the Elapsed Time radio button to display the time elapsed since the start of the current time frame.
Skip Multiple Samples for each X-Pixel
On a time based trend each pixel in the X direction represents a time range. If more than one log is available in the time range of a particular pixel, this option can be used to display only the first sample for the time range. If this option is switched off which is the default, the minimum and maximum values for all samples for each X-pixel time range are plotted. Switching on this option can increase drawing speed on a large log. If using a database log, settting scan buffer size (see below) to 1 will significantly increase the retrieval time from large log files as the trend will only need to retrieve one scan per X-pixel.
Channel Based Options
These options are specific to Channel Based Trends:
X Channel
If the Trend is channel based then an x channel should be specified. This channel will become the x-axis against which all other channels are plotted. 

To nominate an x channel click on the Change... button. A dialog will be displayed which lists all channels configured for the Trend. Select a channel and click on the OK button. If there are no channels configured for the Trend then the dialog will not be displayed. If an x channel is not specified explicitly then by default the first channel line configured in the Trend will be used as the x channel. If the channel does not exist in a log file associated with the trend then the first channel to exist in both the log file and the Trend will be used.
Advanced Options
Scan Buffer Size
The scan buffer size determines how many log file scans are held in memory at any one time. This buffer affects data retrieval performance.
No. Logged Text Chars
This field indicates the maximum number of logged text characters that will be displayed for a scan in the logged text area. If there are more characters in the text log than have been specified then the text will be clipped.
No. Header Text Lines
Determines how many header lines of text will be visible without scrolling.
No. Visible Legend Lines
The default number of legend lines which will be shown at the particular time is four. This number may be changed according to your needs.
Header Logo Left
Click Browse to select a valid image file to use as the left hand logo
Header Logo Right
Click Browse to select a valid image file to use as the right hand logo
Embedded
When Embedded is check the logo files are saved within the Trends document, if Embedded is not check the Trends document links to the external image files.  In this scenario if the image files are moved or deleted the logo’s will not appear.


[bookmark: _Toc394746156][bookmark: _Toc395410462][bookmark: _Toc457899777]Value Bar Options Page
If the Trend cursor is on, the value boxes will show the values of the channels at the time position of the cursor.

If the cursor is off and the logger is still adding scans to the log file, the value boxes will show the actual values of the channels at the last recorded.
Value Bar On
De-selecting this option will turn off the Value boxes normally displayed above the graph.
Date Format
Select one of the following formats to represent dates in the Trend:
Short Date Format
Displays dates in their short format as defined in the ‘Regional Settings’ applet of Control Panel.
Long Date Format
Displays dates in their long format as defined in the ‘Regional Settings’ applet of Control Panel.
Timezone Offset:
	          Display (UTC +/- HH:MM) Time Zone Name
	          Displays the current timezone of the system with the time zone name onto the trends window.
[bookmark: _Toc394746158]Values Display
Value Width & Value Precision
These text boxes refer to the width and precision of the analogue channel values that appear in the Value Boxes.   In the Width text box enter the total number of digits, including the decimal point.  In the Precision box enter the number of places required after the decimal point.  If a width is chosen too small for any value, the result will be shown in scientific notation.
Display Options
Identifier
Shows the channel identifier (Prefix and Channel Number) in the value bar.
Tag
Shows the channel tag in the value bar.
Description
Shows the channel description in the value bar.
Units
Shows the units for the channel value in the value bar.
[bookmark: _Toc394746159][bookmark: _Toc395410463][bookmark: _Toc457899778]Grid Options Page
Grid Options
Vertical Grid On
Check this box on to turn on vertical grid lines in the graph area.  
Number of Lines
If Vertical grid lines are chosen a text box is available in which the number of lines required can be entered. The first vertical grid line will be placed at the start of the graph ( 0 on X axis), the remainder will be spaced  equidistant across the graph.
[bookmark: _Toc394746161]Horizontal Grid 
Check this box on to turn on horizontal grid lines in the graph area.  
Number of Lines
[bookmark: _Toc394746162]If Horizontal grid lines are chosen a text box is available in which the number of lines required can be entered. The first horizontal grid line will be placed at the top of the graph (Full scale on Y-axis), the remainder will be spaced equal distant across the graph.
[bookmark: _Toc395410464][bookmark: _Toc457899779]Colour Options Page
Background Colours
The background colour of the graph area and all other areas of the trend windows can be defined and a different colour can be chosen for the printer.
Screen Colour
To change the background colour of the screen, click on the Select... button.   A Colour Dialog Box will be shown.  Choose a colour from the palette and then select the OK button to confirm selection and return to the Trends Option Dialog box.
Printer Colour
To change the background colour of a trend printout, click on the Select... button.   A Colour Dialog Box will be shown.  Chose a colour from the palette and then select the OK button to confirm selection and return to the Trends Option Dialog box.
Colour Dialog Box
If you wish to define your own custom colours, whilst in the Colour dialog box choose the Define Custom Colours button.  The Colour dialog box will expand to show a customising section.
 
Select a Basic Colour first by pointing to one and clicking the mouse. Move the cursor to the colour spectrum and drag the cursor across the colour range until the required colour is found.  Alternatively edit the text boxes in the customise section to achieve the colour needed.  Choose Add to Custom Colours Button and the colour will be added to the Custom Colour boxes on the left of the dialog box.
[bookmark: _Toc457899780][bookmark: _Toc395410465]Fonts Options Page
The fonts for the various components in the Trend Display windows can be configured.
Category
From the category field select the component whose font you wish to change, then click on the change font button to bring up a new dialog box, select the font, font size and style you want then click OK. Click Apply to make the changes, if you are not happy with the new fonts, click Reset All, then Apply to restore the fonts to their defaults.
Sample
Shows a sample of the currently selected font.
[bookmark: _Toc457899781]Log Selection
The log file page allows for one of five options to be selected. 
Manual
Manual is the default option. This option does not alter the behavior of the current Trend configuration.
Most Recent File In directory or Most Recent Log in a Database
This option is useful when you are monitoring a cycling logger. Click the Browse button and locate the directory which has the live log file. Once the end of the current logging cycle is reached the next log file will be opened and displayed on screen. This saves you the task of having to reconfigure a new Trend to show the information again. 
Select a Log File or Select a Database Logs
This is similar to the above except the same log will be opened with the associated Trend configuration file each time it is opened.

N.B. For both of the last two options above, save the Trend configuration file exiting Trends otherwise it will not work. 

[bookmark: _Toc394746163][bookmark: _Toc395410466][bookmark: _Toc457899782]Select a Logged Data File.
From the File menu choose the Select Log File command. Using the toolbar click on the [image: ] button.

A Select Log File Dialog box will appear.  

[bookmark: _Toc394746164][bookmark: _Toc395410467][bookmark: _Toc457899783]Select a Database Log
From the File menu choose the Select Database Log command. Using the toolbar click on the [image: ]  button.

A Select Datbase Log Dialog box will appear.  

Select Previous Log
From the File menu choose the Select Previous Log command. Using the toolbar click on the  [image: ] button.

The previous log created by the currently selected logger is selected.  

Select Next Log
From the File menu choose the Select Next Log command. Using the toolbar click on the [image: ] button.

The next log created by the currently selected logger is selected.  


Add a Line to a Trend

When a log file has been selected, channels can be chosen from that file and added to the graph.  To add a line from the Edit menu choose Add Line. Alternatively from the toolbar choose the  button.  The result will be an Add Line to Trend dialog box.  

[image: ] 

When editing the dialog box detailed in the following sections has been completed, choose the Add button. The configured trace will appear on the Trend Graph and the information in the dialog box incremented to the next possible channel.

When all the required channels have been added to the trend choose the Done button. If at a later time more traces are to be added return to the Add Line To Trend dialog box.
[bookmark: _Toc394746165]Source
From the drop down list select the block of channels that contains the channel that is to be added to the graph.  If the User Defined option is chosen enter either an expression including channel prefix and number e.g. P1.  For databases, the expression can include the basic +, -, / and * arithmetic operators. The expression can include references to logged channels. If channels are logged by tag, ensure the references are to the tags. Some databases can support advanced operations such as bitwise and comparison operators and conversion, trigonometric and logarithmic functions. Refer to the SQL syntax of the database.
Tag, Description and Units
For user defined expression, the expression is handled as an analog channel. The tag, description and units of the analog expression can be configured.
Scale Options
Value Type
The value type can be set to 
		NORMAL	Value is displayed directly from file or database
		SUM 		Value is displayed as a cumulative sum from start of replayed data.
		COUNT		Value is displayed as a count of valid scans.
		LOG		Value is displayed on log scale.

Minimum
Enter the lowest channel value you want to display on the trend.
Maximum
Enter the highest channel value you want to display on the trend.

[bookmark: _Toc394746167]Axis On
If this check box is unchecked no axis will be displayed for this line.  If it is checked an axis in the same colour as the line will be drawn on the graph.
[bookmark: _Toc394746168]Axis Position
The axis position can be chosen from the drop down list.  
On Graph:	The Axes of the channels will be spaced equidistant across the graph.
Left/Top of Graph	The Axes will be drawn to the left/top of the graph depending on orientation.  
Right/Bottom of Graph	
		The Axes will be drawn to the right/bottom of the graph depending on orientation.  

NB.
If too many axes are configured to the left of the graph. The horizontal space left for the actual graph will be reduced.
[bookmark: _Toc394746169]
Major Tick Marks
If this check box is crossed then a tick mark with the value alongside will be placed at every position identified by the entry in the Every text box.
[bookmark: _Toc394746170]Minor Tick Marks
If this box is checked then a tick with no value will be placed on the channels axis at positions identified by the entry in the Every text box.
[bookmark: _Toc394746171]Control Limit Lines
Up to 5 different fixed lines can be displayed on the trend to display upper control, upper warning, center, lower warning and lower control limit lines. Check the limit line box in order to be able to see a fixed line for the selected channel on the trend.
Value
The value for the fixed limit line.
Line Colour
The colour of the line can be chosen from the drop down list. As each line is added to the graph a new colour will be offered for each line.
Line Width
From the drop down list select the thickness of the line.  The thinnest line is the default.
Line Style
To enable lines to be identified more easily the style of the line can be chosen from a continuous line, dotted, dashed or combination of dotted and dashed.
[bookmark: _Toc394746173]Line On
Check this box in order to be able to see a value line for the selected channel on the trend.
Line Colour
The colour of the line can be chosen from the drop down list. As each line is added to the graph a new colour will be offered for each line.
Line Width
From the drop down list select the thickness of the line.  The thinnest line is the default.
Line Style
To enable lines to be identified more easily the style of the line can be chosen from a continuous line, dotted, dashed or combination of dotted and dashed.
Plot Errors As Blank
Select this check box if you wish to have all channels in error not to be added to the trend on screen
[bookmark: _Toc394746174]Markers On
If the Markers On check box is clicked on a Marker is drawn at each point on the line.
Marker Type
From the drop down list select the type of Marker required.
Marker Color
The colour of the Marker can be chosen from the drop down list.
Display in Valuebar
If the Display in Valuebar check box is checked, a value box for the line will be added to the value bar. If the Cursor is on, the value box will show the value of the channel at the cursor position. If the selected log file is a real time log file (live log file) then when the Cursor is not on, the value display will show the current value of the channel.
Entry from Value Bar
If the Display in Valuebar check box is checked, the user can enter the current value for the displayed channel.  Note this does not alter historical logged data.  The purpose of this to allow trends to be used as primary monitoring display.

Note:
When the Line On and Markers On check boxes are both set to off, no data for the line is visible in graph form. Therefore a warning will be displayed.
[bookmark: _Toc428247151][bookmark: _Toc457899784][bookmark: _Toc97010971][bookmark: _Toc408991132][bookmark: _Toc394746175][bookmark: _Toc395410468]Log By Tag
[bookmark: _Toc428247152]The Standard Logger Configuration module is used to create the data log file (*.odl) which is used as input for the Trends module.  The Standard Logger allows you to log up to 64 channels or channel ranges. A channel range has a start and an end prefix which will be displayed on the Logged Channels range buttons. However, the Log By Tag facility allows for the user to log channel ranges by tags instead of prefixes. The rules for this as described below:
[bookmark: _Toc428247153][bookmark: _Toc457899785]Rules For Logging By Tab

As the system is logging data by tag, (details for setting up the Log By Tab Option are detailed in Part Six of the User Manual), the user is free to alter the value of the prefix associated with the tag. i.e. if a logged channel has a tag called Temperature and a prefix P10, logging will still work if you change the prefix to another prefix number as tag will refer to the prefix number. The start and end tag will be displayed on the block button if the size of the tags do not exceed the button extent. Otherwise, the channel range will be displayed. If there is only one channel on the range the tag will be displayed if it does not exceed the button extent. When the logger is enabled the channels from the start to the end tag will be logged.

[image: ]


The start prefix can not be greater than the end prefix .i.e. if the start tag refers to P30, then the end tag must refer to a channel greater than or equal to P30. If this situation arises, the tag range will be removed from the logged channels range. 

The tag name can be changed at will. However, the start tag must refer to a prefix will is less than or equal to the end tag. 
[bookmark: _Toc457899786][bookmark: _Toc457899787]The significance of changing tags to a state whereby one of the above rules is breached, is that the trend information for the logged channel or channel range will not be shown in Trends. 
Editing a Line
After a line has been added to an SCADAPRO Trend Window it can be edited at any time. 

If the Legend Box at the bottom of the Trend Window is visible select the line to edit within the Legend Box. Then either choose Edit Line from the Edit menu or click on the [image: ] toolbar button. 

If the Legend Box is not available at the bottom of the screen choose Edit Line from the Edit menu or the Edit Line tool from the toolbar as above. If a channel is not selected for editing a Select a Line For Editing dialog box will appear with a list of possible channels.  Select the channel to edit and choose the OK button.

An Edit Line dialog box will appear. The dialog box has almost exactly the same contents as the Add Line to Trend dialog box. Please refer to the previous section for details. The Next and Previous buttons allow you to move backwards and forwards through the list of channel which are currently display on the Trend.
[bookmark: _Toc394746176][bookmark: _Toc395410469][bookmark: _Toc457899788]Delete a Line
After a line has been added to an SCADAPRO Trend Window it can be deleted at anytime.  

If the Legend Box at the bottom of the Trend Window is visible select the line to delete within the Legend Box.  Then either choose Delete Line from the Edit menu or use the Delete Line toolbar button [image: ]. 

If the Legend Box is not available at the bottom of the screen choose Delete Line from the Edit menu or the Delete Line button from the toolbar as above.  If a channel has not been selected for deleting a Select a Line to Delete dialog box will appear with a list of possible channels.  Select the channel to delete and choose the OK button.
Editing Multiple Lines
You can add or edit multiple lines in a Trend Window by using the “Edit Multiple Lines” button on the toolbar as shown[image: edittrendicon].

[image: editwindow]

The Edit Multiple Lines Window displays a list of channels from the selected log file on the left.  You can then select and add as many channels to the Trend.  The right displays a list of trend lines that are added.  Here you can quickly change some settings such as Line Colour, the minimum and maximum values, the type of axis on the Trend, major and minor tick values.

When changing a colour or axis type you simply left click and hold while chosing your value and once done release mouse click to select.  When you are done adding or making changes to the trend lines simply click Apply then OK to add the trend lines to the Trend Window.  To delete any trend lines simply select the lines you wish to delete then click on “Delete Selected Lines” to remove them from the Trend Window.

[bookmark: _Toc394746177][bookmark: _Toc395410470][bookmark: _Toc457899789][bookmark: _Toc97010972][bookmark: _Toc408991133]Examining a Completed Trend Graph
Once a Trend has been displayed in it's window it can be expanded and areas of particular interest examined in close detail.

Initially when lines are drawn on the Trend Window from a closed log file the Time base (x-axis) will show all the scans of the selected channels from the log file.  The time base could be from 2 seconds to one year wide depending on the Logged data fileGlossLoggedDataFile.133.  This initial time base is called the TOP-LEVEL time base for this Trend Window.
[bookmark: _Toc394746189][bookmark: _Toc395410471][bookmark: _Toc457899790][bookmark: _Toc394746178]Using The Cursor
To examine data at a single point in time SCADAPRO Trends has incorporated a Cursor.  The cursor can be used to identify a particular point of interest and provide accurate information about the time and the values of each line on the graph at that instance.

When the Cursor has been activated a vertical line will appear across the graph.  In the Date and Time box will appear the date and exact time at the position of the hair line.  In the Channel Value boxes will be shown the values of the respective channels at that point in time. The mouse and keyboard cursor keys can be used. 
Using The Mouse
To activate the cursor point the mouse to the point of interest and double click.  To reposition the hair line move the mouse cursor to the new position and double click the mouse.  Once a Cursor is present it an be stepped one scan at a time using the right and left keyboard cursor keys. 
Using Keyboard
To activate the Cursor press the right keyboard cursor key.  The hair line will appear at the start of the line.  Use the right and left cursor keys to position the cursor.  To remove the Cursor press the ESC key or double click on the right mouse button.
Clearing the Cursor
To remove the Cursor press the ESC key or click the right mouse button over the Trend Area and click Clear Cursor from the menu. 
[bookmark: _Toc395410472][bookmark: _Toc457899791]Selecting an Area of a Trend
To select an area of a trend for exporting (See Data Export later in this section) or for Zooming (see Zooming later in this section), drag the mouse cursor over the area of the trend you wish to select. A dashed box appears surrounding the area of the trend selected.
Clearing the selection
To clear the selection, click the right mouse button over the trend area and select the Clear Selection option in the menu which appears.
[bookmark: _Toc395410473][bookmark: _Toc457899792]Zooming in on a trend
Zooming In - One step at a Time
The time scale is divided into three areas.  You can select an area and zoom by a factor of 2. The Time Base will have changed e. g. from 60 mins to 30 mins.  The zoom can be repeated many times until the time base is equal to one log period.  Selecting Zoom Left zooms the left half of the screen, Zoom Right, the right hand half of the screen and Zoom Centre the central half of the screen.  See the previous picture. 

The time base frame width and the date of the logged data is shown to the left of the time axis.
[bookmark: _Toc394746179]Zoom Left/Top
Use this command to Zoom the left half of a horizontal trend or the top half of a vertical trend by a factor of 2
Using Zoom Menu: choose Left for horizontal trends or Top for vertical trends     
Using Fast Key to Zoom Left: When the required Trend Window is active then use the F5 Function Key for horizontal trends and CTRL+F5 Function Key for vertical trends.
Using Toolbar Button:  To zoom the left half of the screen one step choose the [image: ] button for horizontal trends and  for vertical trends..  
[bookmark: _Toc394746180]Zoom Centre
Use this command to Zoom the central part of the window by a factor of 2
Using Zoom Menu: choose Centre    
Using Fast Key: When the required Trend Window is active then use the F6 Function Key for horizontal trends and CTRL+F6 Function Keys for vertical trends.
Using Toolbar Button:  To zoom the Central half of the screen one step choose the [image: ] button for horizontal trends and the [image: ] button for vertical trends.  
[bookmark: _Toc394746181]Zoom Right/Bottom
Use this command to Zoom the right half of a horizontal trend or the bottom half of a vertical trend by a factor of 2
Using Zoom Menu: choose Right for horizontal trends or Bottom for vertical trends     
Using Fast Key to Zoom Left: When the required Trend Window is active then use the F6 Function Key for horizontal trends and CTRL+F6 Function Key for vertical trends.
Using Toolbar Button:  To zoom the right half of the screen one step choose the  [image: ]button for horizontal trends or the [image: ]  button for vertical trends.  
[bookmark: _Toc394746182]Zoom Out One Level
Use this command to Zoom out one level.
Using Zoom Menu: choose Zoom up One Level.    
Using Fast Key:  When the required  Trend Window is active then use the F8 Function Key for horizontal trends and CTRL+8 Function Keys for horizontal trends.
Using Toolbar Button:  To zoom up one level choose the [image: ] button for horizontal trends and the [image: ] button for vertical trends.  
[bookmark: _Toc394746183]Zoom Out to Top Level
Use this command to Zoom out to original Time Frame.
Using Zoom Menu: choose Zoom to Top Level.    
Using Fast Key:  When the required  Trend Window is active then use the F9 Function Key for horizontal trends and the CTRL+F9 Function Key for vertial trends.
Using Toolbar Button:  To zoom to top level choose the [image: ] button for horizontal trends or the [image: ] button for vertical trends.  
[bookmark: _Toc394746184]Zooming an Area
To zoom an area of the Window first select the area.  A dotted rectangular box will be displayed enclosing the area that is required to fill the Window when zoomed.  Then do one of the following:

Using Zoom Menu: choose Zoom Selected Area.    
Using Fast Key:  Press CTRL+Z
	      	 Using Toolbar Button:  To zoom area use [image: ] button
Zooming to Time
To zoom to a particular time select the start date and start time, followed by the end date and end time. 

To zoom to a particular period select the start period, followed by the end period and adjust the time if required, the data will display at that time.

[image: ]

Using Zoom Menu: choose Zoom To Time.    
Using Fast Key:  Press CTRL+Y
	       Using Toolbar Button:  zoom to time  button
[bookmark: _Toc394746188][bookmark: _Toc395410474][bookmark: _Toc457899793]Panning Through a Trend
When a trend has been zoomed it may be necessary to move forward and backwards through the Trend to examine points of interest. There are several different methods to pan through a Trend. When a Trend is panned the time base will not change but the time axis will move forwards or backwards, half a screen for each step.
Pan Backwards
Use this command to move the Trend half a Window to the left when zoomed in.
Using Pan Menu: choose Left for horizontal trends or Back for vertical trends   
Using Fast Key:  When the required Trend Window is active then use the F2 Function for horizontal trends and use the CTRL+F2 Function Keys for vertical trends.
Using Toolbar Button:  To Pan the to the left choose the [image: ] button for horizontal trends and the  [image: ] button for vertical trends.  
Pan Forwards
Use this command to move the Trend half a window to the right when zoomed in.
Using Pan Menu: choose Right for horizontal trends or Forward for vertical trends
Using Fast Key:  When the required Trend Window is active then use the F3 Function for horizontal trends and use the CTRL+F3 Function Keys for vertical trends.
Using Toolbar Button:  To Pan to the right choose the [image: ] button for horizontal trends and the [image: ] button for vertical trends.  
Pan to Current
Use this command to move the current or last logged point to the centre of the Window.  When zoomed in.
Using Pan Menu: choose Current.    
Using Fast Key:  When the required Trend Window is active then use the F4 Function for horizontal trends and use the CTRL+F4 Function Keys for vertical trends.
Using Toolbar Button:  To Pan to the current scan choose the  [image: ]button for horizontal trends and [image: ] the  button for vertical trends.  
Panning - Using Scroll Bars
The scroll bars can be used to pan through a graph.  Normal windows techniques should be used.
[bookmark: _Toc394746190][bookmark: _Toc395410475][bookmark: _Toc457899794]Examining Real Time Data
If a Trend is being displayed with an active/live data log, (i. e. scans are still being added) the SCADAPRO Trends facility can still be used to examine the scans already stored on disk.  When a suitable Time Base Frame has been selected the graph with the configured lines will be shown up to the last scan on disk.  As each new scan is recorded the lines will be extended.  When the lines reach the end of the Window the time base is panned forward automatically so that the most recent data fills approximately the first half of the screen.  The new data is shown to the right as it is collected.  The value boxes will show the last recorded values of each of the channels included in the Trend.

If a Logger Stop Time is reached, or the logger is manually disabled the graph will remain to allow interrogation of the data.  

If the logger is configured for cyclic operation the graph will remain on the Trend Window after the end of a cycle.  It will be replaced automatically with a display when the cycle starts again. 
[bookmark: _Toc394746219][bookmark: _Toc395410476][bookmark: _Toc457899795][bookmark: _Toc394746191]Enter a Text Log
If the logged data chosen is configured as a Text Logger (See Part Six of this manual for details of configuring a text logger), this dialog allows you to enter a text log into a time-based Trend. 
Enter a Text Log at the Current Time (Real Time Data Files only)
To enter a text log at the current time, ensure the Cursor is cleared (See Clearing the Cursor earlier in this section). Then, click the right mouse button over the Trend Area and select Enter Text Log option on the menu which follows. Click on the Log at Current Time to log text at the current system time and then click the OK button to enter the log. The current time is calculated as soon as the OK button is clicked.
Enter Text Log at the Cursor Position
Place the Cursor in the area of the trend where the Text Log is to be entered. Then, click the right mouse button over the Trend Area and choose Enter Text Log… command from the edit menu In the dialog which follows, the time field in the dialog is set to the time at which the cursor is set. Enter the text as before and click the OK button.

 [image: ]

If the Logged Text option is enabled in the Trends Options dialog (see earlier in this section for details) then the logged text appears vertically at the bottom of the Trend Area. Placing the Cursor over a text log shows the text log in the value bar where the text is more clearly visible.

Instead of typing a text log, the user can select a message from the list of predefined messages. These are defined when the logger is being configured (see Part Six of this manual for details of configuring a Text Logger). 

By checking Position within Graph Area the user can specify the vertical position where the logged text will appear on the trend chart.

Enter a Start / End Text Log
If the logged data chosen is configured as a Text Logger (See Part Six of this manual for details of configuring a text logger), this dialog allows you to enter a start and end text log to represent a time period into a time-based Trend. 

Click and drag to make a selection on the trend, right click within that selection and choose Enter Start/End Text Log.

[image: ]

Select a period name from the list of predefined messages or type in your own period in the manual section.

Enter the start and stop date and time using the calendar and time input boxes.
The start and stop date and time cannot be outside the scope of the log.


[bookmark: _Toc457899796]Workspaces and Full Screen Mode
Trends saves the position of the application on the screen and the position of any Trend configurations each time the application is closed. When you re-launch the application the positioning of configurations will be exactly as it was when Trends was last opened. The Full Screen option is available under the View Menu (or by pressing the icon  in the toolbar). To return to normal screen size, you need to press the escape key.

[bookmark: _Toc457899797][bookmark: _Toc97010973][bookmark: _Toc408991134]The Logger Wizard
The logger Wizard allows the user to enable a logger and specify the channels to be logged from within Trends. To launch the Wizard, go to the Edit Menu and select Logger Wizard or use Ctrl+W (or click the icon [image: ] from the icon bar). 

There are three steps to using the Logger Wizard.

Step 1 of 3 - The first thing you need to do is to specify the name of the SCADAPRO server. Use the Browse for Server button to locate the server. Then click the Next > button when ready.

Step 2 of 3 - You can view the status of a logger. The Logger status will either be Disabled or Enabled. You may select a disabled or a currently enabled logger. Click the Next > button when ready.

Step 3 of 3 - You will see the channel range buttons, which are explained in the Standard Logger section of the manual. If the logger had been configured with channels previously then these will be displayed. You can use the clear button to remove any existing channels. The name of the logger can be changed if required. Click the Finish button when ready. The logger will be activated and a new Trend configuration will appear. This Trend configuration will have all the channels you selected for logging displayed on it. The time frame across the bottom of the Trend will be set to one minute. 

[bookmark: _Toc395410477][bookmark: _Toc457899798][bookmark: _Toc97010974][bookmark: _Toc408991135]Data Export
Using Trends it is possible to identify a section of a log file and export the data of that portion of the logged file to another file in a format compatible with industry standard spreadsheet packages.

To select the area of interest move the mouse pointer into the graph area of the Window and to the start of the area to export.  Hold the mouse button down and drag to the end of the area.  A dotted rectangular box will be displayed enclosing the area that is required to export.  From the File Menu choose the Export Data command.   Using the tool bar select the [image: ] button.

A Data Export Dialog Box will appear.  

For the full details in completing the Data Export dialog box, please refer to the section on Data Export at the start of this part of the User Guide.
[bookmark: _Toc394746192][bookmark: _Toc395410478][bookmark: _Toc457899799][bookmark: _Toc97010975][bookmark: _Toc408991136]Printing A Trend
To Print a Trend ensure the Trend Window to be printed is active.  If not point the mouse anywhere in the required window and click.  If the Trend Window is not visible from the Window Menu choose the correct window from the list at the bottom of the Window menu list.  Each Trend Window bears the name of the configuration filename used in that window. The following facilities are used to set up the task to print a Trend to the printer.
[bookmark: _Toc457899800]Page Setup command (File menu)
From the File Menu choose Page Setup to set the page orientation, margins and size of the trend to be printed.
[bookmark: _Toc394746193][bookmark: _Toc395410479][bookmark: _Toc457899801]Print command (File menu)
From the File Menu choose Print to print a Trend. This Print dialog box appears, where you may specify the range of trends to be printed, the number of copies, the destination printer, and other printer set-up options.
Shortcuts
Toolbar:	[image: ]

Keys:	Ctrl+P
[image: ]
[bookmark: _Toc394746194][bookmark: _Toc395410480][bookmark: _Toc457899802]Print dialog box

The following options allow you to specify how the Trend should be printed:
[bookmark: _Toc394746195]Printer
This section describes the name, status and type of printer and the port it is connected to on its host computer. If the printer is a network printer, and the system administrator has entered a comment for the printer, this is also displayed.
[bookmark: _Toc394746197]Print Range
[bookmark: _Toc394746198]The user can select Current page printing, where the entire log will be printed.
Time allows you to specify a range within a page for printing.
Selecting All allows the user to specify a length of time using page length.
	Copies
Specify the number of copies you want to print of the Trend.
[bookmark: _Toc394746199]	Collate
This option has no effect within the Trends.


[bookmark: _Toc394746201][bookmark: _Toc395410481][bookmark: _Toc457899803]Print Progress Dialog
The Printing dialog box is shown during the time that SCADAPRO Trends is sending output to the printer.  The page number indicates the progress of the printing.

To abort printing, choose Cancel.
[bookmark: _Toc394746202][bookmark: _Toc395410482][bookmark: _Toc457899804]Print Preview command (File menu)
From the File menu choose Print Preview to display the active Trend as it would appear when printed.  When you choose this command, the main window will be replaced with a print preview window in which a page will be displayed in its printed format.  The print preview toolbar offers you options to zoom in and out of trends; and initiate a print job. Note: The dashed lines illustrated on a page during Print Preview denote the current page margins.
Print Preview toolbar
The print preview toolbar offers you the following options:
Print
Bring up the print dialog box, to start a print job.
One Page / Two Page
Preview one or two printed pages at a time.
Zoom In
Take a closer look at the printed page.
Zoom Out
Take a larger look at the printed page.
Close
[bookmark: _Toc394746203][bookmark: _Toc395410483]Return from print preview to the editing window.
[bookmark: _Toc457899805]Print Set-up command (File menu)

Use this command to select a printer and a printer connection.  

[image: ]

This command presents a Print Set-up dialog box, where you specify the printer and its connection.
Print Set-up dialog box
The following options allow you to select the destination printer and its connection.
Name
Select the printer you want to use.  From the drop down box, choose from one of the available printers on your system If none are available, contact your system administrator or set up a new printer using the control panel applet (See the Operating instructions provided with your computer/operating system).
Orientation
Choose Portrait for a long printer orientation or Landscape for a wide printer orientation.
Paper Size
Select the size of paper that the document is to be printed on.
Paper Source
Some printers offer multiple trays for different paper sources.  Specify the tray here.
Network…
Choose this button to connect to a network location, assigning it a new drive letter.
[bookmark: _Toc394746204][bookmark: _Toc395410484][bookmark: _Toc457899806][bookmark: _Toc97010976][bookmark: _Toc408991137]Saving a Trend Configuration
When a Trend has been configured satisfactorily the settings can be saved.  The saved configurations can be used again on different logged files if necessary.  Use one of the following methods to save the configurations.
[bookmark: _Toc394746205][bookmark: _Toc395410485][bookmark: _Toc457899807]File Save As…
Choose from the File menu File Save As ....  A File Save As..  dialog box will appear.  The following options allow you to specify the name and the location of the file you are about to save:
[image: ]

[bookmark: _Toc394746206]File name
Type a new filename to save a document with a different name.  A filename can contain up to 253 characters and an extension of up to three characters.  Trends add the extension specified in the Save File As Type box.  This should normally be specified as  [Trend File (*.ort) ].
[bookmark: _Toc394746207]Save in
Select where you want to store the trend configuration file. The drop down list shows all possible areas to save to.
[bookmark: _Toc394746208]Directories
Select the directory in which you want to store the file. This will normally be in a sub directory called Trends within the SCADAPRO main directory.  Alternative locations can be used if for example you would rather use a project directory.
[bookmark: _Toc394746210][bookmark: _Toc395410486][bookmark: _Toc457899808]Save Command
From the File menu choose Save or from the toolbar choose the [image: ] tool button.

Use this command to save the active document to its current name and directory.  When you save a document for the first time, Trend displays the Save As dialog box so you can name your configuration file.  If you want to change the name and directory of an existing configuration before you save it choose the Save As command
[bookmark: _Toc394746211][bookmark: _Toc395410487][bookmark: _Toc457899809][bookmark: _Toc97010977][bookmark: _Toc408991138]Retrieving a Trend Configuration
[bookmark: _Toc395410488][bookmark: _Toc457899810][bookmark: _Toc394746212]File Open
To retrieve a Trend Configuration select the Open command from the File. Or select from the toolbar the [image: ]  button. An Open File Dialog will be displayed. 

[image: ]
File Name
Type or select the filename you want to open. The box lists files with the extension .ort, as selected in the List Files of Type box.
[bookmark: _Toc394746213]Files of Type
Select the type of file you want to open. Trend Files are of type *.ort.
[bookmark: _Toc394746214]Look In
Select the drive/folder in which the Trend Configuration was stored.
[bookmark: _Toc394746215]Network
Choose the Network Neighbourhood icon in the Save in field to connect to a network location, assigning a new drive letter.
[bookmark: _Toc394746216][bookmark: _Toc395410489][bookmark: _Toc457899811]1, 2, 3, 4 (recent files) command (File menu)
Use the numbers and filenames listed at the bottom of the file menu to open the last four configuration files you closed. Choose the number that corresponds to the document you want to open.

The Trend Window will assume the name of the Trends Configuration filename.
[bookmark: _Toc394746217][bookmark: _Toc395410490][bookmark: _Toc457899812][bookmark: _Toc97010978][bookmark: _Toc408991139]Creating New Trend Windows

To create a new Trend Window either choose New from the File Menu, or click on the  toolbar button.

A new Trend Window will appear initially with the name Trend n, where n is the number of the trend that is created during this SCADAPRO session. 

Select a logged data fileGlossLoggedDataFile.133 and then configure the channel lines for the Trend window.  

The name of the Trend Window will remain unaltered until the configuration information is saved using a different name.
[bookmark: _Toc394746218][bookmark: _Toc395410491][bookmark: _Toc457899813][bookmark: _Toc97010979][bookmark: _Toc408991140]Copying Traces
When two or more Trend Windows are open it is possible to copy a line from one window to another.  To copy a line, identify it in the source window Legend box by pointing to the entry and clicking the mouse.  The record will be highlighted.  Select Copy from the Edit menu, or choose the [image: ] copy toolbar button.  

If the line is to be removed from the source Trend Window then select Cut from the Edit menu, or choose the [image: ] cut toolbar button.
In the destination Trend Window from the Edit menu choose Paste, or click on the [image: ]  paste toolbar button.

The axis of the pasted channel will appear on the destination Window, the line will appear also if the time base of the pasted line falls within the time base of the destination Trend Window's time frame.
[bookmark: _Toc394746220][bookmark: _Toc395410492][bookmark: _Toc457899814][bookmark: _Toc97010980][bookmark: _Toc408991141]Navigating Trend Windows
The following section details methods of moving between Trend Windows.

Within the main SCADAPRO Trend application Window Trend windows can be organised to suit the users requirements.

Initially, when a new trend window is created it will lay over the top of any other window within the Trend Application window.  Windows can be brought to the front by either pointing to any exposed part of the required window and clicking, or by choosing Window from the menu bar and then selecting the appropriate channel group window.

[image: ]

From the Window menu option windows can be arranged in a Cascade or Tile layout.

By creating a new window and then minimising it the Trend Application Window can comprise of one or more icons representing each trend window. Choosing the Arrange Icon option from the Window menu will organise any icons uniformly in the window.

All trend windows displayed are visibly updated, not just the active window.
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[bookmark: _Toc394746221][bookmark: _Toc395410493][bookmark: _Toc457899815][bookmark: _Toc93382176][bookmark: _Toc408991142]Part Eight – Excel RTD & DDE

Part Eight explains how to use ScadaPro’s Excel Real-Time Data (RTD) Capabilities and Dynamic Data Exchange (DDE).
[bookmark: _Toc93382177][bookmark: _Toc408991143][bookmark: _Toc394746222][bookmark: _Toc395410494][bookmark: _Toc457899816]
Excel Real-Time Data
From Excel 2002 onwards, Excel supports retrieval of real-time data. The RTD architecture is more fast, efficient, reliable, and robust than the DDE architecture.

Excel can be used for continuous data retrieval from applications which send updates to Excel as new data becomes available. The ScadaPro system supports retrieval of channels using channel identifiers.

Values can be retrieved from the local ScadaPro server in a cell by entering

=RTD("ScadaPro.RTDServer",,"channel identifier")
e.g.
=RTD("ScadaPro.RTDServer",,"C1")

Channel can be retrieved from the local ScadaPro server in a cell by entering

=RTD("ScadaPro.RTDServer",,"channel identifier.attribute")
e.g.
=RTD("ScadaPro.RTDServer",,"C1.tag")
or
=RTD("ScadaPro.RTDServer",,"C1.desc")
          or
=RTD("ScadaPro.RTDServer",,"C1.units")

[bookmark: _Toc93382178][bookmark: _Toc408991144]Excel RTD across Networks
Values and attributes can be retrieved from a remote ScadaPro server in a cell by entering

=RTD("ScadaPro.RTDServer",,"\\<server>\channel identifier")
e.g.
=RTD("ScadaPro.RTDServer",,"\\localhost\C1")


If a channel is disabled values are displayed as ***Error***.

If a channel does not exist, values are displayed as Invalid Channel

If N/A appears in the cell even though the channel exists on the current server, under Tool/Options/Security/Macro Security set security level to Medium or Low. Then save and close and reopen the spreadsheet.
[bookmark: _Toc93382179][bookmark: _Toc408991145]
Excel RTD Throttle Interval
The Excel update rate is called the data throttle interval. This defaults to 5 seconds. This can only be modified via the Excel object model or the registry. There is no user interface for configuring the RTD throttle interval in Excel. 

To set the throttle interval through the Excel object model: 
1. In Excel, go to the Visual Basic Editor (by pressing ALT+F11 or clicking Visual Basic Editor from the Macro menu (Tools menu)). 
2. In the Immediate window (press CTRL+G or click Immediate Window on the View menu), type this code:
Application.RTD.ThrottleInterval = 1000 
3. Make sure your cursor is on the line that you just typed, and then press ENTER. 
4. To verify that it is set correctly, type this line of if code in the Immediate window:
? Application.RTD.ThrottleInterval 
5. If you put your cursor at the end of this line and press ENTER, it should display 1000. Then you know that your throttle interval is set correctly.
Alternatively you can define a macro using the Excel Visual Basic Editor which runs when the workspace is opened e.g.
[image: ]

To set the throttle interval higher through the registry, set the following registry key. It is a DWORD and is in milliseconds:
HKEY_CURRENT_USER\Software\Microsoft\Office\10.0\Excel\Options\RTDThrottleInterval
[bookmark: _Toc93382180][bookmark: _Toc408991146]
Dynamic Data Exchange
Dynamic Data Exchange (DDE) is the traditional protocol to transfer data between Windows applications. The DDE protocol is a set of messages and guidelines. It sends messages between applications that share data and uses window messages to exchange data between applications.

Applications can use the DDE protocol for one-time data transfers and for continuous exchanges in which applications send updates to one another, as new data becomes available. The ScadaPro system has a set of pre-defined DDE links.
[bookmark: _Toc394746223][bookmark: _Toc395410495][bookmark: _Toc457899817][bookmark: _Toc408991147]Starting and Stopping DDE
To enable or disable the DDE server within ScadaPro from the main ScadaPro application window, choose Control menu from the drop down list and select DDE. The following dialog box will be displayed. 

[image: ]

The Start and Stop buttons are used to start and stop the DDE link. The Start-up button allows the user to define how the DDE server will start-up when ScadaPro service is first invoked.

On pressing the Start-up button the ScadaPro DDE start-up dialog box is displayed.

[image: ]

[bookmark: _Toc394746224][bookmark: _Toc395410496][bookmark: _Toc457899818]Automatic
When the Automatic check box is checked the DDE server will be enabled automatically when the ScadaPro service is started.
[bookmark: _Toc394746225][bookmark: _Toc395410497][bookmark: _Toc457899819]Manual
When Manual is checked the DDE server will only commence once the Start Button on the previous dialog box is pressed.
[bookmark: _Toc394746226][bookmark: _Toc395410498][bookmark: _Toc457899820]Priority
Select the appropriate check box for the system priority of the DDE links. The higher the priority the faster the link will be updated in the destination application but this may be at the expense of system speed in other applications and services.
[bookmark: _Toc394746227][bookmark: _Toc395410499][bookmark: _Toc457899821][bookmark: _Toc408991148]Using DDE to Link to other Applications
To specify a DDE link on another application to an ScadaPro DDE source an Application Name, Topic and Item must be specified.

All ScadaPro DDE links have the application name Orchdde.

If the topic is Channel then the Item is an ScadaPro channel e.g. C1. The value of the ScadaPro channel will then be linked to the destination application. If the topic is defined as Logger then the Item is a logger name. The enabled status of the logger, 1 for enabled, 0 for disabled will be the information linked. If the system status needs to be signalled to a remote application then the topic Sys and the item STATUS.

	Application Name
	Topic
	Item

	Orchdde
	Channel
	Scadapro Channel[footnoteRef:1]*  [1: * Enter appropriate channel or logger name.] 


	Orchdde
	Logger
	Logger Name*

	Orchdde
	Sys
	STATUS




The following are examples of dynamically linking ScadaPro information Microsoft Excel and Microsoft Access

NB:
ScadaPro RTE software allows the ScadaPro System to be a DDE server. It cannot be configured as a DDE client.

[bookmark: _Toc394746228][bookmark: _Toc395410500][bookmark: _Toc457899822]

Microsoft Excel Spreadsheets
In Excel a DDE link to ScadaPro is achieved by using a remote reference formula, which has the syntax:

=Application|Topic!Item

The delimiter following the Application is the “pipe” character, and following the Topic is the exclamation mark. As an example to create a link to ScadaPro calculator channel C3 the formula would be entered as follows:

=Orchdde|Channel!C3

Two files are provided on disk 1 of the set-up disks giving DDE examples for Excel. The files are ORCXLEX.XLS and ORCXLEX.DOC.

Excel supports arrays of values. Array formulae are entered as follows:

=Orchdde|Channel!’C1:3’

Array formulae must be entered using the CTRL+SHIFT+ENTER instead of ENTER.

Transferring arrays of values into Excel is much faster than single values.  To transfer arrays of values, you must enter the formula into a range of cells that has the same number of columns as the array has. 

For example, to transfer C1, C2 and C3 into 3 cells.

1) Select 3 columns on 1 row

2) Enter =Orchdde|channel!'c1:3'

3) Press CTRL+SHIFT+ENTER instead of ENTER after entering the formula

All 3 values should now update

Note DDE arrays do not work if the elements are referenced twice e.g. if you also entered =Orchdde|channel!c1 in another cell in the same spreadsheet. It is recommended to start with a new spreadsheet and get all the values in. There is a limit of 255 values in one array but multiple arrays can be retrieved.

NOTE: A syntax problem has been encountered with Microsoft Excel v5.0 using network DDE from ScadaPro and the following describes a procedure for working around the problem.

The syntax for connecting to channel C3 would be:-

=\\server\ndde$|orcchannel!c3

but this returns the message “Error in formula”. To overcome this enter without the $ as:-

=\\server\ndde|orcchannel!c3

and the cell will then display #N/A. From the EDIT menu select Links and highlight the above link. Choose Change source and add the $ to the end of NDDE and choose OK. Click OK to close the Edit links box.
[bookmark: _Toc394746229][bookmark: _Toc395410501][bookmark: _Toc457899823]
Microsoft Access Database
Dynamic links can be created to link data into Microsoft Access reports and forms. For example you can link a value or values into a report so that each time you print the report the current value(s) is included.

A link must be created in the design view of either Form or Report. Create the report or form as normal creating a text box to contain the linked data. Select the Properties dialog box for this text box. A typical Properties box is shown below.

[image: ]

In the Control Source property field enter the DDE function the syntax of which is:

=DDE(application, Topic, Item)

The field names are enclosed within speech marks. As an example to create a link to ScadaPro calculator channel C3 the statement would be entered as follows:

=DDE(“Orchdde”, “Channel”, “C3”)

[bookmark: _Toc394746230][bookmark: _Toc395410502][bookmark: _Toc457899824][bookmark: _Toc408991149]
DDE across Networks

N.B. Netbeui must be installed on the machine in order for Network DDE to operate on Windows NT.

N.B. Network DDE is not supported on Windows 95 or Windows 98.

ScadaPro includes a set of NetDDE shares which allow DDE links over network to a remote Client. ScadaPro must be prepared for DDE service as described at the beginning of this section.

In addition the remote client must also have its network DDE service enabled. For example in Windows for Workgroups this is done by selecting the Network Icon within Control Panel and choosing Start-up options. The Enable Network DDE must be checked and then click OK twice to exit. Close Windows and restart to allow network DDE to start.
[bookmark: _Toc394746231][bookmark: _Toc395410503][bookmark: _Toc457899825]Using Network DDE to Link to other Applications
Using DDE across a network is similar to linking to local applications except that different Application Name and topics are used. The Application name is as follows (case sensitive):

\\server\ndde$

where Server is the name of the ScadaPro computer server.

The shares installed require the following topic names:

	OrcChannel
	Channel

	OrcLogger
	Logger

	OrcSys
	System




When establishing links in some applications you may be prompted for your Client password.
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[bookmark: _Toc457384616][bookmark: _Toc457386609][bookmark: _Toc457899827][bookmark: _Toc408991150]Part Nine – Channel configuration

This section describes the Channel Configuration Utility.

[bookmark: _Toc397140378][bookmark: _Toc457384617][bookmark: _Toc457386610][bookmark: _Toc457899828][bookmark: _Toc408991151]
Channel Configuration
The generic  Channel Configuration utility allows the user to configure device and processor channels by tag. The user selects a tag from the Tag combo box (see below).   This utility can be launched from the Configurable Monitor. The list of tags is loaded from a file on the local machines <Program Directory>\CURRENT_CONFIG directory. This file is user specific and is named User_Channels.txt where User is the name of the currently logged on user. This file defines which channels a user has access to and is in the 
following text format :

<ServerName>,<TagName>

[image: ]

The Server field displays the server which the System channel resides on.
The Value field displays the current value of the channel.

When the tag for a channel has been selected the application searches the associated server for the channel and determines whether it is a processor or device channel. It also determines if the channel is an analog or digital channel. If the channel is not found on the server an error message is displayed and the selection is cancelled.

[bookmark: _Toc397140379][bookmark: _Toc457384618][bookmark: _Toc457386611][bookmark: _Toc457899829][bookmark: _Toc408991152]Configuring Digital Channels
The following fields can be configured for digital channels :

[image: ]
[bookmark: _Toc397140380][bookmark: _Toc457384619][bookmark: _Toc457386612][bookmark: _Toc457899830]Enable Channel
Click this check box on to enable the channel.
[bookmark: _Toc397140381][bookmark: _Toc457384620][bookmark: _Toc457386613][bookmark: _Toc457899831]Description
Enter up to 16 characters to describe a processor channel.
Enter up to 32 characters to describe a device channel.
[bookmark: _Toc397140382][bookmark: _Toc457384621][bookmark: _Toc457386614][bookmark: _Toc457899832]Low State Description
Enter up to 32 characters to describe a device channel in low state.
[bookmark: _Toc397140383][bookmark: _Toc457384622][bookmark: _Toc457386615][bookmark: _Toc457899833]High State Description
Enter up to 32 characters to describe a device channel in high state.
[bookmark: _Toc397140384][bookmark: _Toc457384623][bookmark: _Toc457386616][bookmark: _Toc457899834]Event Checking
Event checking is used, if required to trigger a logger to record information on an event. If this facility is required click on the drop down list box and select OFF, HIGH STATE, or LOW STATE appropriate
[bookmark: _Toc397140385][bookmark: _Toc457384624][bookmark: _Toc457386617][bookmark: _Toc457899835]Alarm State
Alarm checking is available on all channels throughout the  system. To configure alarm checking on this channel select OFF, HIGH STATE, or LOW STATE as appropriate. If a channel's status  changes to an Alarm State an alarm will be triggered on that channel. When monitoring channels, if the alarm is triggered, then the fact will be annotated alongside any other channel information.
[bookmark: _Toc397140386][bookmark: _Toc457384625][bookmark: _Toc457386618][bookmark: _Toc457899836]Alarm Priority
Enter the priority of the alarm triggered by this channel.
[bookmark: _Toc397140387][bookmark: _Toc457384626][bookmark: _Toc457386619][bookmark: _Toc457899837]Common Alarm
Channels can be configured to trigger a Common Alarm. A common alarm is a single digital output which will switch on when any channel with the Drive Common Alarm enabled goes into an alarm state.
[bookmark: _Toc397140388][bookmark: _Toc457384627][bookmark: _Toc457386620][bookmark: _Toc457899838]Alarm Delay
Enter the number of seconds before the alarm is announced.
[bookmark: _Toc397140389][bookmark: _Toc457384628][bookmark: _Toc457386621][bookmark: _Toc457899839]Alarm Message
Enter up to 32 characters to describe the channel when it is in alarm state.
[bookmark: _Toc397140390][bookmark: _Toc457384629][bookmark: _Toc457386622][bookmark: _Toc457899840][bookmark: _Toc408991153]
Configuring Analogue Channels
The following fields can be configured for analog channels :

[image: ]
[bookmark: _Toc397140391][bookmark: _Toc457384630][bookmark: _Toc457386623][bookmark: _Toc457899841]Enable Channel
Click this check box on to enable the channel.
[bookmark: _Toc397140392][bookmark: _Toc457384631][bookmark: _Toc457386624][bookmark: _Toc457899842]Description
Enter up to 32 characters to describe the channel.
[bookmark: _Toc397140393][bookmark: _Toc457384632][bookmark: _Toc457386625][bookmark: _Toc457899843]Units
Enter up to 4 characters to describe the unit of measurement.
[bookmark: _Toc397140394][bookmark: _Toc457384633][bookmark: _Toc457386626][bookmark: _Toc457899844]Significant Change
To enable the Significant Change feature check the Significant Change check box. This facility allows filtering of data on channels on which significant change is of interest. Such changes can cause an event, which can be logged. The figure entered in the Value text box, in engineering units is the rate of change that if the measured channel exceeds per scan, either increasing or decreasing will cause the significant change event trigger. If a logger is configured in Event mode, or Period-Event, each time the significant change trigger operates information on the channels defined in the logger will be recorded. A significant change event only lasts one scan, unless the next reading also changes greater than the Significant change value. When monitoring channels, if the Significant Change is triggered, then the fact will be annotated alongside any other channel information.

The significant  change events are in addition to those caused by an Event (See Below).
[bookmark: _Toc397140395][bookmark: _Toc457384634][bookmark: _Toc457386627][bookmark: _Toc457899845]Event Checking
Event checking is used, if required to trigger a logger to record information on a number of channels during  an event. Check the Event Checking  check box if this facility is needed.
[bookmark: _Toc397140396][bookmark: _Toc457384635][bookmark: _Toc457386628][bookmark: _Toc457899846]High Limit
A value, in engineering units, entered in this text box will define the level that, if exceeded,  will cause an event trigger.
[bookmark: _Toc397140397][bookmark: _Toc457384636][bookmark: _Toc457386629][bookmark: _Toc457899847]Low Limit
A value entered in this text box will define the level that if the channel result falls below will cause an event trigger.
[bookmark: _Toc397140398][bookmark: _Toc457384637][bookmark: _Toc457386630][bookmark: _Toc457899848]Scaling
To enable the utility check the Scaling Check box. The Slope and Offset values can be entered directly into the text boxes.  The formula applied is:

y = mx + c  where:

m is Slope
x is the measured value.
c is the Offset

[bookmark: _Toc397140399][bookmark: _Toc457384638][bookmark: _Toc457386631][bookmark: _Toc457899849]Auto Scale
Click On the Auto Scale button if you want the scale and offset values calculated automatically. In the dialog box enter the values in the text boxes.  The low measured value, and the high measured value, the output range of the transducer. 

Note :
Scaling is only available for Analog Input and Counter Input channels.
[bookmark: _Toc397140400][bookmark: _Toc457384639][bookmark: _Toc457386632][bookmark: _Toc457899850]Low and High Alarm Checking
Alarm checking is available on all channels throughout the  system. Low Alarm and  High Alarm levels can be configured independent of each other. All the values entered are in engineering units. If a channel reading exceeds the High Alarm limit then an alarm will be triggered as it will if the channel goes below the Low Alarm limit. When monitoring channels, if the high or low alarm is triggered, then the fact will be annotated alongside any other channel information.
[bookmark: _Toc397140401][bookmark: _Toc457384640][bookmark: _Toc457386633][bookmark: _Toc457899851]Enable Alarm Checking
Check either the Low Alarm Checking or High Alarm Checking or both check boxes to enable the facility.
[bookmark: _Toc397140402][bookmark: _Toc457384641][bookmark: _Toc457386634][bookmark: _Toc457899852]Drive Common Alarm
A common alarm is a single digital output which will switch on when any channel with the Drive Common Alarm enabled goes into an alarm state. Check this box if a link to the Common Alarm is required.
[bookmark: _Toc397140403][bookmark: _Toc457384642][bookmark: _Toc457386635][bookmark: _Toc457899853]Alarm Limit
Enter or edit the alarm limit in the text box.
[bookmark: _Toc397140404][bookmark: _Toc457384643][bookmark: _Toc457386636][bookmark: _Toc457899854]Warning
Check the box if this feature if needed.  Enter the warning value in the text box.
[bookmark: _Toc397140405][bookmark: _Toc457384644][bookmark: _Toc457386637][bookmark: _Toc457899855]Hysteresis
Check the box if this feature if needed.  Enter the value of the dead band in the text box.
Hysteresis can prevent 'noisy' channels from reporting multiple alarms when the average reading is close to the alarm threshold.
[bookmark: _Toc397140406][bookmark: _Toc457384645][bookmark: _Toc457386638][bookmark: _Toc457899856]Priority
Enter or edit the number in the text box to allocate the priority of this  alarm.
[bookmark: _Toc397140407][bookmark: _Toc457384646][bookmark: _Toc457386639][bookmark: _Toc457899857]Delay
Enter the number of seconds before the alarm is announced.
[bookmark: _Toc397140408][bookmark: _Toc457384647][bookmark: _Toc457386640][bookmark: _Toc457899858]Alarm Message
Enter up to 32 characters to describe the channel when it is in low and high alarm state.

[bookmark: _Toc397140409][bookmark: _Toc457384648][bookmark: _Toc457386641][bookmark: _Toc457899859][bookmark: _Toc408991154]Automatic Scaling
Enter the low measured value the high measured value, and the output range of the channel. When the fields have been completed and assuming the System is enabled click on the Apply button. Under the heading Current Values the actual measured value will be shown, as well as the Engineering Value. Click on OK to accept the scaling, or Cancel to abort the Auto Scaling facility.


[image: ]

Note
Scaling is only available for Analog Input and Counter Input channels.
[bookmark: _Toc397140410][bookmark: _Toc457384649][bookmark: _Toc457386642][bookmark: _Toc457899860][bookmark: _Toc408991155]Saving Channel Configurations
To save a channel configuration click on the OK button. The user will be asked if the configuration is to be saved at this point. Click Yes to do so, No to quit without saving changes and Cancel to return to the configuration dialog.
[bookmark: _Toc397140411][bookmark: _Toc457384650][bookmark: _Toc457386643][bookmark: _Toc457899861][bookmark: _Toc408991156]Setting Channel Values
Any System Output channel, digital or analog channels can have their values changed manually. To modify the value of a channel point to the Value field and double click the left mouse button. Depending on the channel type (Analog or Digital) the following dialogs will be displayed

[bookmark: _Toc397140412][bookmark: _Toc457384651][bookmark: _Toc457386644][bookmark: _Toc457899862]Analog Channels
If the channel chosen is an analog output the dialog box will contain a text field. Edit the value in that field and choose the OK button. The channel value will be changed to the new value on the next scan.


[image: ]
[bookmark: _Toc397140413][bookmark: _Toc457384652][bookmark: _Toc457386645][bookmark: _Toc457899863]Digital Channels
If the selected channel is a digital output channel the dialog box will contain two radio buttons. The button of the current status will be selected initially. Choose the required button and then select the OK button to confirm the change. The digital output will be set on the next scan.

[image: ]
[bookmark: _Toc397140414][bookmark: _Toc457384653][bookmark: _Toc457386646][bookmark: _Toc457899864][bookmark: _Toc408991157]Alarm Masking
It is possible to mask an alarm for the selected tag by clicking the Mask button at the bottom of the window. This has the effect of setting the channels alarm status to Masked. Masked alarms can be hidden in the alarm monitor by unchecking the Masked Alarms check box in the Monitor’s property page. Masked alarms are not shown on Main Menu’s alarm bar.
To Unmask a channel’s alarm status, click the unmask button at the bottom of the window.
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[bookmark: _Toc47494850][bookmark: _Toc408991158]Part 10 – Data Exchange

This section describes the use of the Data Exchange Processor.


[bookmark: _Toc47494851][bookmark: _Toc408991159]Data Exchange

Data Exchange is a data capture client that can connect to multiple OPC Servers and/or multiple DDE Servers. This provides a means for data transfer to and from data servers provided by more than one vendor. Servers available include device drivers to proprietary hardware.  

Data Exchange is configured as a Processor and as such it makes available data input/output to and from the RTE. Data transfer is performed synchronously thus making network connections update as fast as possible. Each item of data to be transferred is configured as a channel.

NB.
Data Exchange can only be installed as a Client on Windows 95.

NB.
For Data Exchange to run on Windows ’95 it is necessary that DCOM for Windows ’95 is installed first. However, do to security restrictions actual DCOM facilities for this product are not supported on Windows ’95.



[bookmark: _Toc526648214][bookmark: _Toc47494852][bookmark: _Toc408991160]
Configuration

To configure either double click on the Data Exchange icon in the ScadaPro programme group or select Processors and then Data Exchange from the ScadaPro menu bar.


The Data Exchange Configuration window will show which channels have been configured.  Channels not yet configured will bear the tag description of DISABLED. Channels that have been configured will be shown with a tag description and a channel description.

[image: ]


To configure a channel, point to and double click the mouse button on the channel to be configured.  A Configure Channel Dialog box will be displayed.

[bookmark: _Toc416508893][bookmark: _Toc526648215][bookmark: _Toc47494853][bookmark: _Toc408991161]
Advanced Data Exchange Configuration
[bookmark: _Toc416508894][bookmark: _Toc526648216]AutoEnable Data Exchange
Before any Data Exchange Channel can be incorporated into the overall ScadaPro System the Advanced Data Exchange Configuration bar must be selected and the AutoEnable Data Exchange box checked. Now, when the ScadaPro system is enabled from the Main Menu, the Data Exchange channels will automatically be enabled also.


[image: ]

[bookmark: _Toc526648217]Update Rate.
This field specifies the rate at which the Data Exchange processor should attempt to retrieve/set values on the connected data sources.

[bookmark: _Toc526648218]OPC Recovery Rate.
This field specifies the rate at which the Data Exchange processor should attempt to re-establish contact with OPC servers that are not responding. This field should be set to as high a timeout as possible as interrogation of OPC servers which are not operating correctly can take some time.

[bookmark: _Toc526648219]DDE Recovery Rate
This field specifies the rate at which the Data Exchange processor should attempt to re-establish contact with DDE servers that are not responding.

[bookmark: _Toc416508895][bookmark: _Toc526648220]Auto Save.
To Enable this utility check the AutoSave flag. All values in all channels are saved to disk when the system is disabled. The next time the system is restarted the values which were previously in each channel will be restored to the appropriate channel number.
[bookmark: _Toc526648221]By Tag
Channel values can be saved and restored to channels using the channel tag as the reference instead of the channel number. In this way, channels can be rearranged within the modules and as long as the channel tags remain the same, the correct channel values will be restored to the appropriate channel number.

[bookmark: _Toc416508896][bookmark: _Toc526648222][bookmark: _Toc47494854][bookmark: _Toc408991162]Saving the Configuration
When a configuration has been completed it must be saved to retain any changes made.  To save either:
1.	Click on the Save icon; [image: ] The Data Exchange configuration will be saved to the current ScadaPro System configuration.  No File Name will be requested.
2.	Select Save from the File menu.
3.	Select Exit from the file menu.  If any changes have been made a dialog box will ask if you want to save the configuration before exiting the window.

NB.
Any changes to the Data Exchange Channel Configuration will not be incorporated into the ScadaPro System until it is next enabled or the processor is reconfigured.

[bookmark: _Toc416508897][bookmark: _Toc526648223][bookmark: _Toc47494855][bookmark: _Toc408991163]Copy and Paste
Two of the icons on the Configure Data Exchange toolbar are Copy and Paste. From the Data Exchange Configuration Window it is possible to copy one channels configuration to another. Point to the channel to be copied, it will be highlighted, click on the Copy icon the configuration will be copied to the clipboard.  Now point to the channel that the configuration is to be copied to, again it will be highlighted. Select the Paste icon and the configuration will be pasted from the clipboard.

[bookmark: _Toc416508898][bookmark: _Toc526648224]Shortcuts

Toolbar:	
Keys:	CTRL+C, CTRL+V







[bookmark: _Toc416508899][bookmark: _Toc526648225][bookmark: _Toc47494856][bookmark: _Toc408991164]Configure Data Exchange Channel
The configuration of Data Exchange Channels is divided into 7 sections plus a row of buttons at the bottom. 


[image: ]

[bookmark: _Toc526648226]Enable Channel
For a channel to be operative and therefore configurable the Enable Channel check box must be checked.
[bookmark: _Toc526648227]Tag:
A 12 characters alphanumeric field that can contain channel information or wiring schedule references.

[bookmark: _Toc526648228]Description:
A 32 channel alphanumeric field in which a description of the channel can be detailed. 

[bookmark: _Toc394745947][bookmark: _Toc526648229]Engineering Units:
[bookmark: _Toc526648230]Minimum: 

Minimum engineering value for all analog channels in addition to the unit field.  The default is 0
[bookmark: _Toc526648231]Maximum: 

Maximum engineering value for all analog channels in addition to the unit field.  The default is 100
[bookmark: _Toc526648232]Descriptor: 

A 10 character field available to describe the units of the measurement

[bookmark: _Toc526648233]Significant Change
To enable check the Significant Change check box.  

This facility allows filtering of data on channels on which significant change is of interest.  Such changes can cause an event, which can be logged.

The figure entered in the Value text box is the rate of change in engineering units, which, if the measured channel exceeds per scan, either increasing or decreasing will cause the significant change event trigger. 

[bookmark: _Toc526648234]Event Checking
Event checking is used, if required to trigger a logger to record information on an event. Check the Event Checking check box if this facility is needed.
[bookmark: _Toc526648235]High Limit:
A value entered in this text box will define the level that if exceeded, by the channel result will cause an event trigger.
[bookmark: _Toc526648236]Low Limit:
A value entered in this text box will define the level that if the channel result falls below will cause an event trigger.

[bookmark: _Toc526648237]Alarm Error Checking
[bookmark: _Toc526648238]Drive Common: 
A common alarm is a single digital output which will switch on when any channel with the Drive Common Alarm enabled goes into an alarm state.
Check this box if a link to the Common Alarm is required.
[bookmark: _Toc526648239]Priority :
Enter or edit the number in the text box to allocate the priority of this channels alarm.

[bookmark: _Toc526648240]Delay:
Enter the time, in seconds, between the channel value entering the alarm state and the system flagging an alarm.

[bookmark: _Toc526648241]Low and High Alarm Checking
Alarm checking is available on all channels throughout the ScadaPro systemGlossScadaProSystem.63.  Low Alarm and High Alarm levels can be configured independent of each other. All the values entered are in engineering unitsGlossEngineeringUnits.60.  If a channel reading exceeds the High Alarm limit then an alarm will be triggered as it will if the channel goes below the Low Alarm limit.  

When monitoring channels, if the high or low alarm is triggered, then the fact will be annotated alongside the other channel information in the Monitor Window.   
[bookmark: _Toc526648242]Enable Alarm Checking:
Check either the Low Alarm Checking or High Alarm Checking or both check boxes to enable the facility.
[bookmark: _Toc526648243]Alarm Limit:
The value at which the channel will flag an alarm.
[bookmark: _Toc526648244]Warning and Limit:
If required, a warning can be displayed when a channel reaches a limit close to the alarm limit. For low alarm checking, the limit must be less than the alarm limit. For high alarm checking, the warning limit must be less than the alarm limit.
[bookmark: _Toc526648245]Delay:
Specify the number of seconds the channel must be in the alarm zone before an alarm will be flagged within the system.

[bookmark: _Toc526648246]Hysteresis 
Hysteresis can prevent 'noisy' channels from reporting multiple alarms when the average reading is close to the alarm or warning threshold. The Hysteresis value is relative to the alarm or warning limit.

For example, if a channel’s high alarm is set to 80 degrees C, Hysteresis is enabled and a Hysteresis value of 5 degrees C is specified the system will respond as follows:

When the channel reading goes above the high alarm limit of 80 it will trigger the alarm. The alarm will not be reset until the channel reading falls below 75, the high limit - Hysteresis value.

Check the box if this feature is needed.  Enter the value of the dead band in the text box.

[bookmark: _Toc526648247]Priority
Enter or edit the number in the text box to allocate the priority of this alarm.  
[bookmark: _Toc526648248]Drive Common Alarm:
A common alarm is a single digital output, which will switch on when any channel with the Drive Common Alarm enabled goes into an alarm state.

Check this box if a link to the Common Alarm is required.
[bookmark: _Toc526648249]Alarm Message:
An Alarm Message can be defined to be displayed on the Status line of the ScadaPro Main Window when a channel goes into an alarm state. 

Enter the message, up to 32 characters.

[bookmark: _Toc526648250]Access
[bookmark: _Toc526648251]Read/Write:
	
This field specifies whether this channel will be able to Read/Write it’s connected data source. If Read is selected then Write options are greyed out. If Write is selected then the user can also specify some read characteristics for this channel. These are “Read at startup” and “Read if no change”

· Read at start-up 	–  	On the first pass of the processor the value will be read
into the RTE.
· Read if no change 	– 	If there is no data to be written then the value will be
read into the RTE.

[bookmark: _Toc526648252]Type:
Data is available from two source types, OPC server and DDE server. 

OPC
These following fields are used to configure the OPC Data Item that the channel will be linked to.

Node
Enter the name of the machine where the desired OPC Data Access Server resides. Alternatively click on the Node… button to select the machine name from a list of machines found on the network.

Server
Enter the name of the OPC Data Access Server you wish to retrieve data from.  Alternatively click on the Server… button to select the server from a list of servers found on the desired machine.

Read Quality
When read quality is check the channel with return the OPC Read Quality.  This is useful when it is necessary to monitor the quality of OPC data over remote links.


[image: ]

Item
Enter the name of the individual Data Item on the OPC Data Access Server you wish to retrieve data from. Alternatively click on the Item… button to select the item from a list of items found on the desired server. The list can be hierarchical or flat depending on the servers browse settings. 


[image: ]

Access Path
Enter the access path of the OPC Data Item. This is the access path that the server should associate with this item. By convention if this is left blank the server should select the access path.



 







DDE
If the user selects the DDE option button the Application, Topic and Item fields are displayed as below. 

[image: ]

The user must complete these fields were Application identifies the DDE server application, Topic the group of data points of interest and Item the actual data point of interest
	
[bookmark: _Toc416508900][bookmark: _Toc526648253]Windows Buttons
Eight buttons are at the bottom of the Configure Data Exchange Channel Window. Their use is explained below.


When a channel has been successfully configured, click the OK button to accept and move back to the previous window.


Clicking on the Cancel button will nullify any changes made. The configuration of that channel will remain the same, The previous window will be displayed.


If the configuration of the current channel is to be repeated, clicking on this button will copy the configuration to the Windows Clipboard.


When a configuration has been copied to the Clipboard, it can be pasted into any other channel in this group by this button.


Clicking on Previous or Next buttons will accept the current channels configuration and move on to either the next or previous channel’s Configuration Window.


Selecting the Goto… button will accept the current channel’s configuration and move on to the channel entered in the resulting Goto Channel No. dialog box.


If any help is required concerning any element of this window, clicking on this button will select the Help utility.



[bookmark: _Toc431789500][bookmark: _Toc526648254][bookmark: _Toc47494857][bookmark: _Toc408991165]Configuring Data Exchange for Remote Operation

For any OPC client to access remote data through DCOM it is necessary to configure both the server and client machines for DCOM. Through the rest of this document we will reference the RTE OPC Server as or OPC Server application. This may be substituted for the OPC server of your choice.

The client and server machines must be running either Windows NT 4.0 with SP3 patch or later. The “dcomcnfg.exe” in the <Windows>\system32 directory can be used to make the required changes. This can be run from the “Start/Run…” menu command.

The client and server machines must then be configured as per the following pages. Note that this document describes only one method by which a remote client can use DCOM to connect to a OPC server. If a server machine is already configured to run DCOM, there may be no configuration necessary on the server machine. However this document assumes DCOM has never been previously used on the server machine.
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Likewise, if the client application is a true DCOM client, then all that may be necessary on the client machine is to install the OPC server and the client application will allow users to specify a remote server. However, this document assumes a simple COM client application, where the RTE OPC Server machine name must be hard coded on the client machine.

[bookmark: _Toc431789501][bookmark: _Toc526648255][bookmark: _Toc97098652][bookmark: _Toc408991166]
Server Machine

The server machine is assumed to already have the ScadaPro OPC Server registered  / installed. After this the main changes required are to configure the system and security to allow remote users to connect. The method described in the following pages does this by allowing all COM servers to be used by the specified remote users. If it is necessary to have tighter control of COM / DCOM security permissions, contact your security administrator, for alternative configuration options.


Default Properties

From the Start bar choose Run. Enter DCOMCNFG into the edit field and Click OK.  Expand Component Services, Computers and My Computer.  Right click on My Computer and select properties.  Click the Default Properties tab.  Select the settings shown below:
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· Select the “Default Properties” tab:

· Set the “Enable Distributed COM (DCOM) on this machine” check box.


· Set “Default Authentication Level” to  “None”.

· Set “Default Impersonation Level” to “Identify”.


· Clear the “Provide additional security for reference tracking” check box.

· Click the “Apply” button.

Default Security
· Select the “COM Security” tab.
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Access Permissions
· Edit the “Default Access Permission”. Add both the SYSTEM account and the required users / groups to the list of users / groups who are “Allowed Access”.
· Click “Edit Limits”.  By Default the Everyone group has already been added.  Ensure that the Everyone group has remote access checked.  Once DCOM has been configured you can remove the Everyone group and define a smaller subset of users if required.

Launch and Activation Permissions
· Edit the “Default Launch Permission”. Add both the SYSTEM account and the required users / groups to the list of users / groups who are “Allowed Launch”.
· Click “Edit Limits”.  By Default the Everyone group has already been added.  Ensure that the Everyone group has Local Launch, Remote Launch, Local Activation and Remote Activation option checked.  Once DCOM has been configured you can remove the Everyone group and define a smaller subset of users if required.

*Note: The “Edit Limits” options above are not available unless you have installed Windows XP Service Pack 2.

Default Protocols
· Click on the Default Properties tab
· If the Connection-orientated TCP/IP protocol is not at the top of the list it must be moved there.
· This is done by selecting the TCP/IP Protocol and clicking the move up button until it is at the top of the list.
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Application Configuration
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The OPC Server must be configured to “Run As” a particular user, follow the steps below:

Expand the DCOM Config group as shown above and find the Orchestrator OPC Server object.  Right click on the object and select properties.
[image: ]


· Select the “Identity” tab 

· Select the “This user” radio button.


· Enter the user name and password of the account in which the OPC server process should run.

· Click the “Apply” button.


· Click the “OK” button.


Windows XP Service Pack 2 Firewall Configuration
By default your Firewall is turned on and this setting recommended to give the machine the highest possible protection.  It may be appropriate to turn of the Firewall completely if the machine is sufficiently protected behind a corporate Firewall.  The steps below describe configuration changes required to allow Remote OPC Communication when the Firewall is turned on.

· Click Start, Settings and Control Panel
· Open the Security Centre Applet
· Click the Firewall option
· Click the Exceptions Tab
· Click Add Program and add Data Exchange from the list of applications
· Click the Browse button and navigate to C:\ScadaPro\Bin and add MS_OPCSvr.exe.  If you wish to use any 3rd Party OPC Servers or Clients you must specify their executable (.exe) file names here also.
· Click the Add Port button.  Port 135 is needed to initiate DCOM Communications and allow for incoming echo requests.  Enter the following Details:
Name: DCOM
Port Number: 135
Choose the TCP Radio Button
· Click Ok and Restart the Computer.

[bookmark: _Toc431789505][bookmark: _Toc526648259][bookmark: _Toc97098653][bookmark: _Toc408991167]Client Machine

The client machine will not normally already have the ScadaPro OPC Server registered. If this is the case it must be registered before following the instructions below. This can normally be done either by installing the RTE OPC server or running the supplied registry file, RemoteOPCServer.reg. Once this is done the required steps are to:

Default COM Settings
From the Start bar choose Run. Enter DCOMCNFG into the edit field and Click OK.  Expand Component Services and Computers.  Right Click on My Computer and select Properties.
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From the Default Properties Tab set the Default Authentication Level to “None”.  Set the Default Impersonation Level to “Identify”.



Note: The ScadaPro Service must be configured to run as a user on the client system.
To configure the ScadaPro Service to start as a user click Start, Control Panel, Administrative Tools and open the Services applet.  From the list of Services find and double click on the ScadaPro service.  Click the Log On tab and click “This Account”.  Specify a user account that has sufficient rights to access the OPC Server PC.
[bookmark: _Toc431789508][bookmark: _Toc526648261][bookmark: _Toc47494860][bookmark: _Toc408991168]Register OPC Proxy

The OPC Proxy DLL (“OPCProxy.dll”) must be registered on the client machine. This DLL contains the information needed to send data between any OPC client and server. The proxy is registered using the RegSvr32.exe” utility. Copy the OPC Proxy DLL to the <Windows>\system32 directory and from the command prompt in that directory, run “RegSvr32 OPCProxy.dll”.

[bookmark: _Toc526648262][bookmark: _Toc47494861][bookmark: _Toc408991169]
Trouble Shooting

Problem: Each time an OPC Client connects to an OPC Server a new instance of the server is launched. Thus resulting in multiple OPC Servers if more than one client is launched.

Solution: This can occur if the OPC Server is being launched as “The Launching User”. A solution to this would be to set the “Identity” property of the OPC Server to be that of a specific user. In the example below the RTE OPC Server is being launched as the user “DomainName\SmithJ“. This means that everytime a client connects to this OPC Server the system will check to see if the server is already launched and if so it will connect the new client to this instance of the server. This option can be configured by using “dcomcnfg.exe”, selecting the appropriate OPC Server and clicking on the “Properties” button.
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[bookmark: _Toc457384654][bookmark: _Toc457386647][bookmark: _Toc457899865][bookmark: _Toc408991170]Appendix A – Environment variables

Appendix A Details the use of ScadaPro Environment Variables.
[bookmark: _Toc457384655][bookmark: _Toc457386648][bookmark: _Toc457899866][bookmark: _Toc408991171]
ScadaPro Environment Variables

The ScadaPro Setup Program adds several Environment Variables which the various programs in the suite use for successful operation. The capabilities files also contain environment variables used by individual programs. This appendix outlines the environment variables, the programs which rely on the variables and their purpose.

[bookmark: _Toc457384656][bookmark: _Toc457386649][bookmark: _Toc457899867][bookmark: _Toc408991172]Replays Environment Variables
The entries in the REPCAP.TXT file require some environment variables as follows:

[bookmark: _Toc457384657][bookmark: _Toc457386650][bookmark: _Toc457899868]LOGDIR
The LOGDIR term defines the environment variable name of logger data directory and is typically ORC_LOGGED_DATA
[bookmark: _Toc457384658][bookmark: _Toc457386651][bookmark: _Toc457899869]ROOT
ROOT is the environment variable defining an automatically selected replay configuration file, for example the root picture for Trends is defined by the TRENDROOT environment variable.
[bookmark: _Toc457384659][bookmark: _Toc457386652][bookmark: _Toc457899870]PIC_ENV
PIC_ENV is the environment variable name of the configuration directory for the replay option. For example, the ORC_TRENDS environment variable defines the name of the Trends configuration directory.
[bookmark: _Toc457384660][bookmark: _Toc457386653][bookmark: _Toc457899871]ROOTLOG
ROOTLOG is the environment variable name of logger file directory for the log file to be replayed, for example the ROOTLOG environment variable for Trends is defined by the TRENDLOG environment variable.
[bookmark: _Toc457384661][bookmark: _Toc457386654][bookmark: _Toc457899872]MRF
MRF is the environment variable which tells Trends whether to use the Most Recent File option or not. If it is set, then when Trends is run it takes the most recent file from the ROOTLOG directory instead of prompting the user for a log file. A typical environment variable name for MRF would be TRENDMF
[bookmark: _Toc457899873][bookmark: _Toc408991173]Monitors Environment Variables

The entries in the MONCAP.TXT file require some environment variables as follows:

[bookmark: _Toc457899874]ROOT
ROOT is the environment variable defining an automatically selected monitor, for example the root picture for Configurable Monitor is defined by the MONROOT environment variable.
[bookmark: _Toc457899875]PIC_ENV
PIC_ENV is the environment variable name of the configuration directory for the monitor option. For example, the ORC_CMONITORS environment variable defines the name of the Configurable Monitor configuration directory.
Appendix A		ScadaPro Environment Variables
Appendix A		Dynamic Data Exchange
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[bookmark: _Toc457384662][bookmark: _Toc457386655][bookmark: _Toc457899876][bookmark: _Toc408991174]Appendix B - Security
Appendix B details ScadaPro Security. 
[bookmark: _Toc457384663][bookmark: _Toc457386656][bookmark: _Toc457899877][bookmark: _Toc408991175]
ScadaPro Security
There are several methods in ScadaPro for preventing certain users from accessing part or all of the ScadaPro system configuration, monitoring data sources, changing channel values or changing the state of the system (enabling, disabling or reconfiguring the system).

It is recommended that only your ScadaPro SYSTEM ADMINISTRATOR configure protection on your ScadaPro system as a mistake can have disastrous consequences!
[bookmark: _Toc457384664][bookmark: _Toc457386657][bookmark: _Toc457899878][bookmark: _Toc408991176]Prerequisites
ScadaPro security can only be implemented on an ScadaPro server which has been installed on an NTFS disk partition.

The reader should be familiar with setting up user accounts using the Windows User Manager facility, and setting user permissions on files and directories using the Windows Explorer. For details on either of these utilities, see your Microsoft Windows documentation.

User accounts should be set up for each user who will monitor or configure the ScadaPro system. Rights for these users will be set on certain files in the ScadaPro CURRENT_CONFIG directory in order to allow or prevent access to certain parts of the system.

A detailed knowledge of the ScadaPro directory structure would be preferable. Files discussed in this manual SHOULD NOT BE EDITED OR RENAMED. To do so may render the ScadaPro system inoperable and require technical assistance from your vendor in order to fix.
[bookmark: _Toc457384665][bookmark: _Toc457386658][bookmark: _Toc457899879][bookmark: _Toc408991177]File Location
In order to set permissions, you must be familiar with the location of certain files and sub-directories within the ScadaPro system. The following section tells you how to locate the files:
[bookmark: _Toc457384666][bookmark: _Toc457386659][bookmark: _Toc457899880]Configuration Subdirectories
Data sources fall under the categories of Devices and Processors. Each of the data sources and loggers in the ScadaPro system has a corresponding configuration program which is run from the Devices, Processors or Loggers menu in ScadaPro Main Menu. Each data source has a corresponding file called ‘config’ where the data source’s configuration is permanently stored. Loggers also store their configuration on disk. These configuration files are located in the ScadaPro CURRENT_CONFIG directory under the data source’s configuration sub-directory, or, in the case of loggers, in the LOGGERS sub-directory.

The data source configuration sub-directory is named as follows:
Configuration Sub-directory – Devices
The configuration sub-directory for devices is named using the device name, followed by an underscore, followed by the device number. This information can be found in the ‘devcap.txt’ file located in the ScadaPro CURRENT_CONFIG directory. Each device in the ScadaPro system has a single line entry in the ‘devcap.txt’ file which has the following format:

device name, device number, print name, an ip, dig ip, an op, dig op, cntr ip

The first two fields are the ones we’re interested in. The name you see in the ScadaPro Main Menu’s Devices menu corresponds to the print name field in the devcap.txt. file.

Here’s an example of the ‘devcap.txt’ entry for a Generic device number 2:

gener,2,Generic Device,EI:1000,,EO:1000,,

From this we can deduce that the configuration sub-directory for the Generic device is:
CURRENT_CONFIG\gener_2

Configuration Sub-Directory – Processors
The configuration sub-directory name for processors is very similar to that of devices with the exception that processors do not have the trailing underscore and device number combination found on device configuration sub-directories. The processor configuration sub-directory simply consists of the processor name. 

Processor names can be found in the ‘datproc.txt’ file located in the ScadaPro CURRENT_CONFIG directory. Each processor in the ScadaPro system has a single line entry in the ‘datproc.txt’ file which has the following format:

processor name, print name, channel range, runtime option

This time we are only interested in the first field of the entry. The name you see in the ScadaPro Main Menu’s Processor menu corresponds to the processors print name field in the ‘datproc.txt’ file.

Here’s an example of the ‘datproc.txt’ entry for the User Analog processor:

usera,USER ANALOG CHANNELS,A-P:1000

From this we can deduce that the configuration sub-directory for the User Analog processor is:

CURRENT_CONFIG\USERA

Configuration Sub-Directory – Loggers
The configuration sub-directory for loggers is simply called ‘LOGGERS’ and is the same for all loggers in the system. Therefore, the configuration sub-directory for loggers is simply:

CURRENT_CONFIG\LOGGERS
[bookmark: _Toc457384667][bookmark: _Toc457386660][bookmark: _Toc457899881]Configuration Files
Each device, processor and logger has a configuration file located in each individual configuration sub-directory. Configuration files do not have any filename extension. The following section describes how the configuration file for each data source and logger is named.

Configuration File – Devices and Processors
Configuration files for all data sources (devices and Processors) within the ScadaPro system are simply named ‘config’. This file is located within the configuration sub-directory for the data source.

Therefore, the full path from the ScadaPro root directory to the configuration file for the Generic  device numbered 2 is:

CURRENT_CONFIG\gener_2\config

Similarly, the full path from the ScadaPro root directory to the configuration file for the User Analog processor is:

CURRENT_CONFIG\USERA\config

Configuration Files – Loggers
The configuration file for each logger is named ‘standard’ followed by an underscore, followed by the logger number. Loggers are numbered from 1 to the maximum number of loggers on the ScadaPro system. To determine the logger number of a logger, open the Loggers menu in ScadaPro main menu and count to the position of the logger’s name in the menu, starting from 0.
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In the above ScadaPro Main Menu Loggers menu, the logger named Engine Control room is number 2 and therefore its configuration file is called

standard_2

Likewise, the logger named Power Use in number 11 its configuration file is called

standard_11

The full path from the ScadaPro root directory to the Power Use loggers configuration file is therefore

CURRENT_CONFIG\LOGGERS\standard_11
[bookmark: _Toc457384668][bookmark: _Toc457386661][bookmark: _Toc457899882]Channel File Types
Each data source in ScadaPro has one or more channel types associated with it. There are five possible channel types in all: Analog Input, Digital Input, Analog Output, Digital Output, Counter Input. A processor typically has one channel type of the output variety associated with it. A device can have anything from one to all five channel types associated with it. Loggers don’t have any Channel Type Files associated with them as they are not a data source.

The Channel Type File(s) associated with a data source are located in the data source’s configuration sub-directory. The name of the file corresponds to the channel type associated with it and is one of the following:

	Channel Type
	Channel Type Filename

	Analog Input
	AI

	Digital Input
	DI

	Analog Output
	AO

	Digital Output
	DO

	Counter Input
	CI



[bookmark: _Toc457384669][bookmark: _Toc457386662][bookmark: _Toc457899883][bookmark: _Toc408991178]
Protecting the System – Configuration
In order to protect a data source configuration, you must set the permissions on the data source’s configuration file. For details on setting file permissions, consult your Microsoft Windows documentation.
[bookmark: _Toc457384670][bookmark: _Toc457386663][bookmark: _Toc457899884]Read and Change Configurations
By default, all users can read and change configurations. To allow a single user access to read and change a configuration, grant that user read and write access to the data source’s or logger’s configuration file. In the case of data sources, the user must also have read and write access permission to all channel type files associated with the data source.

If the user has read and write access on a data source, they can also reconfigure the data source after any configuration changes have been made so that the changes will be reflected in the system immediately. This is done by selecting Reconfigure from the Control menu of the data source’s configuration window.
[bookmark: _Toc457384671][bookmark: _Toc457386664][bookmark: _Toc457899885]Read Configurations Only
To only allow a user to view a data source’s configuration, grant them Read access on the data source configuration file. The user must have at least read access to all channel type files associated with the data source.

A user with read access only to a data source cannot reconfigure the data source.
[bookmark: _Toc457384672][bookmark: _Toc457386665][bookmark: _Toc457899886]No Access to Configuration
By denying access totally to a user on a data source configuration, that data source is hidden from the user completely in both ScadaPro Main Menu and Configurable Monitor.

N.B.
If a user has no access to a data source configuration file, the user will not be able to read or write the data source’s configuration, nor will they be able to monitor the values from the data source.

It is not possible to hide a data source configuration but still allow monitoring of the data source.
[bookmark: _Toc457384673][bookmark: _Toc457386666][bookmark: _Toc457899887][bookmark: _Toc408991179]Protecting the System – Monitoring
In order to prevent a user from monitoring or changing channel values, you must set the permissions on the Channel Type file(s) for the data source.
[bookmark: _Toc457384674][bookmark: _Toc457386667][bookmark: _Toc457899888]Monitoring and Setting Channel Values
To allow the user to monitor and change values for a data source, first of all grant the user at least Read access to the data source’s configuration file. Then, grant the user read and write access for each channel type file you want the user to be able to monitor and set values for.

For example, if there exists a device on the system called DEVICE1, and it has a device number of 1 and has the following channel types:

Device1 Analog Input Channels
Device1 Digital Input Channels
Device1 Analog Output Channels
Device1 Digital Output Channels

and you want the user to be able to monitor and set values of all channels, then grant the user read and write access to the ‘ai’, ‘di’, ‘ao’, and ‘do’ files in the DEVICE1_1 configuration directory.
[bookmark: _Toc457384675][bookmark: _Toc457386668][bookmark: _Toc457899889]Monitoring Channels Only
By their nature, all input channel types are read only and therefore their values are not set within the ScadaPro system. 

Output channels, however, can also have their channel values altered by the user using the ScadaPro Configurable Monitor. To allow a user to monitor an output channel’s value but prevent them from altering that value, grant the user read access only on the Channel Type’s corresponding Channel Type File.

For example, if there exists a device on the system called DEVICE1, and it has a device number of 1 and has the following channel types:

Device1 Analog Input Channels
Device1 Digital Input Channels
Device1 Analog Output Channels
Device1 Digital Output Channels

and you want the user to be able to monitor and set values of the digital output channel type, but only monitor the analog output channel type, then grant the user read and write access to the ‘do’ file but only read access on the ‘ao’, ‘ai’ and ‘di’ channel type files in the DEVICE1_1 configuration directory.
[bookmark: _Toc457384676][bookmark: _Toc457386669][bookmark: _Toc457899890]No Access to Channel Types
You can hide a particular channel type completely from the user for monitoring purposes. 

To do this, set the users access permissions on the channel type file to No Access. 

N.B.
In order to be able to view the configuration of a data source, the user must have at least read access to all channel types within the data source. Preventing a user from monitoring one or more channel types within a data source also prevents them from reading ANY part of the configuration for that data source.

For example, if there exists a device on the system called DEVICE1, and it has a device number of 1 and has the following channel types:

Device1 Analog Input Channels
Device1 Digital Input Channels
Device1 Analog Output Channels
Device1 Digital Output Channels

and you want the user to be able to monitor only input channel types and have no access to other channel types then grant the user read access to the ‘ai’ and ‘di’ channel type files and No Access to the ‘ao’ and ‘do’ channel type files.
[bookmark: _Toc457384677][bookmark: _Toc457386670][bookmark: _Toc457899891][bookmark: _Toc408991180]Protecting the System – System Status
Only users with Read and Write access to ALL Devices, Processors and Loggers within the ScadaPro system can Enable, Disable or Reconfigure the system from the ScadaPro main menu.

Users who have Read and Write access to a particular device or processor may reconfigure that data source from the Control menu of its configuration screen.

Only users who have Read and Write access to a particular logger may enable or disable that logger either from its configuration screen or from the Control Loggers screen within ScadaPro Main Menu.
[bookmark: _Toc457384678][bookmark: _Toc457386671][bookmark: _Toc457899892][bookmark: _Toc408991181]
General Rules for Implementing Security
In order to successfully implement security on your ScadaPro system, you should consult the following rules and guidelines.

RW 	= Read and Write Access
R	= Read access only
N	= No Access
N/A	= Not applicable. This combination will cause unexpected results if used with your ScadaPro system.
[bookmark: _Toc457384679][bookmark: _Toc457386672][bookmark: _Toc457899893]The order of importance of access rights
	Importance
	Access Rights

	Maximum
	RW

	
	R

	Minimum
	N



Examples or minimum/maximum file type access rights:

	Channel Type File
	Access Rights

	ai
	RW

	di
	RW

	ao
	RW

	do
	RW



In the above scenario, the minimum access right of all the channel type files within the data source is RW, and the maximum access right of all the channel type files within the data source is RW.

	Channel Type File
	Access Rights

	ai
	RW

	di
	R

	ao
	RW

	do
	RW



In the above scenario, the minimum access right of all the channel type files within the data source is R, and the maximum access right of all the channel type files within the data source is RW

	Channel Type File
	Access Rights

	ai
	N

	di
	R

	ao
	R

	do
	R



In the above scenario, the minimum access right of all the channel type files within the data source is N, and the maximum access right of all the channel type files within the data source is R.


[bookmark: _Toc457384680][bookmark: _Toc457386673][bookmark: _Toc457899894]Access Rights Scenarios
In the following table, if a data source has more than one channel type file, then use the minimum access right of all the channel type files within the data source:. 

	Configuration File
	Channel Type Files (Minimum Access) 
	Result

	RW
	RW
	User can read or change configuration and monitor or set channel values.

	RW
	R
	The user can only read the configuration, can monitor or set values of channel types whose corresponding files s/he has Read and Write access to and can only monitor channel types whose corresponding files s/he has Read access to.

	RW
	N
	The user cannot read the configuration, can monitor or set values of channel types whose corresponding files s/he has Read and Write access to, can only monitor channel types whose corresponding files s/he has Read access to and cannot see channel types whose corresponding files s/he has No access to.

	R
	RW
	User can only read configuration and monitor or set values for all channel types.

	R
	R
	User can only read configuration, can monitor or set values of channel types whose corresponding files s/he has Read and Write access to and can only monitor channel types whose corresponding files s/he has Read access to.

	R
	N
	The user cannot read the configuration, can monitor or set values of channel types whose corresponding files s/he has Read and Write access to, can only monitor channel types whose corresponding files s/he has Read access to and cannot see channel types whose corresponding files s/he has No access to.

	N
	RW
	N/A

	N
	R
	N/A

	N
	N
	User cannot read or write configuration, nor can they monitor or set channel values for any of the channel types within the data source (data source is completely hidden from the user).





N.B.
The user rights for configuring channels within a data source must be less than or equal to the most important access right among the channel type files
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